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copies made by or for you) or any related intellectual property rights.
Additional restrictions may apply to certain software titles. Please refer to
any software licenses that accompany such software for details.

Join Us to Fight Against Piracy

The Acer Group has been implementing a policy to respect and protect
legitimate intellectual property rights. Acer firmly believes that only when



each and every one of us abides by such policy, can this industry provide
quality service to the general public.

Acer has become a member of the Technology Committee of the Pacific
Basin Economic Council which is encouraging the protection and
enforcement of legitimate intellectual property rights worldwide. Moreover,
in order to ensure quality service to all of our customers, Acer includes an
operating system in Acer computer systems which is duly licensed by the
legitimate proprietors and produced with quality.

Acer commits itself and urges all of its customers to join the fight against
intellectual property piracy wherever it may occur. Acer will pursue the
enforcement of intellectual property rights and will strive to fight against
piracy.
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A network is made up of computers and network devices
that run on different operating systems and communicate
with each other within an environment. The network
connects servers, workstations, personal computers, and
a variety of software and hardware devices like printers
and fax machines. To work properly, all of the computers
and devices in the network need to be maintained.

Advanced System Manager Pro (ASM Pro) is a network
management software that allows you to spot errors or
potential system malfunctions in network devices through
a single management station. It also allows you to monitor
all of the systems and devices on your network without
sacrificing efficiency.

Advanced System Manager Pro consists of two elements:
a manager console and system agents. The manager
console monitors all of the agents in the network. The
system agents are the software programs on each of the
systems in the network that collect information about the
systems and report the information to the manager
console.



) Features

The major features of ASM management system include the following:

ASM Console

ASM Console is the manager console where all of the information that
is gathered from the system agents is evaluated and assessed, using
two protocols: SNMP (Simple Network Management Protocol) or DMI
(Desktop Management Interface).

The SNMP and DMI protocols return the information from the system
agents to the ASM Console through the Management Information
Base (MIB) Object ID get/set requests from the ASM Console.

DMl is an API (Application Programming Interface) that allows system
agents to collect information from the instrumentation code
supporting MIF (Management Information Format) in the system.

System Alert Manager

System Alert Manager is a utility that runs in the background of your
ASM Console system every time you bootup. It monitors network
systems for faults and malfunctions and warns you if such an event
occurs. This utility also includes an event viewer that allows you to
view the event logs of network systems.

ASM Server Agent Utilities

The ASM sever agent utilities are configuration utilities that run under
SCO OpenServer, SCO Unixware, Windows NT, and NetWare. These
utilities allow you to enable or disable password protection, create
and change passwords, change event handling options, and create,
change or delete IP addresses.

ASM MIB Browser (customized version only)

ASM MIB Browser is an MIB (Management Information Base) file
browsing tool included with the ASM package. This tool allows you to
view and modify the OID (Object ID) values of the systems you are
managing on your network. It also allows you to define and maintain
a list of OIDs to view.

ASM MIF Browser (customized version only)

ASM MIF Browser is an MIF (Management Information Format) file
browsing tool included with the ASM package. This tool is used to
describe a hardware or software component of a system. MIF files
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are used by DMI (Desktop Management Interface) to report system
configuration information to the Console.

Asset Manager

Asset Manager gathers information about the hardware and software
configuration of each system being monitored by the ASM Console,
and saves this information in an asset log file for future reference.

Asset Manager consists of four parts:

e Asset Control - shows you the hardware and software
configuration of the system currently being monitored.

¢ Asset Statistics Information - summarizes the hardware
information contents of two or more systems.

¢ Asset Log - Displays the asset log and saves it to disk.

e Asset History - Shows a comparison of two or more asset log
versions of a system.

Statistic Viewer (customized version only)

Statistics Viewer records and displays system utilization information
about monitored systems. This information can then be saved for
future reference.

Alert via LAN

The Alert via LAN (Land Area Network) function of ASM enables
administrators to easily monitor and reconfigure local systems via a
network.

Remote Console

The Remote Console function of ADM allows the administrator to
remotely control the local systems connected to the LAN via the
server, if access is granted.

CMOS Setup Manager

CMOS Setup Manager is one of the ASM utility programs used to
change the CMOS settings remotely. With this remote capability, you
do not need to visit the machine physically to change the CMOS
settings for some abnormal system configuration. This program is not
intended to replace the common CMOS setup function provided by
all BIOS vendors, but for convenience under Windows environments,
including Windows 9x and Windows NT systems. This feature
requires proper hardware support.

BIOS Update Manager



BIOS Update Manager updates the BIOS remotely. With such remote
capability, administrators do not need to visit the machines physically
to upgrade their system BIOS. Administrators can also schedule the
upgrade in advance, and the BIOS Update Manager will perform the
task at the scheduled time. This feature requires proper hardware
support.
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1 Getting started



Advanced System Manager Pro (ASM Pro) is a
network system management tool designed to
assist you in monitoring performance, managing
assets, and detecting errors or potential system
malfunctions in network systems.



) Welcome

The ASM package consists of the following software components:
e ASM Console
ASM Console is installed on the monitoring station and collects the

server and desktop information provided by the ASM Server and the
Desktop Agent.

ASM Console supports systems running on Windows 95, Windows
98, Windows NT, or Windows 2000.

e ASM Server Agent

ASM Server Agent is installed on the network servers that are
monitored by the ASM Console.

ASM Server Agent supports systems running on Windows NT Server,
Windows 2000, Novell Netware, SCO Openserver, SCO Unixware, or
Red Hat Linux.



10

1 Getting started

Features

The basic features of ASM are as follows:

System Information - helps you locate the systems in your network
and collects general information about your systems like operating
system, protocols, addresses, etc.

Configuration Information - shows the configuration of hardware
devices (i.e. BIOS, I/0O ports, hard disks, network interface cards, etc.)
and software installed in each system in your network.

Performance Monitoring - displays utilization information of system
resources like read/write useage, network packets, memory, and the
central processing unit, and shows whether these resources exceed
their allowable threshold value.

Fault Management - checks the systems for hardware errors and to
see if a system resource has exceeded its threshold value. When the
threshold is exceeded, the program notifies the system administrator.
When a hardware error occurs, it can be set to shut down the system
to protect it from further damage.

ASM also provides a number of utilities to help you view information and
manage your network systems:

System Alert Manager (SAM) - runs in the background of your system
and warns you immediately of any abnormal events. You can use it to
trace system failures and malfunctions.

ASM MIB Browser - checks the network for all available MIB
(Management Information Base) defined systems. It can also build a
user-defined browsing object database to view the information for
each system.

ASM MIF Browser - checks the network for all available MIF
(Management Information Format) defined systems. It can also build
a user-defined browsing object database to view the information for
each system.

Asset Manager - monitors systems for any hardware component
changes and logs them into a database for future reference.

Statistic Viewer - monitors systems use and logs them into a
database for future reference. You can use it to identify and reduce
bottlenecks occurring in your network and servers.
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In addition to these features, ASM also supports the following Add-on'
and Snap-in* modules:
¢ Mylex GAM Agent -

e CA Unicenter - This module creates classes and objects in the
repository of Unicenter TNG. The ASM Agent object is created
automatically when a new host is added into the repository (manually
added or by auto discovery).

e HP OpenView -

For specific information about these add-on and snap-in module items,
please refer to their user’s guide.

1 See Appendix D for further information.
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System requirements

ASM Console

e Intel Pentium or higher processor
e 64MB of RAM (128MB recommended)
e 20MB free hard disk space

e Microsoft Windows 95, Windows 98, Windows NT, or Windows 2000
operating system

e Ethernet card
e Modem

ASM Server and Desktop agents

¢ Intel Pentium or higher processor
e 64MB of RAM (128MB recommended)
e 20MB free hard disk space

¢ Novell NetWare, SCO OpenServer, SCO UnixWare, Linux RedHat,
Microsoft Windows NT, or Windows 2000 operating system

e Ethernet card
e Modem (optional for RAS/OOB?)

2 RAS (Remote Access Services) and OOB (Out-of-Band)
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) System setup

Make sure that your computer meets the system requirements before
proceeding. You may also want to change your screen to 800 x 600
resolution or higher for optimum viewing.

Installing ASM Console

To install ASM Console:

1. Insert the Resource CD into the CD-ROM drive on your system.
Click on the Startup icon.

Click on Software Installer, and select ASM Console.

Follow the Installation Wizard.

o~ Db

Click Finish to complete the installation.

Remember to remove all diskettes or CDs from the drives before
rebooting the system.

Installing ASM Server Agent

ASM Server Agent can be installed on four different operating systems.
The installation diskette contains the installation files for the following
operating systems:

e  Novell NetWare 5.x, 4.11

e SCO OpenServer 5.0

e SCO Unixware 7.x

e Microsoft Windows NT 4.0 Server

¢ Linux RedHat 6.2

e  Microsoft Windows 2000 (Server and Advanced Server)

Installing the Novell NetWare Server Agent

Make sure the SNMP (Simple Network Management Protocol) is
configured properly.
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ASM Server Agent requires SNMP.NLM running with Contro/ Community
set to ‘public’;, to allow ASM Console to communicate with ASM Server
Agent.

ASMAGENT.NCF is the script file that loads all related modules of ASM
Server Agent. To load the SNMP use the following command:

load snmp control=public

If you load SNMP.NLM before ASM Server Agent, make sure that the
Control Community has been set up properly. For more information,
please refer to related documents about the SNMP Agent for NetWare
(NetWare SNMP).

Check AUTOEXEC.NCF to see if you have loaded SNMP. Notice that
because of the auto loading feature of NLM, you can not directly find
where SNMP is loaded. The most common module is TCPIP.NLM which
auto loads SNMP.NLM. If you are using TCP/IP, load SNMP by using the
command line /oad snmp contro/=public before loading TCPIP.

For NetWare 4.x and Netware 5.x users, if you are using INETCFG.NLM to
configure the network, be sure to configure SNMP and make sure that the
SNMP.NLM is running with Coniro/ Community set fto ‘public’.

To install the Novell NetWare Server Agent:

1. Use the diskette maker utility on the Startup Resource CD to create
your NetWare installation diskette.

2. Insert the diskette into the NetWare server’s drive.
3. At the NetWare server console, type:
Load A: setup

4. You are asked if you want to install the ASM Server Agent on your
system. Select Yes to install.

The setup program detects the NetWare version and the model of the
server. It copies related NLM files into the SYS: SYSTEM directory
and C: of your NetWare server, and some needed command lines are
added into AUTOEXEC.NCF in SYS: SYSTEM.

5. If the Mylex GAM driver and GAM service is installed in your NetWare
system, the setup program asks you to install the Bbp agent.

6. Press any key to continue. The ASM Server Agent Configuration
Utility is launched.

7. The Password option is highlighted. Set up a password, and exit the
utility.
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A password is required when using the ASM Console to remotely
change or set any values for the agent, such as threshold values and
any trap handling method. If the password is disabled, there is no
security protection for the agent when the Console tries to change or
set these values.

8. Reboot the system to activate the ASM drivers.

ASM Server Agent automatically starts after the server is restarted
and running.

Installing the SCO OpenServer Agent

Make sure the SNMP (Simple Network Management Protocol) is
configured properly.

ASM Server Agent requires SNMP running with community set to ‘public’.
The IP address of ASM Console should be in /efc/snmpd.trap so that ASM
Console can communicate with ASM Server Agent.

Follow these steps to install the SCO Server Agent:

If the ASM installation diskette is already available, go to Step 2.
Otherwise, perform Steps 1 to make the ASM installation diskette from the
diskette image file on the ASM package CD-ROM.

1. Use the Diskette Maker utility on the Startup Resource CD to create
your SCO OpenServer installation diskette.

2. Ifyou are in the desktop window, click on the Software Manager icon.
If you are at the UNIX shell prompt, type “custom” and press Enter.

3. From Software Manager or the custom program, select Software and
then Install New.

4. The “Begin Installation” screen appears. Follow the onscreen
instructions. Click on Continue to accept the defaults.

5.  When the Select Media screen appears, highlight Floppy Disk Drive 0
and select Continue.

6. At the Install Preferences menu, select Full. The asmconfig screen
appears.
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If the SCO Server Agent has been installed, the program asks if you
want to preserve the existing config file. Choose Reinstall to
overwrite the previously installed SCO Server Agent, or choose
Upgrade if you know the existing password.

A password is required for a new installation. The system prompts
you to enter a new password, and after you have entered it once,
prompts you to reenter it.

After you set up the password, select the SNMP_Config option, and
enter the IP address of the ASM Console system. (You can run
asmconfig at a later time to add or change the ASM Console IP
address. See the ASM Server Agent Utilities chapter in the ASM Pro
manual for information about running asmconfig.)

If the SCO Server Agent has been installed, target IP addresses
appear on this screen.

The installation process adds the ASM agent driver to the SCO
operating system, and the following message appears before the
kernel relinks.

Adding device to system configuration files. . .
When the installation is complete, the following message appears:
Installation Complete.

Exit Software Manager or the custom program, and reboot the
system.

Configuring ASM Server Agent for SCO OpenServer

You may disable the password if you are installing ASM Server Agent to
use only UPS (Uninterruptible Power Supply) or RDM functions.

You can use the asmconfig utility to set up a password for the agent. A
password is required when you are using ASM Console to remotely
change or set any values for the agent.

Refer to the ASM Server Agent Utilities chapter in the ASM Pro manual for
instructions on how to use the asmconfig utility.
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Installing the SCO UnixWare Server Agent

All of the following procedures require root permission.

To install the SCO UnixWare Server Agent:

1. Make the ASM installation diskette from the DD file on the ASM
package CD-ROM.

Mount the CD-ROM drive. For example, mount the CD-ROM to /mnt.

3. Insert an empty 1.44MB diskette into your floppy drive and execute
the command:

# dd if={PATH}/asmuw.dd of=/dev/rdsk/f03ht

Here, {PATH} denotes the directory where asmuw.dd is located. For
example, /mnt/UnixWare.

4. Insert the ASM installation diskette into your floppy drive and, at the
shell prompt, execute this command to begin ASM installation:

# pkgadd -d diskette1 asm

The installation process copies the ASM Server Agent package into the
/usr/asm directory, and automatically makes changes to the following
system configuration files:

/etc/netmgt/snmpd.comm
/etc/netmgt/snmpd.peers
/etc/inittab

After the installation is complete, ASM Server Agent can be manually
started by executing the command:

# /usr/asm/asmsmuxd

or it will automatically be started on the next system reboot.

Before starting ASM SMUX Agent asmsmuxd, execute the ASM
Agent Configuration Utility asmcfg to configure at least "SNMP",
"ASM_Password" and other parameters. Refer to “Chapter 4 - ASM
Server Agent Utilities” in the ASM Pro manual for detailed instructions
on using the ASM Configuration Utility.
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Installing the Microsoft Windows NT Server

Agent
Before installing the ASM software, make sure that the TCP/IP and its
related SNMP service are installed on the server.

Follow these steps to install the Windows NT agent:

1. Insert the installation CD-ROM into your drive after booting NT and
logging in as the system administrator.

2. Click on the Start button and select Run. A dialog box appears that
allows you to specify the setup program in the NT directory of the
installation CD.

Verify the path and click OK. The Welcome screen appears.
Click Next. You are asked to stop SNMP service.

5. Click Yes. You are prompted to choose a destination directory. If you
only want to install ASM SNMP agent and Remote Console, you can
choose Typical. If you want to choose more components, click
Custom. There are five components in ASM agent:

¢ SNMP agent
e DMmI

ASM Pro agent defines a proprietary ASM.MIF that supports the
same items as the SNMP agent.

e Server Mif
The server.mif that defined by DMTF will be installed.
¢ Remote Console

The Remote Console Server is installed which can be remote
control by Remote Console Client

e MMC

This component is only supported on Windows 2000. And it is
integrated with Microsoft Mangement Console.

6. Click Next, for the default directory, or click on Browse to find your
own destination directory. Check any components you want to install,
and click OK.

The asmcfg utility launches automatically.
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You may skip steps 7 through 11 if you are installing ASM Server
Agent solely for the purpose of utilizing UPS and/or RDM functions.

Enter a password and click OK. A password is required when using
the ASM Console to remotely change or set any value for the NT
Agent. If the password is disabled, there is no security protection for
the agent when the ASM Console tries to change or set these values.

Enter the IP address of the ASM Console system, then click ADD to
add trap destinations. Click OK to end the asmcfg utility. This IP
address tells the Agent where to report (trap).

Click Yes to save your changes. The view readme file dialog box
appears.

Click Yes to view, No to continue.

Click Finish to exit setup.
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1 Getting started






This quick tour is a step-by-step tutorial that
helps you get started with setting up and
customizing ASM Console for your needs.

This tour shows you how to find network
systems using the Auto Discovery function,
manage them with the System Listing window,
customized background graphics, printer fonts,
and warning messages, and configure polling
intervals.

For a complete reference to the commands and
functions of ASM Console, please refer to
“Chapter 2 ASM Console” on page 15.
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) ASM console

To launch ASM Console, press the Start button and then select Programs
> ASM > ASM Console or you can double-click on the ASM Console
shortcut icon.

If you are using ASM Console for the first time, it will ask you to initialize a
password before continuing.

To initialize a password, enter a password in the New Password field, re-
type the password in the Confirm field, and then click OK. From now on,
the Log In dialog box will prompt you to enter your password each time you
access ASM Console.

After initializing a password, the Auto Discovery window appears:

System Listing window is empty when you launch

;— — 1 Auto Discovery Button } 77777777 ASM Console for the first time

#)ASM 4.0 Console
Fig, Setup Utiity Admin Yiew Window Help

[ien %o (22[momve

&) System Listing

...... ALL [LL] System Listing
Name | Address los | Protocol | Connection |
“#)Auto Discovery H[=lE3
IR L
- Marne [ Protocol [

Time Autodiseovery message

& 134253 Mo message
@ 134253 InitIP subnet
& 124253 Init IPX subnet

=
| ER 1323210
|
|
|
|
|
|
|
|
|
|
|
|

|Status : Init IPX subnet 4

134311

|
< v |[0f0  [Alert Time: NZA  |Alert: N/A
I

I
Highlight a subnet and then click the The Auto Discovery window displays automatically
Refresh button to search for systems when you launch ASM Console for the first time

= — e
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Auto Discovery searches for available systems Displays the supported service for a system.
in the network and displays them here The protocol could be SNMP or RPC
T \

2106310 Name | Pratocal |
R =} al=rtorl=n [210 63 107 146] [ E148 Deskiop Infarmation RFC
asmnt2000 [210 63101 158] 6% Desktop Hardware RPC
chrischang-1 [210.63.100.108]
chrisnt [210.63.101.59]

monet [210.63.101.3]

pmi17d1 [210.63.101.160]
21063101234

g} Generic Nods : <
%g 1929210 Time Autodiscovery rr!essage
@ 160002 Found DMI service Acer HG...

@ 16:00:02  Found DMI service ADM Se.

@ 160002 Found M| service ADM Se..

@ 16:00:02  Found DMI service Acer HG.

@ 1600:07  Find all routers

@ 15:00:07  arrange folder

@ 160007 Ready Bl
A

|Status : Ready ';‘ Z
1

Displays Auto Discovery messages and

the time they appear

Understanding system listing

The System Listing window is the main interface of the ASM Console. Itis
from this window that you will be doing all your work. The System Listing
window consists of three panels: System Organizer, All System Listing,
and Service panels.
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- connected
- disconnected

This panel indicates the connection status of the
system. It can be:

...... AL [5LL] System Listing v
Name
ZIDEINOLEE  Windows 98 2 Connected
2106310365 Windows NT IF £ Connected
21063101253 Windaws NT IF & Disconnected
Service [ Frotocal [ State [ Health |
|68 Deskiop Hardware B Alive BNoimal
i Desktop Information RFC 1§ dlive E@Nomal
A A
eagear ) ) ‘ + "
,,,,,,, q [ ‘
| | |
I I |
I | I 4
| |
| -0 |
|

The default services for server
system are:

- System Hardware

- System Information

The default services for desktop
system are:

- Desktop Hardware

- Desktop Information

This panel indicates the protocol

of this service. It can be:

- SNMP for SNMP services

- RPC for DMI Instrumentation
code

This panel indicates the health
status of this service. It can be:
- Normal

- Abnormal

- Not Supported

-
‘ \
[
[
[
[
[
[
[
[
|

- Alive
- Unstable
- Dead

This panel indicates the state
of this service. It can be:
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Click and drag a system from the
All System Listing to the new folder

Create a new folder here for classification

T

“K) System Listing

[M7E 7] S pstem Lit
Ad

Connection

2106310196
R ntstd 2106310365
B monet 210631013

Service [ Protocel [ State [ Heaith [
€% Desktop Hardware AP & Alive RANot Support
*s Desktop Information  RPC ' Alive [BNot Support

Customizing system listing

If you get bored looking at the same background graphic or if the fonts you
are using now hurts your eyes, you can easily change them to fit your
needs. Also, you can set the warning option to warn you before it executes
a certain command. To display the Option dialog box, select Setup >



27

“KIASM 4.0 Console - VBSLA_NTSTD M=
Information Utilty Admin Yiew Window Help
”ﬁ @ Config Paling Interval & ” 02 a3
S EventHande
% System Alert Manager
] ELL 0
o % CERS « @
#)System Listing [_[O]x]
||ai k2| & BB
i AL [ALL] System Listing
) fddress
ZI0B310365  Windows NT P £ Comnected
21063101253 Windows NT P £ .Disconnected
Service [ Protacal [ state [ Healh |
|8 Deskiop Hardware RPC i Alive EAomal
-8 Desktop Information RPC ) tive BNomal
VA
4| v l0/0  [Alert Time: N/A  Alest: N/A [1847:03

User interface (UI) tab

Choose a graphic to change the
background display of ASM Console

Gives you an option to display all or
selected toolbars for a system
or service. The default setting is

“Show Selected”
I |
Opti E3
1] |Waming | | |
Background Toolba|+
“asmhkg brmp Browse. .. | ‘ = Show All
i+ Show Selected
Printer Font N -
ote
Title : IDBfauIl Thiz option take effect
afte_r you cloze t_he
Body - W Bhaes. | Option 5 etup window.
A
I
OPtj'onB' ok | Cancel | Apply | Help
|

Choose a font for the title and hody
text of the printed material
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Warning tab

The options here indicates whether ASM
Console should warn the user when one
of the following event occurs

I

] Warning | +

Dizplay warning for following commands :

V¥ Delete a Service
V¥ Delete a Folder
¥ Exit this program

Options Ok | Cancel | ool Hep

Configuring polling interval

ASM Console polls each monitored system to get information and checks
on the systems for faults and malfunctions. You can set the frequency by
which the ASM Console do this by stting up the polling interval of each
system. To access the polling interval window, select Setup > Config
Polling Interval.



“KIASM 4.0 Console - VEELA_NTSTD
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JH[=] E3
Fi Y Information Uty Admin View Window Help
| ICEEERT
< EventHande
”- System Alert Manager
” @ 8 Option Paud |
“H1System Listing [_[O] x|
(| R ]
ALL [SLL] System Listing
2106310195  Windows 38 & Cornected
2106310365 Windows NT P & Cornected
21063101.253  Windows NT P &, Disconnected
Service [ Pratacol [ State [ Heaith [
{5 Deskiop Hardware RAPC Blive BANomal
£ Diesktop Information RPC 1§ Alive [BANomal
4
4| 070 [Alert Time : N/A  [Alert: N/A [14:4617

Alive Polling indicates how often

the connection status between the
Console and the agent is checked.
Polling interval must be from 01 to 60

Information Polling determines how
frequently the Console polls the Agent
to update its data. Polling interval
must be from 01 to 60

I
Config Polling Interval

Hast Name NSSLA

Addrets : [FTE 1M

36 T

Lgent Tyile |
Alive Poling
Curment : |1 Sec.

Hew: [1 3 See

Info Puuing—+—
Current : |5 Sec.

Mew : |5 _I:j Sec

pply to all systems

|_>|_ Apply ta all service

Cancel |

A
i

to all services

You can set the interval to all systems or
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System alert manager

System Alert Manager is a utility that runs on the background of your
Console system every time you bootup. It actively monitors network
systems for faults and malfunctions and warns the administrator if such an
event occurs. This utility also includes an event viewer that allows you to
view event logs of network systems.

|
You can view SNMP Traps, DMI Indications,
and AVL Packets by clicking any one of these

[ System Alert Manager M= E
File  Edit {iew— Help — — -
JJmM d AllAlerts |@:|
F Trap
Alert T 5 | . 7
~System Alert Manager
l’ | .
L ]
| Al Alerts
2 ' o :
SNMP Traps{0] _E ' SNMP Traps_
| DMI Indications
I -
: Alert via LAN
[0] = e : i ? B 3
bl i
| | i
‘ ' | [16:15:1
|
|
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ystem Alert Manager - SHMP Traps
File Edit 38 Yiew Help

IEC

Alert Type Ih.. | Time | Host | Address | Typal Diescription |

MIB Manager

MIB File
Server Add

el
4
|SNMP Traps [11:03:3 2

A
|
|
|
|
|
|
|
|
I

SNMP Traps also contains a MIB Manager that allows you to add or remove
customized trap definition for SAM. If you have a third party device that
supports MIB files, you can add this to the database and configure each
trap type
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To receive a DMI Indication, you have to register
the source system to the service provider. ASM
Console will register the machines in the System
Listing automatically
T
G System Alert Manager - DMI Alert _[O]
1
2l
1
In... | Time [|Hast [ Tope | Deseription |
|
|
|
Machine Manager [x]
Hachine [ Aotess [ Status | Addiess Hst Name
<< Add
iﬁ wEEla 2106310196 Renistered —I 192.3.210.27 TEDPANGNT
5] 21063101253 Registered 2 g 21 ‘”
192.9.210.88 GOLDEMLIN
1929.210.1 MONET
192.9.210.200 Ns&
— P Refresh>>
- Lehs |
|
| Manual dd
! - 4 Subret
L Feaier | Uneaiter | I o flsain ] _Hew
A A |
| | | |
_____ 1 | |
| = |
|DMI Alert I I [11:04:2 ; |
T |
1

Click these huttons to
Register and Unregister
a system respectively

Click this button to refresh the list and
add a new system or click the Manual

Add button to add a system

Click this button to view a new
subnet. The systems found in
the new subnet will be displayed

in the right panel

Assigning event handler

Select Edit > Event Handler or click the Event Handler button on the menu
bar to access the Event Handler screen. Event notification applies to
certain systems that you specify.



! System Alert Manager

SHMP Traps[0]

I

DMl Aler{0)]

. —
I
A¥L[0]
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18|33

; 'S.yste"'m Alert .M_ahager -

Al Alerts
SNMP Traps

Alertvia LAN

o

|System Alert Manager

[17:24:0 2
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< DD
<< Add Al

Show >

Event Handler

Default
=45 SHMP Trap
%8 Server

DMI Aletts
5 ADL Aletts

Close

d

Disable || Dt Seting | D | setal |

Setup ||| Pager || Progrem| | Saund |

Conzole Side Action
¥ Wwisming Dislog Box
™ Flashing Titls Bar
I~ Audio Alam

I™ Dialto a Pager

[ EMail

™ Run progiam

Agent Side Action
I= Shut dopn server

I= Execute auser defined Piagiam
I~ Broadoast a waming Message

Click these buttons to add specific systems
to handle and define different settings

Event Handler

%8 SNMP Trap

; = <ADD
|

=45 DMl Alerts i << Add Al
[ER<) ollage
B¥ Citical ;
B waning _ cothde |
B Nomal
%5 Vitual memory

&5 CPU temperature
%5 GO resource

Clase

=
Delete | seal |

Discble | | Default Setting |

Setup |Mal | Pager | Program | Sound |

Agent Side Action

J= | Shut down server

I™ | Evecute a user defined Program
™ Broadeast a waming Message

Cansole Side Action
¥ ‘warning Dialog Box
I¥ Flashing Title Bar
¥ twudio Alarm

[¥ Dialto a Pager

v E:Mail

¥ Fiun pragram

2 Quick tour

Click this button
to display the
Machine List

Machines at subnet §82.9. 210

Addiess Host Name:

192.3.210.27 TEDPANGNT
192.3.210.51 ASMNT
192.3.210.31 MA&
192.3.210.88 GOLDENLIN
192.5.2101 MONET
1929210200 MM

Refresh
Subnet
1923210 M New

Select 3 maching to sstup its event
handing method.

Click this button to apply the current settings to all sub items under the
currently selected item. Example, select Voltage Indication and click Set
All, the sub items, critical, warning, and normal, takes the current settings




Click this button to reset the
event notification function to
the default setting

Event Handler

35

Click this button to remove the
event notification function
assignment to the system

Default |

MOMET [192.9.210.1] |

=153 SNMP Trap |
=45 Server |

= 3 T criperature

=3 Temperaturg Critical

EB ECC Memary Erar

E® Fan Stops |

EB Voltage Exceeds Sate Range

j B pUs Utilizat*on High

Disable | Default Setting |

=] CADD tachines at subnet 192.9.210
Address | Host Mame |
1929.210.27 TEDPANGNT
<< Add Al 152921051 ASMNT
o - 192.3.210.31 MAA
<< Hide 192.9.210.88 GOLDENLIMN
MOMET
1929210200 MA&

Cloze

| Sl

Setup :l T | Fager I F’rograml Sound'

C Insole Side Action
v] ‘wWarning Dialog Box
|_| Flashing Title Bar
|_| Audio Alarm

'] Dialto a Pager

I E:Mail

I'T Run program

Agent Side Action

= Shut dowr senver

I™ | Eszcute & user defined Program
™ Broadcast a warring Message

Refresh |

Subnet :

|192 9210 - MNew

Select a machine to setup itz event
handling method

Click this button to disable the event notification function assigned to this
system forcing it to adopt the default event notification function setting

Event viewer

Event Viewer gathers information about events in the system being
monitored by the ASM Console. This information is then saved in the event
log file for future reference.
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[:j System Alert Manager
File Edit Mode Wiew Help

EXELREDEE

Alert Type

- system Alert Manager

M Alerts
 SNMPTraps
7 DMI Indlcatlons
 AlertvialLAN

AlL[0]

|System Alert Manager [11:15:5 2
|
‘ Click here to switch to Event Viewer function




Click this button to view a
single event log information

Click this button to view multiple
event log information
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Sy:item Alert Manager - v66la_ntstd
File Edit Operation  Yiew Help |
| |
[oBE Pe e BB ———
Alert Typs Server Na.. | Type] Oceurring Time | Description I=|
- wBBla_ntstd - 1006 WedJun 09 05:30:131999  Fan iz not running properly. Pleasze wun ASM E..
Evvent Yiewer vBEla_ntstd 1006 WedJun 090530151339 Fan iz running properly.
wBhla_ntstd 1003 Fridun 11 02:11:32 1999 Free drive size iz lower than “Waring Thiesho...
wBBla_ntstd 1009 FriJun 11 O7:35:44 1999 Asset ters changed. Please run Asset Mana...
wBBla_ntstd 1009 FriJun 11 07:35:45 1999 Azzet tems changed. Pleaze run bszet Mana
wBEBla_ntstd 1003 FriJun 11 10:16:50 1933 Free drive size iz lower than wWarning Thiesho...
wBBla_ntstd 1003 Fridun 11 10:16:50 1993 Free drive size iz lower than “Waring Thiesho...
? wBBla_ntstd - 1003 Fridun 11 10:17:09 1999 Free drive size iz in narmal condition.
maE wBBla_ntstd 1003 FriJun 11 10:17:09 1393 Free drive size iz in normal condition
NTSTD wBBla_ntstd 1003 Fridun 11 10:17:40 1333 Free diive size is lower than ‘waming Thiesho...

- wBBla_ntstd 1003 Fridun 11 10:17:40 1999 Free drive size iz lower than “Warning Thiesho...
wBBla_ntstd 1003 Fridun 11 10:17:40 1999 Free drive size iz lower than Critical Threshald
wBBla_ntstd 1003 FriJun 11 10:17:40 1993 Free drive size iz lower than Critical Threshold
wBEBla_ntstd 1003 FriJun11 10:18:18 1939 Free drive size iz lower than Warning Thiesho...
wBBla_ntstd 1003 Fridun 11 10:18:18 1939 Free drive size iz lower than “Waring Thiesho...
wBBla_ntstd 1003 Fridun 11 10:18:36 1999 Free drive size iz in narmal conditian.
wBBla_ntstd 1003 FriJun 11 10:18:36 1999 Free drive size iz in normal condition -
Server Mame | Address | Count | Percent... | Erent Statistics
wBEla_ntstd 210.63.103.2 84 100.00

100.0%
B vty rtstd
¢ By Server " By Type * Pie O Bar (Sl I G
¥66la_intstd [11:16:5 2
I

Lists the systems found in the System Listing of ASM Console
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) Remote console

The Remote Console function of ADM allows the administrator to remotely
control the local systems connected to the LAN via the server, if access is
granted.

Type in the system’s name or IP address
to connect to the remote system
1

9 Remote Console [_[O] x]
Fle Wiew Help H
|
] Comect S 'W | @
&f| Discanrect ]
E® Eile Transfer |
|
£ Snapshot |
Lock Keyboard }
Unlock Keyboard |
Lock Mouse Connect to remote computer [x]
Unlack Mouse |
You can use the host name of IP addess to specify the camputer you want to cannect to,
Press Search button to find all avalable computers in your local network
Comnect |
Computer g
[ Carcel |
Password
A Seach |
I
|
|
|
|
|
|
|
|
|
|
Connect to the machine you want to control : 4

|
Type in your password to access
Remote Console Agent




The File Transfer function allows you
to get/put files into a remote system

5 Remate Console - VE6La [210.
File View Help

&F Connect
8} Disconnect

1.96]

@ Snapshot )

Lock Keyboard g - Desktop Agent

Unlock Keyboard View [Go Favoites Tools  Help
Lock Mouss =
Urlack Mause . = [H % 32 =y
Fonar Up Cut Copy  Paste Undo Delete  Properties | Vies

[

Desktop Agent

My Camputer
(25 3% Floppy (4]
== Wing8 [C:]

Z Backup
O] adm23199
=1 ASM40-0604
-] Console
5] Daskiop Agsnt
21 1dem331-5107-aal
(1 Winzip
Dmi2sp
Logs

25 My Documents

Hame | Size | Tupe
] _inst3ziex_ HNHKE EX_Fie
] _setuplib 241KE LB File
admm.pf KB PDF File

dala 11.379E  WirZip File
(o8] sk id 1KB 1D File
(2] Readme 11KE  Test Document
B setup 45KB  Application
P& s 101KE  Intemet Communicz
(s8] setup.pkg EKB  PKG File
5] setupstr 5KE Configuration Settin

File Transfer

ASM Agent automatically creates a folder called
“Upload” in the ASM program folder. You can only————1
access this directory for security control |

ile Transfer Console - 210.63.101_96

Prograrn  Command  Help

o5 7|d |82 I
Refresh M
[LocallE:Progiam FilesiAoet S TES L) [Remate]C:\Pragram FilestAcer A5 AU pload
== |
Mame | Size | Datex’T..ﬂ Narne | Size | Diate/T...
. - |
B samdb 06A114...
Mkdir
gDeIsU.isu 80708 06114... _I
Bl Unesh.exe 20450 055, _Delete |
gSpIash.me 167478 04/20¢... Flefreshl
gASMBKG.bmp 21038 02/03/...
g CoolUldl 274432 0B/0474
? iRk Al “A1RRA ﬂﬁ!')lﬁa’_'j
1 3
Time | Message |
11:23:01  Connecting to 210.63.101.98
11:2301  Connected to 210063.101.96

39
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Asset manager

Asset Manager gathers information concerning the hardware and software
configuration of each system being monitored by the ASM Console. This
information is then saved in an asset log file for future reference.

Select the systems whose asset
information you want to view

|
“"ZASM Asset Manager 5]

File Dggration window Help
|66t J&EeRvoaasa? @]

sset Control - v66la [210.63.101_96]

= 65 ltem Amaurt
ﬁ Processor “wirZip Self-Extractor 1
Base Board WirZip 1
Q Memary Module A5M 4.0 Desktop Agent 1
& Disk

18 Wetwork Interface Controller
Video

% WinZip SelfExtractor

(# winZip
(# ASM 4.0 Deskiop Agent
GH Assattag

Asset Log

LastLog Date  |Mon Oct 05 11:47:23 1938

For Help. press F1

A
A
|
|
|
|
|
|

I 4

Shows the log date




F"%ASM Asset Manager

Select the Asset Statistics Info to collect

and view multiple statistical information
T

Window Help

[ve B reimesseiin Ba B s @Ee ? | @
& Refresh
.63.101.96]
Attiibute
& Assetlog |
1] Asset History |
E Select Machine
g Machines Found [2 Machines Selected [1
=
Machine [Address [ Machine [Address |
NTSTD 2106310365 Add>> I WEBLA 210.63.101.96
WEELA NTSTD 210.63103.216
Rlemove <<
0K
Cancel
Get Asset Statistics Information v
This panel displays asset statistical information for three |
desktop systems displayed in the lower right panel 7‘
! |
Ele Opeiation Window Help) i
|
|[vesLa JEeBssmae ? | @

sset Control | YG66LA [210.63.101.96]

“EAsset Statistics Information

Processor |
% BaseBoard |
& Memom Modulel
& Disk |
18 Network Intettade Cortioller
Video
[# Software W
[# ASM 4.0Desktop Agent (2]
[# CuteFTP
[# Intel DMI 20 5P SDK
[# HyperSnap D
(¥ Miciosaft Intemet Explarer 4.0
[# Microsoft Music Contral
[# Miciosoft wallet
~[# Microsoft Outloak Express
[# VDOLive Player
“BH Asseitag

Item
Frocessor 3|
Base Board 3
Memory Modue 5|
Disk a
Netwark Interface Contro... 4|
Video al
Saftware 1
Assettag 2
|
|
|
|
h 4
Machine Mame__ | Addiess [os
nistd 710310365 Windows 96

VEBLA 21063101 96 Wwindows 38
VEELA_NTSTD 21063103216 Windows NT

For Help, press F1

41
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Systems found by the query is displayed here ‘

I
SM Asset Manage: I [=] E5
|
e : ; '
WE &= Fietiieve Asset Cil+hl aBespae ? i e
@ Fefiesh |
R Asset Stalistics |nfo |
I
B AssetLog Item Amount |
0 ASM 4.0 DeskiopAgent 2
) Asset History o M 5 I
& Conl Processer Intel DMI 2.0 8P SDK 1 I
Asset Information Query I
6 Memory M
~Valug Select 4
& Disk alue Selecto ftem L [ Amout |
- Network I | e cen Tune l—;l Central Processor i 1
Video - Fential Progessor Central Processor } 1
# =l | | Processor Famil Peium I - }
3 CuF || e cor Manufoctaes g
(¥ Intel D |
g :?:.? Processor[D Dont care < :
D Ve pacesorverin ET— !
e Machine Name | Addiess W | Amaunt |
[ vpoL | | Mesimum Speed [Pontcars /66l 21063100196 1
YEBLA_NTSTD  21063103.216 1
BH Assettag
Current Speed Don care -
Processor Upgrade Don't care -
|
|
I
Fowma o o | |
4 |
Statistics Query | | [ 4]
1
‘ Select the item you want to query ‘ ‘ Select any value in this field to find a system ‘
ZLASM Asset Manager [-[Of <]
File [ Hi
|t retipesseitin B e S @E S 2 @
@ Refresh
£ Asset Statistics Info
[ Amount
Zip Sl Extracton 1
WinZip 1
ASM 4.0 Deskiop Agent 1
WinZip SeFEiactor  Totel Assellog: [T
[F WirZip
: Machine [ Item [ Model [ Description [ Time I
= (3 ASk 40 Deskion Age - (erry Softare Wirdip 1 Thu Oct 08 13:44:00 1938
B Assettag VBELA Softare A5M Console... 01 Thu Oct 08 13:44:00 1938
—————— » S Clear
1
|
Show Asset Log i
1

|
[ i 4
|

Click here to save asset log to a text file‘ ‘ Click here to clear asset log




SM Asset Manager [-[o]
indow Help
|[wE &8 Retieve sset £l g@ Eeomae? ‘e‘

€ Refresh

53.101.96]

% Asset Statsties Info

Network Interface Conbioler
Video

WirZip Self-Estractor
[ Wiz
“o[& ASM 4.0 Desktop Agent
GH Assettag

Item Amount

WinZip SelfEatractor 1

Zip 1
#5M 4.0 Deskiop Agent 1

Asset Log

LastLog Date [Mon Oct 05 11:47:23 1398

Show Asset History

| You can view old asset information |
I

History : V6ELA98 [210.63.101.96] <]

[ Version | Time T |
1 ThuJulldT 22:00:16 1939
2 Thu JuRI1 22:06:31 1999
ThuJul 01 2

FriJul 02 01:39:21 1999
FriJul 02 01:43:52 1999
FriJul 02 02:07:20 1939
Fri.Jul 02 02:57:39 1999
SunJul 04 22:23:56 1999

————

Wiew
it

Dietails >

Clear

[ERERERTI

History : ¥66LA98 [210.63.101.96]

[ ersion | Time
1

ThuJul 01 22:00:16 1939
ThuJul 07

3 ThuJul 07 23:20:43 1939
4 Fri.Jul 02 01:3%:21 1933
5 1333

Sun Jli 04 22:23:56 1999
|

x|

IEE

—
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
(I

|
|
|
|
1
1

|
|
|
|
|
1
|

Click Details>> to view history log ‘ ‘ Or compare the difference between two log versions ‘
T

History : V6ELA98 [210.63.101.96]

Yersion | Time |
Thu Jul 01 22:00:16 1993
Thu Jul 01 22:06:31 1999
ThuJul 0] 232043 1999
Fiiul 02 01:35:21 1999
FiiJul 02 01.43:52 1999
Fiiul 02 02.07:20 1999
FiiJul 02 03.57.39 1999

Sun Jul 04 22.23:56 1939

o0~ T O e L R

Wigw
iff
Fee— v |

Clear

v

Inddex [ ltem [ Model [ Deseiiption [ Time

1 Software ASH Cons. 150 ThuJul 01 22:00:
2 Disk. CO-ROM 01 ThuJul 01 22:06:
3 Disk. HadDisk 130 Thudul 01 2206
4 Disk. HadDisk 031 Thudul 011 23.20...
5 Disk. COROM 150 Thudul 01 23.20..
i Disk. HadDisk 130 Fiioul 02 013521 .
7 Disk. HadDisk 031 Fiioul 02 01.4352..
H Sofwaie  ASM Cons.. 031 Fiisul 02 02.07:21..
5 Solwaie  ASMCons.. 130 Fiioul 02 03.57.39.

Click <<Hide to hide
the history log

Clears all asset histories. This command should
have a prior permission set in the agent system
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CMQOS setup manager

The Auto Discovery function helps you
locate systems in the network

CMOS Setup. SIS

ERE

VBELA ::210.63.101.96 -| @ [

| Auto Discovery
Autodiscovery Wizard Curent Selected system: [T

71063101 Stop | [Address  [Agem |
21063101 38/86LA [B 2106310785 VeeLA
21063.101.2630MEELANT) Carcel

B 1523010
Fefiesh
Add >

<< Remave

Wialing time

[Fhecking 0

Ready —
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‘ Click any item here to view or update ‘ ‘ View or update in this panel ‘
T T

05 Setup
lew Help

port CMOS definion
Esit

12 IDE Frimary Chanred Shevs
B 108 Secandury Chasnsl Hastee

12 PaPIFCI Sy Configeeston
B Chp Semngs

Get CMOS data of the selected machine

CMDS Setup

Get CMDS

Look in I {23 ASM Console

samdb
UpdateJab
UpdatePlkg

File name: IIEE Open I
Files of bype: ICMDS definition files [*.icf) j Cancel |

Import CMOS definition I
|

You can import CMOS definition file if the CMOS version of the target system
does not match the current definition then you can setup CMOS remotely
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The Auto Discovery Wizard guides you to find
systems in your network when you launch the ———,
BIOS Manager for the first time |
|
% ’BIOS Update Manager [_[O]x]
System  Wiew Help |
I
== Stait UpService B ‘ I
[ Jur  Sigp Service 08 ] .. Start Service =]
[
b.
Autodiscovery Wizard Cunent Selected system - [
= g 21063101 GE Y [ Addiess [ Agent |
210631011 210E3101.96  VEELA
210063.101.36[VERLA) Cancel
21063101 253(WBELANT] —I
Add >
< Remove
‘Waiting time
5 sec
[Firishednt Load Save
]
Auto Discovery 4
To import a Flash BIOS Package into BIOS Update Manager:
1. Click the Import button to open a package file
2. Click the Add button to add it into the list
T
= 'BIOS Update Manager M =13
File [T Svstem View Help v
Auabiceey
Start Up Service
[Jul  StopService [ Flash BIOS package =)
[Jut Clmeot] [ERTEMPPragam L
Joh
[ T
Description: l@a
Path: [E:\Program Files\Acera5M ConsoletJpdatePkgh0
Add
- Packags list
Remove
Package | Description | Path
whEla whEla E:\Pragram Files\acertaSM Cansoleiil
Al I il
oK
7|
Package 4




After you have define a package list, you |
can define a job and schedule it to run
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= - BIOS Update Manager =15 |

Systern Wiew Help

- ——

AutoDiscovery |
Start Up Service I_El

Package list Job seleted
Package [ Description I Wachine 0s P Address
mﬂ EEIDP\]»JN] {Egmglg \S;AUK.... T VEELA-MTET Wind8 210631013

Ll 1 |

Machine list:

Machine 05 IP &ddiess
VEBLAMTET Win98 21063101
<< Remove

Kl I |

Scheduling | [1une 11,1333, 11:32:33 . o
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2 Quick tour



3 ASM Console



ASM Console is the central management station
where the information gathered from the system
agents is evaluated and assessed using either
the SNMP (Simple Network Management
Protocol) or RPC (Remote Procedural Call).

The SNMP protocol handles communication
between the server and the ASM system agents.



51

) Launching ASM Console

To launch ASM Console, press the Start button and select Programs >
ASM > ASM Console, or double-click on the ASM Console shortcut icon.

If you are using ASM Console for the first time, you ared asked to initialize
a password before continuing.
Initializing and changing the password

Access to the Console is controlled by a password. You are required to
initialize a password when you access the Console for the first time.

% This is your first time uzing A5M Congole.
e celicanative i To initialize a password, enter a

password in the New Password

New Password : field, then re-type the password in
Confim - | the Confirm field, and click on OK.

ok l Cancel I

After setting up a password, the following dialog box appears each time
you access ASM Console:

To access ASM Console, enter your
% Password : | .

password, then click on OK.
Change I oK. I Cancel !
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If you want to change your current password, click on the Change button
to display the Change Password dialog box.

To change your password, enter your

0ld P, d:
oo | current password, and then enter your
New Password: | new password. Retype vyour new
coofim: | | password to confirm it, and then click

K.
ok | Cancel ! O

ASM Console confirms the password change by displaying a dialog box
with the message "Password changed successfully."

Note: The security password mentioned here applies only to ASM
Console and not to its agents. See “ASM Server Agent Utilities” on
page 155 for more information on the ASM Server Agent security
password feature.
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) ASM Console user interface

The primary interface for ASM Console is the System Listing window where
you can view and check all of the systems being monitored. You can switch
windows within the ASM Console windows by pressing Ctrl + Tab. This
allows you to compare the performance of various systems on your
network by displaying the information about them simultaneously.

Before you view a system, you need to add it to the System Listing window.

“#)ASM Console 4.0 - bull [System Information CI] 0[]
Fle Setup Sewerlnfo. Uity Admin View Window Help

[wlee-22 @oBornanm
EEEEEEEEEETE-

X System Listing
o ak &2 o ® B

= B ALL
@ MTE?

2106310169 ‘windows 98
W scosysv 1928.21018  21063101.253 500 OpenServer 1P & Connected

Service | Protocol | State [ Heslth
amal
mal

6% System Hardware C1 RPC B alive FRdbn
Cl =)

I 21
e — r
! - g‘;‘# o » - e
ik e - .0 . - - T
|22 |Alert Time : 13:33: 1”A|Ell [210.63.101.253] SCO TCP/IP Runtime Release 2.0.0 133326 -

Menu bar and toolbar

Toolbar buttons allow quick access to selected functions in ASM Console

through a single mouse click. The Menu Bar contains the following items
and commands:
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3 ASM Console

The File Menu contains commands that allow you to print reports, to
save information about a selected system, or to quit your ASM
Console session.

Command Icon Description

Auto Displays the Auto Discovery screen.

Discovery

Insert System . Manually adds a new system
J

Delete Deletes an existing system or

System/ % highlighted agent

Service

Refresh Server Reconnects to a selected agent or
@ selected agent services

Exit Exits ASM Console

The Setup Menu contains commands that allow you to specify the
systems to be managed by ASM Console and to set its initial value.

Command Description

Config Polling Interval Allows you to set polling intervals
Event Handler Specifies event handling

System Alert Manager Specifies the system alert manager
Option... Displays the option window

The Information Menu allows you to specify viewing commands for
either server or desktop information. The list of commands displayed
depends on which type of service you choose. Both types of
information are described in the following tables.
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Command Icon Description

Basic Displays general information about the

Information system and the system manager. For
servers only.

0O.S. Displays the configuration of your

Information operating system

DMI BIOS Displays information about the
processor, BIOS, and memory for the
selected server

1/0 Devices Displays the configuration of I/0O devices
@ installed on the server

Storage Displays the configuration of the server
system's fixed disks

Network Displays the configuration of the server's
network interface cards. For servers only.

Resources Displays information about IRQ
q‘j addresses, DMA channels, I/0 ports, and

memory addresses

BIOS Event Displays the event log stored in the

Log 'ﬁl NVRAM

Performance submenu

Processor Displays the CPU utilization

Memory Displays the server's system memory

@ utilization
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Command Icon Description

Disk Displays Disk Utilization of Windows NT
and SCO OpenServer servers. For
servers only.

File System Displays the server's file system usage.
For servers only.

NIC Displays network card receive and
transmit transactions

NIC Faults ; Displays the number of instances of
different faults in the server's network
cards

Device submenu

UPS Displays information concerning UPS
connection and configuration. For

servers only.

Power Supply power supply installed in the system

Redundant ﬁ Displays information about the redundant

If you want information about hardware components the following
commands are displayed:
Command Icon Description

Health Monitor Displays the current status of the CPU
voltage, System voltage, Temperature,
Fan status, Chassis status, Fuse status,

SMART and RDM (Remote Diagnostic
Management) status. For servers only.
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If you want information about MIB-Il components the following
commands are displayed:

Command Description

System Implementation of the System group is mandatory for all
systems. If an agent is not configured to have a value for
any of these variables, a string of length 0 is returned

Interface The Interfaces table contains information on the entity's
interfaces. Each interface is thought of as being attached
to a ‘sub-network’. Note that this term should not be
confused with ‘subnet’ which refers to an addressing and
partitioning scheme used in the Internet suite of protocols.

AT The Address Translation group contains one table which is
the union across all interfaces of the translation tables for
converting a NetworkAddress (e.g., an IP address) into a
subnetwork-specific address. For lack of a better term,
this document refers to such a subnetwork-specific
address as a ‘physical’ address. For servers only.

IP Implementation of the IP group is mandatory for all systems

ICMP Implementation of the ICMP group is mandatory for all
systems

TCP Implementation of the TCP group is mandatory for all

systems that implement the TCP.

Note that instances of object types that represent
information about a particular TCP connection are
transient; they persist only as long as the connection in
question
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Command Description

UDP Implementation of the UDP group is mandatory for all
systems which implement the UDP

SNMP Implementation of the SNMP group is mandatory for all
systems which support an SNMP protocol entity. Some of
the objects defined below are zero-valued in those SNMP
implementations that are optimized to support only those
functions specific to either a management agent or a
management station. In particular, it should be observed
that the objects below refer to an SNMP entity, and there
may be several SNMP entities residing on a managed node
(e.g., if the node is hosting on acting as a management
station).

This item is enabled only when the server supports the
MIBII/SNMP group.

e The Utility Menu contains commands to access special functions in
ASM Console.

Command Icon Description

Asset Loads and Views assets of monitored
Manager servers

Remote Flash Remotely sets up Flash BIOS of systems
BIOS connected to LAN via server.

Remote Remotely sets up CMOS of systems
CMOS Setup connected to LAN via server.

Remote Allows the system administrator to
Console remotely control the local systems

connected to the LAN via a server, if
access is granted.
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The View Menu allows you to display or hide certain components of
your ASM Console user interface.

Command Icon Description

Tool Bar Displays the tool bar

Status Bar Displays the status bar

System Displays an overview of the system.
Overview

Displays systems currently monitored by
ASM Console

System Listing

Auto Displays the Auto Discovery screen.
Discovery

The Window Menu provides the following commands that allow you
to arrange multiple views of multiple documents in the application
window.

Cascade Arranges windows in an overlapped fashion
Tile Arranges windows in non-overlapped tiles
Arrange Icons Arranges icons of minimized windows
System Listing Goes to the specified window

The Help Menu provides you with assistance for this application.
Command Icon Description
Help Topics . Provides general instructions on using

Help and offers you an index to topics on
which you can get help

|

=
About Console Displays the version number of this
E application and license information
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Using Auto Discovery to add a system to the
System Listing

The Auto Discovery window displays when you run ASM Console for the
first time. It automatically detects all of the system agents in your subnet.
It displays the names of these systems and their protocols and addresses
in the left panel of the Auto Discovery window. The auto discovery process
may take some time depending on the size of your network.

The upper right panel of the auto discovery window displays the services
of the system highlighted in the left panel. This information includes the
name and OID of the services, if any exist. These services typically include
one or more of the following:

e Hardware, System, or Management Information Base-Il (MIB-II) for
server systems

e  Desktop Information and Desktop Hardware for desktop systems.

The lower right panel displays messages about the operations of Auto
Discovery. The messages include the name of the operation and the time
it was performed.

There are two types of agents shown in Auto Discovery:
e Agents provided by ASM

¢ Industry standard agents.

to Discovery

| %D R
EE- ] 2106310 [ Hame | Community |
B dlertonlan [210.63.101.57] (€2 MIEI Service public
= bull [210.63.101.88] 'a System Infarmation public
5y chiischang-1 [210.63.101.108] 43 System Hardware public

M8y picazso [210.63.101.71]
-#8) tedpanant [210.63.101.95]
= 2106210110

= Z1063.101.180 - - . =
2063101185 Time 1 Autodiscovery message ’

) 210.63.101.236 8 19:0207  Found OMI service ASM Ins..
B 71063107 233 (@ 18:0207  Found DMl service ASM Ins...
il | @i 18:02:09 Found Dkl zervice ASM Ins...

@ 130209  Find all routers

210.3.1 01 3 @ 18:02:09 arange folder
PO Generic =l j

i
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Auto Discovery Commands

Command Icon Description
Stop Cancels current search operation requested
g@ by user
Refresh Updates the current list of systems by
@ performing another search on the network
Insert Subnet Activates the Subnet window which allows

'1'_|" you to input the first three blocks of IP
addresses and performs a search on the

network
Add to System . Adds the selected system to the System
Listing = Listing window
Options Activates the Options window. See
“Specifying options” on page 63
[
Clear Clears the messages, if any, found in the
Messages ﬁ lower right panel of the Auto Discovery
window

After you have run ASM for the first time, you can access the Auto
Discovery window by clicking the Auto Discovery button on the toolbar, or
by selecting File > Auto Discovery on the menu bar.

Adding a system from Auto Discovery to System
Listing
ASM Console uses two types of protocol to monitor server systems:

e |PX (Internetwork Packet Exchange) is usually used for Novell
NetWare operating systems.

¢ |P (Internet Protocol) is used for Windows NT, SCO OpenServer, and
SCO UnixWare operating systems.
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Note: IPX and IP protocols are automatically detected by ASM.

ASM Console detects NetWare, SCO OpenServer, SCO UnixWare, and
Microsoft Windows systems on your network and displays them in the left
panel of the Auto Discovery window.

ASM Console displays each system according to the time a connection
was made. The order of the systems listed may vary each time you open
the Auto Discovery window.

To add an IP or IPX system to the System Listing:

1. Select File > Auto Discovery, or click on the Auto Discovery button on
the toolbar to access the Auto Discovery window.

2. Click on the name of an agent in the left panel of the Auto Discovery
window.

3. Click the Add to System Listing button. The system you just selected
moves to the System Listing window.

4. Repeat steps 1 and 2 if you want to add more systems. When you
finish adding systems, close the Auto Discovery window.

In the System Listing window, the color of the system symbol shown on the
left of the system name appears red at first. This color changes to yellow
during the initialization process, and finally changes to green when the
system has finished initializing.

Adding a subnet

Subnets are smaller groups of servers and desktops within a local network.
For example, a local network might contain separate subnets for different
departments like purchasing, engineering, and manufacturing.

To add a subnet:
1. Click on the Add Subnet button. The Subnet window appears.

2. Enter the first three blocks of the IP address you want the Console to
search.

ASM Console searches all addresses in the specified with different
protocols to find the agent. For all of the ASM agent services, click on
the Option button.



63

Specifying options

Click on the Options button in the Auto Discovery window to display the
Options window as shown below. The Options window allows you to:
e Add or remove an SNMP community name

e Select the agents you want the Console to check.

— SMMP Cammunity
Comrmunity I New
public
Delete |

—Agent for Autodizcoverny

h amne [ oo |
[AMIB Service  1.3.61.21.1.50

[ System Inform.. 1.3.6.1.4.1.1050.25.4.16.0

[ Sustem Hard...  1.3.6.1.4.1.1050.255.20

To add a new SNMP community, click on New and type in the community
name. To remove a SNMP community name, highlight the community
name and click Remove. The list of agents may vary depending on how
you installed ASM Console.

To specify which agents Console checks, click the square box next to each
agent in the Discovery Agent Type box that you want checked to turn
checking on for that agent.
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Manually adding a system

To add a system to the System Listing manually, you typeits IP or IPX
address in the Insert System window.

Insert System

Address:! BT

Community : !public

i« |P PR
ok I Cancel

To add an IP or IPX address manually:
1. Click File > Insert a System in the System Listing window.

2. Type the IP or IPX address of the system you want to monitor, and
click on OK. If the address is available, it appears in the System
Listing window.

Removing a system from the list

To remove a system from the System Listing window, highlight the system
that you want to delete and click the Delete a System toolbar button, or
select File > Delete a System.
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) Working with System Listing

The System Listing window displays the systems currently available to
Console for management. If this window contains no system names, you
need to add network systems to the System Listing. You can add a system
by clicking File > Insert a System, or by using Auto Discovery. Refer to
“Using Auto Discovery to add a system to the System Listing” on page 60
for these procedures.

The system listing screen contains three panels: the system organizer
panel, the all system listing panel, and the system service panel.

") System Listing

|| ol uk 38 (€ BB

E-Er ALl [ALL] System Listing
3 M7ET N
@ M7EB B Ope E &
B9 ALERTONLAM 21063101 57 Windows 98 _&Dlsconnecte
[ MATRIX 20631053 Windows 38 %Discnnnecte
Service | Protocal ! State ! Health
Systern Hardware SHMP @ Unknown  B@dbnarmal
-'s Spstem Information SNMP @ Unknown  [@ébnormal
£ MIB-ll Service SNMP ) tlive BN

The All System Listing panel displays the following information: System
Name, Address, Operating System, Protocol, and Connection status. The
address is the TCP/IP address or the IPX address (for Novell systems).

The Service panel displays the following information: Service Type, Service
Protocol, State of the Service, and Health of the System.

The services for server systems are System Hardware and System
Information. For desktop systems, Desktop hardware and Desktop
Information.

The protocol for desktop systems is RPC. The protocol for server systems
is Small Network Management Protocol (SNMP).
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The health of a system is normal, abnormal, or a hardware feature not
recognized by the ASM product. The health is abnormal when the service
is functioning but is not functioning as it should.

The System Listing can be sorted by clicking on the column bars. For
example, if you click on System Name, the system names are displayed in
alphabetical order.

A colored system symbol at the left of each system name indicates the
status of the server. The color of these symbols may change based on the
performance and condition of the server.

Command Icon Description
Create New Creates a new folder with a temporary
Folder ﬁl name under the ALL folder directory
Delete Folder Erases the folder you specified in the ALL
folder directory
Show All Displays all the folders and their sub-folders
Folder ]
I
Refresh Server Refreshes the System Listing
Add to System . Manually adds a new system
Listing «‘T:_?J
Delete Deletes an existing system or highlighted
System/ % agent
Service
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System organizer

The System Organizer is a tree-structured directory on the left hand side of
the System Listing window that allows you to organize network systems
into folders.

For example, using folders in the system organizer, you can network
systems by type (desktop or server), by location, or by building.

Once you have created folders, you can drag and drop systems from the
All System Listing panel to one of the folders.

To create a new folder:

1. Click the Create New Folder icon, or click the right mouse button and
choose New Folder from the menu. The new folder appears with a
temporary name.

2. Type atitle for the new folder and press Enter.
To delete an existing folder:
1. Select the folder you want to delete.

2. Click the Delete Folder icon, or click the right mouse buton and
choose Delete Folder from the menu.

To display all the lower level folders, click the Show All Folder icon or click
the right mouse buton and choose Show All from the menu.

System symbols

One of the symbols shown below (System Box or Service Box) appears to
the left of each system name.

ethernet connection. The link is initiated automatically when the

E System Box - This means the system is connected in-band via an
system is added to the System Listing.

Service Box - This means a service system. Each server in the
‘m System Listing has a Hardware, System, and MIB-Il service. The
ﬁ"ﬁn link is initiated automatically when the server is added to the
System Listing.

It can also be a combination of both boxes if the system agent is installed
with both types of agent.

The system and service symbols appear in one of the following colors to
indicate the current status of the system.
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e Green means that the communication link between the agent and
monitoring Console is up and running.

¢ Yellow means that ASM Console did not receive a response from the
system agent within a time period. This may be due to heavy network
traffic, a network error, or the system being busy.

e Red means that the communication link between the Console and the
System Agent is down or an error has occurred.

Note: If the status of the selected system is red (question mark), all
toolbar buttons are disabled (grayed out). Only the Auto Discovery
button is available.

Customizing System Listing

You can use the Option dialog box to customize the System Listing user
interface. To display the Option dialog box, select Setup > Option.....

User interface (Ul) tab

The U.l. tab allows you to change the settings of the background display
and printer fonts.

Option...
ul ] “wiarning 1

i~ Background - 1 Toolbar

]asmbkg.bmp Browse.. ||| & Show Al

| € Show Selected
[ Nate :

i~ Printer Fort

Title: [Default iLhange... | | | This option take effect
| afte_r pou cloze t_he
Baody : I[ga—u\l—-' e, ] || Option Setup window
t':}';)ff._:‘_;-_s‘,fg ok ] Cancel I A Eply | Help ]

To display all of the toolbars, regardless of the type of server you have
selected, click on the Show All radio button in the toolbar box and then
click OK.

To personalize the wallpaper of the Console, click Browse and choose a
graphic file, then click OK.

To change printer fonts, click the Change button. A listing of the fonts
located in the Windows fonts folder appears. Choose one and click OK.
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Warning tab

The options here specify whether ASM Console should generate a warning
message to alert the user when one of the following events occurs:

¢ Deleting a system

¢ Deleting a service

e Deleting a folder

e Exiting ASM Console

Dption...
i} W arning I

Display warning far following commands :

V' Delete a Service

¥ Delete a Folder

¥ Ezit this program

cjpﬁﬂﬁ$ 0K, I Cancel | Apply | Help |

To enable these functions, check the appropriate checkbox and click OK.

To disable these functions, uncheck the appropriate checkbox and click
OK.
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System information and performance
monitoring

From the System Listing window, you can select a system from the service
panel to view agent information. To see the information, click the name of
the service in the service panel (the bottom right panel) of the System
Listing window: System, Hardware, or MIB-II, then select an option from
the Information menu. The options in the Information menu vary,
depending on which services are selected.

System information

The following sections describe the Information menu options that appear
when a System Information service is selected in the System Listing
window.

Basic information

Select Information > Server Information > Basic Information to display the
Basic Information window. The window consists of three sections:
System, Machine, and Modem.

System tab

Click on the System tab to view general information about the system. This
tab also displays the system’s network address and System Agent version.



ONET - Basic Information

Up Time :

Systen 1Machme1 Manager

Machine Name :

Metwork Address :

Operation System :

Server Agent Version :

Computer Time ;

M achine Location

MONET

210631013

Nofindows NT 4.0 (build 1381) Service

|Pack 4

Server3 a0

ThuApr 23 033442 1339

1 day 00:19: 04

A5 console test Lab

Machine tab
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Click on the Machine tab to view general information about the system’s

components, such as: Base Board, CPU, BIOS, and Physical Memory.

HIMONET - Basic Information

- Base Board

M anufacture

Wersion
Serial No :

rCPU
M anufacture
Family

Current Speed

Extemal Clock

Product Mame :

Systemn  Machine ]Managel{

|ACER

M4
[96105 14,
|48.59107,011

Intel

_F‘ant\um Prn“F‘ami\y

200 MHz

66 MHz

~BIOS
Wendor ACER
Release Date©  [06/05/96
Wersion :

|ACR2FED0-05-957106-R01-85

Physical kemay

Tatal Memary : 160 MB

M aximurm Memary Capacity : 364 ME

Memarny Slots No. : 3
emary Slots Used Mo - 3

Manager tab

Click on the Manager tab to view information about the person in charge of
the system (for servers only). The manager information can be changed on

the ASM Server Agent system using the asmcmfig program.
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H)MONET - Basic Information

System | Maching Managar]

Machine Location : ]ASM consale test Lab

Manager iManager

Office Address : “

Office Phane : ]

Home Address :

Home Phone :

!
]
Pager : ]
E-mail : ]

Refresh Undo Set
e JRIEEE

DMI BIOS information

Select Information > Server Information > DMI BIOS to display the System
Configuration screen.

BIOS

The BIOS (Basic Input/Output Sytem) tab displays general information
about the BIOS version installed in the system. It also displays the type of
hardware supported by the BIOS. The check marks show the supported
bus, function, boot device, int13 floppy status, and other services based on
the DMI specification used.
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MONET - DMI BIDS Inform:

BIO0S | Base Board | Frocessor | Memow | Cache | Siot | Connector | On Board Device |

BIOS YYendar }.&EEH Stating Address Segment |FOO0:0000
Hileass Date: 06/05/96 ROM Size : (255 KB
e |ACRZFE 00408-961106-R01 BS
i~ Boot Support ~Bus - Other Features Support
¥ Selectable Baot ¥ 154 ¥ Plug and Flay
v CDROM I~ EISA v Automatic Power Manager
" PCMCIA ~ Bl W Upgradable BIOS[Flash]
fr: 2] [ MCa ¥ Shadowing BIOS
L5-120
W ESCD
[ ATAPI Zip [~ WLVESA =
" 1384
L | I PCMEIA " Smart Battery
— Other Devices Suppart 1| [luse W EDD Specification
[~ AGP V' BIOS ROM s socketed
¥ It 9h,8042 Keyboard :
¥ It 14h Serial Service -l R S
¥ Irit 17k Prirter Service W MECHB0012MB [ Toshiba 1.2MB
¥ Int 10h,CGA Videa Service [V 5.25"/360KE W 3.5"/2.80MB
™ PCag ¥ 5.25"1.2MB W 35"/720KB

Base board

The Basic Motheboard Information tab displays the manufacturer, product
name, version and serial number of the base board.
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ass0 - DMI BIDS Information

BI0S  Base Boad | Fiocessar | Memory | Cache | Siot | Connector | OnBoard Device

Manufacturer : F\CE R

Product Mame : im 14

Wersion : 9610514

Serial !48.591 01.011

Processor

The Processor tab displays the type, speed, and other information about
each CPU on the ASM agent.

icasso - DMI BIOS Information

BIOS | Base Board Processor i Mamoryl Cachel Slat l Connectorl On Board Devicei

Type: [Central Processar Yoltage; 33V
Family Eﬁéﬁhu_mﬁgfﬁw— External Clock !EE_Ff'I_Hz
M anufacturer ||nle|7 Current Speed IZUD MMHz
Uparade W tdaw. Speed !ZUD MHz
Processorl Frocessord Frocessors
Socket: Uz [ [ |
PID : ] [ [ [

Status : Enabled | | |




Memory
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The Memory tab displays information about the memory controller and the

memory module.

v66la_ntstd - DMI BIOS Information

| Eror Detect Method :
Error Corect Capability :
| Supported Interleave :

| Current Interleave :

temorny Controller

|Bd-bit ECC

Single Bit Error Correcting
One \Way Interleave

One\wWay Interleave

BIOS | BaseBoard | Processor Memary I Cache] Slot 1 Connecmﬂ On Board Dewce}

- Supported Speed
| I” 50ns ™ 7lns
| I~ BOns ¥ Other

- Supparted Memary Type -

[~ Standard [ SIMM
[ FastPage [ DIMM

| Max M Size: B|IME
[ S e I~ EDO I BurstEDO
| Memory Module Yoltage : 33V [~ Parity I SDRAM
| # of Assoc. Memarp Glots : 3 Iv ECC [ Other
: - N;Iemnry .N;inl.:l.ﬁl.a
Socket ] Ras # ] Type ] Installed Size I Enabled Size ] Ermor Status
D3 4 DMt SDRAM  32MB J2MB No
D2 2 DIkt SDRAM  32MEB J2ME No
D1 Noc Uk nowvaen OMB aMe No

Memory controller

Memory Controller displays the attributes of all memory modules present

in the controller’s sockets.

Memory module

Memory Module displays detailed information about each socket, including
the type, installed size, and error status.

Cache

The Cache tab displays the attributes of CPU cache devices. The CPU
cache is a chunk of fast memory. It stores data that the CPU can process

quickly.
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icasso - DMI BIOS Information

BIOS I Base Boardl F‘rocessori Memary  Cache !Slot I Connectoll On Board Device]
Dest. I Lewel I 53 Sockaledi Location i Statug I tode I Maw Size I Installed Size I
20 1 Mo Internal Enabled  ‘Wite Back 16K 16K
Uz 2 Mo Intemnal Enabled  ‘wiite Back 512K 12K

Slot

The Slot tab displays information about different slots on the system board,
including the type and availability of each bus. Refer to the EISA (Extended
Information System Architecture) or PCI (Peripheral Component Interface)
specification for definitions of the slot IDs. The Designation field refers to
the motherboard layout label.

icasso - DMI BIOS Information

BIOS I Baze Board! Procassm’ Mamoryl Cache Slat IConnectorI On Board Devicei

Designation I Type I Buz Width I Current Usage I Slot Length I 1D i Slot Characteristics

11 158 16 Bitz Unknown Full Length Méa Provides 5.0Vols
12 154 16 Bits Unknown Full Length M Provides 5.0 Vols
13 1S4 16 Bits Unlenawn Full Length N Provides 5.0 Vols
F1 PCI 32 Bits Awailable Full Length 1 Provides 5.0 Vaolts
P2 PCI 32 Bitz In Use Full Length 2 Provides 5.0 Yoltz
P3 FCI 32 Bitz In Use Full Length 3 Provides 5.0 Yoltz
P4 PCI 32 Bits InUse Full Length 4 Provides 5.0 Volts
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Connector

The Connector tab displays information about the motherboard
connectors.

icasso - DMI BIDS Information

BIOS ! Basze Boardl F‘rocessori Memor_l,li Cachel Slat Connectar | On Board Devicei
Internal I Type I Esternal | Type | Port Type I
CH1 3 Pin Dual Inline. DB-9 pin male Serial Port 165504 Compatible
CH2 3 Pin Dual Inline. .. DEB-9 pin male Serial Port 165504 Compatible
CN3 25 Fin Dual Inlin... DB25 Pin Female  Parallel Port ECP/EPP
N4 Mone il P52 Keyboard Port
M Mone J3 P2 mouse Port

Onboard device

The Onboard Device tab displays information about devices found on the
motherboard.

icasso - DMI BIDS Information

BIOS | BaseBoard | Processor| Memory | Cache| Siot | Connector  On Board Device i

Type I Status | Description I
SCsI Dizabled On Board SCSI: Adaptec 7850
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Input/Output device information

Select Information > Server Information > Input/Output Device or
Information > Desktop Information > Input/Output Device to display Input/
Output information for the keyboard, mouse, and video.

I/O port tab

The I/0O Port tab displays information about the system’s input/output
devices and ports.

Glant - 170 Device Infomation

140 Port 1Videu ] Keyboard and touse ]

| Mame | Addiess | IRQ | Capabilly || Description
PRINTER 3be Disable ECFEFP Parallel Port
COM 1 38 4 1B8504 compatible  Serial Paort

Video tab

The Video tab displays information about the system’s video device and
driver.

ZE:IHULL - 10 Device Infomation

General Video I

Manutacturer ‘Phoenix

tadel : ‘83 7324764/ 765 Compatible Graphics Adapter
Drivver Name : |s3

Drrivver Yersion : |4.DD

Current Resolution : |1 024 » 768

Current Colors : |85538
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Keyboard and mouse tab

The Keyboard and Mouse tab displays general information about the
keyboard and mouse type and configuration.

¥ v66lant - 170 Device Infomalion

140 Port | Widen  Keyboard and Mouse

[ Kevboard
e FC/AT Enhanced Keyboard [101/102-Key)
ype:
Connector Type : |PS#2
Layaut ; us
B Mause
Manufacturer: | -oatech IR0 1z
Port Name : Logitech P5/2 Port Mouss Buttors: 2
Diiver Mame Mouclass J
Interface : P52

Storage information

Select Information >Server Information > Storage to display the Storage
Information screen. This screen displays the size, type, and controller of all
physical and logical hard disks that are configured on the system, as well
as the floppy disk drive, Zip drive, or CD-ROM drive.

Physical disk

Physical disk indicates the number of actual hard disk drives installed in a
system. Each hard disk drive is connected to an adapter that controls
them.

Note: The physical disk screen for the desktop systems differ slightly
from the screen shown here but the functions are the same.

To view storage drive information, click one of the items displayed in the
upper left window. The storage device’s logical partition (if the device you
chose is a hard disk drive) and controller information displays on the lower
left and right window.

Click Refresh to update the information on the screen.
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f“l v66la_ntstd - Storage Informalion

Physical | Logical !

Drizk. : Parameters :
Tyoe [ndes [ [ltem | /elue
0 Type Hard Disk.
1 o] 0
2 Size E135 MB
Media Loaded Loaded
Femovable Diive Mot Removable
Femovable Media Mot Removable
Cylinders 790
Sectors/Cylinder B3
Heads 255

Bytes/Sectar 512

Partition : Number of Partitions 2

[ Name | Size (KB) | Free Spa.. | File System |
Ch 30BMB  46MB  NTFS
DA 5831 MB GEETMB  NTFS

Refresh

Logical disk

Logical disks are created when you separate a hard disk into several
partitions and specify each of them as an independent logical drive. This
window displays information about each of the logical drives created on the
hard disk drives. The type of information shown depends on the type of
agent selected: desktop or server.

Click Refresh to update the information on the screen.
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BULL - Storage Information

Physical Logical I

Mumber of Yalume : E Refresh

Wolume | Total Size | Free Size | Type | Total Cluster | Free Cluster |
{14 1090 550 NTFS 1090 550
BackuplG:\) 1200 Pk NTFS 1200 218

Toole[F:A] 1882 509 NTFS 1882 a09
AGENTIE:N) 1004 557 NTFS 2008 1114
NT4.0(D:) 1004 203 NTFS 2008 406
ME-DOS_B[C:H) 250 2 FAT 2 18

Operating system information

Select Information > Server (or Desktop) Information > O.S. Information to
display the Operating System Information screen that displays information
about the operating system. There are six screen tabs for server systems
and three for desktop systems.

Server system

There are six screen tabs for server systems.

User tab

The User tab displays the number of users currently logged on to the
server.
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FBULL - 05 Information

User lDriversi Process Listl Snftwaresl Salwcei Erwiroment Variahlasi

Mumber of Users : i1

Uzer Mame | Login Time
JEAMLIN Tue bay 04 10:35:40 1933

Drivers tab (only available for Windows NT and Windows 98
operating systems)

The Drivers tab displays all the device drivers installed in the ASM Agent.
It also displays the total number of drivers installed in the system.

ULL - 05 Information

Uger  Drivers i Process Llstl Softwares ; Salwcai Erwiroment W anables I
Mumber of Drivers 130
Drriveer Mame | Type E
VgaSave VgaSave
Tcpip TCPAF Service
Serial Serial
53 33
Rdr Fdr
Pscan Pscan
Parédm Parédm
Parpart Parpart
Parallel Parallel
NelnkMHb Niw/Link MetBIOS
Mulnklps Mw/Link |P#/5P¢ Compatible Transpart Pratocol
Hull Hull
Mpfs Mpfs
NetBT WINS Cliert(TCPAF)
NetBIOS NetBIOS Interface
MWE 2000 Mavell ME2000 Adapter Driver
NDIS Microzoft MDIS Systemn Driver I |
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Process list tab

The Process List tab displays the programs and DLL libraries that are
currently running on the system. For a server agent, it also displays the
time that a process was executed.

To terminate a process in the list, select the process and click the Kill
button.

JBULL - O5 Information

User | Drivers Process List ]Soflwaresi Servicei Envirament Valiab\es]

Mumber of Process . [39
Process Mame ] 18] ] Start Tirne ] =
_Taotal 1] MR
MSDEY 232 Tue 03:21:09 May 04 1333
S5ERP 351 Tue DB:57:31 Map 04 1939
niwin32 38 Tue 08:55:50 Map 04 1933
DESKMEMNU b7 Tue 08:55:50 May 04 1333
realplay 366 Tue 08:55:49 May 04 1939
explorer 50 Tue 08:55:38 Map 04 1933
MDDEAGNT 234 Tue 08:55:29 Mayp 04 1999
LOCATOR N4 Tue 08:54:10 Map 04 1933
win3Zrap 298 Tue 08:54:08 May 04 1939
ntsm 234 Tue 08:54:08 Map 04 1333
AsciSry 290 Tue 08:54:08 Map 04 1933
WIN3ZEL 253 Tue 0B:53:56 Map 04 1999
FSTORES 243 Tue 08:53:54 Map 04 1333 &

Kill | Refresh

Software tab

The Software tab displays the software packages currently installed on the
server.
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User ! Drivers; Process List  Softwares i Sarwcai Erveiroment Variablesl

Murnber of Software : 133

3 ASM Console

Saftware Mame I

Wireip
‘windows NT 4.0 Service Pack 4
Microsaft Web Publishing ‘Wizard 1.51
Microzaoft Visual SourceS afe NetSetup
ServerFrotect

Irtel LaNDesk Server Manager 6.0
Server DMI 2.0 Component Interface
53 Refresh

53 Calor Control

FiealPlayer 5.0

F=E FDK

Microzoft Outlook Express

Microzoft Office 97, Professional Edition
Microzoft Mettdesting 2.0

Microsoft W allet

Microsoft Visual C++ 5.0

Microsoft Visual C++

Service tab (only available for Windows NT operating systems)

The Service tab displays the number of services currently active in the

server.

Uger ! Drivers; Process Listl Softwares  Sevice iEnviroment Variablasi

Mumber of Service : 145

Service Name I Start Lip i Status

Win32sl Automatic Running
Win3Zrap Automatic Fiunning
UPs Manual Stopped
TapiSre M anual Stopped
Spooler Automatic Running
SHMPTRAP b anual Stopped
SHMP Automatic Running
ServerProtect Server Autaomatic Running
Schedule Automatic Running
Rpchs Automatic Running
RPCLOCATOR td anual Fiunning
Replicatar Manual Stopped
ProtectedStarage Automatic Running
PlugPlay Automatic Running
Miw/Chfork station Automatic Running
MiLmSzp Manual Running
Metlagan Automatic Funning
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Environmental variables tab (only available for Windows NT
operating systems)

The Environmental Variables tab displays the contents of the initialization
file of the operating system.

“1BULL - OS Information

Desktop system

There are three screen tabs for desktop systems.

Process list tab

The Process List tab displays the number of processes the desktop has
executed since it was turned on. It also shows the type (16-bit or 32-bit) of
the program that was executed.

To terminate a process in the list, select the process and click the Kill
button.
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CHRISCHAMNG-1 - 05 Information

DESKTOP.EXE
ADMSMSAGENT EXE
MOBILESUP EXE
[N EXE
SUSMONEXE
ASSETICEXE

UTILMOM.EXE

TR

Drivers tab

The Drivers tab displays all the device drivers installed in the desktop. It
also shows the total number of drivers installed in the system.

1 CHRISCHANG-1 - OS Information

1E-bitz, DOS
1E-bits, DOS
16-bits, DOS
16-bits, DOS
1E-bits, DOS
1E-bits, DOS

16-bits, DOS
16-bits, DOS

Environmental variables tab

The Environmental Variables tab displays the contents of the initialization
file of the operating system.
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casso - 05 Information

Process List | Drivers  Erviroment Yaniables

ComSpec=0: 4NN T \aystem32\emd exe

IMCLUDE=D:\Program Filez\Mtz\ nclude

LIB=D: Pragram Files\MtsiLib

NUMBER_OF_PROCESEORS=1

05=Windows_MNT

Os2LibPath=0:WANM T systerm32hos2\dll;

Pathi=D:ADMINWAN 324bin 0 ADMI 25 PABIN D AWINNT dspstem32 D MnANNT D AWINN
ThSpstem3IZWWEEM DoWWINNT YSpstem32WWEEMYSMMP D \Program Files\Mtz
PROCESSOR_ARCHITECTURE=xEE

PROCESSOR_IDENTIFIER=x8E Family & Model 1 Stepping 9, Genuinelntel
PROCESSOR_LEVEL=E

PROCESSOR_REVISION=0108

windir=0SWIMNT

/IN32DMIPATH=DADMIZ5F

CN/A  [Alert: N/A

Network information

Select Information > Network Information to display the network
Information screen. This screen displays information about some of the
network interface cards. Not all network cards provide this type of
information.

Details are provided for the type, model, slot number being used, IRQ, I/O
port, base memory address, DMA address, IP address, gateway, NIC
(Network Interface Card) speed, and NIC driver.
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tedpangnt - Network Information

I DNS - |21 0E3.96.2 203 66.109.20

Metwork Card :
| Metwork Card #1 | Metwork Card #2 |

Manufacturer 3Com DigitalE quipmentCorparation
todel Mame 3Com Fazt EtherLink PCI 10/100BASE-T DEC PCI Ethernet DE Cehip 21041
IF Address 210.63.101.95 21063.101.95
Net Mask 255.255.255.0 255.255.255.0
Gateway 210683101 210631011

El59x DC21x4

11 40

System resource information

Select Information > System Resource to display the System Resource
Information screen. System Resource Information consists of four tabs:
IRQ, DMA, I/0O Port, and Memory Address. The following sections briefly
describe each of these tabs.

Server system

There are four tabs for server systems.

IRQ information

This screen displays a list of each IRQ and its assigned use in the system.
It can be used to detect a hardware interrupt conflict.



Im|M7R100—- System Resource Information
RO |oma | 10 Pt | Memow Add |

o] x|

IRE | Description |
] Reserved
o1 B042prt
0z Reserved
03 DC21x4
04 Sermovze
05 NE 2000
06 Reserved
o7 Reserved
0z Reserved
JIE] Reserved
10 Feserved
1l aic 7k
12 Reserved
13 Feserved
14 Feserved
18 Reserved

DMA information
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This screen displays all the DMA channels used by each device in the

system.

8| M7R100- System Resource Information
IR DMA | 120 Port] Memon Add: |

e |

Channel | Deserption

MNong
None
Maone
Maone
MNong
None
Maone
Mone

BEwWOMm— o

I/O port information

This displays the range of port addresses occupied by the system

resources.
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8 M7R100- System Resource Information
RO | DM& 140 Port | Memory Add:. |

=]

Fiange | Diescription |
0060 - 0060 iB042pit

0064 - 00E4 iB042pit

7000 - FO7F DC21x4

0340 - 035F NE2000

[I3FE - 03FE Sermovze

7400 - 74FF aic?Bx

03B0 - 03BE cifmus

03C0- 03DF cifus

Memory address

3 ASM Console

This displays the system’s base memory usage, including the address, the
length, and its description.

[ M7R100- System Resource Information
IRO | DM | 140 Por Memary Addr. |

I |

Address | Length | Dieseription |
04200000 - 04200FFF 0x1000 Sic7Bin
00040000 - DO0BFFFF 0x20000 ciruz
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Desktop system

f“l tedpangnt - DMI Resource Information

Resource l

Driver Mame I 1RO I D& I 1/0 Part J Memory Address i
1904 2prt oz nane 0060-0060;...  none

Serial 04 hong [3FE-03FE hone

ASM nonge g O4F2-04F3 hiore:

DC21x4 03 none FOB0-70FF none

El59x 05 none FO00-701F nong

Floppy 0g 0z 03F0-03F5;... none

aic B 1 hione T400-74FF 0B100000-0B100FFF
atapi 158 naone 700177, none

YgaSave none none 03BC0-03BE..  00040000-000BFFFF

IRQ

The IRQ column displays a list of each IRQ and its assigned use in the
system. It can be used to detect a hardware interrupt conflict.

DMA

The DMA column displays all the DMA channels used by each device in the
system.

I/O port
The I/0O Port column displays the range of port addresses occupied by the
system resources.

Memory address

This displays the system’s base memory usage, including the address, the
length, and its description.
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Performance monitoring

ASM monitors the performance of each agent periodically and sends this
information back to the ASM Console. The polling interval of the Console
can be configured to check the agents whenever the system administrator
chooses.

Configuring polling interval

Select Setup > Config Polling Interval to display the Polling Interval Setup
dialog box shown below.

Config Polling Interval

Host Mame : [66la_ntstd
Addiess : [FT0 62103216

Type |

—Alive Paolling 1 1 Info. Poling —
Current: [ Sec. Current: [§ Sec.
Hew: |1 i New: |5 =] See.

I~ Apply to all systems

T Apply to all service

Canicel ]

The Alive Polling interval indicates how often the connection status
between the Console and the Agent is checked. The Information Polling
Interval determines how frequently the Console polls the Agents to update
its data.

To change the polling interval, click the up and down button to increase or
decrease the number of seconds, or type in the number of seconds, and
click OK. The polling intervals must be from 1 to 60 seconds.

Processor performance (for server system)

Select Information > Performance > Processor to access the Processor
Performance information screen.

This window displays the current load and load limit of each CPU (Central
Processing Unit) installed in the system. The higher the percentage, the
more the CPU is being used. This indicates how much load the system has
and how well the system’s processing power is handling the load.

For multiple CPU systems, the multi-processor performance can be
displayed only on the MP-Kernel OS.



- Proceszor Performance

Processorl =
00.0
20.0
£ &0o
8 a0
b §
20.0
o4 } |
10:49:43 10:50:08 10:50:33
Times
[tem i Current l [LERS ! Hdin. '
Utilization 7 55 16
System 1 46 5
W User 15 15 g
Wit for 10 0 i i

Kernel performance (for desktop system)
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Select Information > Performance > Processor to access the Kernel

Performance information screen.

HRISCHANG-1 - Kemnel Performanc

Threads Created :

irtual Machines Created : |1

Critical Threshold :

=
Set |

—Wirtual Memony ~GDI
Size:  [2044 MB Size:  [BEG3E Bytes
Free: 198 % Free Il %
‘wiaming Threshold : I3U __‘3 B ‘wharning Threshold 5 %

Critical Threshald :

100.0
an.n
G0.0
40.0
200

o

Uilzation

CPU Utiization (%) -

168:33:01

T
163326
Times

1
16:33:51

The Virtual Memory box indicates the size of virtual memory. It also shows
the percentage of virtual memory available related to system virtual
memory. The threshold settings allow ASM to warn you if system operation

exceeds capacity.
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To adjust the warning and critical threshold value, click the Up/Down arrow
key, or type the value in the text box and then click Set. The GDI (Graphical
Device Interface) box also functions the same way.

Below the boxes, a graph of CPU use shows the current load and the load
limit of the CPU installed in the system. The higher the percentage, the
more the CPU is being used. This indicates how much load the system has
and how well the system’s processing power is handling the load.

Memory utilization

Select Desktop (or Server) Information > Performance > Memory to access
the Memory Utilization information screen

The Memory Utilization window consist of three tabs: Info, Graph, and
Advance. The following sections describe of each of these tabs.

Info

If the system being monitored is a server, the Info tab displays a graph
showing the percentages of used and unused memory in the system. It
also indicates the threshold value of memory use.

To change the threshold value of memory use in a server, click the up and
down button to increase or decrease the percentage of use, or type in the
desired value, and click Set. If the memory allocation in the server exceeds
the threshold value, an alert is sent to the Console. For more information
about alert handling, see Chapter 3 - System Alert Manager for more
information.

“Hl scosysv - Memory Ulilization

Info 1 Graph ] Advance

-~ Memory
Total Memory ;i 32300 KB
Used Memory : | 20500 KB

M Free Used
Thieshold Setting
Current Threshald EE]

New Threshold : 100 -
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Note: If the password is enabled in the ASM Server Agent, enter the
password for the Agent when changing the threshold setting.
Graph

The Graph tab shows a graph that measures the use of system memory
and memory paging along a time table.

scosys¥ - Memory Utilization

Infa  Graph IAdvance!
100.0 Memory Liilization

c 80D

o

£ 0.0

= g00

3 200

a t d
09:32:24 09:32:48 09:33:14
Times
100.0 Paging Utilization

w800

i

7 00

i

5 900

® 200

] t U
09:32:24 09:32:48 09:33:14
Tirmnes

Item | Cument | Max | Min. =
| = 53 63 63
BWrac=n i i i
W rage Out 0 0 0 ==
B Page Fault 0 0 0 |

Advance

The Advance tab shows more detailed information about memory use for
different operating systems.
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#ICHRISCHANG-1 - Memory Utilization

MM206 KB FreeMemow: fi568

B
(. (T

BEiFes
l—q

Note: This screen display may be different for different operating
systems.

Disk utilization (for server systems only)

Select Server Information > Performance > Disk to access the Processor
Performance information screen.

For NetWare, this command is enabled if a server is highlighted in the
System Listing window, and is used to view the number of redirected
blocks in the storage device.

For SCO OpenServer, SCO Unixware, and Windows NT, click the pulldown
menu to choose the hard drive you want to view if the system have more
than one hard drive. The screen shows the read/write access and over-all
utilization of the hard disk.
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BULL - Disk Utilization

|#0-SEAGATE STMa7Tw 0484 -]

Info | NT Special |

Disk Busy Ratin: 23
Average Disk BAW Time: o
Byte Transferred : [2B022Z
Mumber of Tramsfer: |5

For Windows NT, you can click on the NT Special tab to display information
about Read, Write, and Read/Write operation that is only supported in
Windows NT. See the following example screen.

BULL - Disk Utilization

[#0-SEAGATE STMI7IW 0484 -
Imia MT Speciall

‘ Fead !M Write 15583 Read /rite |—5888

— Bytes/Operation —‘

Seconds/Operation———————— ‘

‘ Read 0 Wiite 1 Read/Write [1

Fiate bytes/Operation-
‘ Read [0 Wit 0 Read/write |1

Operations/Second——————————————————
Fead 0 Wrike |0 Fead write |U ‘
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File system utilization

Select Desktop (or Server) Information > Performance > File System to
access the File System Utilization information screen.

In the screen below, the utilization column indicates the percentage of
space used for each file system. When file system use exceeds the
threshold value, the Agent sends an alert to the Console. See Chapter 3 -
System Alert Manager for more information.

HIBULL - File System Utilization

File: Systern J Total Size ] Uszed Size l Lltiization[] J Threshold[Z] J
{15 1090 546 50 38

Backup(G:4) 1200 983 g2 98

Tools(F:4) 1a82 1372 72 a2

AGENTIE:A] 1004 472 47 92

WNT40[D:4) 1004 846 a4 93

MS-DOS_B[C:h) 250 188 74 100

i~ Threshold Setting —

Current Threshald[?] 98 Set

New Threshald[%] 1B8 ﬁ Setall |

To change the threshold setting of the selected file system, click the up and
down button to increase or decrease the percentage of utilization, or type
the desired value, and click Set.

To set the threshold value for all of the file systems on the same server, type
the threshold value, and click Set All.

Note: If the password is enabled in the ASM System Agent, enter the
password for the Agent when changing the threshold setting.

NIC (Network Interface Card) utilization
(for server system only)

Select Server Information > Performance > NIC to access the NIC
Utilization information screen.
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The NIC Utilization window shows the selected NIC card packet
transactions on the selected system. The window below shows current
receive and transmit transactions (bytes and packets) of NICs on selected
servers.

E}:;IMI]NET - NIC Utilization

oy Packets Util.

#/Second

40.0
200
] + {
10:45:09 10:45:39 004559
Times
Item ! Current ! I ax. ! Iin J
Total packets sent g 3 a
. Total packet received 11 28 0

This information is useful for determining the network traffic in the periods
that the agent is at its peak.

NIC (Network Interface Card) fault

Select Server Information > Performance > NIC Fault to access the NIC
card failure information screen.

This tab shows the number of instances of different faults in the selected
Network Interface Card.
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HIMOMNET - Storage Information

|#0 - DEC PCI Ethemnet DE Cohip 21047 |
Info ]
Frame Transmit Eror [275 Transmit heart beat [
Frame receive enor [157 CRS last [n
Frame receive CRC erar [0 Transmit late collizion h

Recsive frame slignmert emor I
Tiansmit OK. one collision [273748
Trarsmit OK more collision [282488
Trarsmit OK deffered (22793
Tramsmit fall max colision [Z74
Feceive enor overun m@‘gﬁﬁ“
Tramsmit emor underrun [3—

To view a particular network card, click the arrow button of the NIC# combo
box and select a network card from the list.

Hardware status

The following sections describe the Information menu options that display
when a desktop or server hardware service is selected in the System
Listing window.

Health monitor

Select Hardware Status > Health Monitor to display the Health Monitor
screen. This screen displays the current CPU voltage, CPU temperature,
system voltage, fan status, SMART (Self-Monitoring, Analysis and
Reporting Technology) status, RDM (Remote Diagnostic Management)
status, and chassis status.
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"B scosysv - Health Monitor

Temperature ~ CPU Yolkage - 1 System Yoltage
[§jj [Jomestatue: @ | CPU Yakiage : @ Spsten Vakage :
: CPU socket 1: 34.00 B 230V 3,264 : Wy .30V - 3,308
% 5.00v . 5.016Y

W 12,000 11,942

Fan | Gmat Fuse

ﬁ Fan Slatus ﬁ Smart Status : - B [ fuseStabe:
255 BB HOUSING FanGTOP ST @ Keyboard/Mause fus.
BB HOUSING FanSTOP ) USE fuse : Not Support
&R HOUSING FanSTOP & 5C5 fuse : Not Support
1~ Chassis Status : 1 ~FDM Status :
o | |
17 Mot suppart Lﬁ% o

ASM Console updates the values in the Health Monitor screen during each
polling cycle. The polling intervals can be in the range of 1 to 60 seconds.
Refer to “Configuring polling interval” on page 92 for more information.

Some of the threshold values for hardware components have been preset
by the manufacturer and are not user configurable. When a threshold is
exceeded, the action predefined by the system administrator is used to
correct the problem. Refer to “Chapter 3 - System Alert Manager” for more
information.

Caution: The events described in the following sections that
generate alerts are critical. If any of them occur, correct the problem
immediately. If the problem is not corrected, your system may be
damaged.

CPU voltage

The voltage for each CPU’s power source is shown here. The icon appears
green when the voltage is within the normal range. The icon turns red when
the voltage is not within this range. An alert is generated whenever the
voltage is out of range. This alert is recorded in the alert log file. Refer to
“Event viewer” on page 143 for more information.
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CPU temperature

The CPU temperature is monitored in two stages. First, Console sends a
warning when the temperature rises above a specified threshold. If the
temperature continues to rise above a second, critical threshold, then a
critical alert is issued. In some models, you can set the threshold values in
the BIOS setup.

System voltage

The system power sources are shown here. The icon appears green when
the voltage is within the proper range. The icon turns red when the voltage
is not within this range. An alert is generated whenever the voltage is out
of range. This alert is recorded in the alert log file. Refer to “Event viewer”
on page 143 for more information.

Fan status

The fan status is monitored through the hardware module of the system.
There is no user configurable setting.. If either the housing fan or the CPU
fan stops, it will cause the temperature to rise, and could overheat the
system.

Each fan is represented by a picture of a fan to the left of the fan name. The
icon appears green when a fan is functioning properly. The icon turns red
when the fan is not working. An alert is generated whenever a fan is not
working. This alert is recorded in the alert log file. Refer to “Event viewer”
on page 143 for more information.

SMART (Self-Monitoring, Analysis and Reporting Technology) status

SMART monitors a disk drive’s health and reports potential problems to
prevent impending disk crashes in your system. If this technology is
available to the system, it can report disk error status to Console. If the
system doesn’t support this feature, the status is disabled. An alert is
generated whenever a disk error occurs in the system. This alert is
recorded in the alert log file. Refer to “Event viewer” on page 143 for more
information.

Chassis status

The chassis status is monitored through the hardware module of the
system. No user configurable setting exists. If the server can detect
chassis status, the status is normal if the cover is closed or abnormal if the
cover is open. If the system doesn’t have chassis status detecting
capability, the status indicates that it is "not supported." An alert is
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generated whenever the chassis is opened and the system is not properly
shut down. This alert is recorded in the alert log file. Refer to “Event
viewer” on page 143 for more information.

Note: The above events are critical. If any of the above events
occurs, correct the problem right away. Damage to your system may
result if the problem is left unattended.

Fuse (for server system only)

The fuse status is monitored through the hardware module of the system.
No user configurable setting exists. Each fuse is represented by a picture
of a fuse to the left of the fuse name. The icon appears green when the fuse
is functioning properly. The icon turns red when the fuse is not working.
An alert is generated whenever the fuse malfunctions. This alert is
recorded in the alert log file. Refer to “Event viewer” on page 143 for more
information.

RDM status (for server system only)

The RDM status is monitored through the hardware module of the server.
If the server does not have RDM status detecting capability, the status is
"Unknown." The status is "Active" if you have RDM installed in your
systems. The status is "Not Exist" if your server does not have the RDM
module installed.

IPMI (Intelligent Platform Management Interface)

Select Information > Hardware Status > IPMI to display the IPMI screen.
The IPMI specifications define standardized, abstracted interfaces to
platform management hardware. The IPMI screen consists of three tabs:
Information, Sensor, and SEL (System Event Log).

Information

The Information tab displays the IPMI version and other information
concerning the sensors installed in the system and the system event log for
these installations.
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Information |Sensor | SEL | FRU Product | FRU Board | FRU Chassis |
BMUC Eevision : 0.41
IPMI TFersion : 1.0
BMC Manvfacturer ID 1050
Number of Sensors : 63
Number of Generic Devices : 2
Number of Management Controllers : 7]
Humber of Svstemn Event Log Entries : 25
SEL Total Space Size - 6144
SEL Free Space Size : 5712

SensorFRU

The Sensor tab Shows sensor information in the system.

Information Sensor |SEL | FRU Product | FRU Boswd | FRU Chassis |

Sensor Curent Bea...  * || Description ;
@ CPI Statusl 9’4 Sensor Twpe : Temperature on svstem board 1
@ CTU Sats? WA Current Eeading State © Noxmal

Senaor Unit : C
ENCEU Status3  NiA Upper Critical Thrsshald < 70.00
ACHT Sttt Wik Upper non-critical Threshold - 60.00
@PCFM Temp  30.00C Normel Reading : 40.00

ACPU2 Temp N7k
ACPUS Temp Wik
ACPTS Temp N/
S CPUL Yol 1.98 Volt
ACPUZ Vol Wik
ACPI3 Vol N
ACPU4 Vol N7k
@) ¢ :
A System2 Temp  41.00C lf
L3

il

SEL (System Event Log)

The SEL tab displays system event logs by time and event descriptions.
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| FRU Product | FRU Eoerd | FRU Chessis |

Tndex [

Time

[ Event Deseription

Mon Jul 24 14:27.57 2000
Mon Jul 24 02:06:16 2000
Mon Jul 24 08:06:16 2000
Mon Jul 24 08:06:16 2000
Mon Jul 24 08:06:18 2000
Mon Jul 24 02:10:02 2000
Mon Jul 24 08:10:08 2000
Mon Jul 24 08:10:08 2000
Mon Jul 24 08:10:10 2000
Tue Jul 25 02:19:03 2000
Tue Jul 25 02:19:03 2000
Tue Jul 25 02:19:03 2000
Tue Jul 25 02:19:05 2000
Tue Jul 25 02:22:11 2000
Tue Jul 25 02:22:11 2000
Tue Jul 25 02:22:11 2000
Tue Jul 25 02:22:13 2000
Tue Jul 25 02:05:20 2000

swstemn mgmt module 1 Event Logging Dis...
Peripheral baxy 1 Fuse{USE Fuzl): Abnor..
Peripheral bay 2 Fus{TTEE Fu=2): Abnor...
fanfcooling device * FaniSystem Fan®): 4.
Room 1 Temperatoe{Foom Temp): Uppe...
Peripheral bay 1 Fuse{TSE Fuzl): Abnor..
Peripheral bay 2 Fuse{USE Fuz2): Abnor. .
fanfcooling device 3 FaniSwstem Fan®): 4.
Foom 1 Temperatoe!Foom Temp): Uppe...
Peripheral bay 1 Fuse{TSE Fuml): Abnor. .
Peripheral bay 2 Fuse{USE Fumd): Abnor..
fanfoooling device 3 Fan{Swstern Fan2): 4.
Room 1 Temperatoe{Foom Temp): Uppe...
Peripheral baxy 1 Fose{TUSE Fuzl): Abnor..
Peripheral bay 2 Fus{TTEE Fu=2): Abnor...
fanfcooling device * FaniSystem Fan®): 4.
Room 1 Temperatoe{Foom Temp): Uppe...

FRU product

Field replaceable unit product displays product information.

Information | Sensor | SEL FRU Prodvet | FRU Board | FRU Chassis |

Manufacturer : Arer

Product Mame HTR

Part model Number : L

Version : 0000000000000000
Serial Number : 0000000000000000
Lt Tag: 0000000000000000

FRI File ID» wirfm

FRU board

Field replaceable unit board displays motherboard information.
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Information | Sensor | SEL | FRU Produet FRU Board | FRIT Chassis |
Manufactorer : Aper
Product Wame HTR
Part Number : ¥30L10
Serial Number : 55.35901.021
FRU File ID i fm
tfg Date Time hdon Jul 10014:57:00 2000
FRU chassis

Field replaceable unit chassis displays chassis information.

Information | Sensor | SEL | FRU Produst | FRU Board  FRU Chessis |

Chassis Type : Mini Tawer
Part Nurmber : /4

Serial Number : 0000000000000000
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BIOS event log

This dialog box appears when you select Information > Hardware Status >
BIOS Event Log in the menu bar. It shows you the event log of the servers
being monitored.

MILKYWAY - BIOS Event Log

Ewent Log I [ =T I

Mumnber of BIOS Event Log : |1 45

Thu
ThuOct 21 Swstem Limit Exceeded: Chassis secure...
ThuDct 21 10:3...  BIOS Log: Swstem Limit Exceeded: Chassiz secure. .
ThuOct 21 10:4...  BIOS Log: System Limit Exceeded: Chassis secure...
ThuOct 21 23:5..  BIOS Log: Sestem Limit Exceeded: Chassis secure...
FriOct 2210:28:..  BIOS Log: Sustem Limit Exceeded: Chassis secure...
FriQct 22 13:42....  BIOS Log: Swstem Limit Exceeded: Chassiz secure. .
ton Oct 2508:0..  BIOS Log: System Limit Exceeded: Housing fan [1...
Man Oct 25 08: BIOS Log: System Limit Exceeded: Housing fan [2...
Man Oct 25 . BIOS Log: System Limit Exceeded: Housing fan [4...
Mon Oct 2508:0..  BIOS Log: Svstem Limit Exceeded: Redundant po... -
HP e AN Ilhll'lb

Save | Refrash |

Note: Please refer to the user’'s manual for your main board for more
information about BIOS Event Log.

NVRAM

This button shows you the total amount of memory allocated for storing
BIOS events in the RAM.

NVRAM Size B3
Total Size |2031 Eutes

Used Size |355 Bytes

18%

=

" Current Thieshold : S0¢%

You can adjust the threshold setting by entering the percentage in the input
box, and then click the Set button to accept the setting.
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MIB-II information

This section describe MIB-Il (Management Information Base) information.
MIB-Il is a database of objects that can be monitored by a network
management system. If you have installed the MIB-Il Agent software, you
can view the information from ASM Console.

The following sections describe the Information menu options that display
when an MIB-II service is selected in the System Listing window.

System

Implementation of the system group is mandatory for all systems. If an
agent is not configured to have a value for any of these variables, a string
of length 0 is returned.

& M7R100— MIB-ll System

Diescription : IHardwara: «56 Family & Model 1 Stepping 7 A

Object |0 ;|1 3614131111312
UpTime : fwed Dec 37 17:65.36 1969

Cortact : |
Mame : |M?FH i}

Locaﬁnn:l

Senvices : 7 pplication Laper
™ Presentation Layer
™ Session Layer
¥ Transport Laysr
¥ Metwork Layer
™ Data Link Layer
™ Physical Layer
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Parameter Description

Description A textual description of the entity. This value should
include the full name and version identification of the
system's hardware type, software operating-system,
and networking software

Object ID The vendor's authoritative identification of the network
management subsystem contained in the entity. This
value is allocated within the SMI enterprises subtree
(1.3.6.1.4.1) and provides an easy and unambiguous
means for determining ‘what kind of box’ is being
managed. For example, if vendor ‘Jayson, Inc.’ was
assigned the subtree 1.3.6.1.4.1.4242, it could assign
the identifier 1.3.6.1.4.1.4242.1.1 to its ‘Ann Router’

Up Time The time (in hundredths of a second) since the network
management portion of the system was last re-initialized

Contact The textual identification of the contact person for this
managed node, together with information on how to
contact this person

Name An administratively-assigned name for this managed
node. By convention, this is the node's fully-qualified
domain name

Location The physical location of this node (e.g., ‘telephone
closet, 3rd floor’)

Services The set of services that this entity primarily offers.

Interface

Implementation of the Interface group is mandatory for all systems.
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System Tab

#2M7R100— MIB-I Interface
System |Tab|e |

Description: [M3 TCF Loopback interface

Interface #3

Type: |24 [zaftwarelaopback]

MTL: (1500 Speed.l‘lﬂ Mb/Sec
Shatue
i . [oe -
AT S System Status : IDperatanaI
Operation Status - IUD

Parameter Description

Description A textual string containing information about the
interface. This string should include the name of the
manufacturer, the product name and the version of the
hardware interface

Type The type of interface, distinguished according to the
physical/link protocol(s) immediately "below' the network
layer in the protocol stack

MTU The size of the largest datagram which can be sent/
received on the interface, specified in octets. For
interfaces that are used for transmitting network
datagrams, this is the size of the largest network
datagram that can be sent on the interface

Speed The desired state of the interface. The testing (3) state
indicates that no operational packets can be passed

Admin Status An administratively-assigned name for this managed
node. By convention, this is the node's fully-qualified
domain name

Operation The current operational state of the interface. The testing
Status (3) state indicates that no operational packets can be
passed

System Status Indicates if the system is operational or not
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Table tab
#:M7R100— MIB-Il Interface

Interface #1

Interface #2 It Output

Interface #3 Total Bytes© 151 Iz
Unicase Packets: {123 a3

Nor-unicast Packets : [0 o
Emar Packets : [070.00%) [oro-oos:)

Discard Packets :  [070.00%] | BN

Parameter Description

Input Total Bytes  The total number of octets received on the interface,
including framing characters

Input Unicast The number of subnetwork-unicast packets delivered to a

Packets higher-layer protocol

Input Non- The number of non-unicast (i.e., subnetwork-broadcast or

Unicast Packets  subnetwork-multicast) packets delivered to a higher-layer
protocol

Input Discard The number of inbound packets which were chosen to be

Packets discarded even though no errors had been detected to

prevent their being deliverable to a higher-layer protocol.
One possible reason for discarding such a packet could be
to free up buffer space

Input Error The number of inbound packets that contained errors

Packets preventing them from being deliverable to a higher-layer
protocol

Output Total The total number of octets transmitted out of the interface,

Bytes including framing characters

Output Unicast The total number of packets that higher-level protocols
Packets requested be transmitted to a subnetwork-unicast
address, including those that were discarded or not sent
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Parameter Description

Output Non- The total number of packets that higher-level protocols

Unicast Packets  requested be transmitted to a non-unicast (i.e., a
subnetwork-broadcast or subnetwork-multicast) address,
including those that were discarded or not sent

Output Discard The number of outbound packets which were chosen to

Packets be discarded even though no errors had been detected to
prevent their being transmitted. One possible reason for
discarding such a packet could be to free up buffer space

Output Error The number of outbound packets that could not be
Packets transmitted because of errors
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AT (Address Translation)

Implementation of the Address Translation group is mandatory for all
systems.

# M7R100— MIB-IL AT

Nuraber of Tatal Entries - |2 Refresh |

Index | Physical Addiess | Metwork Addiess |
2 00:00:E2:02:C0:F3 202.39.82.233
3 00:00:CO:E0:BC:C3 1929.210.31

The Address Translation group contains one table which is the union
across all interfaces of the translation tables for converting a
NetworkAddress (e.g., an IP address) into a subnetwork-specific address.
This document refers to such a subnetwork-specific address as a ‘physical’
address.

Parameter Description

Physical Address The media-dependent ‘physical’ address. This is
usually an ethernet address that has been hardwired
on the ethernet chip.

Network Address The NetworkAddress (e.g., the IP address)
corresponding to the media-dependent ‘physical’
address

IP (Internet Protocol)

Implementation of the IP group is mandatory for all systems.
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Generic tab

MILKYWAY - MIB-II IP

Generic: | Net To Media Thl. | Routing Tbl | Addr, Tbl |

IP Forwarding : [Host

Default TTL: 128

3 ASM Console

Statistic
Packet Sent : [G496965 — Re-fdzzembly D atagrams
_ Reguest |0
Packet Received : 2639102 DK'lﬂi
IP Input Error : |0.00% Fail:lﬂi
IF Output Error : |0.00% TimeOut ;|50
Fonwanding Rate : |0
— Fragmented Datagrams
Input Rate : |0 oK - IDi
Mo FRoute : |0 FaiI: 0
Unknaown Prata: |0 Create: |0

Net to media table tab

The IP address translation table contains the IP address and ‘physical’

address equivalents.

Some interfaces do not use translation tables for

address equivalents. DDN-X.25, for example, uses an algorithmic method.
If all interfaces are of this type, then the Address Translation table is empty,

i.e., has zero entries.
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ILKYWAY - MIB-I IP

Generic  Met To Media Tbl. | Routing Thl. | Addh, Tbl. |

| Mumber of Tatal Entries : |1 Refresh |

léjdex | Physical &ddress I Metwork Address | Type |

00:00:E2:04:83:58 100.100.100.101 dynamic

Routing table tab

The IP routing table contains an entry for each route presently known to this
entity.

ILKYWAY - MIB-I IP

Generic | Net To Media Thl  Routing Tbl |Addr, Th. |

Mumber of Tatal Entries : & Refresh |

Destionation | || Mext Hop | Tupe | Prato... | Age | Met Maszk |
100.0.0.0 2 10010010,  diect  local 961.. 255000
100100700, 1 127001 direct  lacal 961... 255.255.25...
100.265.255... 2 10010010.. diect  local 961.. 255.255.25..
127.0.0.0 1 127001 direct  local 961.. 255.0.00
224.0.0.0 210010010,  diect  local 961.. 224000
285.265.255... 2 10010010.. diect  local 361.. 255.255.25...
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IP address table tab

The IP address table contains this entity's IP addressing information.

ILKY'WAY - MIB-lI IP

Generic | Met To Media Thl | Rouing Th.  Addr. ThL |

| Humber of Tatal Entries : |1 Refresh |

Address | IF Index | MHet Magk | Broadcast A, | b an. .. |
100.100.100.700 2 285.0.0.0 1 E5535

ICMP (Internet Control Message Protocol)

Implementation of the ICMP group is mandatory for all systems.

£ M7R100— MIB-Il ICMP

Input Clutput Tatal
ICMP Message :  [355 53] [413

Erer: [I[00%) ooz ooz

Dst. Unreachable : |20 [56%) [FE 457 [Ereza
Time Exceeded : |D [0.0%] |D [0.0%) |D [0.0%)
Parameter Problem :  [00.0%) |00z |00z
Source Quench: [2 [06%) | FEES] | S
Fediect: [000%) | |
Eche: [F0E%) ooz Bz
Echo Reply: [0(0.0%) [315.2%) [310.7%)
Timestamp :  [T10.07]  aEs]  aEs]
Timestamp Reply |I] [0.0%] |D [0.0%) |D [0.0%)
Addr. Mask Fiequest:  [110.0%) TS| TS|
Addr. bask Feply . [T[0.0%] ooz ooz
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Parameter Description
Input/Output The total number of messages which the entity
Messages received/sent. Note that this counter includes all

those counted by InErrors.

Input/Output Errors The number of messages which the entity
received/sent but determined as having -specific
errors (bad checksums, bad length, etc.).

Input/Output Dest The number of Destination Unreachable
Unreachables messages received/sent.

Input/Output Time The number of Time Exceeded messages
Exceeds received/sent.

Input/Output The number of Parameter Problem messages
Parameter Problems received/sent.

Input/Output Source The number of Source Quench messages
Quenches received/sent.

Input/Output Redirects ~ The number of Redirect messages received/sent.

Input/Output Echos The number of Echo (request) messages received/
sent.

Input/Output Echo The number of Echo Reply messages received/

Replies sent.

Input/Output The number of Timestamp (request) messages

Timestamps received/sent.

Input/Output The number of Timestamp Reply messages

Timestamp Replies received/sent.

Input/Output Addr The number of Address Mask Request messages

Masks Requests received/sent.

Input/Output Addr The number of Address Mask Reply messages

Mask Replies received/sent.
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TCP (Transmission Control Protocol)

The TCP connection table contains information about the entity’s existing
TCP connections. TCP connection information lasts only as long as the
connection.

Generic tab

WIMILKYWAY - MIB-1l TCP

Genernc | Tahle I

Retrans. &lg. |vani

Ristrans. timeout : (300 ms. < timeout < 240000 ms. [

Ma. Conn. : [Dynamic

Cument Conr. |1 i}

Active Open : |34

Passive Open |59

Received Seg. |42458?3

Sent Seq. : 4042555

Parameter Description

Retrans Alg The algorithm used to determine the timeout value used
for re-transmitting unacknowledged octets.

Retrans Timeout  Retrans Min - the minimum value permitted by a TCP
implementation for the retransmission timeout,
measured in milliseconds.

Retrans Max - the maximum value permitted by a TCP
implementation for the retransmission timeout,
measured in milliseconds

Max Conn The limit on the total number of TCP connections the
entity can support. In entities where the maximum
number of connections is dynamic, this object should
contain the value -1
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Parameter Description

Active Opens The number of times TCP connections have made a
direct transition to the SYN-SENT state from the
CLOSED state

Passive Opens The number of times TCP connections have made a
direct transition to the SYN-RCVD state from the LISTEN
state

Received The total number of segments received, including those

Segments received in error. This count includes segments received

on currently established connections

Sent Segments The total number of segments sent, including those on
current connections but excluding those containing only
retransmitted octets

Table tab

The TCP connection table contains information about this entity's existing
TCP connections.

ILEYWAY - MIB-Il TCP

Generic  Table |

Mumber of Tatal Entries : |1 Refresh |

Statug | Remnote Addr. | Remate... | Local Addr. | Local F'ortl
listen 0.0.0.0 135 0.0.0.0 18636
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Status The state of this TCP connection

Remote Address The remote IP address for this TCP connection
Remote port The remote port number for this TCP connection
Local Address The local IP address for this TCP connection. In the

case of a connection in the listen state which is
willing to accept connections for any IP interface
associated with the node, the value 0.0.0.0 is used

Local Port The local port number for this TCP connection
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UDP (User Datagram Protocol)

The UDP listener table contains information about the entity’s UDP end-
points on which a local application is currently accepting datagrams.

Generic tab

WMILKYWAY - MIB-II UDP

Genenic | T ahle |

Input D atagramms ; |21E?485

Dutput D atagranms ; |21 E7486

Irivalid Part : |2D

Received Ermor : |D

Parameter Description

Input Datagrams The total number of UDP datagrams delivered to UDP
users

Output Datagrams  The total number of UDP datagrams sent from this
entity

Invalid Ports The total number of received UDP datagrams for
which there was no application at the destination port

Received Errors The number of received UDP datagrams that could
not be delivered for reasons other than the lack of an
application at the destination port

Table tab

The UDP listener table contains information about this entity's UDP end-
points on which a local application is currently accepting datagrams.
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EE;IMILKYWAY - MIB-I UDP

Generic T able

Murnber of Total Entries : |1 Refresh |

Local Addr. I Local Port
0000 135

Parameter Description

Local Address The local IP address for this UDP listener. In the case
of a UDP listener which is willing to accept datagrams
for any IP interface associated with the node, the value
0.0.0.0 is used

Local Port The local port number for this UDP listener

SNMP (Simple Network Management Protocol)

Implementation of the SNMP group is mandatory for all systems that
support a SNMP protocol entity. Some of the objects defined below are
zero-valued in SNMP implementations that are optimized to support only
those functions specific to either a management agent or a management
station. The objects below refer to the SNMP entity, and there may be
several SNMP entities residing on a managed node.
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H)NPI773960 - MIB-1l SNMP

Input Clutput Tatal
SHMP Packets: 523 |22 1045
GetRequests: 507 [96.9%) 0[0.0%) 507 [48.6%)
GetMestPequests: [15[29%) |I] [0.0%] |1 5(1.4%)
Set-Requests : |D [0.0%) |D [0.0%] |D (0.0%)
Get-Responses : jU 10.0%) !523 (100.2%] 523 [30.0%)
Trap: |D [0.0%) |D [0.0%] 0{0.0%]
'tooBig' Error : iU (0.0%) 0[0.0%) 0[0.0%)
'noSuchName! Enor; [0 (0.0%) |3 6.7%) 35335
‘badvalug' Enor: [0 (0.0%) |0 0.0%) 0(0.0%)
‘genEr’ Errar : |D [0.0%] I2 [0.4%) |2 (0.2%]

Parameter Description

Input/Output packets The total number of Messages delivered to the
SNMP entity from the transport service

Input/Output Get- The total number of SNMP Get-Request PDUs
Requests which have been accepted and processed by the
SNMP protocol entity

Input/Output Get- The total number of SNMP Get-Next PDUs which
Next-Requests have been accepted and processed by the SNMP
protocol entity

Input/Output Set- The total number of SNMP Set-Request PDUs
Requests which have been accepted and processed by the
SNMP protocol entity

Input/Output Get- The total number of SNMP Get-Response PDUs
Responses which have been accepted and processed by the
SNMP protocol entity

Input/Output Traps The total number of SNMP Trap PDUs which have
been accepted and processed by the SNMP
protocol entity

Input/Output TooBig The total number of SNMP PDUs which were
Errors delivered to the SNMP protocol entity and for
which the value of the error-status field is ‘tooBig’
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Parameter Description

Input/Output The total number of SNMP PDUs which were
NoSuchNames Errors delivered to the SNMP protocol entity and for
which the value of the error-status field is

‘noSuchName’
Input/Output The total number of SNMP PDUs which were
BadValues Errors delivered to the SNMP protocol entity and for
which the value of the error-status field is
‘badValue’

Input/Output GenErr The total number of SNMP PDUs which were
Errors delivered to the SNMP protocol entity and for
which the value of the error-status field is ‘genErr’
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) Redundant power supply

This section describes the redundant power supply features are displayed
when you select Information > Hardware Status > Redundant Power
Supply.

Important! Redundant power supplies are not available on all server
models. If the devices are not present in the server, their options in
the Information menu are grayed out.

The Redundant Power Supply window shows the current working condition
of the redundant power supplies and their respective fans. When
redundancy between power supplies has been interrupted, such as when
one or both power supplies fail, or a fan stops working, a Fail status
displays. If this happens, refer to this window to determine the cause of
failure.

The color of each icon in the window indicates its status, as follows:
e  Green means Normal

¢ Red means Falil

e  Gray means Does Not Exist or Unknown

Note: On Windows NT and NetWare systems that contain a
redundant power supply, you can monitor and control the redundant
power supply remotely via Console.

Uninterruptible Power Supply (UPS)

(:)................................."..."...“.

Caution: The following must be present on the server for this feature
to be operational:

e Built-in hardware support

e Agent software component; applies to all network
operating systems that ASM supports
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Agent supports a UPS feature, if one is built-in to the server hardware. This
feature ensures a graceful system shutdown in the event of an AC power
failure. A battery backup maintains power for a short time. This allows
users to save their data and log off the system.

UPS is a very important server feature, because most servers have critical
data files stored online that are constantly being modified. If these changes
are not saved or the file system becomes damaged, users may lose a
substantial amount of work.

If an AC power failure occurs, Agent detects it automatically and
broadcasts a message to all users logged on to the server, notifying them
that they must save their data and log off the system. Agent broadcasts
the first message two minutes before it shuts down the server; it
broadcasts a second message one minute before it shuts down the server.
One minute after it broadcasts the second message, Agent synchronizes
all file systems and performs an orderly system shutdown.

The UPS feature distinguishes a power failure from a spike in the power
source. When AC power is interrupted, the UPS immediately activates the
battery backup. Agent broadcasts the two-minute warning only after a
power failure that has lasted for 30 seconds. So, two minutes and 30
seconds elapse between AC power failure and automatic system
shutdown.

UPS information

ASM automatically detects UPS hardware that is built-in to the server, and
monitors the following four UPS-related components:

e AC power
e UPS fan

e UPS power supply (@ maximum of three power supplies are
supported, as indicated by the three icons in the following figure)

e UPS battery

If the server has built-in UPS hardware, selecting Information > Device
displays the UPS Information window shown below.

Note: If the Device submenu is grayed out, ASM does not detect the
presence of UPS hardware in the server.
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The color of each icon in the UPS Information window indicates its status,
as follows:

Green means Normal

Red means Fail

Gray means Does Not Exist or Unknown

scosysy — UPS Information

Pawer

Mormal

Mormal

Mot exist

Mot exist

Mormal
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Fault management

One of the most important functions of ASM is fault management. This is
done through the use of threshold settings and hardware error detection
methods.

The ASM System Agent performs two tasks when it encounters an error:

1. It sends an alert to SAM (System Alert Manager). See “SAM (System
Alert Manager)” on page 131.

2. It handles the error condition based on the event handling method
setup for the server. The event handling method is setup using the
asmconfig utility.

Note: The Broadcast Message checkbox must be checked before
the Agent can broadcast error messages. Refer to “Event handling
method” on page 149 for more information.

After the Console receives an alert from the Agent, the Console performs
two tasks:

1. It logs the alert information into a log file. This log file may then be
reviewed at a later time.

2. It bases the event handling on the method defined in System Alert
Manager.

An event is something out of the ordinary that occurs on an agent, which,
if left unattended, might cause data loss or hardware damage. An event
occurs when a predefined threshold setting is exceeded, or when a
hardware error occurs.

Threshold settings

All threshold settings are preset to the factory-recommended values. The
following threshold values are user-configurable:

e PCI Bus Utilization (for some models only)
e  Memory Utilization

¢ File System Utilization

e BIOS Event Log Utilization

All other threshold values are internally preset and cannot be changed. In
some models, you can set the threshold values in the BIOS setup screen.
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The threshold values are:

e  Temperature warning

e  Temperature critical

e \oltage exceeds safe range

See “Event types” on page 144 for the definition of each threshold.

An example of non-configurable threshold values is the internally-preset
temperature warning and temperature critical. For example, the
manufacturer-suggested threshold value for some types of Pentium
processors is between 131°F - 167°F (55°C - 75°C). (131°F (55°C) is the
temperature warning threshold; 167°F (75°C) is the temperature critical
threshold. ASM reads and checks the manufacturer’s preset temperature
warning and temperature critical range whenever this type of Pentium
processor is detected.

Hardware errors

The following hardware errors are preset by the manufacturer and cannot
be changed:

e ECC memory error

e Fan stoppage

e UPS related errors (power supply, AC power, power supply fan)
(applies only to certain systems)

¢ Redundant Power Supply related errors (power supply, power supply
fan) (applies only to certain systems)

e  Fuse fail (applies only to certain systems)
e Chassis open (applies only to certain systems)
e  SMART error (for systems that have a SMART drive installed)

See “Hardware status” on page 100 for more information about system
health monitoring.
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4 System Alert Manager

(SAM)



System Alert Manager is a utility that runs in the
background of your Console system every time
you bootup. It actively monitors the systemsin a
network for faults and malfunctions and warns
you if they occur. It also includes an event
viewer that allows you to view the event logs of
networked systems.
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) SAM user interface

The following figure illustrates the SAM user interface window.

IS [= E3

Menu Bar
and ToolBar ”lﬁ SE| S| @B B g‘
|
System Alert Manager
' All Alerts
Navigation ; Displa
Panel SNMP Traps T window
i DMI Indications :
A}ert via LAN
[09:36:1

The toolbar, located at the top of the SAM window, contains the toolbar
buttons. The toolbar buttons allow quick access to selected SAM functions
via a single mouse click. You can also access these functions from the
menu bar.

Icon Description

: Load Alert. Displays the previously saved alert file

Save Alert. Saves alert log information to disk

B

Import File. Allows you to view other alert files (ASCII type only)
created by other programs

Export File. Allows you to save alert files in a text format that
other programs can read

EH | Bk
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Icon Description

Event Handler. Accesses the Event Handler screen

B,

Print Preview. Shows the format display before printing

Print. Prints event log lists

B By

Shutdown. Unloads SAM from the system

Close Window. Minimizes the SAM window to the Windows

@ taskbar

The navigation panel has two parts: Alert Type and Event Viewer. The Alert
Type panel shows the alert type icons. The Event Viewer panel shows the
monitored system’s host name and addresses. Click the title bar to switch
between these panels.




135

) Viewing system alert

When a hardware error occurrs or a threshold setting is exceeded, the ASM
Agent detects the condition and sends an alert to inform the Console.
When the Console receives the alert, it logs the event in the Alert Log file.

There are three types of alerts associated with the Console:
e  SNMP Traps

e DMl Indications

e  Alert via LAN

To view the alert log of a specific type, click its respective icon on the
navigation panel.

SNMP traps

SNMP traps are generated by systems that use the SNMP (Simple Network
Management Protocol) to report devices that are not working properly. To
view SNMP traps, select View > SNMP or click the SNMP icon in the
navigation panel. The SNMP trap log displays.

mﬁ System Alert Manager - SHMP Traps
File Edt SWNMP View Help

lvBwE slae6laa

Blert Type Index | Time | Hast | Address | Type | Description

T 04/27/1999133250 21063101.253 21063101.258 0 SCO TCRAP Runime Release 2.0.0
12 04/27/1999133318 21063101253 21063101253 O 5C0 TCP/P Rurtime Release 20.0
13 04/27A19991501:33 21063101253 21063101253 O 5C0 TCP/P Rurtime Release 20.0
14 04/27A9391501:34 21063101253 21063101253 5 Fan Stops

15 04/27A13831501:34 21063101253 21063101253 5 Fan Stops

16 04/27413331501:34 21063101253 21063101253 5 Fan Stops

17 04/2719991501:34  21063101.253 21063101253 & Fan Stops

18 04/27/19991501:34 21063101.253 21063101.253 B BUS Utiization High

19 04/2719991501:36 21063101253 21063101253 § Fan Stops

20 04/27A19991501:38 21063101253 21063101253 § Fan Stops

21 04/27A933150740 21063101253 21063101253 5 Fan Stops

AvLNz]

'SHMP Traps 6064
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4 System Alert Manager (SAM)

ltem Description

Index Index number that is assigned to the event
Time Actual time when the error occurred

Host Name of the system where the error occurred
Address Network address of the system

Type Type of error that occurred

Description Description of the error

SNMP Traps also contains a MIB Manager that allows you to add or
remove customized trap definitions for SAM. To access the MIB Manager,
select SNMP > MIB Manager on the menu bar. The MIB Manager window
appears.

MIE Manager | x|
MIB File

Server Add

Remove |

SAM supports server SNMP trap definitions. If you have a third party device
that supports MIB files, you can add this to the database and configure the
action for each trap type.

To add a new trap definition file to SAM, click the Add button and select the
file you want to include in the list.

To remove a trap definition file, select the file and click the Remove button.

Note: Add the trap definition to SAM, using the procedures above, to
receive some traps for the specific devices you use.
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Trap types for server systems

The following event types are listed in the Event Handler window.

Type. Description

0 Trap Other than ASM

1 Temperature Warning
2 Temperature Critical
3 1-Bit ECC Memory Error

4 M-Bit ECC Memory Error

5 Fan Stops
6 Voltage Exceeds Safe Range
8 Bus Utilization High (applies only to certain

systems)

9 Memory Utilization High

10 File System Utilization High

11 NIC Counter Threshold Exceeded

The following traps apply only to certain system models

12 UPS Power Supply Fail

13 UPS AC Power Fail

14 UPS Power Supply Fan Fail

15 UPS Battery Falil

16 Chassis Intrusion

17 Fuse Fail

18 Redundant Power Supply Fail

19 Redundant Power Supply Fan Fail

20 BIOS Event Log
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Type. Description

21 BIOS Event Log Utilization High

22 CPU Abnormal

23 Asset Change

DMI indications

DMI indications are generated by systems that use DMI (Desktop
Management Interface) to report devices that are not working properly. To
view DMI alerts, select View > DMI or click the DMI icon in the navigation
panel. The DMI indication log displays.

[:System Alert Manager - DM Alert
File Edit DMl Miew Help
leesBm(slaasa
Blert Tope Index | Time | Host | Tupe | Deseription
[1] 05/19/1998 125050 210.63.101.57 LCPL/Sypstem fan Faniz not running propery. Please run ADM to ch.
: 05/19/1998 125057  210.63.101.57 CPL/System fan Faniz running proparly.
AV
[DMI Alert 16:06:2
ltem Description
Index Index number that is assigned to the event
Time Actual time when the error occurred

Host Name of the host system where the error occurred




139

Item Description

Type Network address of the system

Description Description of the error

DMI Alert also includes a Machine Manager that allows you to choose
which systems to view. To access the Machine Manager, select DMI >
Machine Manager on the menu bar. The Machine Manager window
appears.

Machine Manager x|

Machine Address Status «hdd | Address | Host Name |

5 vEBla 2083101 Reaistered

21063101 253 Registered

192921027 TEDPANGNT
q 5 AG

192921031 WA
192921083 GOLDENLIN
15292101 MONET
129210200 WA

Refresh >
Manual Add

.................. binet

Fiegister | Upregister | Cloze: | IM—_[

The systems that you can view are listed in the Machine Manager window.
However, they must be registered to the service provider before you can
access the log files.

Note: SAM registers the system automatically if it is added to the
System Listing window in Console. If the system is removed from the
System Listing, it becomes unregistered.

To add a system, select a system on the right panel and click the <<Add
button. The system you selected appears in the left panel.

The subnet drop-down menu lists all the available subnets in the System
Listing. If you want to view a new subnet, click the New button and type
the subnet you want. If the subnet is valid, the systems located in that
subnet are displayed on the right panel.

To register a system, select a system on the left panel and click Register.
The default status of the system is Not Registered. SAM register the
systems automatically.
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Note: You can register and unregister the systems any time.

To unregister a system, select the system you want to unregister and click
the Unregister button.

To remove a system from the Machine Manager, select the system you
want to remove and then click the Delete>> button. The system you
deleted appears on the right panel.

DMI indication types

The following indication types are listed in the Event Handler window. Each
of these indications have three states: normal, warning, and critical.

Indication Alerts when..

Voltage Voltage exceeds safety range

Virtual Memory Virtual memory utilization exceeds the intended
value

CPU Temperature CPU temperature exceeds the threshold setting

GDI Resources Graphical Device Interface utilization exceeds

resource limit

CPU/System Fan CPU stops working or the system fan stops rotating

Logical Drive Occurs when file system utilization exceeds
warning or critical threshold

SMART Drive Disk error occurs in the system
Asset System device has been added, removed, or
changed

Alert via LAN (Local Area Network)

The Alert via LAN (Local Area Network) function allows administrators to
monitor and reconfigure local systems through a network. Even if a system
is turned off, it can still report its status to the administrator.
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Edt AVL Miew Help
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JJ_mmm\wﬁa\a 2|

Alert Type

Index

[i]
1
1
2
2
2
3
3
4
4
4
5

Time [ Hast | Deseription |
04/27/1999 16:04:00  ALERTONLAN: bbES7620-5650-11 ce-he25-000022205367 Register

0472741999 16:04:01  ALERTONLAN: bbES7620-5650-11 ce-he25-000022205367 LAM Leash Tamper Event
0472741999 16:04:01  ALERTONLAN: bbES7620-5650-11 ce-he25-000022205367 LAM Leash Tamper Event
04/27/1999 16:04:16  ALERTONLAN: bbES7620-5650-11 ce-he25-000022205367 LAM Leash Tamper Event
04/27/1999 16:04:16  ALERTONLAN: bbES7620-5650-11 ce-he25-000022205367 LAM Leash Tamper Event
04/27/1999 16:04:16  ALERTONLAN: bbES7620-5650-11 ce-he25-000022205367 LAM Leash Tamper Event
04/27/1999 16:04:31  ALERTONLAN: bbES7620-5650-11 ce-he25-000022205367 LAM Leash Tamper Event
04/27/1999 16:04:31  ALERTONLAN: bbES7620-5650-11 ce-he25-000022205367 LAM Leash Tamper Event
04/27/1999 16:04:47  ALERTONLAN: bbES7620-5650-11 ce-he25-000022205367 LAM Leash Tamper Event
0472741999 16:04:47  ALERTONLAN: bbES7620-5650-11 ce-be25-000022205367 LAM Leash Tamper Event
04/27/1999 16:04:47  ALERTONLAN: bbES7620-5650-11 ce-be25-000022205367 LAM Leash Tamper Event
04/27/1999 16:05:03  ALERTONLAN: bbES7620-5650-11 ce-he25-000022205367 LAM Leash Tamper Event

[AVL

16:05:0

Description

Index Index number assigned to the event

Time Actual time when an error occurred

Host Name of the host system where the error occurred
Description Description of the error

AVL alert types

The following alert types are listed in the Event Handler window.

Alert Type Alerts when..

Cover Tamper

System chassis is open

Voltage Event/Fan/Temp

System voltage exceeds safety range

LAN Leash Tamper

Network cable is disconnected from the system

Processor Missing

No CPU is available in the system
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Alert Type Alerts when..

Watchdog Event A software hang occurred

Software Event Software failure to the system

Saving and loading system alert log files

You can save the log for future reference by clicking the Save Alert button.
SAM saves the file to the local hard drive. Click the Load Alert button to
view these files in the future.

You can also save the log to a plain text file or binary file by selecting File
> Export File or by clicking the Export File button and saving it as text or
binary.

You can view previously saved log files from other programs by selecting
File > Import File or by clicking the Import File button. You can only import
ASCII type files.
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) Event viewer

Event Viewer gathers information about events in the system being
monitored by the ASM Console. This information is saved in the event log
file for future reference.

Saving and loading event log file

You can save the event log for future reference by clicking the Save Event
Log button. Event Viewer saves the file with a .evt extension. Click the
Load Event Log button to view these files. You can also save the event log
to a plain text file by selecting the command from the File menu.

Retrieving multiple event log information

To retrieve multiple events, click the Retrieve Multiple Events button. The
Select System window displays:

Select Machine
Machines Found |2 Machines Selected |0
Machine [ Address s | [ Machine [ Address |
manet 21063.101.3 Add>>
VEBLA_ 21063103176
wEBla_ntstd 21063103216
Remove <<

It

Cancel

Event Viewer searches for available systems and lists them in the Systems
Found category. Click on the systems you want to view and then click
Add>> to collect event information about the systems you have selected.

To remove a system from the Systems Selected category:

1. Click on the system you want to remove and click the Remove<<
button.

2. Click OK to verify and exit the Select System window. Event Viewer
starts retrieving data from the systems.
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Displaying single event log information

In the Event Viewer navigation panel, click on a system to display the Event
List window. The Event List window displays events from the system being
monitored. The upper window shows the system name, type of event
group, event group name, time occurred, and a brief description of the
event.

[ System Alert Manager - scosysv.192.9.210.18
File Edt Operation WView Help

IR EI =Y

Alett Type Server Name | Type [ Event Group | Ocouning Time | Desciiption |
scospsv192.. 1006 Mon Apr 26 17-07-55 1993 Fan s not 1urning properly. Please run AOM
scosysv 192 1008 Mon Apr 26 17-07:57 1333 Fanis unning propety

scosysv 192 1008 Mon Apr 26 17-08:46 1393 Fanis not rurning properly. Please un ADM
scosysv 192 1008 Mon Apr 26 17-08:48 1393 Fanis unning propey
scowsv 192 5 FanStops  ‘WedAp 28 040652 1339 HOUSING Fan stopped
scowsv 192 5 FanStops  ‘WedAp 28040652 1939 HOUSING Fan stopped
scowsv 192 5 FanStops  ‘WedApr 28 040652 1339 HOUSING Fan stopped
scowsv 192 5 FanStops  ‘WedAp 28040652 1339 HOUSING Fan stopped
scowsv 192 8 PCIBUS Ut ‘Wed Apr 28 04:06:52 1339 Bus #1 utiization 0.53% exceeds threshold 0.
scowsv 192 5 FanStops  ‘WedApi 28 040654 1399 HOUSING Fan stopped

e scospev 192 § FanStops  ‘WedApr 28 04:06:56 1999 HOUSING Fan stopped
scosysv192... 5 FanStops  ‘Wed Apr 28 04:06:58 1999 HOUSING Fan stopped

bl

m%w Server Name | Address | court | Percert.. | Event Statictics

tedpangnit scospev. 192, 210837101 12 100.00
= 1000%

W scospew 1929210008
& BySewer © BuType By Event Group @ Fie O Bar Cm @D

|scosysv.192.9.210.18 [16:27:0

The lower window shows a summary of events by event group type and a
graphic presentation of those events. You can change these displays by
clicking on the radio buttons below them.

Event types

When an event occurs in a system agent, the Agent sends a trap (interrupt
signal) to the Console. An exceeded threshold value, whether user-
configurable or internally preset, will cause Agent to send a trap. It also
sends a trap when it detects a hardware error.

The following table describes the types of events that are trapped by Agent,
and lists the actions taken by Agent and Console. Possible solutions to the
problems are also offered.
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The first part of the table lists the types of events that can be trapped and
managed on all server models. The second part lists those that are only
available on certain models.

Event Type Description

Trap Other Than When trap that is not listed in the ASM event-type
ASM listing occurs, ASM Agent sends a trap to Console

System Up/Down The server has been booted or shut down.
Agent sends a trap to Console every time this occurs.

Console notifies the system administrator by the
method selected in the Console Side Action section
of the Event Notification Setup screen

Temperature The processor temperature has exceeded the first
Warning threshold setting. A typical default threshold setting
is 131°F (55°C).
Agent broadcasts a “Temperature Warning” message
to all users on the server.

Agent also sends a “Temperature Warning” event trap
signal to Console, who handles the event by the
method selected in the Console Side Action section
of the Event Notification Setup screen.

Agent sends a trap every minute thereafter as long as
the temperature remains above the threshold.
Console records each of these traps in the event log
file.

Note: You can check the processor temperature by
clicking the Hardware Environment toolbar button in

Console
Temperature The processor temperature has exceeded the second
Critical threshold setting. A typical default threshold setting is

167°F (75°C). This value is not user-configurable.
Agent sends a broadcast and a trap, after which it
shuts down the server to prevent loss of data and
possible damage to the hardware. Although not
recommended, Agent can be configured to disable
the auto-shutdown feature. Refer to “Chapter 4 -
ASM Server Agent Utilities” for more information.
Note: You can check the processor temperature by
clicking the Hardware Environment toolbar button in
Console
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Event Type Description
ECC Memory A single-bit or multi-bit ECC memory error has been
Error detected.

Agent sends a broadcast and a trap.

Users should immediately back up their data files.
Caution: The faulty memory module(s) should be
replaced immediately to protect data integrity. Refer
to your system’s service guide for memory module
recommendations

Fan Stops A system fan has stopped rotating.
Agent sends a broadcast and a trap.

Replace the defective fan to ensure that the server
stays within its heat

tolerances.

Note: You can verify whether the fan is functioning by
clicking the Hardware Environment toolbar button in

Console
Voltage Exceeds The voltage reading has exceeded the safe operating
Safe Range range.

Agent sends a broadcast and a trap.

Note: You can check the voltage by clicking the
Hardware Environment toolbar button in Console

Memory Memory utilization has exceeded the threshold
Utilization High setting.
Agent sends a trap.
Add more memory to the server if possible. Refer to
your system’s service guide for memory module
recommendations

File System/ File system utilization has exceeded the threshold

Volume Utilization setting.

High Agent sends a broadcast and a trap.
Perform maintenance on the disk(s). Add another
hard drive if the threshold is still exceeded after
performing disk maintenance




Event Type

Description

The following are event types that apply only to certain server models

Bus Utilization
High

PCI bus utilization has exceeded the threshold
setting.
Agent sends a trap.

Rearrange your PCl add-in components to even out
bandwidth distribution, if possible

AC Power Fails

AC power to the server has failed.

Agent sends a broadcast and a trap, then shuts down
the server

Chassis Intrusion

The server cover is open.
Agent sends a broadcast and a trap

Fuse Fail

The keyboard/mouse, USB, or SCSI fuse has failed.
Agent sends a broadcast and a trap

Redundant Power
Supply Fail

The server’s redundant power supply has failed.
Agent sends a broadcast and a trap

Redundant Power
Supply Fan Fail

The server’s redundant power supply fan has failed.
Agent sends a trap.

How Console handles the trap is determined by the
event notification method selected by the system
administrator in the Event Notification Setup screen

BIOS Event Log

The BIOS has detected hardware and has saved the
information to its event log in NVRAM.

Agent sends a trap

BIOS Event Log
High

BIOS Event Log utilization has exceeded the
threshold setting.

Agent sends a trap

CPU Abnormal

The BIOS has detected an internal CPU error.
Agent sends a trap

Asset Change

An asset has changed, for example, a disk has been
added, removed, or replaced.

Agent sends a trap
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Event handler setup

Select Vlew > Event Handler or click the Event Handler button on the menu
bar to access the Event Handler screen. Event notification applies to
certain systems that you specify.

Event Handler

=] = Machines af subnet 192.9.210
= £ SNMP Tap Address [HostHame |
. %145 DMl Alerts 192921027 TEDPANGNT
Event Handling 1 4 ADL dlerts _cconen | [THT05 Rk
atabas: -8 TEDPANGNT [192.9.21027 1A AR AN A
Database #5 SNMPTva[ 1 << Hide 192821031 ARRAY
& DMl e i 192382101 MONET
i e 192921088 GOLDENLIN
e R ADL Alerts 1929210200 ALEXLINLEX
1823210201 BURN
Systems
Available
ote | ocutsetna| | Ooke | | mwh |
Setup |l | Pocer | Frogr=m] Sotd]
- Cansale Side Action- - Agent Side Action
Event Warning Diclog Bax 7 =
Notification T Flashing Tile Bar I~ Evesute a user defined Progiarm ﬂj
T Audio Alarm I™ Broadeast a waming Message
Setup I~ Dialto s Pager Subnet:
I E:Mail 1929210 o] Mew
ClRs s

Select amachine to setup its event
handing method

The default alert definitions consist of three types: SNMP traps, DMI
indication, and AVL alerts. The default event handling actions are defined
for all alerts received by SAM, but you can set some specific event handling
actions for some systems by creating a new database for that system.

To create a new database entry:

1. Click the Show>> to open the System Select view located on the right
side of the window.

2. Choose an existing subnet, or create a new subnet by clicking the
New button.

Click the Refresh button to show all the systems in this subnet.

Select a system in the systems available window and then click <Add.
If you want to add all the systems in the window click <<Add All. The
systems you specified appear in the database list.

To assign event notification to a specific trap or alert:
1. Select a trap or alert under the alert definition in the database list.

2. Use your mouse pointer to check the various boxes in the event
notification setup tabs. Refer to the next section for more information
about these functions.
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To assign event notification to the alert definitions (whole subnode):
1. Select an alert definition in the database list.

2. Check the various boxes in the event notification setup tabs. Refer to
the next section for more information about these functions.

This action automatically activates the event notification you selected
to all the traps defined under that alert definition.

3. Click Close to save the changes.

To remove a system from the database list, select the system you want to
remove and click the Delete button.

To disable the event notification function for a system, select the system
you want to disable, and click the Disable button. Disabling the assigned
event notification function of a system forces it to adopt the default setting.

To reset the default value of the system’s notification, select the system you
want to reset and then click the Default Setting button.

For SNMP traps, users can decide to receive the traps which are defined in
SAM or not. If the user choose to handle generic traps, SAM will intepret
the message according to the varbind list of SNMP trap packet.

'SHMP Trap Handle Dptions

Options

" Ignare generic taps

# Handle generic traps

Note: When the checkbox in the Agent Side Action frame is grayed
out it indicates that you can only enable this action at the agent side.

Event handling method

The following list describes the event handling methods and the function of
each method. You can check and uncheck as many of these boxes as
desired. A check in the box enables the function; removing a check
disables the function. Use your mouse pointer to check and uncheck these
boxes.

When you open the Event Handler window, you see a list of event
notification methods in the Console Side Action box. Checking an event
notification method causes the ASM Console to take the action indicated
in the checkbox.
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Setup ]Mail ] Pager ] F‘rogram1 Sour

- Conzole Side Action Agen
W “warhing Dislog Box =
¥ Flashing Title Bar [ E
W &udio &larm "B
W Dial to a Pager
W' E:Mail

Console side action

¢ The Warning Dialog Box appears on the ASM Console screen when
the ASM System Agent sends a trap to the Console.

e The Flash Title Bar flashes on and off when the ASM System Console
receives a trap.

e The Audio Alarm makes a sound whenever a trap is received from the
ASM System Agent. You need to set up the sound file befor you
select “Audio Alarm”. You can change the sound the system makes
by changing the sound file in the Sound File edit box. Select the
Sound tab. The following display appears:

Setup ] bdail ] Fager ] Program  Sound ]

Sound File: l

Browslng

& Play wave file

" Play Windows' event sstting
Test Play

When you click on the Browse button, you see the Open Sound File
screen. You can choose a specified sound file to edit. The sound can
be tested by clicking on the Test Play button.

If you choose to play a windows event setting, click the bullet button
and choose a theme from the pull-down menu.
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Note: Select the sound file tab to set up a sound file before marking
the "audio alarm" trap action. You must have a sound card for the
sound file to work.

The Dial to a Pager sends a call to a pager when the ASM System
Agent sends a trap to the Console. Select the Pager tab from the
Event Handler screen. The following display appears:

Setup ] bdail Pager ]Prngram1 Snund1

Pager Mumber: || Test Pager

Message: |

COMPot:  [COM =

Note: Select the pager tab to set up a pager before marking the "Dial
to a pager" trap action.

Enter the pager number in the Pager Number box and a message in
the Message box. Enter the modem port in the COM Port box for
dialing out from the Console. The pager can be tested by clicking on
the Test Pager button.

Note: Set up and configure Microsoft Exchange before you use the
Mail function. For more information on Microsoft Exchange, refer to
your Microsoft Exchange User’s Manual.

E:Mail - the ASM Console sends an email when the ASM System
Agent sends a trap to the Console. Select the E:Mail tab from the
Event Handler screen. Fill out the information in the display. Email
can be tested by clicking on the Test Mail button.
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4 System Alert Manager (SAM)

Setup  Mail ]Pagar ] F'rnglam1 Snund1

b ail Sarver: | Test Mail
Recipient: ]

Mail Subject: |

hdail Taxt:

Note: Select the E:Mail tab to set up email information, before
marking the "E:Mail" action.

Run Program - executes the program when an event occurs. To enter

the Program to Run display, select the Program tab from the Event
Handler screen.

Setup ] b ail ] Pager  Program ]Suund1

Program to Rur: "

Browsing J Test

Note: Set up and configure Microsoft Exchange before you use the
Fax and Mail function. For more information on Microsoft Exchange,
refer to your Microsoft Exchange User’s Manual.
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) Page setup for printing

Select File > Page Setup to access the Page Setup window. This allows
you to change the header, contents, and footer fonts and font size when
printing out information. You can also adjust the top, bottom, left, and right
margins on the paper.

Page Setup

Font |

et T 17~
Content: |.~'-\ria| ;HB ;I

Footer: |Ti.mes Mew Rorman ;HB ;I

|D _J;' [ram]

Left: Bight:

= |
2 ez 4 T |
[rrann ] [rrurn]

] I Cancel | fpply Help
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5 ASM Server Agent
utilities



This chapter describes the ASM configuration
utilities for Agents that run under SCO

OpenServer, SCO UnixWare, Windows NT, and
NetWare.
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The configuration utility for each operating system allows you to:

e Enable, disable, or change the ASM Agent password.

e Change Agent event-handling action.

¢ Add, change, and delete the ASM Console name or IP addresses.

Warning! To report events, the ASM Agent must know the IP address
of the ASM Console. Be sure to use the correct agent configuration
utility to enter the Console IP address.

ASM requires a password for the ASM Console and for each server agent.
To launch the ASM console program, you need an ASM console password.
To protect the server agent data, you need a separate password for each
agent.
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asmconfig for SCO OpenServer

asmconfig is invoked during ASM Server Agent installation to set up the
agent password. It may be invoked at any time by typing asmconfig from
a UNIX shell prompt. The executable file is found in the /usr/bin directory.

SNMP_Config Manager_info Event_Action Password Threshold Event_Log Quit

Working in asmconfig:
e Use the right and left arrow keys to select a menu item.

e Use the up and down arrow keys to highlight the item and press the
return key to execute or select the highlighted item.

e Use the left and right arrow keys to switch control between the main
window and confirm selection window shown at the bottom of the
screen.

e To quit, select Quit from the main menu and press Enter.

SNMP config

This function allows you to add, change, or delete any IP address in /etc/
snmpd.trap. When you want the ASM Console to monitor the ASM Server
Agent, the Console’s IP address must be included in /etc/snmpd.trap on
the server site.

In the following screen example, ASM agent sent event traps for three
monitoring systems: 192.9.210.27, 192.9.210.99, and 202.39.85.64.
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SNMP_Config Manager_info Event_Action Password Threshold Event_Log Quit

! 1
|

| public  192.9.210.27 162 i
| public 192.9.210.99 162 !
! public  202.39.85.64 162 ;
| |
i i
I i
! i
i I
i I
I i
| |
i I
! i
i I
| |
I i
i i
i I
! i
| |
i i
I i
i i
| |
! i
i I
| |
B R e
i [ Add ] [Modify] [Delete] [Cancel] i

Manager information

Modify Manager Contact Information and Server Location by selecting this
function. You can also view and change manager information from the
ASM Console by entering Server Information > Basic Information window.

Instructions about editing data appear on the status line at the bottom of
the screen. Press the Enter key to move the cursor to the next line. When
you finish typing, press Enter and the arrow key to return to the menu item.

SNMP_Config Manager_info Event_Action Password Threshold Event_Log Quit

i
I

| Manager Name

| Office Phone

i Office Location
| Home Phone

! Home Location

| Pager Number

| E-mail Address
| Server Location
|

I

I

I

I

i

I

|

I

I

1

I

i

I

I

I

I

i
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Event action

One of the most important functions performed by ASM is event trapping
and handling. This is done through the use of threshold settings, hardware
error-detection methods, and fault management. When an “event” occurs,
Agent performs the event action and sends a trap to Console. It uses the
IP address specified in SNMP Config to send the trap to the ASM Console.

This function allows you to specify the type of action that ASM Agent takes
when an event occurs. The ASM events that Agent traps are predefined in
the ASM software. You can use the Event_Action function to define agent
actions performed on the agent system. After ASM Console receives the
trap it takes the action defined by the System Alert Manager or ASM
Console Setup event handler. You can also use the related Threshold
function, described later, to change some of the threshold settings. For
more information on threshold settings and event types, refer to “System
Alert Manager” on page 131. A typical Event_Action screen is shown
below. The types of events this screen displays are dependent on the
specific server hardware configuration. For example, not all server models
have a UPS or a redundant power supply.

SNMP_Config Manager_info Event_Action Password Threshold Event_Log Quit

| Event Agent Action Execution Program
Warning Temperature Broadcast
Critical Temperature Broadcast Shutdown
ECC Memory Error Broadcast
Fan Stops Broadcast
Voltage Exceeds Safe Range Broadcast

i
! I
! I
| |
! I
! I
! I
| :
I

: PCI Bus Utilization '
1 Memory Utilization High 1
| File System Utilization High Broadcast |
| XPower Supply Fail i
| XUPS Battery Fail !
| XPower Fan Stop i
| XAC Power Fail !
i Chassis Intrusion Broadcast !
| Fuse Fail Broadcast !
! Redundant Power Supply Fail Broadcast I
! Redundant Power Supply Fan Fail Broadcast !
| i
! I
i

]

I

To specify the desired event action, use the up and down arrow keys to
select the event, then press Enter or Tab to move the cursor to the bottom
of the screen. Use the left and right arrow keys to move between the
Broadcast, Execution, and Cancel options. You can also specify the name
of an Execution Program to run when the event occurs.

To exit the Event_Action screen, press Tab and the left/right arrow key.



161

Password

This item allows you to change or enable or disable the agent password. A
password must have a minimum of 3 characters and a maximum of 16
characters. If you disable the password, the ASM Server Agent does not
execute password checking when the threshold is set from the Console.

Caution: If the password feature is disabled, the server has NO
SECURITY protection.

ASM has password protection for setting values. This means that if you
want to change threshold values, manager contact information or server
location, the Console asks you to enter the ASM Server Agent’s password.

SNMP_Config Manager_info Event_Action Password Threshold Event_Log Quit

T
| Change Password |
| Disable Password |

Threshold

The four threshold items that can be set at the server site are: PCI Bus
Utilization (for systems equipped with PCl Bus hardware), Memory
Utilization, BIOS Event Log Utilization, and global File System Utilization
(for all file systems).

Setting a PCl or memory threshold is the same as setting these thresholds
from the Console side. However, the File System Utilization threshold is a
global value that applies to all of the file systems on the agent system.

When the agent uses a resource up to its threshold value, it generates a
trap. You use this to ensure that resources are used within reasonable
limits.
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Note: All threshold settings are preset to factory-recommended
values. Some are user-configurable, others are not. For more
information on threshold settings and event types, refer to “System
Alert Manager (SAM)” on page 131.

SNMP_Config Manager_info Event_Action Password Threshold Event_Log Quit

| PCI Bus Utilization

| Memory Utilization

iFile System Utilization

| BIOS Eventlog Utilization

Event log

This item allows you to view or clear the Trap Log. When any event occurs,
the ASM Server Agent sends a trap and save this event to the Trap Log.

When the View Event Log option is selected, it allows you to view the Event
Log file (/etc/eventlog.dat) by invoking the vi editor.

When you finish viewing the Event Log file, type: q ! and press Enter to end
the viewing session.
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SNMP_Config Manager_info Event_Action Password Threshold Event_Log Quit

‘ | View Event Log | |

| Clear Event Log! |
I

Quit
To exit the configuration utility, select Quit and press Enter.

If you change any data, the asmconfig program asks you to update the data
before exiting from the program. Select Update to update the files.

Note: If you select Cancel, your changes are not saved.

SNMP_Config Manager_info Event_Action Password Threshold Event_Log Quit

Note: If you select Update, and change the SNMP_config
information, the utility displays the following screen prompting you to
restart Agent so that the changes can take effect. This happens
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whenever you change SNMP Config information utility. If you select
Restart (recommended), and have changed an IP address in /etc/
snmpd.trap, the SNMP daemon (snmpd) is also stopped and
restarted.

SNMP_Config Manager_info Event_Action Password Threshold Event_Log Quit

i Do you want to restart ASM Sexrver Agent?
i

Note: If you want ASM Server Agent to execute correctly,
please choose [Restart] after you finish all
modifications.
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) asmcfg for SCO UnixWare

Follow these steps to configure the SCO UnixWare agent:

1. At the shell prompt, execute the command to start the ASM Agent
Configuration Utility.

# /usr/asmy/asmcig

2. Use the Esc key to move the cursor between the menu and form
regions. When the cursor is located in the form region, use the
PageUp/PageDown key to switch to different form pages. (Each form
page contains a group of related configuration parameters.) Use the
Tab key or Arrow keys to move the cursor around fields in a form page
and then set up the values in them.

3.  When the cursor is located in the menu region, select items from the
Config pulldown menu to directly jump into the corresponding form
pages.

4. From the menu, select File > Save to update the modified
configuration parameters back into the ASM configuration file /usr/
asms/asmsmuxd.conf.

5. In the menu select File > Exit to quit from the ASM Configuration
Utility.

Note: The changed parameters will not become effective until ASM

Server Agent is restarted. Therefore, if any configuration is modified
and saved, the ASM Configuration Utility will ask whether to restart

ASM Server Agent.

Config > SNMP

In this pop-up form, the user can enter the IP addresses of SNMP trap
destinations (i.e., those for which ASM Console expected to receive SNMP
traps). The list of IP addresses will be saved to the SNMP configuration file
/etc/netmgt/snmpd.trap after choosing the OK button. Notice that each IP
address entered should be in decimal dot notation, and be typed on one
line.
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ASM Agent Configuration Utility (asmcfg)

ASM Password]

dd/Modify/Delete IPs of SNMP

g —
H o

I i T i
! ! | |
| Password Protection:| Trap Destinations below: i
| Password: [Change 1 !

|
| 3 127.0.0.1 ! !
i i ! i
| w | |
I I !
| 1 |
I I !
| i
3 3 i i
I I !
| I |
I I !
| | | |
i I
3 3 i i
i ' [ OK 1] [ Cancel ] !
i i ! i
i I !
I I !
| o I |
I
| |
t-- KEY: <Arrow Key>/<PgUp>/<PgDn>/<Tab>/<Enter>/<ESC>----—---—---——-—- (Page 1)-----

Config > ASM_Password

In this form page the user can:

e Enable or disable the ASM password protection by selecting or
unselecting the check mark in the square bracket. If the ASM
password protection is enabled, the ASM Console will request the
user to enter the ASM password each time when issuing an SNMP set
command. (The default setting is Disabled.)

e Change the ASM password. A valid password must have a minimum
of 3 characters and a maximum of 16 characters. (The default
password is a null string.)

ASM Agent Configuration Utility (asmcfg)

ASM Password]
assword Protection: [ ]
assword: [ Change... ]

Uty

t-- KEY: <Arrow Key>/<PgUp>/<PgDn>/<Tab>/<Enter>/<ESC>--------—-—-——-——— (Page 1)-----
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Caution: If the password feature is disabled, the server will have NO
SECURITY protection.

ASM has password protection for setting values. This means that if the
user wants to modify threshold values, manager contact information or
server location, the Console will request the user to input the password of
the ASM Server Agent.

Config > Manager_Info

This form page contains the information related to the server manager.

ASM Agent Configuration Utility (asmcfg)

! [Server Manager Info]

| Manager Name:

{ Office Phone:

| Office Address:
| Home Phone:
iHome Address:

| Pager Number :

' Email Address:
i

I
| Server Location:
|
I
I
i
I
I
I
I
i
I
I
I
1

t-- KEY: <Arrow Key>/<PgUp>/<PgDn>/<Tab>/<Enter>/<ESC>-------—--———-—-— (Page 2)-----

Config > Threshold

The Threshold form page allows you to set/change three thresholds: PCI
Bus Utilization (for certain server models only), Memory Utilization, and File
System Utilization. It also allows you to specify the interval that elapses
between polling.

Note: All threshold settings are preset to factory-recommended
values; some are user-configurable, others are not. For more
information on threshold settings and event types, refer to “System
Alert Manager (SAM)” on page 131.
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ASM Agent Configuration Utility (asmcfg)

Threshold Values]

I 1
VI i
|

' PCI Bus Util. (%): 100 '
| Memory Util. (%): 100

iFile System Util. (%): 100

| I
iPolling Interval (sec.): 1

| 1
1 1
I |
| I
1 |
| 1
| |
| 1
1 1
1 |
| 1
I |
| 1
| |
| I
1 I
1 |
| 1
I |
| |
1 I
| |
1 |
| 1
t-- KEY: <Arrow Key>/<PgUp>/<PgDn>/<Tab>/<Enter>/<ESC>-------------—— (Page 3)-----

Config > Event_Actions

The events that Agent traps are predefined in the ASM Pro software.
However, you can use the Event_Actions form pages to define the agent
action that is taken when an event occurs. You can also use the related
Threshold form page, described previously, to modify some of the
threshold settings. For more information on threshold settings and event
types, refer to “Chapter 3 - System Alert Manager”.

ASM Agent Configuration Utility (asmcfg)

<<Event Handling (1)>>
Broadcast Shutdown Execute

[Warning Temperature Event]

Event Action: vl [1 [
Execute Program:

Pager Number:

Execute Program:
Pager Number:

[ECC Memory Error Event]
Event Action: [v] [1] [
Execute Program:

i
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
[Critical Temperature Event]
|
|
|
|
|
|
|
|
|
|
|
|
1
|
Pager Number:

|

|

iEvent Action: [vl [vl] [

-- KEY: <Arrow Key>/<PgUp>/<PgDn>/<Tab>/<Enter>/<ESC>---------—————— (Page 3)-----
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) asmcfg for Windows NT

The ASM configuration utility for Windows NT (asmcfg) is found in the ASM
Server Agent target directory. The features are similar to asmconfig
features for the SCO OpenServer utility described earlier in this chapter.

To Run the Program:

1. In Windows NT, click Start > Program. Click ASM Server Agent and
ASM Server Agent Utility. The password window appears.

> -ASM Agent Utility

Manager Information | Server Information EvemtAct\om}EvantLug F'asswurd1

—Add Trap Destination
| Trap Destinations:
1592.9.210.25

. _ 182921070
IP Address: _sen | LR

To gend traps to the stations, the ASH Agent Ltility provides to add trap destinations by
I addresses.

2. Type in the correct agent password and click OK. The utility has the
following functions that can be accessed by clicking on their tabs.

SNMP Config

This section allows you to add, change, or delete any address in the SNMP
service trap destinations. If you want the ASM Console to receive event
traps from the ASM Server Agent, the Console’s IP address or the ASM
Console name must be included in the SNMP service trap destinations with
the community name "public" on the agent site. The ASM Console name
is found in System > Control Panel > Network >Information on the ASM
Console system.

To add an IP address to the trap list, type in the IP address or ASM Console
name and click on the Add button. To remove IP address(es) from the trap
list, select the IP address or ASM Console name and click on the Remove
button.
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Manager information

Click on the Manager Information tab to change server manager or owner
information.

+1-ASM Agent Utility

Snmp Config  Manager Information I Sewerlnlurmal\uml Ewent Acliunl Ewent Log Passwurdl

Manager Mame: I

Office Location:
Office Phane:

Home Location:

Home Phone:

Pager Mumber: I
E-Mail Address: |

0K Cancel

The maximum number of characters allowed is 48 per field.

Server information

Click on the Server Information tab to change the server location. This tab
describes basic server data. You can also view this tab through ASM
Console > Server Information >Basic Information. This screen also allows
you to specify the ASM server agent location so that you can track it when
you need it.
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b i’ ASM Agent Utility

SanCDnFiglManager\nfurmalian Server Information EvenlActionIEventLug Passwordl

Server Name: BULL
05 Weasion: “wiindowes NT 4.0 Build 1381

Server Location: ||
Swstem Root: D:MwANMT
05 Install Date: FriJan 24 10:45:20 1937

BoatUp Time: 2days 15: 56: 50
Registered ta: i

acer

212960EMD1 2345601235

The maximum number of characters allowed is 48.

Event action

This function allows you to specify the action that ASM Agent takes when
an event occurs. Click on the Event Action tab to display the following
screen.

ASM Agent Utility

Snmp Config | Manager Information | Server Information  Event Action IEvenl Lngl Passwnrdl

Temperature Warning

Ewent Handling kethod
W Broadcasting
Message

I Auto Shutdown

Program To Execute

T emperal hing
Temperature Critical

ECC kemory Errar

Fan Stops

Yoltage Exceeds Sate Rar
BUS Utilization High ) .
Memory Uilization High "lml\a\ Threstald SE[[II’]Q—‘

File Spstem Utlization High
Chassis Intrusion Abnormal =]

=

This event is izsued when the CPU temperature exceeds the first level threshold setting.

coca_|

A number of events are defined in ASM. You can define the agent action
(broadcast message or shutdown), the threshold setting, and the user-
defined program to be executed by the server agent when the trap occurs.
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ASM Agent sends a warning message to all users that are logged in at the
time the event occurs.

To specify the event action, highlight the event, and use the mouse to
check the Event Handling Method checkbox. You can type in the name of
the user-defined program you want to execute when the event occurs. You
can also set the threshold value for certain events.

Event log

The ASM Event Log is stored in the Windows NT application log area. You
can save or delete this information using the Windows NT Eventview
program. Click on the Event Log tab to display the following screen:

SM Agent Utility

Snmp Conf\g] Mamagerlnformation] Serverlnlormanon] Event Action  EwentLog lF’assword1

Type | Time | Description i]
02/28/1997 06:15:14  Housing fan 3 stopped,

02/28M1997 06:15:13  Housing fan 2 stopped

02/28/1997 06:15:13  Housing fan 1 stopped,

02/28/1957 06:14:54  CPUT Fan stopped.

02/28/1997 18:5216  Memory uliization 87% exceeds threshold 6%
02/28/199718:52.15  Voltage for sensor 2 is too low with reading 01404
02/28/1997 18:5215  Housing fan 3 stopped,

02/28/1997 18:5215  Housing fan 2 stopped,

02/28M1997 185215 Housing fan 1 stopped

02/28/1997 18:48:34  Memory utilization 85% exceeds thieshold 6%
02/28/1997 18:48:30  Voltage for sensor 2 is too low with reading 01404
N2/7AM997 18473 Hrusina Fan 3 stanned _>_]L|

|

Befresh Total Events: 140
! Cared

AN W O (1@ e e

This screen shows the Event Log list. It contains all of the traps generated
in the server system. You can view all of the ASM events from the day you
installed the ASM server agent.

To refresh the Event Log list, click on the Refresh button.

Password

Click on the Password tab to display the following screen:
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> 1-ASM Agent Utility

Shmp Conligl Managerlnformationl Server [nformation EvemtActionI Eventlog Password |

" Disable Password
' Enable Password

New Password

Password: I""’i

LConfirm
Password: I"""

This screen allows you to change, enable, or disable the agent password.
A password should have a minimum of 3 characters and a maximum of 16
characters. If you disable the password, the ASM Server Agent does not
execute password checking when the threshold is set by the ASM Console.

Caution: If the password feature is disabled, the server has NO
SECURITY protection.

ASM server agent has password protection for setting values. If you want
to change threshold values, manager contact information or server
location, the ASM Console asks you to enter the ASM Server Agent’s
password.

Saving changes in asmcfg

After you have finished making changes, click on OK. The following dialog
box appears:

ASM-Agent Ulility x|

@ Fieplace existing configuration ?
Mo | Eancell
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To save your changes, click on Yes. If you have changed the SNMP_config
data, the following dialog box appears:

ASM-Agent Utility

You must stop and restart your SMMP zervice before
the new settings will take effect.

Dio pou want to restart your SNMP service now?

|

This dialog box prompts you to restart the SNMP services for the changes
that you made to take effect. Click on Yes to restart these services.
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) asmcfg for NetWare

The ASM configuration utility for NetWare (asmcfg) is similar in function to
the asmcfg utility used for Windows NT and the asmconfig utility for SCO
OpenServer.

At the system console prompt on your NetWare server, enter the command
“load asmcfg”. A window similar to the following appears:

Configuration Item
00B
Manager Information
Server Location

Event Handling
Uninstall

Trap Target
Hit

ENTER=Select ESC=Exit Menu

The utility includes the following functions: (For each function, follow the
instructions at the bottom of the screen.)

Password

ASM has password protection for setting threshold values. When changing
a threshold value from the ASM Console, it asks you to enter the password
for the ASM Server Agent. If you disable the password, the ASM Server
Agent no longer executes password checking when any values are
changed.

Caution: If the password feature is disabled, the server has NO
SECURITY protection.
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To enable or disable the password option:

1. Select the Password option. A password must have a minimum of 3
characters and a maxmum of 16 characters.

2. Use the left and right arrow keys to switch between Yes or No and
then press Enter.

Configuration Item

|Passw0rd
00B

Password Setting
Password protect [No |
Change password

ENTER=Select ESC=Exit Menu

To change the password:

1. Highlight the Change password option and press Enter. The Set
Agent Password window appears.

2. Type the new password and press Enter.

Configuration Item

Set Agent

Type the passwor

Change password

ENTER=Select ESC=Exit Menu
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Out of band

When you use a modem to connect the agent and the ASM Console, select
the OOB button (Out of Band connection between the agent and the
Console via modem) to configure and to change the out of band modem
settings. The modem settings control the out of band connection between
the ASM Server Agent and the ASM Console, including the COM port
settings. Refer to your modem manual for the proper values.

Configuration Item
COH Ports Used for 0O0B rd

COH2 19200 N 8 1 r Information
Location

Handling
all

arget

ENTER=Select INS=Add DEL=Delete ESC=Previous Menu

Manager information

Select Manager Information to change manager contact information, such
as the manager’s name, address, and phone number.
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Server Manager’'s Information

Name : |

0ffice Phone Number:

O0ffice Address:
Home Phone Number :
Home Address:
Pager Number:

EMail Address:

ENTER=Select ESC=Exit Menu

Server location

Select Server Location to specify the physical location of the server.

Configuration Item

Password
00B

Manager Information

L

Event handling

This function allows you to specify the action that ASM Agent takes when
an event occurs. Select Event Handling to display the Event Handling
screen. (A typical Event Handling screen is shown below.)
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Broadcast Shu n Execute Program

Temperature Harning
Temperature Critical

ECC Memory Error

Fan Stops

Yoltage Exceeds Safe Range
UPS - Power Supply Fail

UPS - AC Power Fail
UPS - Power Supply Fan Fail
UPS - Battery Fail
Chassis Intrusion
Fuse Fai
Redundant Power Supply Fail
Redundant Power Supply Fan Fail
New BIOS Event Log
CpuDisabled
AssetChanged
Threshold

ENTER=Select ESC=Ex1t Menu

See “Event types” on page 144 for a description of the important events.
There are three ways that events are handled:

Broadcast - sends a messages to all users logged in to the network.
Shutdown - Shuts down the network operating system.

Execute Program - Executes a specified program when an event occurs.

Trap target

Select Trap Target to add, change, or delete any IP address in the trap
target destinations. If you want the ASM Console to receive the trap from
the ASM Agent, the Console’s IP address must be included in the trap
target destinations with the community name "public" on the system site.
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e
uration Item

Information
ocation
ndling

1

get

[INS=Add DEL=Delete ESC=Previous Menu

To add an IP address to the trap list:
1. Press the Insert key. The Add Trap Target window appears.

Trap Target

Add Trap Target

Network Address: 123.123.123.123

INS=Add DEL=Delete ESC=Previous Henu

2. Type the IP address and press Enter.

To remove an IP address from the trap target list, select the IP address and
press the Delete key.
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e
uration Item

123.123.123. 123

[INS=Add DEL=Delete ESC=Previous Menu

Saving changes in asmcfg

After you are finished making changes, select the Exit option. The following
dialog box displays:

Configuration Item
Pas
00B| Exit ASMCFG?

Han
Ser
Eve
Uni
Trap Target
Exit

ENTER=Select ESC=Exit Menu

To exit asmcfg, select Yes. If you choose to exit asmcfg, the following
dialog box displays:
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Save changes

ENTER=Select ESC=Exit Menu

To save changes, select Yes. Press the Esc key to exit asmcfg.

Uninstalling ASM server agent

From the main asmcfg screen, select uninstall, and follow the onscreen
prompts.

Remove ASM Agent

ould you like to continue?

|Manager Information

Remove ASHM Agent now?

ENTER=Select ESC=Exit Henu
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) asmcfg for Linux

asmcfg is invoked during ASM Server Agent installation to set up the agent
password. It may be invoked at any time by typing asmcfg from a Unix
shell prompt. The executable file is found in the /usr/local/share/asm
directory.

w Manager_Info Event_fction Password Thresheld Event_Log Quit
p—

| Password: |

| Configure Trap Targets for SHHP/SHUX |

Working in asmcfg:
e Use the right and left arrow keys to select a menu item.

¢ Use the up and down arrow keys to highlight the item and press the
return key to execute or select the highlighted item.

e Use the left and right arrow keys to switch control between the main
window and confirm selection window shown at the bottom of the
screen.

e To quit, select Quit from the main menu and press Enter.

SNMP_Config

This function allows you to add, change, or delete any IP address in /usr/
local/share/snmp/snmpd.conf. When you want the ASM Console to
monitor the ASM Server Agent, the Console’s IP address must be included
in /usr/local/share/snmp/snmpd.conf on the server site.
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In the following screen example, ASM agent sent event traps for three
monitoring systems: 10.34.155.205 and 10.34.155.250.

m Manager_Info Event_Action Password Threshold Event_Log Quit
u
D

trapsink 18.34.155.285

| [ Add ] [Modify] [Delete] [Cancel] |

Manager information

Modify Manager Contact Information and Server Location by selecting this
function. You can also view and change manager information from the
ASM Console by entering Server Information > Basic Information window.

Instructions about editing data appear on the status line at the bottom of
the screen. Press the Enter key to move the cursor to the next line. When
you finish typing, press Enter and the arrow key to return to the menu item.
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SNMP_Config Event_fction Password Threshold Fuent_Log Quit
.

Manager Name
Office Phone
Office Address
Home Phone

Home Address
Pager Humber
Email nddress
Server Location :

| Use arrow key and edit... . .. ..... ... ... |

Event action

One of the most important functions performed by ASM is event trapping
and handling. This is done through the use of threshold settings, hardware
error-detection methods, and fault management. When an “event” occurs,
Agent performs the event action and sends a trap to Console. It uses the
IP address specified in SNMP Config to send the trap to the ASM Console.

This function allows you to specify the type of action that ASM Agent takes
when an event occurs. The ASM events that Agent traps are predefined in
the ASM software. You can use the Event_Action function to define agent
actions performed on the agent system. After ASM Console receives the
trap it takes the action defined by the System Alert Manager or ASM
Console Setup event handler. You can also use the related Threshold
function, described later, to change some of the threshold settings. For
more information on threshold settings and event types, refer to “System
Alert Manager” on page 131. A typical Event_Action screen is shown
below. The types of events this screen displays are dependent on the
specific server hardware configuration. For example, not all server models
have a UPS or a redundant power supply.
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SHHP_Config Hanager_Info (fIFeiHefil] Password Threshold Event_Log Quit

e

| _Event Agent Action Execution Program
Broadcast
Temperature Critical Broadcast  Shutdown
ECC Hemory Error Broadcast
Fan Stops Broadcast
Uoltage Exceeds Safe Range Broadcast

|
| |
| |
| |
| |
| |
| e Exceeds Sa I
| BUS Utilization High |
| Hemory Utilization High |
| File System Utilization High Broadcast |
| |
| |
| |
| |
| |
| |
| |
| |

Power Supply Fail Broadcast
AC Power Fail Broadcast Shutdoun
Power Supply Fan Fail Broadcast
UPS Battery Fail Broadcast
Chassis Intrusion Broadcast
Fuse Fail Broadcast
Redundant Power Supply Fail Broadcast

Redundant Power Supply Fan Fail Broadcast

| [Broadcast] [Execution] [Cancel ] Pgbn/Hext Page |

To specify the desired event action, use the up and down arrow keys to
select the event, then press Enter or Tab to move the cursor to the bottom
of the screen. Use the left and right arrow keys to move between the
Broadcast, Execution, and Cancel options. You can also specify the name
of an Execution Program to run when the event occurs.

To exit the Event_Action screen, press Tab and the left/right arrow key.

Password

This item allows you to change or enable or disable the agent password. A
password must have a minimum of 3 characters and a maximum of 16
characters. If you disable the password, the ASM Server Agent does not
execute password checking when the threshold is set from the Console.

Caution: If the password feature is disabled, the server has NO
SECURITY protection.

ASM has password protection for setting values. This means that if you
want to change threshold values, manager contact information or server
location, the Console asks you to enter the ASM Server Agent’s password.
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SNMP_EunFig Manager_Info Event_fiction Threshold Event_Log Quit

]
Ichange Passwor di

|bisable Password]|

| You can change a new password which is from 3 to 16 letters... |

Threshold

The four threshold items that can be set at the server site are: PCI Bus
Utilization (for systems equipped with PCI Bus hardware), Memory
Utilization, BIOS Event Log Utilization, and global File System Utilization
(for all file systems).

Setting a PCl or memory threshold is the same as setting these thresholds
from the Console side. However, the File System Utilization threshold is a
global value that applies to all of the file systems on the agent system.

When the agent uses a resource up to its threshold value, it generates a
trap. You use this to ensure that resources are used within reasonable
limits.

Note: All threshold settings are preset to factory-recommended
values. Some are user-configurable, others are not. For more
information on threshold settings and event types, refer to “System
Alert Manager (SAM)” on page 131.
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SNMP_EonFig HManager_Info Event_fiction Password |GGG Event_Log Quit

L}
JPCI Bus Utilization|

|
|Memory Utilization |
|File System Utilization |
|Bios EventLog Utilization|

| Current PCI Bus Utilization Threshold is 188 |

Event log

This item allows you to view or clear the Trap Log. When any event occurs,
the ASM Server Agent sends a trap and save this event to the Trap Log.

When the View Event Log option is selected, it allows you to view the Event
Log file (/etc/eventlog.dat) by invoking the vi editor.

When you finish viewing the Event Log file, type: g ! and press Enter to end
the viewing session.
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SNMP_EonFig Hanager_Info Event_fction Password Threshold Quit

L |
JUiew Event Log|

|Clear Event Log|

| View event log file by vi |

Quit
To exit the configuration utility, select Quit and press Enter.

If you change any data, the asmcfg program asks you to update the data
before exiting from the program. Select Update to update the files.

Note: If you select Cancel, your changes are not saved.
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SNMP_EonFig Manager_Info Event_Action Password Threshold Event_Log
u

| Do you want to update ? |

| [{updatell [Cancel] |

Note: If you select Update, and change the SNMP_config
information, the utility displays the following screen prompting you to
restart Agent so that the changes can take effect. This happens
whenever you change SNMP Config information utility. If you select
Restart (recommended), and have changed an IP address in /usr/
local/share/snmp/snmp.conf, the SNMP daemon (snmpd) is also
stopped and restarted.
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SNMP_EnnFig Hanager_Info Event_action Password Threshold Event_Log

| Do you want to restart ASH Agent ¥ |

Note: If you want ASH Agent to execute correctly,
please choose [Restart] after you finish all
modifications.

| [|Restart]] [Cancel] |
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This chapter describes how to view ASM Agent
system information locally. Both Desktop and
Windows NT and Windows 2000 agents come
with ASM Local Console. ASM Local Console
displays the agent information and some
performance and health data. The local console
on the Windows NT system is similar to the
Desktop Local Console. The following sections
discuss each of the functions included in the
Desktop Agent User Interface.
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) Basic system information

Click the System tab to display basic information sbout the system. Basic
information includes system name, operating system, and system board
and memory information.

[E ASM Local Console M= E3
File  Config

Basic System Information

@ System |£ Storage I & Metwork | [J F'er. mance I 8 Healh I@ OnBoard I \ﬁ’ Fesource I %}‘ 10 Device I

vﬁcﬁ e Name : [TEDPANGNT
~System
Operating Syster Mictasoft® Windaws NT{TH]
0.5. Yersion r\/a.rs_iq'rf:{rﬁ__;ﬁu'lﬂd] 381, Service Pack 4
—Hardware
Model: [ACEF M11A 95105 14
| BIOS Versian : IACER ACR2FED-08-97021 250185 R
\ Processar [Intel Pentium Pro 200MHz
o P:d;rmrijwza: |123‘k;|9.3'
; ASM i . “Eﬂpbe Sifé i [L1:1EKB . L2256 KB
—Lagin Infomatiors -
Local Console | v e
Damain+arkgroup : |M?EF

This screen shows the agent system software and basic motherboard
information. Some system models have an asset tag property in their
motherboard BIOS. If the asset tag property is available, the “Asset Tag”
field appears in this window. The Asset Tag function allows you to assign
a name to the current asset information.
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Physical and partition information

Click on the Storage tab to display storage device and partitions
information when you select a drive. The screen is divided into three
sections: the display window, the pie chart, and the information section.

Accessing physical storage device information

To access physical storage device information:
1. Click on a device in the display window. For example, a hard disk.

2. Click on the logical drive to display more partition information and the
usage pie chart..

Click the Refresh button to display the most current device setup.

Click on the logical drive to display more partition information and the
usage pie chart.

M 45
File Config

Ci[]- 4102 ME
1) Floppy Disk

Refresh
T Hand sk
Model \
© Doterdace: Enhanced ATAIDE
*_ Devige IDLUN JIEI]
Remaveble: i

Local Console s -
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The information section displays the following:

Parameter Description

Type Type of storage device (i.e., hard disk, cd-rom,
etc.)

Model Model name of the storage device

Interface Type of interface the storage device uses (i.e.,
SCSI, IDE, etc.)

Device ID:LUN Device ID and LUN (Logical Unit Number) of

physical devices.

ID number is 0 or 1 for IDE (Integrated Drive
Electronics) interface devices, while 0 to 7 is for
SCSI (Small Computer System Interface) devices.
LUN is an encoded 3-bit identifier used by the
SCSI system as a secondary address associated
with the SCSI ID. There can be up to 8 LUNs per

target ID.
Removable Identifies whether the storage device is removable
or not
Total Size Maximum storage capacity of the storage device
Partition Total number of partitions in the storage device

Accessing partition information

Logical partitions are created when you divide a hard disk into several parts
and specify each of them as an independent logical drive.

To access logical partition information:

1. Click the plus (+) sign, or double-click on a physical device to see its
logical partitions.

2. Click the partition you want to view.

3. Click the Refresh button to display the most current device setup.
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ASM Local Console
File  Canfig

6 ASM Local Console

Physical and partition information

~

r

'G‘A ITED]
Tatal Bize : 1%994]3
Used Size : 1583 MB
Free Size : 416 MB

D Sysen 2 Stoiage | 2 Netwerk | 13 Pertormance | Bl Healh | @ OnBoxrd | B Resouce | $7 140 Device |

0303

ATEDPANGA] - 2047 MB
® ® FUNITSU M295200 512 0147
6 Flappy Disk
5] @ CO-ROM

B FALL-OME

* Partition:
ghr

gy
_ Fomat:
Total Size s

Fres Size

‘Compressed :

Refresh

o

fTED

FAT

155 M

1B NE

[Na

The pie chart shows the total space and the free and used space of the
partition. The information section displays the following:

Parameter Description

Partition Displays the logical drive name for the partition.

Label Partition label

Format Format type of the partition (FAT or NTFS) File system
format

Total Size Total capacity of the partition in MB

Free Size Amount of unused space in MB

Compressed

Shows if the partition is compressed or not
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) LAN adapter, TCP/IP, and modem
setting

Click the Network tab to access information about the system’s network
settings. If you have more than one network card installed, click the arrow
button to cycle through them. The screen contains three sections: LAN,
TCP/IP, and Modem.

5 ASM Local Console C[OIX]
File Config

LAN Adapter, Modem and TCP/IP Setting

i sysiem | 8 Stoage B Nework | i Patomance | B Heatt | 9 0noad | [# Resauce | €5 170 Devies |
LAN Selting [1/2]

Manufacturer [3Com
Mr_adeW [3Com Fast EtherLink PCI 10/100BASE-T j
Diriver : EBg1.1 j
Driver Description [3Com Fae}‘E-{hELLmk FCI10/100BASE-T
i~ TCPAP Setting
Machine Name Itedpanant
P Address 2106310195
Subnet Mask [2655,265.255.0
¢, Galeway lZTElEjr?.\'lm"};
LDNS T Z1063.96.2 20366.109.2
i q —
€ : : i el
% - odem—s
3 o ? | r
2 Asm i anufEETyer =

Zacal Console |

Ciriver Descriptitn :
Aftached bo

LAN (Local Area Network)

This section displays information about your LAN card or NIC (Network
Interface Card).

Manufacturer Name of the manufacturer
Model Model name of the device
Driver Device driver identifier and version number

Driver Description Brief description of the driver
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TCP/IP (Transmission Control Protocol/
Internet Protocol)

This section displays information about your connection to the Internet.

Parameter Description

System Name Name of your system
IP Address IP address of the system
Subnet Mask Mask address of an IP. A mask is use to identify

what subnet your IP belongs to

Gateway The IP address the system is connected to. A
gateway is any device that links two different types
of networks

DNS (Domain Name  Address of your network domain server
System)

Modem

This section displays information about your modem connection. This
section is grayed out when the system does not have a modem.

Manufacturer Manufacturer of the modem

Model Model identifier and version number

Driver Description Brief description of the modem’s driver
Attached to COM port the modem is assigned to (COM1 or

COM2)
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) System performance information

Click the Performance tab to access information about the system’s
performance in the following areas: CPU utilization, memory management,
file swapping, and file system utilization.

£ ASM Local Console =0 ]
File Canfig

System Performance Information f

&2 Spstem | %2 Storage I % Metwark ﬁ Perfarmance |3 Health |‘$ OrBoard | @’ Resouice | % 1/0 Device I

- CPU Utization

Current Usage : - Tatal thread 154

—Wirtual Memary Manager

.;Allocaled emony : |1 35476 . KB

Locked Memary : [18963 - KB

| Swappable bemory : [Fa772 ) KB

= T Free WMoy : ] KB

s N _ =
Acer ASM * - Swap Fle=——— Fil System
§fﬂ FL !C le Size : o~ [f7824 KB Bytes Read / Sec: 48088
L BIE0, InUse 35028 KB Bytes Write /Sec: [0

Page Discards : 11 P/S || Read/Sec: 23
Page Fault : 204 PS5 || white / Sec: 0

CPU utilization

This section displays a line graph for the use of your system’s CPU. The
graph is interpreted as the percentage of utilization during the time

indicated.
Parameter Description
Current Usage Current percentage of CPU utilization

Thread Number of total executing threads
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Virtual memory manager

This section displays the available memory resources in the system.

Parameter Description

Allocated Memory Total amount of memory in kilobytes used on the
system
Locked Memory Amount of memory allocated and locked

Swappable Memory ~ Amount of memory in kilobytes allocated in the swap
file

Free Memory Amount of memory in kilobytes not in use

Swap file
This section shows the available memory allocated for swap file use.

Parameter Description

Size Total amount of memory in kilobytes allocated for
swap file use

In use Total amount of swap file memory in use

Page Discards Amount of page discarded (dumped) to a physical
device per second. Pages that haven’t been used for
a long time are discarded to free memory space

Page Fault Amount of faulty pages in memory which are
discarded to free memory space

File system
This section shows the file read and write performance of the system.

Parameter Description

Bytes Read/Sec Speed at which the system can read files

Bytes Write/Sec Speed at which the system can write files
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Parameter Description

Read/Sec Number of times the system can read per second

Write/Sec Number of times the system can write per second
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System health status

Click the Health tab to display the current fan, CPU temperature, and CPU
voltage status.

Desktop Agent sends a warning to the Console if any of the instruments fail
to operate or malfunction. The Console SAM (System Alert Manager)
receives the warning information from different system protocols. For more
information, refer to “System Alert Manager (SAM)” on page 131.

! Type Statns Tupe Status

 CPD Fan. Ok 3 CPU Temperature Ervor
| Valta
Tuge [ stes [
W17 Ok
33 Volt Ok
5 Volt Ok
/12 Volt Ok

Loeal Console

Fan

This section displays all of the fans installed in the system. Fan status is
monitored through the hardware module of the desktop. The green check
icon indicates that the fan is functioning properly. The icon turns to a red
X mark when the fan is not working.

Temperature

This section displays the CPU’s temperature. Temperature status is
monitored through the hardware module of the desktop. The green check
icon indicates that the CPU temperature is normal while the red X mark icon
indicates that the temperature exceeds the normal threshold.
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Voltage

The voltage for the processor and the motherboard is shown here. The
icon is green when the voltage is within the normal range. The icon turns
red when the voltage is not within this range.
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) CPU, memory, and onboard chips

Click the Onboard tab to display basic motherboard information including
the system’s CPU, memory, and other onboard devices.

[ntel
Fomaly : e
Extornal Speed : (100 Bz
Tntemnal Speed : 50 BEz
Foltage : FIVISV

- Memary : 64 MB, Total 8lot: 3, Used Slot : 1

Designation | Type [ Sizs.
DIM1 DIMM SDRAM 64 MB
DIMZ Ni& Wik
o DIM3 N Nin
| -0n Board Device-
— i s St Type. [ Description [
; Asm Videa ATl 3D RAGE PRO AGP
Ethemet Inte] 382558
; Sound Crystal 4235
Local Console

Processor

This section displays information about the system’s CPU.

Parameter Description

Manufacturer Manufacturer of the CPU

Family Model identifier of the CPU
External Speed (Bus  External speed of the CPU in MHz
speed)

Internal Speed Internal speed of the CPU in MHz

Voltage Current voltage setting of the CPU
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Memory

This section’s title bar shows the total amount of memory, in Megabytes,
installed in the system. It also shows the number of memory slots available
on the system board, and the number of slots currently occupied.

Designation Designated name of the memory module
Type Type of memory module installed
Size Total capacity of the memory module

Onboard device

This section displays all the onboard devices installed in the system. Refer
to your system board manual for more information about its onboard
devices.

Parameter Description

Type Type of onboard device in the system

Description Brief description of the device
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System resource

Click the Resource tab to view the system’s IRQ, DMA, I/O port, and
memory address assignments. This information is useful for detecting

hardware interrupt conflicts.

Click on the item title to sort the data.

[E ASM Local Console
File  Config

System Resource

Local Console

Device Name [ IRG | DM [ 1/0 Pat | Hemenp Addr
E042prt 01:12 none  ODBO-O0B0,00..  nene

Serial 04 none  OSFSOGFE none

A5H none  none  D4F204F3 none

DC21H4 03 none  7080-70FF none

El59x 05 none  7000-701F hiohe

Floppy 06 02 O3F0-03F503. none

aic7 5 11 none  7AD0-74FF 0B100000-08 1 00FFF
atapi 15 none ON700177.03. none

VgaSave rone none  03B0-03BB.03.  00040000-000BFFFF

6 ASM Local Console

1 System | 82 Storzge | B Netwark | B Patomance | B Healtn | 9 Onos B Resouce |5 10 Devies |

L
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) /O device information

Click the I/O Device tab to display the types of Input/Output devices
installed in the system. 1/O devices include the keyboard, mouse, serial
ports, parallel ports, video devices, and expansion slots.

[ ASM Local Console &
File  Config

=

I1/0 Device Informatio L

g
L

o
i

Healh | @ 0rBosrd | [ Resouce S 1/0 Device |
|F‘S.‘2 PC/AT Enhanced Keyboard (10110
[Logitech PS/2 Port Mouse
Serial Ports : fi
Parallel Ports fi
Wideo
Manufacturer /ATI Graphies Accelerator
Model iATI Technologies Inc. machB4 Graphics 4c
| Curent Resolution 1024 by EB piels
" Cument Colors 65536 mﬁ_ £3
Slat :
" [ Designation [ Type [ Length [ Usage |
il 154 Full Length Unknown
12 154 Full Length Unknown
[k} 154 Full Length Unknown
Lﬂcﬂl Cﬂnﬁ'ﬂle Pl PLI Full Length Inuse
P2 PCI Full Length Inuse
PJ PCI Full Length Inuze
P4 PCI Full Length Avvailable
L
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ASM MIB Browser is a MIB (Management
Information Base) file browsing tool. It is an
add-on utility available with the ASM package.
ASM MIB Browser allows you to view and
change the OID (Object ID) values of the
systems you are managing on your network. It
also allows you to define and maintain a list of
OIDs to view.
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) Installing ASM MIB Browser

To install ASM MIB Browser, run the setup program under the ASM
Console directory, select Custom as the setup type, then select Utility, and
click Change. Then check the ASM MIB Browser subcomponent.

To launch ASM MIB Browser from the ASM Console, click on the ASM MIB

Browser icon on the toolbar or select Utility > ASM MIB Browser from the
menu bar.

Ele Config Conwol Operdtion Srmp Walk View Window Help
|[swienso00 10100 -]| P @B A2 B @O0 ID B & Bae ?ER
MIB Tree MIB Tree
H ER=TE -
Window T " DS
[E] directoy
mat
=3 mib2
EE syt
Selection _
. L2 e
Window ) apsContact
(3] syshlame
[ab] spsl ocation
£..[01] spsServices
] interfaces
et
Ok
] iemp =
- o=t
DeSCFIptIOﬂ [1.3.6.1.21.1. =
Window | fis0.0rg.dod.internet mgmt.mib-2.system.sysDescr
It textual description of the entity. This value should include the full name and version
identification of the system's hardware type, software operating-system, and networking
lsoftware. It is mandatary that this only contain printable ASCII characters. =l
Status Bar
elp, press F1 1722616 No ltem Selected A
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User interface

The ASM MIB Browser user interface allows you to move around easily and
to access information either by using menu commands or by clicking
buttons. When you start ASM MIB Browser, the main screen displays the
information from your last ASM MIB Browser session.

This section discusses the following screen components:
e Menu Bar, Toolbar, and System List Combo Box

e MIB Tree Window

e  Selection Window

e Description Window

e  Status Bar

Menu bar and toolbar

The System List box lists all of the systems added to the Selected list in the
Auto Discovery window. Click on the down arrow and select the name of
the system whose Object Identifiers (OIDs) you want to view.

File Config Control Operation Sehmp ‘walk iew ‘wWindow Help

”|Switch3|]uuwn|J|JvI|E§EE.L%%9 PeEagansases ?ER

Toolbar buttons provide quick access to selected functions in ASM MIB
Browser with a single mouse click. The Menu Bar contains the following
items and commands:

e File Menu - allows you to save and print your files.

Command Icon Description

Save Save an existing query

Print Setup Setup printer parameters

Print Preview Shows a preview of the materials to be

El printed
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Command Icon Description

Print Prints information contained in the current

E window

Exit Terminates ASM MIB Browser session

Config Menu - controls the environment of the browser. You can
select systems to view and set polling intervals.

Command Icon Description

Auto Searches for available systems in the

Discovery ﬁ network and displays them for monitoring
purposes

Trap Enables or disables the Trap Handling

function of the browser and also displays
the alert log. This function is disabled when
ASM Console is running

Community Specifies the SNMP community and port for

and Port Get and Set Operations

Option Qg Sets up the MIB Browser configuration
=k option

Control Menu - contains the tools for manipulating and querying
MIBs.

Command Icon Description

Define New Specifies your own query (list of OIDs) to
Query ﬁ browse

Select Query Select from a list of previously defined

ﬁ queries to browse or to remove queries
from the list
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Command Icon Description

Manage MIB Displays a window where you can add,

Database IE remove, initialize, and view the history of
MIB files

Telnet Connect to the server by telnet

e Operation Menu - contains the tools for manipulating and viewing
OIDs. It includes commands to add or remove OIDs in the Selection
window and to view the values of these OIDs.

Command Icon Description

Add Appends the highlighted OID or OIDs of a
E highlighted node in the MIB Tree window to

the Selection window

Remove Deletes the selected OIDs from the
E Selection window

Remove All El Clears the Selection window

Browse Displays the values of the OIDs in the
@ Selection window

Find Searches for the OID the user wants to find
@ in the MIB tree

e  SNMP Menu - SNMP (Simple Network Management Protocol) allows
you to control and view information about OIDs. The pulldown menu
is enabled when the SNMP Table is open. Refer to “Browsing OIDs
(SNMP table)” on page 229 for more information on how to open the
SNMP Table.
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Command Icon Description

Get Updates the contents of the OID Value
table with the current OID values

15]

Set Enabled only when the SNMP Table is the
active window and when the OID selected
can be modified

8| =

Polling Continually retrieves the current values of
OIDs and updates the OID Value Table
Stop % Stops browsing the OID
Rotate Switches the order in which the contents of
3@% the OID Value Table are displayed and acts
as a toggle between views, so rows are
turned into columns and vice versa
Option Qg Displays the Option window
)

e  Walk Menu - detects available OIDs from a node or subnode and
displays their values.

Command Icon Description

Walk o Displays the values of a selected node and
U its subnodes in the Walk Operation window

OID To specify an OID in the Walk Operation -
% Input dialog box from which the walk

operation starts
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Command Icon Description

Pause Available only when a walk operation is in
progress to temporarily halt or resume the
walk operation

Set . Enabled only when the Walk Operation
i"ﬁ" window is the active window and when the
OID selected can be modified, displays the
Set Operation dialog box

e View Menu - allows you to show the toolbar and status bar.

Toolbar Displays/hides the toolbar
Status Bar Displays/hides the status bar
Trap Log Displays the trap log dialog box

¢ Window Menu - allows you to arrange the windows in your ASM MIB

Browser.
Cascade Arranged the open windows in a cascading manner
Tile Arranged the open windows in tile manner
Arrange Icons Arranges the icons properly

¢ Help Menu - The context-sensitive Help menu contains the following

items.
Command Icon Description
Help Topics Starts ASM MIB Browser Help, displaying
? the Index screen
About Displays ASM MIB Browser product

information
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MIB tree window

Located on the left side of the screen, this window shows the MIB tree
structure. MIB nodes and subnodes are represented by folders, and the
OIDs are represented by files listed under the folders.

You can expand or collapse the nodes and subnodes by clicking on the
folders. If you double-click on a node, all of the OIDs contained in that level
are shown.

If you double-click on an OID, ASM MIB Browser gets its value and shows
it in the Description Window.

MIB tree

MIB Tree

1 mamt Al
experimental
Ea private
E1423 enterprises
B4 acer
42 asm
+ D storage

nic
+ systemBoard
El 24 serverE nvn

1 systemintiCache

1 systemE =tiCache

1 systemT atald emary

: N )/
1.3.6.1.4.1.1050.25.4.1 -]
iso.org.dod.internet.private.enterprises.acer.asm.serverEnvrm.productName

IThis entry shows the machine product name.

ASM MIB information is located under:
iso/org\dod\internet\private\enterprises\acer (or subtree)

If you cannot see the ASM folder, use the MIB Database option to add the
ASM MIB file to it. All of the ASM-supported MIB files are located in the
program files in the the /Acer/ASM Console directory.
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Selection window

This window is on the right side of the MIB Tree Window. OIDs can be
added by selecting OIDs and clicking on the “Add OID”button. You can
select the OIDs from the MIB Tree Window or use previously defined OIDs
from the Select Query dialog box.

Description window

The description window is located at the lower part of the MIB Tree
Window. It displays OIDs, labels and a brief description of the node or OID
highlighted in the MIB Tree Window.

Status bar

The status bar is located along the bottom of the screen. The left side
displays a brief description of a highlighted menu command or a clicked
toolbar button. The right side contains the network address of the selected
systems.
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) Functions

This section tells you how to perform the following tasks:
e  Selecting browsing systems

e  Setting up browsing options

e  Configuring community and port
e Defining a new query

e Selecting a query

e Managing the MIB database

e Adding an OID

¢ Removing an OID

e  Browsing OIDs (SNMP Table)

e Taking a Walk through the MIB

¢ Finding an OID

e  Saving Information

Selecting browsing systems

When you launch MIB Browser from the ASM Console, all the systems that
the console monitors are added to the system listing. You can make
changes to the systems using the Autodiscovery option.

From the Config menu, select Auto Discovery, or click on the Auto
Discovery icon on the toolbar menu, to display the Auto Discovery dialog
box.
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E2) Auto Discovery [_ O] x]
Machines Found |83 achine Selected IS_
Machine Mame I Address I Machines | Address [

=& 1929210 <] addss | £l 1925.2102 1929.210.2

) 3COM Hub[1929.210.2] £ AMIGO-ALTA 2023982147

) scoS04[1929.21018) pE— E scof02 1929.210.18
-8 2023982 4| £ JeffNT 2023982120

@ 20239821 £ Switch 300010/, 1722616

- BULL [202.39.82.127] Ma”“a'Addl £ PUPRY2 35506674:0000000..

i CHRISCHANG-1 [202.39.82.79) £ BULL 2023982127

- f@ M7A100 [202.39.62.4) Sweep | £ ASMNTUNICE.. 2023982249

~§d DRION [20239.82160] £ 1928.21027 1929.210.27

i PRN17D1 [202.39.82.105] Close |

@ TESUD0301 [202.39.82.3]

i, W5ILA-2 [202.39.82.253]
o8 E

- ACATSD

- ACER_COM

- BCER_PE,

- f BCER_SERVET

g s -

IPx | v

This window displays all IP/IPX systems in your network detected by the
ASM MIB Browser. The following items are available in this dialog box.

Auto Discovery dialog box items

ltem Description

Machines Found Displays all the IP/IPX systems available on your
network

Machines Shows all the systems to be monitored by ASM MIB

Selected Browser

Button Description

Add Appends the highlighted systems to the Systems
Selected list

Remove Deletes the highlighted systems from the Systems
Selected list

Manual Add Allows you to enter an IP address manually to add a

system to a selected list.
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Item Description

Sweep Searches an address by matching the first three
parts of the IP Address that you specify

Refresh Searches the subnet that is currently in the Auto
Discovery database.

Close Closes the dialog box and causes the modifications
you made to take effect; the System List Combo
Box now contains all the systems you specified in
the Systems Selected list

Note: For the auto discovery function work properly, the agent must
be able to respond to standard MIB-II requests.

Setting up browsing options

From the Config menu, select Options to display the Configure Options
dialog box.

Configure Options

SHMP Table Optian
I~ SetLogFie IND log file setting

™ Rotate Table

ol Sl i @ Decimal  Hexadecimal
ow Enumeration

o Sl el Palling Interval [10 i’

Graphic Option:

I~ Graphic ILine Chart 'l ) Value ) Deviation

¥ | Greate e Granhic i ndow

¥ Load Trap Handler Cancel |
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Configure timer dialog box items

Item Description

Set Log File Sets the log file and starts to record SNMP
values to the log file

Rotate Table Switches the order in which the contents of the
table are displayed and acts as a toggle
between views, so rows are turned into
columns and vice versa

Show Enumeration Shows the Enum String if this OID is declared
as an enum value in the MIB file

Show Grid Shows grid lines in the SNMP table

Set Decimal/Hexadecimal Shows decimal or hexadecimal type of OID
values

Polling Interval Field Specifies the amount of time in seconds for
the bowser to retrieve data from the target
system. You can type an integer from 1 to 60

Graphic Options Displays the SNMP table with graphics

Create New Graphic Specifies a new graphic window

Window

Load Trap Handler Loads trap handler to handle trap receiving
operations

Button Description

OK Closes the dialog box and causes the

modifications you made to take effect

Cancel Closes the dialog box, discarding all changes
made

Configuring community and port

You can set Get/Set communities and ports for SNMP Operations by
selecting Configure Community and Port from the Config menu.
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Configure Community & Port
Get Cammunity : !
Set Cammunity - public

Drata Port AP J'I 1 ok ]
Trap Part AP : 162 Cancel

Defining a new query

This dialog box lets you specify names and descriptions for a list of OIDs
that are frequently viewed, and saves this information to the database. This
eliminates the need to search for the same sets of OIDs each time you start
ASM MIB Browser. After setting a query, it is added to the Name field in
the Select Query dialog box.

Follow these steps to define a new query (set a list of OIDs to view):

1. From the MIB tree window, select the OIDs you want to include in the
query and add them to the Selection Window.

2. Select Control > Define New Query. The Define New Query dialog
box displays.

Type a name and description for the query.
Click OK to accept it.

Define New Query [ x]

Name 3coB02 & Default
Address [1929.210718 " Curert

Query Name Iqueuﬂ

Description

This is a test query for ASM Browsed]

Cancel |

Each time you want to view this list, select its name from the Select Query
dialog box (under the control menu). All of the OIDs are listed in the Select
Query window. Highlight the query name that you want to view, and click
on the open button. See "Selecting a Query" below for more information.
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Selecting a query

From the Control menu, click on “Select Query”. The Select Query dialog
box, shown below, appears. This dialog box allows you to choose from a
list of previously defined queries. It displays all OIDs in a query in the
Selection window. You can also remove queries from the database, or
clear the database of all queries.

Select Query
Systerm:  [MILKYwiaY |
Descrption—————————————
azm server disk
Remove |
Close |
Q1D name | oo =
disketteDrvindex 1.3.6.1.4.1.1060.25.1.1.1.1
disketteDreType 1.36.1.41.1080.281.1.1.2
hdCrtrlMum 1.3.6.1.4.1.1080.25.1.3.11 —
hdCrtrl5 lotM um 1.36.1.41.1080.251.3.1.2
hdCntriChannel 1.3.6.1.4.1.1080.25.1.3.1.3
hdCrtrlType 1.36.1.41.10680.251.3.1.4
hdChtrfy endar 1.36.1.41.1080.251.3.1.5 LI

Select query dialog box items

ltem Description

System Field Shows the name of the systems you are currently
browsing
Address Field Displays the network address of the systems you are

currently browsing

Query Name All query names defined in the Define New Query
dialog box are listed here. Click the name of the query
you want to view or remove from the database

Description Field Displays a brief description of the selected query
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ltem Description

Button Description
Open Opens the selected query. A SNMP table appears.
Remove Removes all queries in the database. This action

takes effect only after clicking OK

Close Closes the dialog box, discarding all changes made

When you select a query name, all of the previously defined OIDs are listed
in the OID name table.

Managing the database

The MIB Browser needs a description file to identify each Object ID that you
plan to browse. ASMserver Agent uses a asmnt.mib file to describe its own
object IDs. It is installed on the asm agent system. ASM Desktop also
includes a number of MIB files in its MIB directory.

Select Control > Manage MIB Database to launch the MIB database
managing dialog box.

Manage MIB Database

1B Mame | Install Time | Add
asmpro.mib Thursday, July 02, 17:26:23, 1938

RMOM. mib Tuesday, July 14, 13:22:56, 1998

bridge. rib Tuesday, July 14, 132315, 1998 [ElEte

I
[Coss |
[ |

Iritialize:

Initializing the database

The Initialize command removes all added MIB files from the existing MIB
database. After this process is carried out, only the basic MIB tree
contents remain. Select Control > Manage MIB Database > Initialize to
confirm the initialization.

This dialog box prompts you to confirm whether or not to continue
initializing the MIB database. To continue, click OK; otherwise, click
Cancel to close this box without initializing.
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Warning! The initialize action cannot be undone. Do not click the OK
button unless you are sure about removing all installed MIB files from
the database.

Adding a new MIB

To install a new MIB file into the existing MIB database, select Add from the
MIB database managing dialog box. The Add New MIB dialog box appears.
Specify the path and filename of the MIB file you want to install, and click
on the “Open button.

Add New MIB HE
Look in: Ia ASM Console

arigin

Powemet

File hame: DOpen I
Filess of tupe: | j Cancel

Add new MIB/remove MIB dialog box items

Iltem Description

File Name Type or select the filename you want to add or remove.
This box displays the files with the extension you
specified from the List Files of Type box

Files of Type This box lets you specify the extension of the file you
want to add or remove

Look in: Use this box to specify the drive and folder containing
the file you want to add or remove
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Removing a MIB

To remove an installed MIB file from the existing MIB database, click Delete
from the MIB database managing dialog box.

To remove all installed MIB files from the MIB database, select the Initialize
command. Refer to “Initializing the database” on page 227.

Note: You cannot browse OID data unless a MIB file has been added
to the database.

Adding an OID

Select the OIDs you want to view by highlighting them from the MIB Tree,
then select Operation > Add or click the Add icon on the toolbar. The OID
appears in the selection window.

Note: If you highlight a node, all of the OIDs on that node are added.

Removing an OID

Select the OID you want to remove by highlighting it in the Selection
window then select Operation > Remove OID or press the Delete key on the
keyboard. The OID disappears from the Selection window.

Removing all OIDs

You can remove all of the OIDs in the Selection window by clicking on the
Remove all toolbar button or by selecting Operation > Remove All.

Browsing OIDs (SNMP table)

To get the OID values of an SNMP agent:

1. From the System List Combo Box on the toolbar, select the system’s
name.

2. Browse through the MIB Tree window to select the OIDs you want to
view.

3. Select Operation > Add or click the Add button from the toolbar. The
OID appears in the upper right frame of the MIB Tree window.
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4. Select Operation > Browse or click the Browse button on the toolbar.
The SNMP Table window appears displaying the OID values you
selected.

To search for a particular OID, select Operation > Find or click the Find
button on the toolbar and specify the OID to find.

& Snmp Table - scob02 - 192.9.210.18

ISC\ﬁUZ ‘I O " Decimal ¢ Hexadecimal

010 name | Access Type | Data Tupe | 01D Y alue

oz erzion Read OctetString SCO LN Swstem /386 3.2v5.0.4  97/08/07
expanBusTyoe Fiead OctetSting 154 MCa,

pracessar] yoe Fiead OctetString Pentium Pro 200Mhz

sypstemintiCache Fead Integer

sugtemE stlCache Read Integer o

Note: If you highlight a node, all of the OIDs on that node are added.

SNMP table (Simple Network Management
Protocol)

SNMP table allows you to manage and view information about OIDs.

The toolbar at the right allows you to Get Value, Set Value, Poll, Rotate,
Find, Configure Options for, and Stop OIDs in the table. The Browse button
updates the contents of the OID Value table with the current OID values.
Clicking the Stop button immediately stops the get value feature.

The Set button is enabled only when the SNMP Table is the active window
and when the selected OID has the “write” attribute and can be modified.
You can also record events in the log file by activating the log file entry.

There are 4 columns for each OID: OID name, Access Type, Data Type and
OID Value.

e  OID name - the OID label defined in the MIB file.
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e Access Type - Read, Write, R/W or No Access for each OID,
depending on the definition in the MIB file. Only an OID whose access
type is R/W or Write can be set.

e Data Type - Integer, Unsigned Integer, Gauge, Counter, Counter64,
TimerTick, OctetString, BitString, Network Address, IP Address,
Opaque, Object ID, and Unknown.

¢ OID Value - The value returned by SNMP agent for this OID. If the OID
is a table, i.e., the values of this OID are more than one, the values are
shown in columns "OID Value #1", "OID Value#2", etc.

Set operation

The OID value can be set if the attribute of the OID is R/W (Read/Write) or
Write. If you highlight a R/W OID the Set button is enabled.

" Decimal " Hewadecimal
[25M Lab -

Set Cancel I

If the OID has multiple values, use another Set dialog box to set another
value in the table.

Set - usedF55izeT hreshold

& Decimal " Hexadecimal

[100 |

Set | 0K l Caniel

Decimal or hexadecimal

The OID Value column heading can be viewed in two ways: Decimal and
Hexadecimal. The SNMP Table displays the OID values in decimal when
you click Decimal and in hexadecimal if you click Hexadecimal.
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Activating the log file
To activate the log file:

1. In the SNMP Table window, click the Option button. The SNMP-
Option dialog box appears.

Configure Oplions [ ]

SMMP T able Dption;
I~ SetLogFile INO log file setting

I Rotate Table

¥ | Show Enumeration & Decimal ¢ Hexadecimal
¥ Show Grid Palling Interval |10 ﬂ

Graphic: Optian

I Graphic Line Chart VI ) Yalie €0 ) Desyatior

¥ | Create e Graphic s o

¥ Load Trap Handler OF I Cancel |

2. Click Set Log File. The Save Log File dialog box appears.

3. Enter the filename of the log file then click Open. The filename
appears in the text box.

Enumeration display

This window displays a list of string-to-integer mappings for the selected
OID. You can highlight an OID and press the right button of mouse and
then choose Enumeration from the pop-up menu. The Enumeration
window appears.

81 Enumeration - osType =10 =] |

Walug 1 Enumeration 1

nehware
sCoUnid
windowsNT
Linixpane

W = o

You can view OIDs by the enumeration values defined in the MIB file
instead of the original values.

To see the Enumeration Display:
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1. Click the Option button in the SNMP Table window. The SNMP-
Option dialog box appears.

2. Click on the Enumeration Display checkbox.

Recording OID polling information

The Polling button continually retrieves the current values of OIDs and
updates the OID Value table. You can record this information by activating
the Log File. If the Log File is not activated, it is not recorded. Refer to
“Activating the log file” on page 232 for more information.

Setting the time interval for polling

You can set the time interval for polling. The polling interval must be in the
range from 1 to 60 seconds.

Rotating the SNMP table

The Rotate button is used to switch the order in which the contents of the
OID Value Table are displayed. It also acts as a toggle between views, so
rows are turned into columns and vice versa. If you select non-tabled OIDs
in the SNMP Table window, this function is disabled.

Finding OIDs in the SNMP table

To search for an OID, click the Find button. The Find OID dialog box
displays. For more information about the Find OID dialog box, refer to
“Finding an OID” on page 235.

Find 01D [X]

Find: Iploductname j

™ Search from top of MIB Tree
Find Mext

I¥ batch whole word Only

™ Match Case Cloze |

Taking a walk through the MIB

You can use the Walk function to automatically view OID values starting
from a particular node or OID.

To Walk from a Node (MIB Tree):
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1. From the System List Combo Box in the toolbar, select the system’s
name.

2. Browse through the MIB Tree window and select an OID or node from
which you’d like to start the walk operation then select Walk > Walk or
click the Walk button on the toolbar.

3. The Walk Operation window appears and the OIDs pop up in the
window.

To Walk from a query input OID:

1. To start at a particular OID, select Walk > OID or click the OID button
on the toolbar. Type in the OID you want to Walk in the OID text box.

‘walk Operation - Input 01D <]
(ufi=l(1.2.6.1.4.1.1050.25.4] =
,WI Cancel |

2. Click Walk. The Walk Operation window appears and all available
OIDs start popping up one-by-one.

Walk operation window

The Walk Operation window shows detailed information about each OID.
It keeps displaying OIDs as long as there are OIDs available. The Pause
button on the right side of the window pauses the walk function. The Find
button displays the Find OID dialog box. The Set button displays the Set
Operation dialog box. You can only set an OID, if it can be modified.
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Finding an OID

To find an OID:
1. In the MIB tree, highlight the node where you would like to start the
search.
2. Click the Find button on the toolbar or select Operation > Find. The
Find OID dialog box appears.
Find OID [<]
Find: Iploductname j
™ Search from top of MIB Tree
I™ Match Caze &I
3. Type in the OID name you want to find in the Find text box. You can

check the checkbox for the browser to do the following:

e Search from top of MIB - the browser searches the whole MIB
tree.

¢ Match Whole Word Only - the browser searches the MIB tree for
matching words.

e Match Case - the browser searches the MIB tree for case-
sensitive words.
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4. Click Find Next. The Browser starts searching for a match.

5. The find result appears in the bottom part of the MIB Tree window.

Saving information

This command works two ways, depending on the current active window:

If the SNMP Table window is active, this command displays the Save
SNMP Information dialog box. The information is saved as a text file with
an .smp file extension.

If the Walk Operation window is active, this command displays the Save
Walk Information dialog box. The information is saved as a text file with a
.wlk file extension.






ASM MIF Browser is a MIF (Management
Information Format) file browsing tool. It is an
add-on available with the ASM package, and
describes a hardware or software component of
a system. MIF files are used by DMI (Desktop
Management Interface) to report system
configuration information to the Console.
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) Installing ASM MIF Browser

To install ASM MIF Browser, run the setup program under the ASM
Console directory, select Custom as the setup type, then select Utility, and
click Change. Then check the ASM MIF Browser subcomponent.

To launch ASM MIF Browser from the ASM Console, click the ASM MIF

Browser icon on the toolbar or select Utility > ASM MIF Browser from the
menu bar.

Menu bar, -
’ 5 ASM MIF Browser M= B
Toolbar, and Fle Corfig Dpeatin Quey Yiew Window Hop
System List |[arrav JeeH sl nt @B |de 2
Combo Box % PICASSO [210.63.101.71] [CIoIx]
B[] PICASSO
£ (] Win32 DMI Servize Layer Subscriber . i
(1 ComporentiD 58] Subscrier Tr. 2 DisplayString
{1 Senice Layer Characteristics 58] Subscriber A 3 DisplaySting
MIF Tree (L] Serice Layer Secirty | Subscrber 10 0 4 Inkeger
. {E] 8P Indication Subscription (5%) Subscription..  2000/01/01 00:00:00000000U.. 5 Date
Window [E] 5P Fiter Information [5%) Subscription... 2000/01/01 010000000000 ... 6 Date

(11 Deskiop Management MIF [01] Indication Fai.. 1 7 Integer

(] DMI BIOS w2 MIF

(20 Misc. Management WIF

(3 Utiization Meritor MIF

. Asset Monitor MIF
Information (3 Acer HBuard
. [ Deskiop
Window {1 ADM Securiy Setiing MIF

(23 INVENTORY MANAGEMENT MIFZ
| I
Comporent [ Group [ attibute. |

Query
Window

Status —FHeb-press Pl | 21063101.23% Z
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User interface

The ASM MIF Browser user interface allows you to move around easily and
access information using menu commands or by clicking buttons. When
you start ASM MIF Browser, the main screen displays the information from
your last ASM MIF Browser session.

This section discusses the following major screen components:
e Menu Bar, Toolbar, and System List Box

e  MIF Tree Window

e Information Window

e Query Window

e  Status Bar

Menu bar, toolbar, and system list box

The system list box allows you to select the name of the systems whose
configuration you want to view. It contains all the systems added to the
Systems Selected list in the Auto Discovery window.

File Config Operation Query Yiew Window Help

I EEE R FEER L EEIETE:

Toolbar buttons enable quick access to selected functions in ASM MIF
Browser through a single mouse click. The Menu Bar contains the
following items and commands:

e  File Menu - allows you to save and print your files.

Command Icon Description

New ﬁ Creates a new DMI window for a system
Print Setup Set up printer parameters

Print Preview Shows a preview of the materials to be

E printed




Command Icon Description

Print Prints information contained in the current
El window

Exit Terminates ASM MIF Browser session

¢ Config Menu - searches for available systems in the network and
controls the environment of the browser. You can select systems to
view and set polling intervals.

Command Icon Description
Auto Discovery Searches for available systems in the
ﬁ network and displays them for monitoring
purposes
Options Displays the browsing options window.

EE See “Setting up browsing and default
connection options” on page 248

e  Operation Menu - contains the tools to move around and view table
information of MIFs.

Command Icon Description

First Row Goes to the beginning or first row of the

table, if the data is listed in MIF table format

Next Row Goes to the next row in the table, if the data
E is listed in MIF table format
Browse Displays the whole DMI information. Use it
m to view all of the records.
Edit —r Allows you to change the value of an item if
""'ﬁ"' the item is configurable. Changing the
value of an item requires no password from
desktop agent
Property % Displays item properties
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*  Query Menu - contains the tools for assigning and defining queries for

later use.
Command Icon Description
Add ltem Adds an item to the query window

Remove Item Removes an item from the query window

Define New
Query

Saves the item list in the query window to
disk for later use

Select a Query Opens a query file from disk

W B & &

Polling Updates information on screen

e View Menu - gives you the option of whether or not to show the
toolbar and status bar..

Command Description
Toolbar Displays/hides the toolbar
Status Bar Displays/hides the status bar

e Window Menu - allows you to arrange the windows in your ASM MIF

Browser.
Cascade Arranges the open windows in a cascading manner
Tile Arranges the open windows in tile manner

Arrange Icons Arranges the icons properly
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e Help Menu - ASM MIF Browser comes with a context-sensitive Help
menu with the following items:

Command Icon Description
Help Topics Starts ASM MIF Browser Help, displaying
": the Contents screen

About Displays ASM MIF Browser product
information

MIF tree window

Located on the left side of the screen, this window shows the MIF tree
structure. MIF nodes and subnodes are represented by folders while item
attributes are represented by documents. These documents appear in the

following form:
Icon Document type

String data
[ab]

Integer data

Hexadecimal data

Date data

Table data

You can expand or collapse the nodes by clicking on the folders. If you
double-click a node, all of the item attributes and folders contained in that
level are displayed in the Information Window.

When you double-click on an item attribute or a DMI table attribute, ASM
MIF Browser displays its value in the Information Window.
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=1 PICA350 Item Yalue
-0 Win32 DM Service Layer Comporent D 1
= (3 G HD Group D 1

Hame Manufacturer
Yalue Intel Corporation
D 1
Tupe DisplayStiing

AccessMode  Fesd-Only
{01] veify Max Size B4
[Z Service Layer Characteristics Storage Type  Common

ervice Layer Secuity

Information

window £ Desklon i
(2 DMIBIOS v2.% MIF

(23 Misc. Management MIF

(23 Utiization Moritar MIF

(2] Aseet Monitor MIF

(2] Acer HGuard

(23 Deskiop

(L] ADM Secuity Selting MIF

(L3 INVENTORY MANAGEMENT MIF2

Component [ Group [ Attribute

Query

Information window

This window is to the right of the MIF Tree Window. The attributes selected
from the MIF Tree Window can be seen here.

Query window

The Query Window is below the Information Window. It displays the
component, group and attribute of the item you want to put into a query.

Status bar

Located along the bottom of the screen, the status bar provides different
information as you work with ASM MIF Browser. The left side displays a
brief description of a highlighted menu command or a clicked toolbar
button. The right side contains the network address of the selected
systems.
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) Functions

This section tells you how to perform the following tasks:

Selecting browsing systems
Setting up browsing options
Browsing the DMI table
Defining a new query

Selecting a query

Selecting browsing systems

Select Config > Auto Discovery or click on the Auto Discovery icon ¥ on
the toolbar menu to display the Auto Discovery dialog box.

Clse:

Eg) Auto Discovery H= B3
Mashines Found [ Machine Selected |6
Machine Mame | Address | Machines [ Address |
EE=W S | ] ARREY 21063101 234
B 1528210 I BuLL 21063101.88
ey R £ PICass0 210631071
L (210637101 234] [ | £ SKYMANNT 210.63.101.139
) BULL [21063.101.83] BULLYS 2106310236
% EULLE[E : Manual Add %zmsmmw 2106310117
[21063101.185)
£} BULLSE [21063 101 236]
£ CHRISCHANG-1 [21063.101 87] Sweep |
£} JEANLIN [210 6310 157]
£} PICASSO (2106310 71 Refiesh |
£} SIMPC (21063 101.184)
) SKYMANNT [21063.101,139) Hep |

This window displays all Desktop Management Interface (DMI) systems in
your network detected by the ASM MIF Browser.
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The following items are available in this dialog box:

ltem Description

System Found Displays all the DMI systems available on your
network

System Selected Shows all the systems to be monitored by ASM MIF

Browser

Button Description

Add Appends the highlighted DMI systems in the System
Found list to the System Selected list

Remove Deletes the highlighted system from the System
Selected list

Manual Add Manually adds an IP address

Sweep Searches an address by matching the first three parts

of the IP address that you specify

Close Closes the dialog box and causes the modifications
you made to take effect; the System List Combo Box
now contains all the system you specified in the
System Selected list.

Refresh Refreshes the information display in the System
Found panel

Note: For the auto discovery function to work properly, the agent
must install Intel DMI Service Provider 2.0. Refer to the DMI 2.0
Service Provider SDK Release 1.0 for more information.

Manually adding a system

To manually add a system, type the IP address of the system in the text box
and then click OK. If found the system is displayed in the System List
Combo box and MIF Tree window. If the address is not found, it displays
a not found message.
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Input IP Addiess

IPAddress: | 210 . 62 . 103 . 21§

ok I Cancel |

Sweeping subnets

To sweep subnets, type the first three address blocks of the subnet and
click OK. If the sweep finds a system in the subnet, it is displayed in the
System List Combo box and MIF Tree window. If the sweep does not find
anything, it displays a not found message.

Sweep Subnet

IP Address: 210 . B3 . 103

oK I Cancel |

Starting a new connection

When you start MIF Browser, it follows a default setting connection
configuration described in the Browing Options window (see next section).
However, you can use this function to make a new connection without
following this configuration.

Select File > New to start a new connection. The Browse DMI window
displays.

Browse DMI

~ Connection

RPC Type: & dee © lacal

TransportType: incacn_ip_tcp -
Spstern: !AH R&Y -

Cancel I
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ltem Description

RPC Type MIF Browser supports two kinds of RPC (Remote
Procedure Call) types: dce (remote) and local

Transport Type  Defines a transfer protocol for your default connection.
Lists all the protocols available to the system

System Lists all systems inclued in the MIF Tree window. Choose
a system you want to connect to, or type its IP address.

To make a new connection:
1. Choose the type of RPC you want to use.
Choose a transport type from the pulldown list.

Choose the system you want to connect to in the pulldown list

LD

Click OK to connect. A message dialog box appears.

Scan DMI Database : 210.63.101.253

Connect 21063.101.253 [210.63.101.253]

Please wait... Cancel

5. Click Cancel to stop the process.

Setting up browsing and default connection
options

Browsing options allow you to preset configurations for the MIF Browser.
This includes connection features, data formats, and polling intervals.

Select Config > Options to display the Configure Options dialog box.



— default connection
RPC Type: & dce " local
TrahsportType: Inc:ac:n_ip_tc:p vl
D ata Format
& Decimal  Hewaderimal ‘
— Palling
Palling Interval |3 ﬂ
" Set LogFile

Cancel
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ltem Description

RPC Type MIF Browser supports two kinds of RPC (Remote
Procedure Call) types: dce (remote) and local
Transport Type Defines a transfer protocol for your default

connection. Lists all the protocols available to the

system

Data Format

Displays data format in decimal or hexadecimal

Polling Interval

Defines the number of seconds between polling

sessions
Set Log File Stores information gathered from the system in a file
Button Description
OK Closes the dialog box and causes the modifications
you made to take effect
Cancel Closes the dialog box, discarding all changes made
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Browsing the DM table &

A DM table is displayed in the information window when you double-click
a DMI table attribute. To view information in the table, you can either use
the Next Row, First Row, or Browse button.

Select Operation > Next Row or click the Next Row button to cycle through
the table one row at a time until it reaches the end of the table.

Select Operation > First Row or click the First Row button to go back to the
beginning of the table.

Select Operation > Browse or click the Browse button to display table
attributes in the browse window. This way you can see several rows at a
time as shown below.

&% DMI Table : chrischang-1 [210.63.101.87] - IRQ
i
0 InUse (4] [0 False (0]
1 InUse(4) [0 False (0]
2 InUse[4) [0) False (0]
3 InUse[4) [0) False (0]
4 In Use (4] [0) False (0]
5 Avvailable [3) [0) False (0]
B InUse[4) [0) False (0]
7 InUse (4] [0) False (0]
) InUse (4] [0) False (0]
9 Avvailable [3) [0) False (0]
1n InUze (4] [0) True 1]
n InUJze (4] 0 True (1]
12 In Use[4] [0] Falze (0]
13 In Use[4] [0] Falze (0]
14 In Use (4] [ True [1]
18 Ayailable [3] [ Falze (0
| | |

Changing table Attribute Value

Select Operation > Edit or click the Edit button to change attribute value in
the table document. This function is available if the table has the write
attribute. The table attribute value can be set if the attribute is R/W (Read/
Write) or Write. If the table attribute you chose is not R/W or Write, the Set
button is disabled.
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For Integer and String Attributes

Type the new value in the text box and then click Set to save changes.
Click Cancel to disregard changes.

Set - Subscriber Transport Type

& Decimal " Hexadecimal
|ASM 4.0 Tes| =

Set Cancel |

The attribute value can be viewed in two ways: Decimal and Hexadecimal.
Click the radio button to toggle between views.

For date attributes

Type the new value in the text box as indicated and then click OK to save
changes. Click Cancel to disregard changes.

Set - Installation
- Date
Year tonth: Day:

T
I}n—::ur: Min:  Sec: Micro Sec:
i [ [ [eec00

Timezone [Minutes):
-480

Cancel

Viewing table document properties

Select the table item from the MIF Tree Window, and select Operation >
Property or click the Property button to view table document properties.
Table property items may vary for different table documents.
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5P Indication Subscription Properties

Group | Table Keps

Companent: 5P Indication Subscription
1D: 1

Class Sting:  DMTFISP Indication Subscription|007

Description:

Thiz group defines the subscription infarmation for a managing
naode interested in indications fram this system. The Dk
Service Provider wil maintain this as table, with each row
representing an individual managing node.

] Cancel

Defining a new query

This dialog box allows you to specify a name and description for a list of
frequently viewed MIF items, and saves this information to the database.
This eliminates the need to individually search for the same sets of MIF
items to view each time you start ASM MIF Browser. After setting a query,
it is added to the Name field in the Select Query dialog box.

Follow these steps to define a new query (set a list of attributes to view):

1. Highlight an attribute or a list of attributes in the information window
and select Query > Add Item or click the Add Item button to add the
attributes to the query window. If you want to remove an item in the
query window, select Query > Remove Item or click the Remove item
button.

2. Select Query > Define New Query or click the Define New Query
button to create a new query file. The Save Query window appears.

Save Query [ %]
Guery Name Itest‘l
Desciiption

This iz a test for AMS 4.0]

Cancel |

3. Type a name and description for the query.
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4. Click OK to save it.

Each time you want to view this list, simply select its name from the Select
Query dialog box. Refer to “Selecting a query” on page 253.

Selecting a query

Select Query > Select a Query to choose from or remove a list of previously
defined attributes to view. The Select Query dialog box appears.

Select Query

Systemt [PICASSO [210.63.101.71]

 Quem M Dezcription
This is a test for AMS 40 4”"5”
Remove |
Close I
Component | Group | Attribute |
Win32 DMI Service L..  Compaonentl D M anufacturer
“Win32 DMl Service L..  ComponentlDr Praduct
"Win32 OM| Service L..  Componentl D Wersion
"Wind2 DMI Service L..  Componentl D Serial Mumber

This dialog box allows you to choose from a list of previously defined
queries. It also places all attributes in this query into the Query window.

You can also remove queries from the database or clear the database of all
queries.
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8 ASM MIF Browser

Select query dialog box items

System Shows the name or address of the system you are
currently browsing

Query Name All query names defined in the Define New Query dialog
box are listed here. Click the name of the query you
want to view from the database

Description Displays a brief description of the selected query

Button Description

Open Opens the selected query

Remove Removes the selected query from the database

Close Closes the dialog box, discarding all changes made




9 Asset Manager



Asset Manager gathers information about the
hardware and software configuration of each
system being monitored by the ASM Console.
This information is saved in an asset log file for
future reference.
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) Introduction

Asset Manager consists of four parts:

e Asset Control - shows you the hardware and software configuration of
the system currently being monitored.

e Asset Statistics Information - summarizes the hardware information
contents of two or more systems.

e Asset Log - Displays the asset log and saves it to disk.

e Asset History - Shows a comparison of two or more asset log
versions of a system.

Select one of the following methods to run Asset Manager from the
Console:

e Select Asset Manager from the Utility menu.
¢ Click the Asset Manager icon in the toolbar.

The Asset Manager works with ASM Agent. If the monitored system is not
an ASM agent, the “Cannot Load Asset Log File” message appears.
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9 Asset Manager

) Asset Manager user interface

This section discusses the following major components:

e Menu bar and Toolbar

e  System List Combo Box

e Auto Discovery

M Asset Manager [_[O]>

Operation  Window Help

sset Control - scosysw [210.63.101.253]

Base Board
BIOS
Processor
B-hy Cache

m by Memory Madule
188 Disk Controller
& Disk

-J8 Network Interface Controller
- Keyboard

= [3 Mouse

o -ER Fan

B[4 Software

m-F-F-E-E-E

el

[soosysw e BEos@mas ?

Item Amount

Ease Eoard

Processor
Cache

Mermary Maduls

Diisk Cantraller

Disk

Network Interface Controller
Keyboard

Mouse

Fan

Software

i i e o

- Asset Log

LastLogDate  |WedApr 28 11:32:10 1933

For Help, press F1

Menu bar and toolbar

The toolbar, located at the top of the Asset Manager window, contains two
components: the System list box and the toolbar buttons.
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The toolbar buttons allow quick access to selected Asset Manager
functions via a single mouse click. You can also access all of these
functions from the menu bar.

Icon Description

Get Asset Information. Activates the Asset Control window and
@ displays information about the currently monitored server or
desktop

Refresh. Refreshes the display information in the active window

G

- Statistics. Activates the Asset Statistics Information window and
E% displays hardware summary information about the chosen server(s)
or desktop(s)

Asset Log. Displays the asset list log of a system. It is automatically
@ generated every time you start Asset Manager

Show Asset Log. Shows the difference between the asset list log
versions of a system

T

Show Asset History. Activates the Asset Information Query window
to help you find the information you are looking for

iy

Preview. Displays the layout and format of information to be printed

B

Print. Prints information regarding the server or desktop currently
E being monitored

Help. Presents help information
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System list combo box

The System list box lists all the servers and desktops available for
monitoring. Use this box to select the name of the system you want to
view.

SCOSYSY vllﬂ@ﬁﬁa@aﬁa?

Auto Discovery

From the File menu, select Auto Discovery to display the Auto Discovery
dialog box.

System Found:  [4 System Selected : |1
System Mame | Address | Machine | Address |
By 1929210 Refresh | MMONET ZI0E31M 3

22 2106310
LA BULL [210.62.101.179] Add »>

£ MONET [210.62101.3]

£2 PRN17D1 [210.63.101.120]

o WEELAMT [210.62.10.179]

<< Remove

Sweep

M anual &dd

Stop

LR

Cloze

This window displays all IP/IPX systems in your network. The following
items are available in this dialog box.

Auto Discovery dialog box items

ltem Description

Systems Displays all the IP/IPX systems available on your network
Found
Systems Shows all the systems to be monitored

Selected
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Iltem Description

Button Description

Add Appends the highlighted systems in the Systems Found list
to the Systems Selected list

Remove Deletes the highlighted systems from the Systems Selected
list

Sweep Searches an address by matching the first three blocks you
specify

Manual Add Allows you to manually add an IP address

Stop Immediately halt the discovery operation if it is running

Close Closes the dialog box and causes the modifications you

made to take effect; the System List Combo Box now
contains all the systems you specified in the Systems
Selected list
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) Asset control

The Asset Control window displays the hardware and software
configuration of a system. Clicking on an item with a plus (+) sign shows
you one or more devices available for that item.

EMASM Asset Manager
File Dperation Window Help
‘scusysv v\%“ﬁﬁé%ﬂg, i@,‘
= 5 CHRISHT Altribute Value
1 Piocessor Manufacturer Aer
Base Board Product Name WESMA,
Acer =
Q Memory Modul
@ Disk Attribute Walue
8 Metwork Intert. ;mdu’:tNtame m;ga
@ vid anufacturer
Slol:vowale e2! Wersion 9610514
[# MSDN L 58 Processor SerigMumber 48.59101.011
* i m % Cache
|? Lotus Note $ Memary Module
[# Microsaft' +' 188 Disk Contraller
[ Microsott|  ® @ Disk
[# Microsoft ¢ [+ J8 Hetwork Interface Controller
(¥ Chinese(r| ®8 Kevboard
[# peihywt| E 10 Mouse
[F Micosohtp| &R Fan
[ MProduct| = [F Software
@’ SCO UM System Operating System
i-[# SC0 Spstem Y Link Kit
(# Estended Tcl
[ Visual Tel
[# Administration Framework ~Asset Log
(# Software Manager
[# Metwork Canfiguration Manager Last Log Dale [WedApr2811:3210 1999
(# 5CO Mail User Agents
[ 500 M e Endlishi EarehiogsiSuppat
(¥ SCO OpenServer Dsk Diiver =
For Help, press F1 [ 7

Asset Control also monitors the hardware and software changes within a
system. It compares the devices currently installed in the system with the
ones recorded earlier in the asset list log file.

If Asset Manager detects any changes within the system, like installing a
new device or software, or replacing or removing old devices or software,
it displays a question mark beside the device.

Once a change has been made, it shows the number of devices that have
been removed or installed in the system. For example, 0 to 1 means that a
device has been added to the system. 1 to 0 means that a device has been
removed.
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) Updating hardware and software
information

The question mark on the item displays every time a device is installed,
replaced or removed within the system. You can confirm these changes by
clicking on the Update button of the Asset Log dialog box.

F7LASM Asset Manager

File Operalion Window Help
0 EoBvsnae?
[_[0fx]
Itern Amaunt
Base Board Base Board it
BIOS BIOS 4

@ Processor Processor 1

SR Cank Cache 2

G Cache Memory Module 3

F-6p Memony Module

= Disk Cartroller f

+1- 18 Disk Contioler St 1

- Disk Network Inteiface Contioler 1

118 Network Interface Controler Keyboard 1

g Kevboard Mause 1

-1 Mouse Fan 3

= &8 Fon Saftware: 157

@ [¥ Sofware

Chssetlog
Last Log Date [Wed Apr 2611:32:10 1989

For Help, press F1 4

The Asset Log dialog box automatically updates the log file and displays
the date and time of the latest update.
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) Asset statistics information

The Asset Statistics Information window collects the total number of
hardware devices and software components installed in a system and
displays them for your reference. You can choose one or more systems at
the same time as shown below.

Select Operation > Asset Statistics Information or click on the Asset
Statistics Information icon on the toolbar to display the Select System
window.

Select Machine
Machines Found |4 Machines Selected |1
Maching [ Addiess | | [ Machine [ Address [
SCOSpEY 210.63.101.253 i Add>y i TEDPANGMT 210.63.101.59
AOL 2106310157
MONET 21063.101.3
CHRISHT 210.62.101.59 Remove <«

Ok
Canicel

To select a system:

1. Click on the name of the agent you want to view from the left panel.
To make multiple selections, hold down the Control key and click on
the names of all the agents you want to view.

2. Click the Add button. The system you selected moves to the Systems
Selected window.

3. Repeat steps 1 and 2 if you want to add more systems. When you
have finished adding, click OK. The Asset Statistics Information
window appears.
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ZTASH Asset Manager H =
FEile  Operation  Help

| & m . [ <= B
Iscusysv JEaBESIsmEa ? i@il
T Asset Statistics Information
Item Amnount
Frocessor Processor 3
£ Base Board Bass Board 3
Memory Madule EEL"UW Module ;
@ Disk 12
1 Network Interfece Controlle Belnli laceBectaralls
" Wideo 1
& video Softuare 167
Software BIOS 2
EBIDS Cache 4
% Cache Disk Contraller 2
188 Disk Controller Keyboard 2
Keyboard ':;:SE g
8 Mouse
F
G ?;Skijr; Machine Name | Addiess I as |
@ Processar TEDPANGNT 210.63.101.59 “findaws NT
) SCOSYSY 21063.101.253 SCO OpenServer
L . indows
‘]“ ffse B°;’dd ; MONET 210631013 Wwindows NT
[ emory Module
- Disk
- J8 Network Interface Controller
B[4 Software
For Help. press F1 |SCO OpenServer 21 0.63.101.253 4

The left window displays all the items currently available to all the servers
or desktops being monitored. Clicking an item with a plus (+) sign displays
the type of device and the total number of the device installed in the servers
or desktops being monitored.

The upper right side of the screen displays the types of devices, and the
total number of devices and software components. The lower right side
displays the servers and desktops currently being monitored. Click on one
of the systems to see the number of devices installed in that system.
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) Asset information query

The Asset Information Query is a search function that helps you find what
you are looking for. It can only be activated in the Asset Statistics
Information window. Choose an item in the Asset Statistics Information
window, and click the Asset Information Query icon on the toolbar to
activate the window below.

) Asszet Information Query

—Walug Selection 1
Item ] Amount ]
Famil ]“—‘—‘—E Pentium Pro 1
arnily Pentium Pra Bartiir D 1
Type Central ';
Manufacturer Inkel '1
18] Don't care '1
CurentSpeed = =| |200mMHz i
Machine Name 1 Address ] Amount ]
SCOSYEY 210063.101.253 1
MOMET 21063101.3 1
Processor Close

The left side of Asset Information Query window lists a number of fields that
are associated with the type of item you chose.

You encounter two types of fields in this window:

e Search fields - are used to specify the device you want to find in the
servers or desktops being monitored.

e Numeric operator field - is used when you encounter a numeric input
such as the capacity of a hard disk drive. Select one of the operators
(<, =, or >)and type in the capacity of the device you want to find and
click Query. Asset Query displays anything that matches your search
items in the device list window.

The item list box lists all of the items allocated to the servers and desktops
being monitored. Click on the pulldown menu to see a list of items available
and click one of them to search a device in that item.
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) Asset log

The Asset Log window displays the systems that have undergone
hardware or software changes. You can save this information to a file for
future reference. Choose an item in the Asset Control window and select
Operation > Asset Log or click the Asset Log icon on the toolbar to activate
the window below.

Asszet Log
tachine | Item I todel | Description I Time I =]
SCOSYPSY Drisk SOMY  -CD.. 0->1 Sun Apr 25 16:24:16 1999
SCOZYEY Disk. SOMY  -CD.. 0-:1 Sun Apr 25 16:24:16 1999
SCOSYEY Disk. SOMY  -CD.. 0-x1 Sun Apr 25 16:24:16 1999
SCOSYEY Drisk SOMY  -CD.. 1-»0 Sun Apr 25 16:26:16 1999
SCOSYSY Drisk SONY  -CD.. 10 Sun Apr 25 16:26:16 1999
SCOTPTY Dk, SOMY  -CD.. 1-x0 Sun Apr 25 16:26:16 1999
A0L Processor Central Proce...  0-x1 Sun Map 17 13:20:48 1938
AL Processor Central Proce... 110 Sun bday 17 13:20:48 1338
AL Processor Central Proce...  0->1 Sun bay 17 13:20:45 1933
AL Praocessor Central Proce.. 110 Sun bap 17 13:20:48 1993
CHRISHT Dizk CD-ROM 0-x1 Tue Apr 27 16:44:43 1333
CHRISHT Digk. CD-ROM 1-:0 Tue Apr 27 16:44:43 1333
CHRISNT Software Microsoft Platf...  0->1 Tue Apr 27 16:44:49 15939
CHRISNT Software MyProductYe.. 0->1 Tue Apr 27 16:44:49 15999
CHRISNT Dizk CD-ROM 0-x1 Tue &pr 27 16:44:49 1333
CHRISMT Software windows 95 .. 0-x1 ‘whed Apr 28 09:16:19 1993
CHRISHNT Software Windows 950 0-x1 wied Apr 28 031619 1933
CHRISNT Software Windows 95,  0->1 ‘wed Apr 28 09:16:19 1993 =

“iew Diff Save Clear

ltems Description

System Shows the monitored systems that undergo a hardware or
software change

ltem Shows the kind of device or program that was changed

Model Shows the model name of the item

Description ~ Shows a brief description of the items added or removed from
the system

Time Shows when the change occurred

To save the log file, click the Save button and choose a filename for the log.

To erase the list, click the Clear button.
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To view the difference between two log versions, click the View Diff button.

Refer to “Viewing and comparing different log versions” on page 269 for
more information.



) Asset history

269

The Asset History window displays a list of log versions with their date. You
can view each version independently or compare two log versions to view
the hardware and software configurations of the system. Choose an item
in the Asset Control window and select Operation > Asset History or click
the Asset History icon on the toolbar to activate the window below.

History - ALERTONHLAN [210.632.101_.115]

Wersion | Time

1 Tue kMay 19 02:493:31 1998

2 wied b ap 20 01:05:34 13992
= 13993

4 Thu kday 20 07:00: 26 1993

5 1998

Viewing and comparing different log versions

You can select two log versions and compare their hardware and software
configuration status. Select two log versions in the Asset History window
and then click the Diff button. The Asset History Diff window appears.

To view a log version, select the version you want and click View. The

Asset History Window appears.
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Asset History Diff - scosysv [210.63.101.253]

iE SCOSYSY Altribute I Walue I

-4 Base Board
#-5E BIOS
[ﬂa Frocessor
E% Cache
E—"% Memary Module
(188 Disk Contraler
E@ Disk.
g SEAGATE -5T31051M
"8 SONY - CD ROM COUBRS 1 0)
{8 Network Interface Contraller
g Keyboard
15 Mouse
-G8 Fan

Software

Tt

=

+

{E

[

H

Aszet Histary Diff

Log Date ISun Apr 25 17 46:15 1999
Log Date bian Apr 26 11:37:14 1999

A question mark beside a device means that the device has been changed.
Select one of the devices to view its attributes and value.
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Statistics Viewer is an optional package that
records and displays system utilization
information about the systems being monitored
that can be saved for future reference.
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) Adding Statistics Viewer to your
system

To add Statistics Viewer to your system, select Custom as the setup type
during ASM Console installation, then select Utility, and click Change.
Use one of the following ways to run Statistics Viewer from Console:

e  Select Statistics Viewer from the Tools menu.

e  (Click the Statistics Viewer icon in the toolbar.
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Statistics Viewer user interface

The following figure illustrates the Statistics Viewer window, which is its
primary user interface.

. 4

BIASM Statistics Viewer 9 =1 3
File Opeialion Stalisics Query Window Help

e ds@s 3986 2 @]

tics Configuration - MILKYWAY - 10.62. 10 41

=) E Server Server Name. Address Tupe Lrel ] 11

=g
Memory Utilization

@ LoginUsers

{8 Network Transferied Bytes

< -f88 Network Sent Bytes

|} Network Received Bytes
©f88 Network Transfened Packets
L)@ Network Sent Packets

18 Network Received Packets e e
CPU1 ' “ta hE
tPUZ
188 NIC Intel(R] PROA 00+ Server Adapter (|
@ Flle System
Recording Interval 10 secends
Required Space Unlimited
For Help, press F1 105210.41 7

The Toolbar buttons provide quick access to selected Statistics Viewer
functions. You can also access these functions from the menu bar.

Icon Description

Bring up Statistic Configuration. Brings the Statistics
Configuration window to the forefront when you have multiple
windows open.

Refresh. Refreshes the display of information in the active window.
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Icon Description

Setup Statistic Item. Sets the statistical recording method.

Open Query. Displays the previously saved query file.

Save Query. Saves new query file information to disk.

Add ltem. Adds a selected item to the viewing window.

Remove Item. Removes an item from the viewing window.

Remove All. Clears the viewing window.

View Statistical Information. Displays the Statistics Graph View

@ window.

Print. Prints query files.
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) Viewing statistical information

The Statistics Configuration window, shown below, lists the systems
currently being monitored on the left side of the window. The utilization
items for each system are displayed on the right side of the window.

Before you can add an item to the viewing list, you need to set up its
recording method and start to record its activity.

Statistics Configuration : SCOSYSY : 192.9.210.18

E Server Server Mame Address Type
FPLPFY

Elg SCOSYSW
Q Memany Utiization
@ Login Users
- {8 Metwork Transfened Bytes
{8 Metwark Sent Bytes
{8 Metwaork Received Butes
{8 Metwork Transfered Packets
- {88 Metwork Sent Packets
- Metwork Received Packets
E]--@ CRU1
- BUS 1

[ M8 MIC AMD PCMet-PC [5242443023039)

El-ifp File System

@ m/

Lol (2] Astand

UNE<WARE

B BULL

ARRAY
Recording Interal 10 zeconds
Required Space Unlimited

To view the record stastics information, you must add items to the right
side of the window.

To add an item, highlight it on the left side of the window; then click the Add
Iltem toolbar button. The selected item displays in the right side of the
window.

To remove an item from the right side, highlight it and click the Remove
Item toolbar button.

To remove all items from the right side, click the Remove All toolbar button.

Recording utilization information

To view statistical information, you must first record the utilization data.
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To record the utilization data, highlight an agent, and click the Setup
toolbar button to open the Setup window, shown below.

From the setup window, select the item you want to record, then click on
the record button. Press the Apply button to start recording.

Setup - SCOSYSY. 192.9.210.12 |
lkermn l Fecord Status l —
b emary Utilization AR
Login U=zers AR
MHetwork. Transferred Bytes Fecording
MHetwork. S ent Bytes Fecording —_—
Metwork Aeceived Bytes Fecording
Metwork Transferred Packets Fecording
Metwork Sent Fackets MNAR
Metwork R eceived Packets MAF
[1] CPU Processar Utilization AR _I
M1 Dl O i il A T i~ L] =]

""""""""" Mot Record I Start I Clear I
— Aecarding Parameters
Fecording lnterwal |1 0 Secconds - I
Fecord Size
*  Unlirited ™ Limited ID Fecords
Feqguired Space ID KE
Close I f e [ I

The Item column lists the items that can be recorded. The Record Status
column indicates whether the item is being recorded (“Recording”) or is not
recorded (“N/R”).

To select item(s) for recording:
e Highlight the item(s) you want to record and click the Record button.

Note: The Record Status for the item(s) changes from “N/R” to
“Recording.”
e Click Start to start the recording process.

To deactivate the recording of items, highlight the items, and click the Not
Record button. The Record Status for the items changes to “N/R.”

To deactivate the recording of all selected items, click the Clear button.

To specify the recording interval and file size for each item you are
recording, use the items in the Recording Parameters section.
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The Recording Interval specifies the amount of time that elapses between
the times that Statistics Viewer obtains information from the monitored
system. The minimum time interval is 10 seconds; the maximum is one
hour.

The Record Size limits the number of records that are recorded for each
item. Choose Limited and specify the number of allowable records for each
item. The Required Space field is calculated automatically based on the
number of records that you specify. Choose Unlimited for unlimited file
size.
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) Saving and loading query files

You can save recorded utilization information for future reference. To do
this, click the Save Query button, or Query Save, after the desired utilization
information has been recorded. The following Define New Query dialog
box appears to allow you to name and describe the query file.

Define NHew Query E3
Query Mame Istat1
D escription

This is a test for Stat Wiewe]
Cancel |

To open an existing query, click the Open Query toolbar button. The
following Open Query dialog box appears.

— Duery Marm Description
Thiz is a test for Stat Yiewer Ilnlerval SileEEs
Remove
Cloze |
Server Mame | Address | Type |
SCOSYSY 1929.21018 Metwork Transferred Bytes
SCOSYSY 1929.21018 Metwork Sent Bptes
SCOSYSY 1929.21018 Metwork Received Butes

To specify the query file you want to load, highlight its name and click the
View button. The Remove button erases highlighted query files; the Close
button closes the dialog box.
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) Working with statistics graph view

The Statistics Graph View window displays item utilization graphically. Itis
a “snapshot” of selected utilization statistics information. The y-axis
(vertical) indicates utilization frequency; the x-axis (horizontal) indicates
utilization start and end times.

EZ Statistics Graph View - 1 | _ (O] x|
A Statistics Graph View
] F933.0

A54F 4 i f"\ -

N i

27732 0 ]

13865 , v@\

= 0 A N i
] Start Time = 07/19/88 024596 End Time = 0711898 03:01:56
Period = 50 secs/per grid
Start |D°/° Range |95°/° Start Time: |D?.-/1 8/93 024526 End Time |D?.-/1 8738 03:01.56 Setup |
< |~
Server Name | Item | Start Time | Last Recording Time | tdean | Devigtion |
Metwork Transfered ... 07/18/38 02:45:26 07/18/98 03:02:46 100976 196475
MNetwork Sent Bytes 07/18/98 02:45:26 07/18/98 03:02:45 526.53 97271
Metwork Received B 07/18/98 02:45:26 07/18/98 03:03:06 483.08 832.00

The legend below the graph lists the names of the items whose utilization
information is displayed by the line graph. Their colors correspond to the
colored lines on the graph.

The legend lists the server name, the name of the item being recorded,
recording start and stop times, and utilization mean and deviation. The
mean measures average utilization, while the deviation measures the
difference of the utilization against a fixed value.

To specify the information you want the line graph to display, click the
Setup button in the Statistics Graph View window. The following Statistics
Graph Setup window displays.
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Statistics Graph Setup E

— Time Scale P. i~ Graph Object Options

i~ Representation
Period ITU Secconds 'l il Lz & Average
~ Gid .
StatTime  [07/18/38 024526 ﬂ [ Time Asis Label C Pesk

End Time [o7/18/38 02:57:16 ﬂ —Seroll Speed ~Seroll Range
1 [ J = | Slow Quick || Smal Large
' Axis Scale P
Min [ 0.0 Max [ 63330
ol [ ] = |

) Canicel

Use the Time Scale Parameters section to set the time intervals between
each grid (x-axis) on the graph. The display bar at the bottom of this
section focuses the graph display to a limited time frame.

Use the Y-Axis Scale Parameters section to set the minimum and
maximum values for the y-axis. The display bar at the bottom of this
section focuses the graph display to a limited performance frame.

Use the checkboxes in the Graph Object Options section to enable/disable
display of:

e the legend below the graph that acts as a key to the data being
graphed

e grid lines that appear in the body of the graph to improve readability
* labels beneath the x-axis that indicate the recording time interval

Use the Average and Peak radio buttons to specify the type of performance
data you want the graph to display.
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The ASM Alert via LAN (Local Area Network)
function allows administrators to monitor and
reconfigure local systems via a network.
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) Alert via LAN Manager function

To launch the Alert via LAN function on a server system, do one of the
following:

e  Select Admin > Alert via LAN Manager from the ASM Main menu
e Click on the Alert via LAN button from the ASM toolbar

Menu bar and toolbar

The menu bar and toolbar are located at the top of the Alert via LAN
Manager window. The table below describes the function of each menu
item and toolbar icon.

Item Icon Description
File Menu
Exit Choose this command to close the Alert via LAN

Manager window

Operation Menu

Add Client Allows the administrator to add local system(s) to the
list of systems currently connected to the server.
.ﬁ Selecting this command displays the Input IP
Address dialog box
To add a local system, simply enter the IP address of
the desired local system in the IP Address textbox
then click on OK

Refresh Choose this command to update the local system
@!r information currently displayed on the screen

Save Config Allows the administrator to save the local system
configuration. This function is the same as clicking
ﬁ on the Set button located at the bottom of the Alert
via LAN Manager window
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Item Icon Description
View Menu
Toolbar Display or hide the Toolbar, i.e., the buttons just

below the Menu bar. When the Toolbar is displayed, a
check mark appears beside the command item

Status Bar Display or hide the Status bar, i.e., the bar located
along the bottom of the window. When the Status bar
is displayed, a check mark appears beside the
command item

Help Menu
Help Topics Opens the Alert via LAN Manager Help. This Help file
; contains information on how to use the Alert via LAN
Manager function
About Alert Displays the copyright notice and the version number

Via LAN Eg of the Alert via LAN Manager utility




Information tab

i~ Alert via LAN Manager Hi=
File Operation Yiew Help
|[sLERTONLAN ||z & @ @3 7 e

Infarmatian |Network| Timersl Ailerts I

Spstem [nformation
uuio
wiorkstation |P address
‘wioik station Mame
MAL address
Hardware revision

29298b40-182-11d3-b234-000022125100
210.63.101.146

ALERTOMLAN

00: 00 2:2:1 &:81:00

209

¥ Enable alert transmission

¥ Enable Remoate Setting

Retranzmizzion delay period in seconds

Alert via LAN agent polling period in seconds

—
—

Apply |

For Help. press F1

Femote Set |

1210.62.101.146

287

ltem Description

System Displays the system configuration of the local system

Information currently being monitored
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11 Alert via LAN

ltem Description

Enable alert Activates the alert function. Once an alert packet is issued,
transmission notification methods specified in the Alerts page are
option automatically performed

Retransmission delay period in seconds - specifies the
period (in seconds) after which retransmission of an alert
packet is repeated

Alert on LAN agent polling period in seconds - specifies the
period (in seconds) after which the server system repeats
the polling process

Enable Allows the administrator to reconfigure the local system via

Remote the network. If this option is disabled, the local system

Setting option  information that appears on the server screen becomes
nonconfigurable

After you have entered your settings, click on the Apply button.

Network tab

£< Alert via LAN Manager - [O] %]
File  Operation Miew Help
|[aLERTONLAN e @a ? @

Information  Metwark |Timers| Alerts I

Admin Congole [P Address 3 et § e e
Admin Console Port lSSDD

Femate Set

For Help. press F1 |210.63.101.146
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ltem Description

Admin Specifies the IP address of the server system to which the
Console IP local system is connected

Address

Admin Specifies the port used by the local system for sending alert

Console Port packets

Timers tab

4~ Alert via LAN Manager M=
File  Operation “iew Help
|[ALERTONLAN 2o @827 @

Information | Metwork ~ Timers |Alerts |

i~ Heartbeat
¥ Enable heartheat
Alert via LAM agent sends a presence packet to the management server.

Interval in seconds

£

i~ watchdog Timer
¥ Enable watchdog timer
This timer is periodically updated by Alert via LAM agent.

|43
Intervalin seconds |88

Lels

Walue rounds to 43 second interval

The walid range iz from 43 to 5461 seconds Apply |
Femote Set |

For Help. press F1 |21 0.63.101.146
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ltem Description

Heartbeat: When enabled, the server checks for the heartbeat signal
Enable sent by the local system to determine its connection status
heartbeat Interval in seconds - specifies the period (in seconds) after

which, if the server does not detect any heartbeat signal,
the local system is automatically considered disconnected

Watchdog When enabled, the local system's processor checks for
Timer: Enable any register setting change to verify its status

vyatchdog Interval in seconds - specifies the period (in seconds) after
timer which, if no register setting is detected, the local system is

considered to be OFF

The Valid period setting for both the Heartbeat and Watchdog timers range
from 43 to 5,461 seconds.

After you have entered your settings, click on the Apply button.

Alerts tab

i~ Alert via LAN Manager s 3
File Operation “iew Help
|[ALERTONLAN  -||ln @ & 02 7 @
Informationl Networkl Timers Alerts |
i Select Alerts to Activate

Type | Status | Alerts |

Cover Tamper Enabled

Yolage/Temperature/Fan Dut of Spec  Enabled Detected

L&N Leash Tamper Enabled

Proceszor Mizsing Enabled

Clear Alerts Refresh Apply |

Femote Set

For Help, press F1 |210.63.101.146
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ltem Description

SelectAlertsto  Specifies the local system's hardware parameters to
Activate monitor

Alert Action Specifies the notification methods that Alert via LAN utility
performs once a local system issues an alert packet

To clear all settings on the Alerts page, click on the Clear Alerts button.
This disregards the previous settings and the settings which you have just
entered.

To refresh the page information to its saved settings, click on the Refresh
button.

To save your settings, click on the Apply button.

Saving the Alert via LAN Manager settings

After you have configured the Alert via LAN function, click the Set button
for the changes to take effect.
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) Alert via LAN local function

To launch the Alert via LAN function on a local system, click on the Alert via
LAN icon located on the Taskbar.

Information tab

&7 Alert via LAN Agent = B

Infarmation | Network | Timers | Alsits |

Spstem Information

uui 35bB35940-c224-11ce-30a2-0000e21 58100
‘w/orkstation P address 21063.101.144

Warkstation Mame tedpang

MALC address 00:00:c0:57:bc:cB

Hardware revision 209

[V Enable alert transmission
Retransmission delay peniod in seconds
Alert on LAN agent polling peroid in seconds

™ Enable Fremote Setting

The Information tab of the Alert via LAN Agent window displays the system
configuration of the local system. The parameters that appear here are
exactly the same as those in the Alert via LAN Manager window. Refer to
“Information tab” on page 287 for the description of these parameters.
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Network tab

§5 Alert via LAN Agent

[Tivrs | s |

1592, 8 .20, 27
5E00

Item Description

Admin Specifies the IP address of the server system to which the
Console IP local system is connected

Address

Admin Specifies the local port used by the local system for
Console Port sending alert packets

Click on the Apply button for your settings to take effect.
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Timers tab

InfomahonlNeiwork Timers IAlerts |

— Heartheat

¥ Enable heartbeat

A0L agent sends a presence packet to the management server.

Interval in sconds 6 :ll
~ Watchdog Timer

¥ Enable walchdog timer

‘This timer is periodically updated by A0L agent

Interval in seconds 86 jl
Value romnds t0 43 second inderval
The walid range is from 43 to 5461 secomnds. Apply

Refesh | R Help |

This page is exactly the same as the Alert via LAN Manager Timers tab. For
more information, refer to “Timers tab” on page 289.

Alerts tab

§% Alert via LAN Agent 2] %]

\nfulmatmnl Nelworkl Timers Alerts I

i~ Select Alerts to Activate

Type | Status | Alerts |
Cawer Tamper Enabled Detected

Voltage/Fan/Temperature Out of Spec  Enabled Detected
Processor Over Temperature Enabled
[ L&N Leash Tamper Disabled
Processor Mizsing Enabled Detected

I~ Show slart warning message

Clear Alerts Refresh Apply |

Help |
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ltem Description

SelectAlertsto  Specifies the local system's hardware parameters to
Activate monitor

Show alert When this option is enabled, a warning message appears
warning once an alert packet is detected
message

To clear all settings on the Alerts page, click on the Clear Alerts button.
This disregards the previous settings and the settings which you have just
entered.

To refresh the page information to its saved settings, simply click on the
Refresh button.

To save your settings, simply click on the Apply button.

Updating the onscreen information

To update the onscreen system information, simply click on the Refresh
button.

Quitting alert via LAN agent

To close the Alert via LAN Agent window, simply click on the Close button.

Getting help information

If you need help on how to reconfigure the Alert via LAN Local function and
move around the window, simply click on the Help button. This displays
the Alert via LAN Agent Help topics.
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12 Remote Console



The Remote Console function allows you to
control the ASM agent systems through the
Local Area Network (LAN).
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) Remote Console administrator
function

To activate the Remote Console administrator function do one of the
following:

e  Select the Admin > Remote Control Console from the ASM main
menu

e  (Click on the Remote Console button from the ASM toolbar

¢ Run the Remote Console program from the ASM Console program
group

The Remote Console window appears on the screen:

[ Remote Consale
Action File ¥iew Help

e (E &2 w2

For Help, press F1 NUM A
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Menu bar and toolbar

The menu bar and toolbar are located at the top of the Remote Console
window. The table below describes the function of each menu item and
toolbar icon.

Item Icon Description
Action menu
Connect Choosing this command enables the administrator to

establish connection to an ASM agent system.

Disconnect Choosing this command automatically disconnects
the existing server-client connection

File Opens the File Transfer window, allowing the server to

Transfer send and receive files from an ASM agent system.
For more details, refer to “File transfer function” on
page 302

Snapshot Allows you to copy the currently displayed image on

the screen and store it onto the Clipboard

File menu

Save This command allows you to save the currently

Image displayed image on the screen as a .BMP file

Save This command allows you to save an existing image

Image As file to another filename

Print Image This command lets you print the currently displayed
screen

Print This command lets you check the layout and format

Preview of the file before actually printing it
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Item Icon Description

Print Setup This command allows you to configure the printer
according to your preferences

Exit Choose this command to close the Remote Console
window

View menu

Toolbar Displays or hides the toolbar, i.e., the buttons just

below the menu bar. When the toolbar is displayed, a
check mark appears beside the command item

Status Bar Displays or hides the status bar, i.e., the bar located
along the bottom of the window. When the status bar
is displayed, a check mark appears beside the
command item

Help menu

Help Opens the Remote Console Help. This Help file

Topics contains information on how to use the Remote
Console function

About Displays the copyright notice and the version number

Remote of the Remote Console utility

Console

Establishing a connection to an ASM server
system

To establish connection to an ASM system:

1. Select Action > Connection or click on the Connect button on the
toolbar. The Connect to remote computer dialog box appears.
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Connect to remote computer

“Y'ou can uze the host name or [P address to specify the computer you want to connect to.
Prezz Search buttan ta find all available computers in your local nebwark.

LComputer IMiIkyW'ay j

Uzer Mame |Administrator Cancel

bl

[ d
Pazawan I Search

2. Enter the name or the IP address of the desired ASM server system.
You may also click on the Search button to view a list of available
systems you can connect to. If the password function of the ASM
server system is enabled, you are prompted to enter the correct
password.

Enter the correct password in the Password textbox.

Click on Connect to proceed with the connection process or Cancel
to disregard the entry that you have just entered.

Once connection is established, you can access the selected ASM agent
system from your site.

File transfer function

The File Transfer function of the Remote Console application enables the
server to send and receive files from any ASM agent system. It is based on
the standard file transfer protocol (FTP). But unlike FTP which uses the
standard FTP port, File Transfer uses a private port to avoid conflicts with
FTP.

To enable the File Transfer function, do either of the following:
*  From the Remote Console menu, select Action > File Transfer or
e  (Click on the File Transfer button from the Remote Console toolbar.

The File Transfer window appears on the screen.
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Connect to remote computer

*f'ou can use the host name or IP address to zpecify the computer pou want ta connect to.
Press Search button to find all available computers in your local network.

-
Computer m j -
User Hame IAdministratol Cancel |

Paszword |

Subnet: I j Metmask I
Hiozt Hame | Internet Address |
MILK sy 1052104

The server's file information appears in the top box, while the currently
connected remote system's file information appears in the bottom box.
The lower box displays the time, file and error messages for all transfers.

Disconnecting from an existing remote
console connection

To disconnect, do one of the following:

e  Select Action > Disconnect from the menu bar

e  (Click on the Disconnect button from the Toolbar.
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) Remote console server function

The Remote Console server function is automatically enabled when a
system boots up. To display the Remote Console window on the agent

system, simply click on the Remote Console Server icon located on the
taskbar.

The Remote Console Server window appears on the screen:

Action  View Help

~ = =

Host Name | Internet Address [ Enter Time

Orion 2106210151 Thu 1993/11/26 1426:47
For Help, press Fi NUM i

Menu bar

The menu bar is located at the top of the Remote Console Server window.
It contains the following menus:

ltem Icon Description

Action menu

Hide Minimizes the screen and reduces it into an icon
E on the taskbar. To restore the window, simply
click on the icon
Enable

— Enables the Remote Console function. When

Command @ enabled, it allows you access to control the
server system
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ltem Icon Description

Disable —_— Disables the Remote Console function
Command B

Disconnect Automatically disconnects the existing server-

client connection

)

Set Password Sets a password to protect your system from
unauthorized access

Exit Closes the Remote Console Agent window
View menu
Toolbar Displays or hides the Toolbar, i.e., the buttons

just below the Menu bar. When the Toolbar is
displayed, a check mark appears beside the
command item

Status Bar Displays or hides the Status bar, i.e., the bar
located along the bottom of the window. When
the Status bar is displayed, a check mark
appears beside the command item

Help menu

About Displays the copyright notice and the version
Remote ? number of the Remote Console Agent utility
Console

Help Topics Opens the Remote Console Agent help

Setting a password
To set a password:

1. Select Action > Set Password from the menu bar, or click the Set
Password button on the toolbar. The Password Setting dialog box
appears:



306 12 Remote Console

Action View Help

EE IR =

Host Name | Interet Address | Enter Time
Cirinn 21063.101.51 Thu 1995/11/26 14:26:47

[¥ Enable Password

Password W
cua_|
For Help, press F1 [ UM 7

2. Click on the Enable Password option.

3. Enter your password in the Password textbox then click on OK.

User setting

This option allows administrator to set the users’ names and passwords
and privileges. When you choose this command, the User setting dialog
box automatically appears.

User Setting

Uzer Setting
[ Dizabled

User Name  |ted

Change Password

¥ Control keyboard and mouse
I Lock keyboard and mouse

W Transfer files

Add LDelete

ok | Cancel | il |

You can add or remove users by selecting the user’s name and then
clicking Add or Delete. The Disable checkbox prevent the user from any
access to remote console. This is a nice was of suspending the user
without erasing the user from the llist.
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To add a new user:
1. Type the name of the user in the User Name edit box.

2. Click the Password button to assign or change the password of the
user.

3. Choose one of the attributes of the user by clicking the attribute
checkboxes.

4. Click the Add button to add the user into the list.
5. Click OK to exit.
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) Chatting

The chat function enables the client user to chat with the server user. This
feature is based on TCP. The chat function is enabled only when a
connection has been established.

Chat with M7L3 M [=1E3

File Edit View Help
=] =2 L

Local : This is a test for char H

For Help. press F1 NUM

Item Icon Description

File Menu

Save Save the conversation on screen to a file

Exit Quits chatting
Edit Menu

Undo Undo the last function

Cut Cuts the selection and put it on the Clipboard
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ltem Icon Description

Copy Copies the selection and put it on the Clipboard
Paste Inserts Clipboard contents

View Menu

Toolbar Displays or hides the toolbar, i.e., the buttons just

below the menu bar. When the toolbar is
displayed, a check mark appears beside the
command item

Help Menu

Help Topics Opens the Remote Console Help. This Help
file contains information on how to use the
Remote Console function

The window is split into two views. At the bottom of the window is the input
area and at the top is the display area (read-only). Type your messages in
the input area and then press the Enter key on your keyboard to send.

To open the Chat function for Remote Console Client and Server, do either
of the following:

Select Action > Chat
Click on the Chat button on the toolbar.



310 12 Remote Console



13 CMOS Setup Manager and
BIOS Update Manager



This chapter describes how to install and use
the CMOS Setup Manager and the BIOS
Update Manager.
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} CMOS Setup Manager

CMOS Setup Manager is an ASM utility programs that is used to change
the CMOS settings remotely. This means that you do not need to visit
machines physically to change the CMOS settings for abnormal system
configurations.

This feature does not to replace the common CMOS setup function
provided by all BIOS vendors. It is for Windows environments, including
Windows 95, Windows 98, Windows NT, and Windows 2000systems.
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Menu commands

Command Description

File menu

Auto Discovery

Searches for available systems in the network and displays
them for monitoring purposes

Get CMOS

Retrieves the CMOS data of the selected system and puts
it into the cache

Save CMOS

Stores the CMOS data in the cache to the selected system

Load Previous
Settings

Resets the CMOS data in the cache to that previously
saved one

Load Previous
Settings and
Close

Resets the CMOS data in the cache to that previously
saved and closes the update window

Save Settings

Stores the CMOS data in the cache to the selected system

and Close and closes the update window
Import CMOS Imports a CMOS script file
definition

Exit Exits CMOS Setup Manager
View menu

Toolbar Shows/hides the toolbar
Status Bar Shows/hides the status bar

Window menu

Cascade

Cascades the open update window

Tile

Tiles the open update window

Arrange Icons

Arranges icons in the client area
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Command Description

Help menu
Content Launches the Help Content window
About CMOS About dialog box of CMOS Setup Manager

Installation and uninstallation

To install CMOS Setup Manager:

1. CMOS Setup Manager is an ASM Console component that is
automatically installed whene you install the ASM Console. Refer to
“Installing ASM Console” on page 13 for the installation instructions
for ASM Console under Windows NT 4.0 and Windows 95/98.

2. Restart the system.
To uninstall CMOS Setup Manager:

1. Click on the Start menu, select the Programs folder, then the Acer
ASM Console folder. Click on the Uninstall Acer ASM option to
uninstall the whole ASM package.

2. Restart the system.

Note: Only the ASM Console includes the CMOS Setup Manager.
This function is not available in the Agents.

Selecting browsing systems

From the File menu, select Auto Discovery to display the Auto Discovery
dialog box.

Double click on the subnet address to search for an available ASM agent.
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Auto Discovery

Autodiscovery Wizard Curtent Selected spstem :
E\E 210.63.101 (5] 4 Addiess | Agent |

210.63.101.96vEELASE]
210.63.101.108[CHRISCHANG-1] Cancel

Refresh

Add »>

<< Remove

i

b arual Add

‘W aiting time: :

I

Sec.

[k load | Save |

This window displays all IP/IPX systems in your network detected by ASM.
The following items are available in this dialog box.

Auto Discovery dialog box items

Item Description

Current Shows all the systems to be monitored by ASM

Selected

Systems

Waiting Time Indicates the amount of time before the system terminates

the operation if the system is not responding

Button Description

OK Closes the dialog box and causes the modifications you
made to take effect; the System List Combo Box now
contains all the systems you specified in the left panel

Cancel Exits the auto discovery window without saving

Refresh Refreshes the System Listing (left panel display)
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ltem Description

Add Appends the highlighted IPX systems in the Systems Found
list or the IP systems specified in the IP Address field to the
Systems Selected list

Remove Deletes the highlighted systems from the Systems Selected
list

Manual Add Allows you to manually add an IP address

Load Loads the system list in the left panel of the auto discovery
window

Save Saves the current system list (left panel) to file for future use

Note: In order to make the Auto Discovery function work properly, the
agent must be able to respond to standard MIB-Il requests. Please
refer to RFC1213 for more information about MIB-II.

Basic operations
To launch the CMOS Setup Manager:

1. Make sure the desired system is available in the system list. To do
this, find the ASM agent systems automatically via the Auto Discovery
function, then select the desired system from the system list.

2. Click on the CMOS Setup Manager button on the ASM Console
Toolbar or select Tools > CMOS Setup Manager.

3. The CMOS Setup Manager main window appears on the screen.
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Note: You can use the auto discovery function to find the system
whose CMOS data can be setup remotely.

To launch the CMOS Setup window:

1. Inthe CMOS Setup Manager main window, select the system you
want to setup in CMOS from the Available System List box.

NT-TEST ::202.39.82.11 .

YINCENTYEH-1 ::202.39.82.191
NT-TEST ::202.39.82.11
TEST :1202.39.82.242

2. Select File > Get CMOS to launch the CMOS Setup window.
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{tilit
System Information
B[ Basic Configusation
-B Basic Configuration
IDE Primey Channel Master T Advanced Configuration
~[B IDE Primary Channel Slave
~[8 IDE Secondary Channel Master

IDE Secondary Chamel Slave
B Boot Options
System Security
Power Management
B-£7 Advanced Configuration
£ Onboard Peripheral Configuration
| Onboard Device Settings
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MemonrCache Options
PuP/PCT Bystern Configuration
Chip Settings
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) Advanced operations

To change the CMOS settings:
1.  Open the CMOS Setup Window.

2. Click the desired page in the left pane, e.g., Basic Configuration.

1.44MB 3 .5-inch

Mone
360KB 5.25-Inch
[B IDE Primary Channel Slave 1 2MB 5 25-inch

IDE Secondexy Channel Master |
IDE Secondexy Channel Slave 1 240
Boot Options
Svsten Security
B Power Management
=-F7 Advanced Configuration
=7 Onboard Peripheral Configuration
Onboard Device Settings
Onboard Serial/Paralle] Port Settings
B MemoryCashs Options
B PoP/PCI Systemn Configuretion
Chip Settings

IDE Primsry Channel Master

3. Notice that the right pane displays the settings defined on this page.
Change the settings.

4. Select File > Save CMOS to save the new settings to CMOS.

To import a CMOS definition file for another model:
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Select File > Import CMOS definition... to launch the Import CMOS
definition dialog box.

Select the desired ICF file and click on the OK button to import the
ICF file.
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BIOS Update Manager

BIOS Update Manager is an ASM utility used to update the BIOS remotely.
You do not need to visit the machine physically to upgrade the system
BIOS. You can also schedule the time to perform the updating task in
advance, then the BIOS Update Manager performs the task at the time
scheduled.

Menu commands

Command Description

File menu

Exit Exits BIOS Update Manager

Action menu

Auto Discovery Searches for available systems in the network and
displays them for monitoring purposes

Start Up Service Starts the BIOS update service. The Update manager
checks if the job in the queue needs to be processed in
a fixed interval

Stop Service Stops the BIOS update service

Package Defines the package to deliver to the client side;
defaults are Remote Shutdown and Remote Wake-up

Job Defines the job needed to be executed

System menu

Setting Configures the system settings
View menu
Toolbar Shows/hides the toolbar

Status Bar Shows/hides the status bar
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Command Description

About menu

About CMOS About dialog box of CMOS Setup Manager

Installation and uninstallation

To install the BIOS Update Manager:

1. The BIOS Update Manager is an ASM Console component. It is
automatically installed once you install the Console of ASM. Refer to
“Installing ASM Console” on page 13 for the installation instructions
of ASM Console under Windows NT 4.0 and Windows 95/98.

2. Restart the system.
To uninstall the BIOS Update Manager:

1. Click on the Start menu, select the Programs folder, then the Acer
ASM Console folder. Click on Uninstall Acer ASM to uninstall the
whole ASM package.

2. Restart the system.

Selecting browsing systems

From the File menu, select Auto Discovery to display the Auto Discovery
dialog box.

Double click on the sub-net address to search for an available ASM agent.
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Auto Discovery

Autodiscovery Wizard Curtent Selected spstem: [~
EE% 2102813673031_1 01 3EELASE] o |[den Legen I
192291.5803.1 (01.108[CHRISCHANG-1) Cancel
Add »> |
<< Remove |
b arual Add I
‘W aiting time: :
5 _':j Sec.
W Load | Save |

This window displays all IP/IPX systems in your network detected by ASM.
The following items are available in this dialog box.

Auto Discovery dialog box items

ltem Description

Current Shows all the systems to be monitored by ASM

Selected

Systems

Waiting Time Indicates the amount of time before the system terminates

the operation if the system is not responding

Button Description

OK Closes the dialog box and causes the modifications you
made to take effect; the System List Combo Box now
contains all the systems you specified in the left panel

Cancel Exits the auto discovery window without saving
Refresh Refreshes the System Listing (left panel display)
Add Appends the highlighted IPX systems in the Systems Found

list or the IP systems specified in the IP Address field to the
Systems Selected list
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Item Description

Remove Deletes the highlighted systems from the Systems Selected
list

Manual Add Allows you to manually add an IP address

Load Loads the system list in the left panel of the auto discovery
window

Save Saves the current system list (left panel) to file for future use

Note: In order to make the Auto Discovery function work properly, the
agent must be able to respond to standard MIB-Il requests. Please
refer to RFC1213 for more information about MIB-II.
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) Basic operations

To launch the BIOS Update Manager:

1. Make sure the desired system is available in the system list. To do
this, find the ASM agent systems automatically via the Auto Discovery
function and then select the desired system from the system list.

2. Click on the BIOS Update Manager button on the toolbar or select
Tools > BIOS Update Manager to launch BIOS Update Manager. The
BIOS Update Manager main window appears.

~." - Patch Manager [_ O] x]
Elle  #ction  System  View About
ol#| || Bl

B
L »
Ready [ T

Update operations
To start the BIOS Update service:

1. Select Action > Start Up Service or click on the Start Service button
on the toolbar to start the update service. Make sure the service is
on; otherwise, the scheduled jobs won't be executed.

2. The status window appears on the screen.



~' - Patch Manager [_ O[]
File  Action System Yiew About

22| ]| B

[ August 04, 1998, 20:22:43 ] .. Start Service =

[ August 04, 1998, 20:22:43 ] .. Listening at port 4500
fnugust 04, 1998, 20:27:58 ] .. Stop Service

K]

o

Ready [ [NUM P

To stop the BIOS update service:

327

Select Action > Stop Service or click on the Stop Service button on the
toolbar to stop the update service.

To prepare the package:

1.

Select Action > Package or click on the Package button on the

toolbar to launch the Package dialog box.

— Import Flash Bios Package

Chmgai 3] [eka

Marms: I

D escription: I

Add

Fath: IEI “~Frogram Files“acertabb-d L\l pdatePkg 000702

— Package List

Femowe I
FPaclkage | Description | Fath

wESla wESla C:wProgram FileshacerabDiiwUpdateFk
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2. Click on the Import button to launch the Open dialog box.
Open

Look jr: i@vBEIa j I:EJ IE_ =
] vESla

File name: Im Open I
Files of type: | Package Fiesl* pka) = Cancel |

3. Select the PKG file and click on the Open button to close the dialog
box.

4. Click on the Add button to add the selected package to the package
list.

5. Click on the OK button to close the Package dialog box.
To prepare the job:

1. Select Action > Job or click on the Job button on the toolbar to open
the Job dialog box.

2. Select the package item from the Package List and select the system
where you want to apply the package.

Click on the Add >> button to add the job to the Job list.
Click on the OK button to close the Job dialog box.
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Job
Package List Jab Seleted:
Package | Descriptian | Pz
[SHUT DOWN] [REMOTE SHU... [os [ 1P Address
[WAKE UP] [REMOTE Wak... WinNT 2023982173
vESma wE5ma [
N |
Package Selected:
Hame SO DOwWH] (e 55
Descrption=[REMOTE SHUT DOWM &
MACHIME
Path= l <¢ Remave
Machine List: |
Machine I o0s | IP Address
YESMA-2 WinNT  202.39.82
ERICLIN- "Wwin 95 202.39.82
| | 1l ]
Start Time | [August 04, 1938, 20:43:05 ] _
0K

@

Note: The newly added job is placed in the job queue waiting for the
processing of the Update Manager. The interval defined in the
Setting dialog box is used by the Update Manager to process the job
by fixed interval, so the start time defined in the job is not the
accurate time to process the job.

To change the settings:

1.
2.

Select System > Setting.

To change the maximum acceptable connection, type the desired
value in the Max Acceptance box, then click on the Apply button.

To change the distributor interval, type the desired value in the
Distributor interval box, then click on the Apply button.
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Setting

~Cutrent Setting

Service Pott: I 4500
Mlax Acceptance: i 10
Distributor interval: I 10 Mitmates

7 SBawve as default vahe Apply |




14 Remote Diagnostic

Manager (RDM)



Remote Diagnostic Manager (RDM) is a server
service program that offers remote server
management functionality. It utilizes modems
and telephone lines to remotely monitor and
analyze the server condition via a remote RDM
station, allowing you to update system BIOS
settings for quick restoration of the system to
normal operation. It also uses a pager to notify
the system administrator of server failures. This
"quick response" feature of RDM minimizes the
system down time due to system failures and
therefore, offers the best solution to overcome
the distance barrier of the remote server
management.
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) Overview

RDM architecture

The RDM architecture consists of three main components:
e RDM agent

e RDM station

e RDM connectivity

Hidden
Partition

:7 Operating —}

| System |

| RDM 0.S. ROM| |

<—+ Modem ’1‘ Modem H COM2 H BIOS ‘ ‘ Briver |
| |

| |

| |

| |

.
} Mggme Heartbeat }
with

STATION | TR0 ‘
} CPU }

| |

\ LED \

e S _

During normal operation, the RDM driver periodically sends a heartbeat
signal to the RDM module. Once the server fails, the RDM driver stops
sending heartbeat signals to the RDM module. If the module processor
does not receive any signal for a certain period of time. RDM learns that the
server has crashed and then takes some emergency management.

When RDM module takes emergency management, it takes control of the
COM 2 port. It notifies the system administrator (through paging) that the
server failed. RDM operates according to the RDM Work Mode in BIOS
Setup (refer to page 348).
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RDM agent

The RDM agent refers to the system with an RDM module. An RDM module
contains a microprocessor that acts as an RDM controller.

To enable the RDM module, the RDM agent driver (in ASM Pro) must be
installed into the RDM agent and the system BIOS must include the RDM
BIOS.

For information on how to configure the system BIOS, see the user's guide
that came with the system.

RDM station

The RDM station can be any standard PC system with RDM station
software installed and the necessary peripherals connected. For details on
how to install the RDM station software and the necessary peripherals,
refer to page 342.

RDM connectivity

This refers to the RDM connection. For the RDM agent to establish
connection, it must have the RDM module, and the RDM agent driver
installed into the server. For the RDM station to connect, it must have the
RDM station software installed.

Peripherals such as a modem and pager are necessary for RDM to function
properly. The RDM agent and the RDM station communicate via modem
protocol.

Note: Make sure that the modem and other peripherals are turned
ON. Otherwise, the RDM agent will not be able to establish
connection with the RDM station.

RDM features

The following features explain how RDM offers efficient server diagnostic
service to reduce the server down time.
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Remote management features

¢ RDM offers remote server diagnostic service, eliminating the distance
barrier for remote server management

¢ Informs the system administrator once the server hangs
¢ Allows automatic system reboot once failure is detected

e  Supports Novell NetWare, Microsoft Windows NT, SCO OpenServer,
and SCO UnixWare

e Monitors and displays server status information (such as health log,
critical event, CPU information, temperature, voltage, fuse, CPU
critical event, power supply, etc.) and configuration, even in the event
of server failure

¢ Automatically powers off the system when there is a system failure or
the processor temperature exceeds the maximum limit

¢ Allows the server to boot from any available processor through its
smart recovery feature

e Can power on/off or reboot the server from the RDM station

RDM station features
¢ Monitors the system boot sequence

e Allows updating of the system BIOS or changing of the CMOS setup
remotely

¢ Allows the system to boot normally or to the RDM partition
e Allows remote access to the server's diagnostic utilities
e  Supports file transfers

e  BIOS supports ANSI terminal, allowing the RDM station to display the
RDM server screen after connection is established

e Features the Talk utility that allows users at both server and RDM
station sites to communicate easily
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) RDM installation

This section gives step-by-step instructions on how to install the RDM
module, the RDM function in agent side and console side of ASM Pro
software.

System requirements

Before you begin the installation, make sure that you have the following:

RDM server requirements

Hardware

e  External modem

e RDM module

e RDM LED indicator

e Pager

Software

e Novell NetWare v4.1 or later, and/or

e SCO OpenServer 5.0 or later, and/or

e Microsoft Windows NT 4.0 or later, and/or

e SCO UnixWare 7.0 or later

e ASM (Advanced System Manager Pro) agent

RDM Station requirements

Hardware

e Pentium or faster PC

e Atleast 16-MB RAM

e At least 5-MB free hard disk space
e Modem

Software

e Microsoft Windows 98, Microsoft NT Workstation 4.0, or Windows
2000
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e ASM Pro 4.3 Console

RDM server setup

This section describes how to set up the RDM server.

Installing RDM module

Note: The RDM module is installed at the Acer factory. The following
RDM module instructions is provided in the event you need to
reinstall the RDM module.

ESD precautions

Electrostatic discharge (ESD) can damage your processor, disk drives,
expansion boards, and other components. Always observe the following
precautions before you install a system component.

¢ Do not remove a component from its protective packaging until you
are ready to install it.

e  Wear a wrist grounding strap and attach it to a metal part of the
system unit before handling components. If a wrist strap is not
available, maintain contact with the system requiring ESD protection
at all times.

Preinstallation instructions
Always observe the following before you install a system component:

e Turn off and unplug the system and all the peripherals connected to
the unit before opening it.

e Open the system housing.

¢ Follow the ESD precautions listed above before handling a system
component.

¢ Remove any expansion boards or peripherals that block access to the
desired system board slot or connectors.

e See the following sections for specific instructions on the component
you wish to install.

Installing the RDM module

1. Open the system housing.
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2. Align the module connectors with their corresponding connectors on
the system board.

Module
connector
RDM
controller
Module
connector

3. Gently insert the module. Make sure not to bend the pins and that the
module is properly seated.

4. Replace the housing cover.
5. Enter BIOS Setup to set the desired RDM Work Mode.
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Connecting communication peripherals

Modem

The RDM server and the RDM station communicate via modem protocol.
Therefore, you need to connect an external modem with a baud rate of not
less than 9600 baud to both systems. To connect an external modem,
connect the RS232C serial cable to the modem data port and the
appropriate COM port of the system.

Note: The modem at the RDM server side must be connected to the
COM2 port, while the modem at the RDM station side can be
connected to either the COM1 or COM2 port. Use only modems that
are purchased locally to ensure compatibility with your telephone
system. The modem must have a transfer rate of at least 28.8K.

When the modem is turned ON, the CD/DCD (Carrier Detect/Data Carrier
Detect) signal light on the front panel must be OFF for RDM to function
properly. If this is not the case, refer to the modem's user's guide and
check the section on DIP switches for information on how to adjust the CD/
DCD light. If your modem does not have a DIP switch, then we recommend
that you replace it with another model that supports such switches.

Telephone

To connect the modem to a telephone outlet, plug in the telephone
connector to the telephone outlet. Then, insert the telephone line
connector to the modem line port.

Pager

The pager is necessary for notification purposes only.

Post-installation instructions
Observe the following after installing a system component:

e Make sure that the components are installed according to the step-
by-step instructions in their respective sections.

¢ Replace any expansion boards or peripherals that you removed
earlier.

e Replace the system cover.
e Connect the necessary cables.

e Turn on the system and the peripherals connected to it.
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Installing RDM agent software

You must do the following to ensure successful installation of the RDM
agent software:

1. Create a hidden RDM partition.

The hidden RDM partition is a DOS partition on the hard disk that
allows you to run preinstalled diagnostic tools when necessary,
without using a diskette or a CD. It also allows you to access your
system from a remote RDM station.

To create a hidden RDM partition, do the following:

Prepare a "clean" hard disk, i.e., a hard disk without any operating
system installed on it.

Create a bootable RDM floppy diskette from the Management CD
of EasyBuild.

Insert RDM floppy diskette into the diskette drive.

After booting from the floppy diskette drive, use the DOS FDISK
command to create a DOS partition. The minimum partition size is
33 MB.

Activate the partition and exit FDISK; then reboot the system.

Format the DOS partition. When formatting is completed, label
the partition as RDM for easy identification.

Install (or transfer) the DOS operating system to the partition.

Run \RDM\install.bat* from the RDM ffloppy diskette to install the
RDM driver and hide the RDM patrtition. These settings will take
effect only after you reboot the system.

After you create the hidden partition, you can now install other
operating systems on the same hard disk. But before doing so,
make sure that the Hidden Partition parameter in the RDM BIOS
is set to Disabled. For more information on RDM BIOS, refer to
RDM BIOS chapter of the ASM Pro manual.

Important! If you are using an IDE hard disk with a capacity less than
540 MB, make sure that you disable the LBA mode. Otherwise, you
will be required to use the LBA mode that you set for the other
operating systems when you create the hidden RDM patrtition.
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Note: When you boot the system to the hidden partition, you cannot
use other utilities (e.g., FDISK.EXE) to change the hidden partition
settings.

Deleting the hidden partition
Important! You cannot recreate the RDM hidden partition once you
delete it. Before proceeding, make sure that you will not need to
create a hidden partition in the future.

Follow these steps to delete the hidden partition:

* Insert a bootable diskette into the diskette drive.

e Enter the BIOS Setup and set the Hidden Partition parameter in
the RDM BIOS to Enabled.

e After the system boots from the diskette drive, use FDISK to
delete the RDM hidden partition. Do not delete other partitions or
change or reformat the active partition.

e Exit FDISK and reboot the system.

e Enter the BIOS Setup and set the Hidden Partition parameter in
the RDM BIOS to Disabled.

Install an operating system.

RDM supports the following operating systems:
¢ Novell NetWare

¢ Microsoft Windows NT and Windows 2000
e SCO OpenServer

e SCO UnixWare

¢ RedHat Linux

You can install any or all of the operating systems. For the installation
instructions, refer to the documentation that came with the OS
package.

Install the RDM Agent Driver.
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Note: Before you proceed, make sure that you have installed the
necessary components and peripherals, for both the RDM server and
RDM station.

The RDM agent driver or the server driver is contained in the
Advanced System Manager Pro (ASM Pro) software package.
Therefore, to install the RDM agent driver, you need to install the ASM
agent software. For information on how to install the ASM Pro
software, refer to the documentation that comes with the ASM Pro
package.

RDM station setup

This section describes how to install and uninstall the RDM station
software.

Installing the RDM station software

The

Important! Before you proceed, make sure that you have installed
the necessary components and peripherals, both for the RDM server
and RDM station.

Note: The RDM station software can be installed only under
Windows NT 4.0/Workstation or Windows 95/98/2000.

RDM function is one component of ASM Pro 4.3 Console software.

Follow these steps to install the RDM station software:

1.
2.

Turn on the system.

Turn on the peripherals connected to the system such as the monitor,
modem, etc.

Install ASM Console. Run the installation program, i.e., SETUP.EXE.
The Setup Program Welcome screen appears.
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4. For typical installation in ASM Console, the RDM station will be
installed. In Custom mode, user can choose to install RDM station or
not.

Select Sub-components

Select the components you want to install, clear the components
you do not want to install

Sub-components

ASM MIE Browser

ASM MIF Browser 175 K
¥ Azset Manager 292K
Statistic Viewer 2B3 K
¥ Remote Console 273K
ViWakeupanLall oo 13K G
Drescription
ROM/EMP

Space Required: 4720 K

Space dwailsble:  BI7696 K

5. Continue to finish the installation of ASM Console.

Uninstalling the RDM station software

RDM station software can only be uninstalled within ASM Console
package.
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Configuring the RDM server

This section discusses the different RDM operation modes. It also explains
the RDM BIOS features, as well as how to configure the RDM function via
RDM BIOS.

RDM operation modes

The RDM enabled servers can run in three different RDM operation modes:
e RDM Local mode

e RDM Remote mode

e RDM Runtime mode

RDM local mode

In the RDM Local mode, the hidden RDM partition is activated; the server
boots up to the activated RDM partition. This allows you to run diagnostics
and other test programs locally on the server. However, in this mode, there
is no remote connection. Thus, all RDM features are only locally available
on the server console.

This mode is useful only if you are physically located next to the server.

RDM remote mode

In this mode, the hidden RDM partition is activated; the system boots up to
the activated RDM partition; and a remote connection is automatically
established to the pre-specified RDM station. This makes all RDM features
available to both the local server and the RDM station. You can run any
RDM utilities remotely from the RDM station. However, this requires
operator intervention since Remote mode can only be activated locally
through the server's RDM BIOS Setup.

RDM runtime mode

The RDM Runtime mode is the normal RDM operation mode. In this mode,
the system operates under its installed operating system. In the event of
system failure, the driver stops sending heartbeat signal to the RDM
module. The RDM module then takes over the COM port and dials the
pager number(s) pre-specified in the Remote Diagnostic Configuration
menu.
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There are two types of Runtime mode operations:
¢ Runtime Reboot Mode (Smart Reboot)
¢ Runtime Remote Mode (Waiting Mode)

The procedures to setup and to make use of the RDM operation modes are
described in the sections that follow:

RDM BIOS

This section explains how to configure the RDM functions via RDM BIOS.
The settings entered in the RDM BIOS determine how RDM handles a
server failure.

Entering the RDM BIOS

To enter the RDM BIOS, press the Ctrl+Alt+Esc key to enter the BIOS
Setup utility. Highlight the Remote Diagnostic Configuration option and
press the Enter key. Page one of the Remote Diagnostics Configuration
appears on screen. This page is for configuring the RDM station functions.

Remote Diagnostic Configuration

RDM 4.3 BIOS Version ..
Console Redirection

Hidden Partition ..........cccccoiiiiiiiiiniis [Disabled]
Communication Protocol .........cccecevererenieneenenns [N,8,1]
COM Port Baud Rate .........ccevviriciiiciiiice [567600]
Remote Console Phone No.........ccocociiincicineas [ 1699]
Dial Out Retry TIMES .....cceeveeeeeieeereereereeeeeeene [2]
Modem Initial Command ..........ccccceeieeienieereeeen. [ ]

11 = Move highlight bar, « — = Change Setting, F1 = Help
PgUp/PgDn = Move screen
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Press the Page Down key to view page two of the Remote Diagnostic
Configuration menu. This page is for configuring the RDM module
functions.

Remote Diagnostic Configuration

RDM WOTrK MOQE ....cueiiniieieeiierieeie et [Waiting]
Waiting Mode PassWord ...........coererereeeenenenesienieneesesennes [ 1234]
PagiNg ..eeeueeeieee e [Enabled]

System Critical Paging No.
T [ 1234566789,,,,,#8823940]
-l

2..

Paging TiMES .c.covueieirierieriesierie et [1]

11 = Move highlight bar, < — = Change Setting, F1 = Help
PgUp/PgDn = Move screen

After entering all the necessary settings, press the ESC key to exit the RDM
BIOS setup.

RDM 4.3 BIOS version
This parameter specifies the version of the RDM BIOS.

Console redirection

This parameter lets you enable or disable the connection to the RDM
station. If enabled and conditions are met, the RDM enabled server
automatically dials the RDM station using the phone number specified in
the Remote Console Phone No. parameter (see page 347) when the server
reboots. Once the connection is established, both the RDM server and
RDM station display the same screen which enables the RDM station to
function the same as the server console. Setting this to Disabled
deactivates the RDM station.

Hidden partition

If you want the hidden partition to become accessible, set this parameter
to Enabled. When enabled, the server boots to the hidden partition.

To disable the hidden partition and return to the normal booting procedure,
set this parameter to Disabled.
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Note: We recommend that you set this parameter to Enabled
especially when you are troubleshooting system problems.

Communication protocol

This parameter specifies the parity, stop bits, and data length for the COM
port to be used for the RDM connection. This is fixed at N (none), 8, 1
setting and is non-configurable. RDM requires no parity and one stop bit
settings.

COM port baud rate

This parameter lets you set the transfer rate of the COM for the RDM
connection. The parameter setting depends on your modem specification;
therefore, before you change the setting of this parameter, check your
modem user guide.

Important! Check your Onboard Peripherals settings in the BIOS
Setup and make sure that you have assigned a port to serial 2.
Otherwise, RDM will not function.

Remote Console phone number

This parameter allows you to set the phone number of the RDM station that
the RDM module must dial once RDM is activated and the Remote Console
is enabled. To set, simply highlight the parameter and enter the Remote
Console phone number.

Remote Console Phone No....[ 5455299 ]

If the remote console phone number is using a Private Branch eXchange 1
(PBX) line, then you must enter six commas (,) after the phone number and
before the extension number, if any. When entering the extension number,
we recommend that you insert a comma after each number. The commas
specify delay.

Remote Console Phone No...[5455299,,,,,,6,6,4,9]

If this parameter is left blank, the Remote Console calling function is
disregarded.
1

PBX is a telephone switching system that requires manual operation to get an
outside line. This is synonymous to PABX - Private Automatic Branch
eXchanges.
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Dial out retry times

This parameter lets you specify the maximum number of times the RDM
server must retry to connect to the RDM station once the server fails and
RDM is activated. If the server has completed the specified number of tries
and the connection still fails, the server bypasses RDM and goes into
normal mode.

Modem initial command

Some modems require specific commands for initialization.  This
parameter allows you to specify the required command to enable your
system to support special types of modems. If you do not specify any
command, BIOS uses the default method to initialize the modem.

Important! Specify an initialization command only when you receive
a Modem Initial Command Fail error message. Otherwise, leave this
parameter blank.

RDM work mode

Note: Before you set this parameter, make sure that you have an
RDM module. Otherwise, you cannot set this parameter.
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This parameter lets you specify the RDM work mode or the notification
procedure. If you enable this function and system crash, RDM module will
do some emergency actions, like power off and paging. The mode options
are listed in the following table:

Mode Description

Waiting(Runtime Once RDM is activated, the server dials the

Remote mode) pager number(s) specified in the System Critical
Paging No. parameters (see section page 350)
and waits for the RDM station to call in. When
the RDM station calls in with the specified phone
number and password, the Agent Information
automatically appears on the RDM station
screen.

Reboot (Runtime  Once RDM is activated, the server dials the

Reboot mode pager number(s) specified in the System Critical
Paging No. parameters (see section page 350)
and automatically reboots the system to its
original operating system.

Disabled Deactivates RDM.

Waiting mode password

This parameter prevents unauthorized access to the server. To set a
password, simply highlight the parameter and enter your code. Your
password may contain at least three characters but no more than eight
alphanumeric characters (i.e., the 26 letters of the alphabet plus the
numbers 0-9). You cannot use special characters.

Make sure to remember your password. Before the server grants RDM
station access, you will be prompted to enter this password.

Note: You must set a password; otherwise, the server will not
establish connection with the RDM station.

Paging

These parameters allow you to enable the paging feature once the server
fails or hangs.
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System critical paging numbers

These parameters allow you to set the pager numbers that the RDM
module must dial once the server fails or hangs. To enter the pager
number, simply highlight 1, 2 or 3. Type in the pager number followed by
commas ',' which specify the delay. The number of commas to enter varies
for every country depending on the communication switch used. Make
sure that you enter the appropriate number of commas; otherwise, the
pager may not receive the complete message. You can use any modem
utility to determine the number of commas to enter. For example, to
determine the number of commas via Windows Terminal:

1. Initialize the COM port assigned for the modem function.

2. Enter the system administrator's pager number (for example:
54555499,,, #XXXX#). The default is four commas (,,,,). If paging is
successful, that means that the number of commas entered is
enough. If not, add one comma to your entry. Repeat the procedure
until paging is successful.

You may also include the server modem number or the message that you
want to send in the pager notification. To do this, simply enter a # sign after
the commas. Then enter your message. At the end of the message, type
another # sign. The message entry must start and end with # sign.

To bypass this feature, do not enter any number after the comma.
System Critical Paging No.
1. [ 123456789,,,,,,#88239404]
2. [ 847982493,,,,,,#34424424]

Leave this parameter blank to disregard this function.

Note: You can enter a maximum of two sets of pager numbers. Each
line accommodates a maximum of 45 characters. Follow the same
procedure to set the additional pager numbers.

Paging times

Similar to the Dial Out Retry Times parameter, this parameter lets you
specify the number of times the server must dial the pager number(s)
specified in the System Critical Paging No. parameters (see page 350) once
the server fails and RDM is activated.
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Setting RDM operation modes

The RDM server can be set to run in one of three different RDM operation
modes: local mode, remote mode, and runtime mode. These sections will
describe how to configure the RDM server and RDM station to run in
different RDM operation modes.

RDM local mode

In RDM Local mode, the RDM server boots to the hidden RDM partition,
which allows you to run diagnostics and other test programs on the server
locally.

Enabling local mode

Follow these steps to enable the Local mode:

e Reboot the server and enter the BIOS Setup.

e From the main menu, select Remote Diagnostic Configuration.
e Set the Hidden Partition parameter to Enabled.

e Save your changes and exit the BIOS Setup. The server automatically
reboots.

Exiting from local mode

After running the diagnostics, you may now resume the system to normal
operation. To do this, you need to exit from RDM Local mode.

To exit from RDM Local mode, do the following:
e Reboot the server and enter the BIOS Setup.

e From the main menu, select the Remote Diagnostic Configuration
option.

e  Set the Hidden Partition parameter to Disabled.

e  Save your changes and exit the BIOS Setup.

RDM remote mode

In RDM remote mode, the system boots to the hidden RDM partition and
automatically establishes a remote connection, which makes all the RDM
features available to both the RDM server and RDM station sites. However,
the RDM Remote mode can only be activated by a local operator in the
server BIOS Setup.
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Enabling remote mode
Follow these steps to enable the RDM Remote mode:

¢ Reboot the server and enter the BIOS Setup.

e  From the main menu, select the Remote Diagnostic Configuration
option.

e Set the Console Redirection parameter to Enabled.

e  Set the Dial Out Retry Times parameter to the desired number of
times the server must attempt to call the RDM station to make a
connection.

¢ In the Remote Console Phone No. parameter, enter the RDM station
phone number.

e Saveyour changes and exit the BIOS Setup. The server automatically
reboots and dials the specified RDM station phone number to
establish remote connection.

Remotely Accessing the RDM Server

Once the RDM server is rebooted into the RDM Remote mode, the RDM
server will try to establish a connection with the RDM station.

If the remote RDM connection is successfully established, you can access
all RDM utilities from the RDM station.

From the RDM station, you can do either of the following:

*  Press the Shift+1 key to view the server BIOS Setup. For details on
BIOS Setup, refer to the system's documentation.

¢ Boot to the hidden partition.

Note: RDM station supports VGA text mode only.

Exiting from remote mode

If you want to resume the server system to normal operation mode, the
server needs to exit from the RDM Remote mode.

To exit from RDM Remote mode, do the following:
¢ Run the RDM station program (See xx).
e From the menu bar, select Agent.

e Select the Reboot Agent command. The Confirm RDM Server
Reboot dialog box appears.
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e Click on Disconnect. The server system automatically reboots,
terminates connection and returns back to normal operating mode.

Note: If you click on the Keep Monitoring option, the server reboots
without disabling the connection with the remote RDM station.

RDM runtime mode

The RDM Runtime mode is the normal RDM operation mode in which the
server system operates under its installed operating system. In the event
of server system failure, the RDM driver stops sending heartbeat signals to
the RDM module which, then, takes over the control of the server system
and the COM port, and dials the pager number(s) to notify the specified
system administrator.

Activating RDM

Note: Make sure that the modems are turned ON during remote RDM
operation.

When the server system fails or hangs, the RDM driver stops sending
heartbeat signal to the RDM module. When the RDM module does not
receive any heartbeat signal for a certain period of time, RDM will be
activated. However, if the temperature of any processors in the system
exceed their limit, the RDM module will immediately turn off the system for
safety purpose.

When RDM is activated, the RDM module takes control of the COM 2 port
connected to the modem. It notifies the system administrator (through
paging) of the server failure. RDM operates according to the RDM Work
Mode specified in BIOS Setup and allows the system administrator to
access the server remotely from the RDM station.

There are two types of Runtime mode operations:
e  Runtime Reboot Mode (Reboot Mode), and
¢ Runtime Remote Mode (Waiting Mode)

The sections below discuss how each mode operates.

Runtime reboot mode (Smart Reboot)

In this mode, RDM module checks the status of all processors installed in
the server. If there is at least one processor in good condition, the server
automatically reboots. However, if the temperatures of all processors in
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the system are higher than the maximum limit, the RDM module will not
reboot the system until the temperature of at least one of the processors
returns to normal.

Note: To minimize the system down time, we recommend that you
set the RDM Work Mode parameter in the BIOS Setup to Reboot.
This setting enables the server to start paging and reboot
immediately in the event of system failure.

Enabling runtime reboot mode

Follow these steps to enable the Runtime Reboot mode:

e Enter the BIOS Setup.

¢ Highlight the Remote Diagnostic Configuration option.
e Go to page 2 of the RDM Configuration menu.

¢ Set the RDM Work Mode parameter to Reboot.

Note: After Smart reboot, the processors with very high temperatures
will be disabled. To enable the processors, you need to turn off the
system.

e  Specify the system administrator's pager number in the System
Critical Paging Number parameter. You may enter a maximum of
three pager numbers.

e  Specify the desired setting for the Paging Times parameter.

e Save your changes and exit the BIOS Setup. The server automatically
reboots and runs in Runtime Reboot mode.
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Runtime remote mode

In this mode, when the server hangs or fails, the RDM module starts paging.
Once the administrator receives the paging, he can establish a connection
from the RDM station to the RDM Server. Once the connection is
established, the Emergency Management Console appears on the screen.

|| o B

Agent Sensar System Retresh Exit
Infartnation Status Evwent Lag Status

Functions Infarmation

Agent Information ] Sensor Status | System Evert Log

BMC Revizion 019
IPMI Version 10
BMC Manufacter 1D 1050
Humber of Sensors 24
Number of Generic Devices : ]
,W Number of Management Controllers : 1
Number of Swstemn Event Log Entries : 4
SEL Total Space Size 144
Displaying
IPhl SEL Free Space Size : G048
Infarmation

Through the RDM station, the system administrator can access the
following from the remote RDM-enabled server:

e Agent Information

e System Event Log

e Sensor Status

For detailed descriptions of these items, see page 357, using the RDM
Station.

Enabling runtime remote mode

Follow these steps to enable the Runtime Remote mode:

e Enter the BIOS Setup.

¢ Highlight the Remote Diagnostic Configuration option.

¢ Go to the RDM Configuration menu.
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e Set the RDM Work Mode parameter to Waiting.

e Enter a password in the Waiting Mode Password parameter. You will
use this password to access the RDM server from an RDM station.

e  Specify the system administrator's pager number in the System
Critical Paging Number parameter. You may enter a maximum of
three pager numbers.

e  Specify the desired setting for the Paging Times parameter.

e Save your changes and exit the BIOS Setup. The server automatically
reboots and runs in Runtime Remote mode on the event of server
system failure.
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) Using the RDM station

This chapter describes how to use the RDM station.

Running the RDM station

Note: To optimize the screen resolution, select 800x600.

Starting the RDM station

In order to run the RDM station, connect to the RDM server by doing the
following:

¢ RDM station automatically starts when you run the ASM Pro console
system. To start RDM station manually, click on the RDM station icon
located on the toolbar of ASM console or select Utility > RDM Station
from the menu bar.

¢ Click on OK to continue. This process is followed by the initialization
of the modem. The message Initialize modem successfully appears if
the modem initialization is successful.

e Click on OK. The screen displays the RDM station window.

Connecting to the RDM server

To access the remote server from the RDM station, do the following:
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1. From a remote location, launch the RDM station program. The RDM
Station Utility window appears on the screen.

PRdm - RDM Station
File Edit View Settings Phone Irnsfer Agent Help

9 2¢| 207 |e |k || v | B

CLs  [connection| Help

Timer

Ready NUM

For more details on the RDM Station Utility, see section page 364.

2. Do either of the following:
e  (Click on the Connection button from the Toolbar, or
e  Click on the Phone menu and select the Agent Phone Book command

3. If the desired RDM agent icon already exists, double-click it. The
station automatically dials to the RDM agent. Otherwise, create a
new RDM agent. See section page 372 for details on creating a new
RDM agent.

4. When the call is successful, the RDM module verifies the entered
password. If the password matches the RDM agent password for
remote connection, the station automatically displays the Agent
Information window on the screen.

EMP (emergency management port) console

Once the RDM connection is established, the EMP Console window is
displayed on the RDM station screen. You may get RDM agent information
by clicking various EMP Console buttons, or perform RDM functions by
clicking on the function buttons.
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EMP console buttons

From the EMP Console window, you can do the following by clicking the
respective RDM Agent Information button:

Agent information

Displays important agent information.

Sgert
wtorton

8 |48y ob

Sensnt Refresh Exit
Infurmahun Status Event Lng Status

Functions Information

Agent Information ]Sensor Status | Systern Event Log

BMC Revision 019
TPMI Version : 10
BMC Mannfactuxer II 1050
Mumber of Sensors 24
Number of Generic Devices : b
,W Nurmber of Management Controllers il
Humber of Systern Event Log Entries : 4
SEL Total Space Size 6144
Displaying
al SEL Firee Space Size - 5045
Information..

Sensor status

Displays readings of sensors.
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g |481|<Q o8| &

Agert Sensar System Refresh Euit
Information Status Event Lag Status

Functions Information

Agert Information  Sensor Status | System Event Log

Sensor Status | Current Rea Description
@ Temper.. 000C gensnr Eype \\I’nllmge on systern board 1
& ensor Tt olt
% ‘TIETPH ? 22 S i Upper non-recovershls Threshold - 0.00
R Voltage ot Upper Critical Threshold - 394
@ Voltage . 166 Volt Upper no-critival Theschol - 362
@ Fanon . 000 RPM Nommal Reading : 3.30

F 0.00 RPM Lower non-critical Threshold : 362
%S e Lower Criticel Threshold - 3.04
: ystem Lower non-recoverable Threshold : 0.00

@5 0V 5.04 Volt

00:05:15 @12y 11.91 Valt

Displarying
IR
Information

System event log
Displays the system event log.

Sy
Sk Thy
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& |48 | < o | &

Agent Sensor Retresh Bt
Infarmmation Status Evem Log Stat

Functions Information

Agent Information I Sensor Status  System Event Log ]

Tndex | Time [ Event Deseription [
Wed May 31 11:21:06 2000 Ewent Logging Disabled Error: Log &re
Wed May 31 11:28:41 2000 Watchdog 2 Eror ;. Timer expired, mier..
Wed May 31 11:31:35 2000 Watchdog 2 Exror . Timer expired, inter..
Wed May 31 13:30:03 2000 Watchdog 2 Exror : Timer expired, inter..

(&)

Lo 13— O

<) IE

00753

Displaying
IPMI
Infarmation..

Refresh status

op Refresh the information of current hardware component (Sensors
= | status, System event logs, etc.) status of the server

Exit

If you click this button, a message box appears to ask: If you want to
Power Off or Reboot the remote server, Please click Cancel, then
select Power Off or Reboot function accordingly. If you select
Cancel, the it goes back to the EMP console. If you select OK, another
message box appears to confirm your choice, then the RDM station
automatically cuts off the existing connection with the server and allows the
server to remain available for other RDM connections.

EMP console functions

From the EMP Console window, you can invoke the following RDM Agent
Information functions:
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Power On/Off

&) Turns off the server. If you click this button, the message System
turned off appears. Simply click on OK.

Reboot

4% Displays the Reboot Options dialog box and reboots the server
according to the specified reboot options.

Reboot Options
Reboot Type R emote Conszole Options
' Smart [" Enable
r
Help | | OK | | Cancel

Save

E Saves System Event log as a file with .TXT extension.

Help
) Displays the Help information.

2

RDM reboot options

From the RDM reboot options dialog box, the following reboot options are
available:
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Smart reboot

When the Smart Reboot option is selected, RDM checks the status of all
processors installed in the server. If there is at least one processor that is
in good condition, the system automatically reboots to that processor.
After reboot, the following message box appears:

- |
& | Syztem reboot successiully :

|

| Spstem Supporting CPUs © 2

| Emisting CPUs - 2

| Available CPU Positions : 2nd

If all processors are in bad condition, a message informing you of the
condition of the processor(s) appears, asking if you still want to force to
reboot the system. Click Yes to "force" the reboot of the server. The
system will use all the processors installed in it to reboot.

Normal reboot

When selected, RDM checks the status of all the processors installed in
the server. If all processors are in good condition, the system automatically
reboots and shows the following message:

a |
&4 : System reboot successhully

| System Supporting CPUs : 2
| Existing CPUs : 2
| Available CPU Positions - 1st 2nd
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If any of the processors are in bad condition, a message informing you of
the condition of the processor(s) appears.

@ : System failed to reboot.
3 At least one CPU’s temperature is too high!!!

Spztem Supporting CPUs - 2
| Existing CPUs : 2
| Available CPU Positions  : 2nd

Click on OK, and then another message box appears to confirm if you want
to force a reboot. Click on Yes to "force" the reboot of the server. The
system will use all the processors installed to reboot.

RDM station options

From the RDM reboot options dialog box, the following RDM station
options are available:

Enable

Maintains remote connection after server reboots and allows the RDM
station to fully control the server.

CallBack

When selected, remote connection cuts off before the server reboots. After
reboot, the server dials back to the RDM station to resume connection.
This option is recommended if you want to pass the connection charges to
the server.

After verifying your settings, click on OK. The server reboots according to
your specified settings.

RDM station utility

This section describes the functions available through the RDM station
utility.
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RDM station utility menus

The File Menu
The File menu contains the following commands:

View Snapshot File... - Displays a saved Snapshot file. It is only for
RDM 4.0x Agent.

Close - Closes the RDM station window.
Shutdown RDM Station - Exits the RDM station utility.

The Edit Menu
The Edit menu contains the following commands:
Clear Window - Clears the utility screen.

Save Log File - Saves the current screen as .LOG file. This is very
useful especially if you are debugging or troubleshooting. By default,
this option is grayed out, i.e., disabled.

Stop Saving Log - Disables the Saving Log File function. By default,
this option is grayed out, i.e., disabled.

The View Menu

The View menu contains the following options:
Toolbar - Shows or hides the utility Toolbar.
Status bar - Shows or hides the status bar, i.e., the bar located at the
bottom of the utility window.

The Settings Menu

The Settings menu contains the following options:
Communication - Lets you configure the RDM station function.

Font - Allows you to change your font properties.

The Phone Menu
The Phone menu contains the following commands:

Hang Up - Disables the telephone connection. By default, this option
is grayed out, i.e., disabled. Once remote connection is established,
this option becomes enabled.

Agent Phone Book - Allows you to add a new agent. To dial to the
desired agent, simply double-click on its icon.
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The Transfer Menu

The Transfer menu enables the RDM station and the RDM server to send
and receive files.

Send File - Enables the RDM station to send files to the server.
Receive File - Enables the RDM station to receive files from the server.
Note: By default, these options are grayed out, i.e., disabled. Once
remote connection is established and server boots to hidden
partition, the options become available.
The Agent Menu
The Agent menu contains the following commands:
Refresh Screen - Updates the current screen.

RDM Station Talk - Runs the Talk utility. This utility allows the users
located at RDM station and RDM agent to communicate online.

Reboot Agent - Allows you to reboot the server from the RDM station.

Note: By default, all options are grayed out, i.e., disabled. Once a
remote connection is established and the server boots to the hidden
partition, these options become available.

The Help Menu
The Help menu contains the following commands:

Index - Displays the Help index. The index helps you to find the
information that you want easily.

Using Help - Opens the RDM online help.

About RDM Station - Displays the copyright, version number and
release date of the RDM station utility.



RDM station toolbar buttons

CLS Clears the screen.

CLS

Clears the screen.
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Connection

s

)

Automatically dials the server phone
number once the system fails. The
button becomes gray or disabled after
remote connection is established.

Talk

Opens the Talk utility. This utility allows
the users located at the RDM station and
RDM agent to communicate online.

Refresh
Screen

Updates the current screen.

Start Log

Saves the current screen as a .LOG file.
This is very useful if you are debugging or
troubleshooting. By default, this button is
grayed out, i.e., disabled. Once remote
connection is established, it becomes
available.

Stop Log

Stops the logging function. By default,
this button is disabled. Once the Start
Log function is enabled, this button
becomes available.

Send File

Enables the RDM station to send files to
the server.

Receive File

Enables the RDM station to receive files
from the server.
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Reboot Allows you to reboot the server from the
RDM station.
Help Opens the RDM online help.

&

Help

RDM station functions

This subsection describes the various RDM station functions you can
perform through the RDM station utility.

Viewing a snapshot file

This feature is only for RDM 4.0x Agent. To view a previously saved
Snapshot file, do the following steps:

1. From the menu bar, select the File menu.
2. Select the View Snapshot File command. The Open System
Information File dialog box appears.

RDM Station - Open System Information file EHE

Loak. in: i;ﬁ RO Station :j ;ﬂi’ EE_ EE

ftiger

File name: itiger Open

Files of type: iTe:-:t Files [¥.tat] ___'_i Cancel I

3. From the Folders box, select the path where the desired Snapshot file
is located.

4. From the File Name list box, select the desired Snapshot file.
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5. After making your selection, click on Open. The screen displays the

selected Snapshot file.

System Information

-
@_ Date and Time

Total Snapshots @ 0 Current Snapshot Mo

Host Mame : Tiger 1
Maoclel Matne : M194,
Server Type : Entry (2 Processors)
Location : Taipei City
Administrator : Admi 1
Phone Mumber : 56911234
E-mail Address : admil @acer .com b
Failure Time : 1995/0714 09:49:20

Accumuitaed Failure Time(s) : 640

ki

Help Frey et ]

Clearing the screen
To clear the screen, you can do either of the following:

e  (Click on the Clear button from the Toolbar.

e  From the menu bar, click on the Edit menu and select the Clear

Window command.

Saving a log file

If you want to save the current screen as a .LOG file, do the following:

1. Do either of the following:
e Click on the Log button from the Toolbar.

e  Click on the Edit menu and select the Save Log File command.
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The Save Log File dialog box appears.

Save in: | =5 My Documerts j @ ﬂ E 5

File: hame: |".Iog

Save as type: [RDM Log Files [=log) |

2. Enter afilename in the File Name box. Then specify the path where
you want to save the .LOG file in the Save in box.

3. Click on Save to save the configuration to the specified filename or
click on Cancel to disregard the entries and quit the Save Log File
dialog box.

Note: Only the current screen on display when you clicked the Save
Log File button will be saved. To save the following screens, you
must click the Save Log File button after each screen. All saved
screens will be appended to the specified Log filename.

Disabling the saving log file function
To disable the Saving Log File function, do either of the following steps:

¢ Click on the Stop Log button from the Toolbar.

e From the menu bar, click on the Edit menu and select the Stop Saving
log command.

Configuring RDM station settings
To configure RDM, follow these steps:

1. Select Settings from the menu bar.



2.

3.

4.

5.
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Select the Communication command. The Communication Settings
dialog box appears.

Speaker Wolume Qi COM Pot — [com -
Baud Rate -
W Auto Answer W Detect Dial Tone ALY

Initialize Cormmand Load Default
AT&F100x4Y1E1802 Help

Ok Cancel ‘

If the modem currently in use requires a special command for
initialization, specify the command in the Initialize Command box. We
recommend that you use the default modem initialization command.
To do this, simply click on the Load Default button.

Note: If the modem initialization fails, check your modem's manual
for the proper initialization command and enter it in the Initialize
Command box.

Click on the down arrow of the COM Port box and select the COM
port that you want to assign for the modem function.

Click on the down arrow of the Baud Rate box and select the baud
rate that you want to support. The default setting is 57600.

Note: We suggest that you leave the other parameters to their default
settings.

Setting the font properties

You can select the font that you want to appear on the RDM station window
for displaying text.

To select a font, do the following:

1.

From the menu bar, select the Settings menu.
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2. Select the Font command. The Font dialog box appears.

Font Font Style Size

Regular 14
Courier Eold 10
Courier New 11
FizedSys 12
Lucida Console
Raster Font 16

Sarnple
AaBb

Help | ol | Cancel |

From the Font box, select the desired font type.
From the Font Style box, select the desired font style.

From the Size box, select the desired font size.

2

After making your selections, the desired character type appears in
the Sample box. Verify your settings and click on OK.

Creating a new RDM agent

To create a new RDM agent, do the following:



373

1. From the menu bar, click on the Phone menu and select the Agent
Phone Book option. The Agent Phone Book window appears.

Agent Phone Book EHE

Cloge

2. Click on the Add Agent Here icon. The Agent Phone Book Setting
window appears on the screen.

This Dialog will help yon to make an agent
connection .

Agent Name : ’Gemim—
Phone Mo, to Dial = ’22—
Phone Mo, to Dial Back : ’21—
RDM Password = ’m—

[T Automatically Dial to Agent Nowr,

OK Caneel |

3. Enter the RDM agent in the Agent Name textbox, RDM agent phone
number in the Phone No. to Dial textbox, RDM station's phone
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number in the Phone No. to Dial Back textbox, and the correct
password in the RDM Password textbox.

Note: The RDM password entries must match with that specified in
BIOS.

4. If you wish to connect to the agent immediately, simply click on the
Automatically Dial to Agent Now checkbox, then click on Finish. The
RDM station automatically dials the server number. When the call is
successful, the RDM module verifies the entered password and the
following message box appears:

Dialing =l
f’i Sending station telephone no.

Access granted

Time Elapsed: xxxx

| |

5. If the password matches the server's password for remote
connection, the Agent Information window appears. This window
displays general information about the server.

6. After verifying your settings, click on Exit. The server boots according
to your specified settings.

Sending files

Note: Before you send files, make sure that the agent is in DOS
command mode and that the files to be transferred are stored on the
local hard disk.

To send files to the server, follow these steps:

1. Do either of the following:

e From the menu bar, click on the Transfer menu and select the
Send File command.

e Click on the Send button from the Toolbar.

The Open File dialog box appears.
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2. Choose the file(s) that you want to send and then click on OK. You
may choose as many files as you want. Then the Remote Directory
Path dialog box appears.

Remote Directory Path

f". Eull path name of remote directory

& |

3. Enter the directory in the server where you want to copy the selected
files in the Full path name of remote directory entry box.

4. After verifying the entered path, click on OK. The File Transfer Status
dialog box appears.

RDM Station - File Transf

File Marme I File Size Bytes Transfered...
CAPROGRAM FILES... 76803 45000

Tetminate Tetminate All 0] Eaneel

5. To stop the sending operation of the file that the RDM station is
currently transferring, click on the Terminate button. To stop the
sending of all the selected files, click on the Terminate All button.

If the file(s) already exist, a message box prompting you to confirm the
replacement of the files will appear. Click on Yes to confirm the
replacement of the file that is currently being transferred. Click on Yes
to All to confirm the replacement of all the common files. Click on No
if you do not want to replace the file.

Notice that the OK button remains grayed until the file transfer is
completed. The Cancel button becomes grayed if the file transfer
fails.
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To close the Transfer Status dialog box, click on OK. To disregard the
operation that has been performed previously, click on Cancel.

The maximum file size that can be transferred is 18 MB.

Receiving files

Note: Before you receive files, make sure that the agent is in DOS
command mode.

To receive files from the server, follow these steps:

1. Do either of the following:

¢  From the menu bar, click on the Transfer menu and select the Receive
File command.

e (Click on the Receive button from the Toolbar.
The Receive File Name dialog box appears.

Receive File Name

Full path name of remote file

@ |

Full path name of Receiving Directory

|E:\HDM

2. Enter the path where the files are located in the Full path name of
remote file entry box and then click on OK. The File Receive Status
dialog box appears.

3. Notice that the OK button remains grayed until the transfer of file(s) is
completed. To stop the transfer of file(s) or to disregard the operation
that has been performed previously, click on Cancel.

If the file(s) already exist, a message box prompting you to confirm the
replacement of the files will appear. Click on Yes to confirm the
replacement of the file that is currently being transferred. Click on Yes
to All to confirm the replacement of all the common files. Click on No
if you do not want to replace the file.

4. When the file transfer is finished, click on the OK button to close the
Receive Status dialog box.
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Note: The maximum file size that can be transferred is 18 MB.

Refreshing the screen

To "refresh" the screen, you can either click on the Agent menu from the
menu bar and select the Refresh Screen command, or click on the Refresh
Screen button from the Toolbar. This automatically updates the RDM
station screen.

Running the talk utility

The Talk utility allows the user at the RDM station to directly communicate
with the user at the server site via PC. Users at both sites can send
messages by simply typing in the text.

To run the Talk utility, follow these steps:

1. Do either of the following:

e  From the menu bar, click on the Agent menu and select the RDM Talk
command.

e  (Click on the Talk button from the Toolbar.

The Talk Utility screen appears both on the server site and on the local
site monitors.

2. Type in the messages that you want to send. The messages from the
server site appear in the upper portion of the screen, while the
messages from the RDM station appears in the lower portion

3. To exit this utility, the user at the RDM station must press Ctrl + X
keys.

Rebooting the server
To reboot the server, follow these steps:

1. Do either of the following:

e From the menu bar, click on the Agent menu and select the Reboot
Agent command.

e  Click on the Reboot button from the Toolbar.
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The Confirm RDM Server Reboot dialog box appears.

Confirm RDM Host Eeboot

fﬁ Reset the RDM Host

| Dizconnect | | Keep Monitoring | | iCancel: |

2. Click on the Disconnect button to disable RDM and reboot the server
to normal mode. Click on the Keep Monitoring button to simply
reboot the server. If you suddenly decide not to reboot the server,
click on Cancel.

3. After making your choice, the dialog box disappears from the screen
and the selected reboot option is performed.
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) SCO OpenServer, UnixWare and
Internet FastStart Installation

This appendix describes how to do a fresh installation of the SCO
OpenServer, UnixWare and Internet FastStart while preserving the RDM
hidden partition.

SCO OpenServer 5

The default option for Hard Disk Setup is Unix only: Bad blocking 0 FF. Do
NOT accept this default option. This will overwrite the RDM partition.

Follow these steps to install SCO OpenServer 5:

1. Boot the system with the SCO OpenServer boot diskette and the
SCO OpenServer CD-ROM loaded in their respective drives.

2. Follow all onscreen instructions until you reach the Hard Disk Setup
entry.

Choose Interactive fdisk/divvy.

Choose either Use the Rest of the Disk for Unix for allocating the
remaining space to Unix, or Display Partition Table to customize it.

5. Continue to follow all onscreen instructions to complete the
installation.

Note: If you are using the SCO OSR 5 Easy Install on the Startup CD,
it will automatically detect and preserve the existing RDM partition in
the system. If you are doing the manual installation, you must
perform steps 2 through 4 to ensure that you do not overwrite the
RDM hidden partition.

SCO UnixWare

Follow these steps to install SCO UnixWare:

1. Boot the system with the SCO UnixWare installation diskette and the
SCO UnixWare CD-ROM loaded in their respective drives.

2. Follow all onscreen instructions until you reach either of the following:

¢ Destructive Installation step - if you have not yet installed
UnixWare in your system. From the Destructive Installation
options listed, select Display a Screen to View/Change Current
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3.

4.

14 Remote Diagnostic Manager (RDM)

Disk Configuration. The installation program proceeds to the Disk
Partition step (see Step 3).

Caution: Do not select Use the ENTIRE DISK for UnixWare 2.1
(Erases ALL Partitions). This option will overwrite all existing
partitions on the disk (including the RDM hidden partition).

¢ Nondestructive Installation step - if you have previously installed
UnixWare. In this step, the installation program will not require
you to create a partition for UnixWare; instead, it will keep your
previous partitions and overwrite the previously installed Unixware
in your system. Skip Step 3 and proceed to Step 4.

Create an active Unix partition by editing the disk partition table
shown on the screen.

Important! The Disk Partition screen not only allows you to create
new partitions, but also displays information on the existing partitions
on the disk. By default, the RDM hidden partition information
appears as the first entry in the partitions list. This partition is
detected by the UnixWare installation program as Others. Therefore,
when creating a UnixWare partition, DO NOT select Others. Doing so
allows UnixWare to overwrite the RDM hidden partition.

Continue to follow all onscreen instructions to complete the
installation.

SCO Internet FastStart

The default option for Hard Disk Setup is Unix only: Bad blocking 0 FF. Do
NOT accept this default option. This will overwrite the RDM partition.

Follow these steps to install SCO Internet FastStart:

1.

Boot the system with the FastStart v1.0 boot diskette and the SCO
Internet Family Release 1.0 CD-ROM loaded in their respective drives.

Follow all onscreen instructions until you reach the Hard Disk Setup
entry.

Choose Interactive fdisk/divvy.

Choose either Use the Rest of the Disk for Unix for allocating the
remaining space to Unix, or Display Partition Table to customize it.
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Note: You must perform steps 2 through 4 to ensure that you do not
overwrite the RDM hidden partition.

5. Continue to follow all onscreen instructions to complete the
installation.
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) Troubleshooting

This section lists the common problems that you may encounter during
RDM operation, followed by the possible corrective action(s).

RDM agent troubleshooting

1.

The RDM Work Mode parameter is grayed out.

Check the RDM module and make sure that it is properly plugged into
its socket.

The message "No RDM Hidden Partition" appears.
Do the following:
a. Enter the BIOS Setup.
b. Set the Hidden Partition to Enabled.
Exit the BIOS Setup and save your changes.

d. Make sure that you have created the hidden partition. Refer to
section 2.2.3 for instructions. In case you need to recreate the
RDM hidden partition, do not forget to back up all important files
before you proceed. RDM partition creation destroys all data on
the hard disk due to the requirement that the RDM hidden
partition must be the first partition on the primary hard disk.

RDM station manager troubleshooting

1.

When running any DOS application that requires ALT + hotkey, RDM
station cannot transmit key to the agent site due to the Windows
operating system interception.

Instead of just pressing ALT + hotkey, press Shift + F1 followed by
the hotkey.

Shadows appear on the screen.
Do either of the following:
e Click on the Refresh button to refresh the screen.

¢ Click on the Hang-up button to disconnect.
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Modem troubleshooting

The RDM program does not run properly. Check the baud rate of your
modem. The recommended baud rate is 57600 Kbps.

Hidden partition troubleshooting

If there are bad sectors or other damage in the hidden partition, do the
following:

1. Insert a bootable diskette into the diskette drive.

2. Enter the BIOS Setup and set the Hidden Partition parameter in the
RDM BIOS to Enabled.

3. After the system boots from the diskette drive, use the Disk Repair
tool to troubleshoot the partition.

BIOS messages

The following table lists the BIOS status and error messages that you might
encounter when using RDM.

RDM Enabled But RDM Work Mode is set to Reboot or Waiting;
Modem Not Ready however there is no modem available for the
RDM module. Check if there is a modem
connected to serial port 2. Make sure that it

is ON.
RDM Dialing Out. RDM station function has been enabled.
Please Wait... BIOS will dial out to connect to the RDM
station. This process will take a couple of
minutes.

Connect Fail: Serial Serial 2 is disabled. Enter the BIOS Setup,
2 Disabled select the System Security option, and set an
1/0O port for serial 2.

Connect Fail: Modem is OFF. Check if modem is connected
Modem Off to serial 2. Make sure that it is ON.
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Connect Fail: The default modem initial command failed.
Modem Initial Consult your modem's manual. The BIOS
Command Fail default command is

AT&F1&C1VOXOM1L2S7=120

Connect Fail: NoDial Modem cannot detect a dial tone. Make sure

Tone that the telephone is working properly.
Connect Fail: Line RDM station is busy now. Wait for a few
Busy minutes, then try reconnecting.

Connect Fail: No No response from the RDM station. Make
Answer sure that the RDM station phone number is

correct.

Connect Fail: No RDM station is enabled, but no RDM station
Telephone to Dial phone number is set. Enter the BIOS Setup,

select the Remote Diagnostic Configuration
option, and enter the RDM station number in
the Remote Console parameter screen.

Connect Fail: User The key is pressed during the RDM dialing

Stop Dialing Out out process. Do not press while RDM is
dialing out unless you want to stop the
connection process.

No RDM Hidden RDM hidden partition is enabled, but no

Partition hidden partition is created on the hard disk.
Enter BIOS Setup, select the Remote
Diagnostic Configuration option, and disable
the Hidden Partition parameter. This returns
your system to its normal booting process.
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Advanced Web-based Manager (AWM) allows
you to manage your network systems on the
Internet using any existing browser. Thus,
allowing you to conveniently monitor servers on
your network without sacrificing efficiency.
AWM uses the function and feature of ASM
Console with some differences in GUI design
and item layout.
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) Installing AWM and Microsoft IIS

System requirements

Intel 486 or higher processor

64MB of RAM

10MB free hard disk space

Windows NT Server 4.0 or Windows 2000 with the following:

e Microsoft Internet Information Server 2.0 or later (4.0 is
recommended)

e  Microsoft Active Server Pages (ASP)
e SNMP Service

Ethernet card

Modem

Installing AWM

To install AWM:

1.

A S

Insert the Resource CD into the CD-ROM drive on your system.
Click on the Startup icon.

Click on Software Installer, and select AWM.

Follow the Installation Wizard.

Click Finish to complete the installation.

Note: For Windows NT 4.0, AWM will automatically install WbEM
core or WbEM SNMP Provider if not installed. For Windows 2000, the
WbEM core is built-in. AWM will only install the WbEM SNMP
Provider if it is not yet installed. After installing either of these
components, the system needs to reboot.

Setting up Microsoft IIS

Note: If you have IIS version 4.0 or later the directory is automatically
added.
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To set up Microsoft IIS:

1. Open your IIS configuration program and check the virtual directory
setting.

2. Check the virtual directory. If there is no virtual directory for AWM,

create one and name it AWM. Point it to the directory where the AWM
main files are installed (e.g. C:/AWM).

WWW Service Properties for m1d9

Service Directories lLDggmg I Advanced}

Directory | Alias | Address \ Error |
ﬁ CiAlnetPublywwnwroot <Home>»

1 iAW JAu

_1 CAlnetPublscripts /Scripts

1 CAYWINNTY Systern324inetsre/iisadmin

¥ Enakle Default Document

Default Document: Default htm

[T Directory Browsing Allowed

QK Cancel Help
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3. After adding the virtual directory, click the Execute checkbox and then
click OK to save changes and exit.

Directory Properties

Browse

Directary:

 Haorme Directary i

& irtual Directary

Alias: [/t

™ “irtual Server

L[ T 7 |

ACCESS

W Bead W Execute
-
r r
Cancel Help
Running AWM

Type this address in your browser:
http://{IPADDRESS}:9999/AWM

The password window appears prompting for authentication as shown
below.

To access AWM, enter your
:ﬁ) Please type your user name and password. user name and password and
S Resowes 210533823 then click OK.

Uszer name: ‘

AWM confirms the user name
Bassward: | and password and displays the

main page.
Cancel
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AWM user interface

AWM'’s user interface includes a series of web pages that displays system
information and configuration. The pages are designed so that each time
you click on a function it displays in a new window allowing you to view
multiple pages at a time. Shown below is the main page of AWM.

t%dvanced Web-based Management Project

Select the device you want to manage:

Or select from the list -
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ltem Description

Network topology Shows the current state of network devices allowing
you to view different portions of your network. It
also displays the gateways and subnets in your
network system. If you are using AWM for the first
time, AWM automatically discovers devices on your
network. See “Network topology” on page 393..
Note: The network views described here are drawn
by a Java Applet. If your browser does not support
applets or if there is an intervening firewall that
prevents the applet from connecting to AWM, this
view may not show up. However, you will still be
able to manage your network using the mechanism
described page 397

Event action Configures event actions that should be taken when
configuration an event occurs. Currently supporting three kinds
of actions: browser notify, send mail, and call pager

Event information Allows you to change the event information as you
configuration see fit. All events are classified by types and listed
in the left frame in tree view.

Real time event Displays history of events as they occur. This

monitoring feature is useful as a warning mechanism. It flashes
an icon on the main page to inform you if an event
occurs

Network event log Records event information and saves them to file for

future reference

Help If you don’t know what to do.....

Manage device form Allows you to directly choose which network device
you want to manage

Device Address (IP Type the name or the IP address of the device or
or Name) click the pull down menu to choose from an existing
list of devices

Add this device into Click this check box if you want to include the
the list? device name or address in the Device Address box
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Item Description

Monitor Community

and Control

Community

Manage It! Opens a management window for the specified
device

Configure It! Opens an Event Action Configuration window for
the specified device

Clear List Erases the list of devices in the device list pull down

menu




393

) Network topology

The Dynamic Network View window displays a list of manageable network
devices (left panel) and its respective properties. It also functions like a
navigation panel to your network topology. From this list you can choose
which device to manage. However, if you are using AWM for the first time
the subnet and device list panel will be empty.

| AWM : manageable device list

Retrieve Nodes | Ao Discover | Manage addnNode | DeisteMode | pemear |

17017200 295.265.0.0 = IF Address Subnethask || 1P address:

192.8.210.0  255.255.255.0 0 Subnet Mask:

i 5.0
(21063880  255.255.255.0 210.63.101.3  255.295.255.0
210 255.0

21062.101.3
21062.101.10
21062101 .41
21062.101.144 .

210.63.101.180 e ACERNT B

210.63.101.244 [T ACER-ADM

-

Mame [MONET
Manage tppe: |IF‘

[ER|ER

State: | Normal

Update

Warning: Applet Window

Using Auto Discovery to add a network device
to the Dynamic Network View

The Auto Discovery function automates the search process for
manageable network devices. It recognizes a variety of devices such as
routers, printers, gateways, etc. The process may take some time
depending on the size of your network.

Auto Discovery undergoes two processes. First, it identifies live nodes on
the subnet and then check if the node have IP Forwarding. Then it fetches
the name, number of the interface of the node. Second, it fetches the IP
table for all Gateways (IP Forwarding nodes). AWM then builds a list of the
network from the information gathered by the discovery process.
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To access the Auto Discovery function, click on the Auto Discovery button.
The Auto Discovery dialog box appears.

Auto Discovery

Subnet |D 210.63.101.0
Subnet Mask - |255.255.285.0 T

Discover Status:

09:55:33
09:55:35
03:55:36::
03:55:38
03:55:41

Warning: Applet Window

Start sweeping 210.63.101.0:255. 255, 255.0
Found node:210.63.101.3

Found node:210.63.101.10

Mo &0k agent is found

Found node:210.63.101. 41

To start the discovery process:

1. Enter the subnet ID and Mask and then click the Discover button. The
process might take some time depending on the size of your network.

2. After Auto Discovery finish detecting manageable network devices,
the Cancel button will change to Close.

3. Click the Close button to exit. The discovered devices displays in the
left panel of the Dynamic Network View window.

Changing device properties

The Dynamic Network View window displays the properties of network
devices. To change device properties:

1. Highlight the device you want to change.



2. Make the appropriate changes and click the Update button.

i AWM : manageable device list

Retrieve Nodes | AwoDiscover |  Manage | audnNoge | DeleteMote |  Deeiern |
17017200 295.265.0.0 = IF Address Subnethask || 1P address:

192.8.210.0  255.255.255.0 5.0 Subnet Mask:

(21063880  255.255.255.0 210.63.101.3 255.255.255.
55.0

21
21063101 41 I

21063101144
Tupe:

- 210.63.101.180 ACERNT -l
- Z10.63.101.244 I ACER-ADM
-
M [MOMET
Manage type:  |IF -l
State [Nomal -l
Update

Warning: Applet Window

Adding a device

To add a device:
1. Click the Add a Node button.

2. Enter the IP address, name, and type of device.

The IP Address/Subnet Mask of the new device must be
indicated.

If the new device is an IP forwarding node, then add the IP
Addresses for each interface and click the This node does IP
routing checkbox.

395

If the device happens to be one of the predefined device types,

select the correct device type. The URL/Icon File, etc. are picked
up from the device defaults configuration. In case of a new device,
give the URL of the management page and the icon file to be used

to show this device in topology views.
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+ AWM : manageable device list (O] x]
Reirieve Nodes | AutoDiscover |  Menage | AddNode | DeeteNoge |  Dereal |
7 0 IF Address | subnetMazk | = IP Address:

192.9.2100  295.235.235.0 Subnet Mask:  [255.255.255.0

21062.980 2552952450

210.62.90.0  255.255.255.0 <L Add

21062.101.0 255.295255.0

210621030 255.295245.0

210621060 255.255245.0 |

103450 2552952450 .

10.34.89.0  295.265.285.0 5EE non SNMP deviee 7]

1034910 2552852450

1034920 2552852450 L

10341000  255.255245.0

Warning: Applet Window

[ This nade does IP rauting

Harne:

Manage type: | IP

State:

Add

LefLe

| Narmal

Cancel

3. Fill up the form and click the Add button to add the device to the
database. Click the Cancel button to cancel adding device operation.

Removing a device

To remove a device, select the device to be deleted and then click the
Delete Node button.

To remove all devices, click Delete All.

information database.

This empties the whole device



) Managing network devices

There are three types of device management page available to AWM:

e Server devices that has a ASM (Advanced Server Manager) agent
installed

397

e Desktop devices that has a ADM (Advanced Desktop Manager) local

agent installed

¢ Generic SNMP (Simple Network Management Protocol) devices that

support SNMP RF1213 MIB

Depending on the system, AWM can use either types of management for a
network device. There are two ways you can manage a device. By using

Network Topology or by using the Manage Device Form.

Managing devices using the Network Topology

To manage devices using the Network Topology:

1. Click the Network Topology link on the main page. The Dynamic
Network View window displays.

|| AWM : manageable device list

Retrieve Nodes | Auto Discowver Manage Add A Hode Delete Hode | Delete Al

17017200  265285.00 =] IF Address
192.9.210.0 255255.295.0

210.63.958.0  255.255.255.0

SubnetMask || 1P Addrese
255 55.0 Subnet bl gk

210.62.101.0 265.265.255.0
----- - 210.63.101.3
- 2106310110

- 0E3101.41 |

- 210.63.101.144 o

- 210.63.101.180 ek ACERNT |

[pessmteates 210.63.101.244 R

=
M ame: [MONET
Manage lype: | IF j
State: [Momal =l
Update

Warning: Applet Window
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Note: If you are using AWM for the first time the subnet and device
list panel will be empty. See “Using Auto Discovery to add a network
device to the Dynamic Network View” on page 393..

2. Select the subnet where the device is located and then click the
Retrieve Nodes button to show all the devices in this subnet.

3. Double click on the device to manage it or select a device and then
click the Manage button. The AWM prompts a dialog box to choose
the management type.

Manage model selection

The node { MONMET J is of following types |
¥Ou can choose one type to manage as |

Types: = Generic SNMP device

Manage it Cancel

W arning: Applet Window

4. Click the management type you want to use and then click Manage It!
The appropriate management window displays.

Managing devices using the Manage Device
Form

To manage devices using the Manage Device Form:

1. Type the device name or address in the Device Address (IP or name)
field or click on the pull down menu to select available devices.

2. Set the community information if necessary and click Manage It! The
appropriate management window displays.

To add a device name or address to the device list, type the device name
or address and then click the Add this device to the list? check box. When
you click on the Manage It! or Configure It! button, the device you just
entered will be saved into the device list.

If you want to erase an existing devise name or address from the device list,
select the device and click the Clear List button or if you want to erase the
whole list simply click the Clear List button to erase.
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Dynamic graphing

Pages optionally permit real time monitoring of various device
performance. These pages contain a Java Applet to present a dynamic
graph which draws real time retrieved data.

The default polling interval is 2 seconds. This can be modified by clicking
the Set Polling Interval Button on the Graphing Applet.

-
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Links 3] Sofware Updates  &]Bestof the Web @ ]Charmel Guide @ ]Customize Links @] Free HotMal ] temel Explorer News & ]intenet Stant & Mietosoft 43 Quick Seachene [ »
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Management pages

The management pages allows you to view device information. To obtain
this information, select an option from the menu tree located on the left of
the page. The options of the Information menu vary, depending on which
of the subagents is selected.

AWM management pages can be classified into two categories:

e ASM management pages for Server devices that have ASM agent
installed

e MIB-2 browser pages for Generic SNMP devices that support SNMP
RFC1213 MIB

ASM Management Pages

Basic System Information

System page

Click the System page to view general information about the system. This
page also shows the system’s contact person, network address, and
System Agent version.

| [ weEL
210.63.101.3:Basic System Information
- System Information
Operating System Contact person [
Network Address 210631013

— Hardware

Environment Operating System Windows NT 40 (build 1381) Service Pack 5
| pmiBIOS Computer Time Wed Oct 20 09:57:43 1999

Hiomon [N - 1 1 01

Information -
[ASM Agent Version version 2.0

I atam Ramon w Subrit | Refresh SetRefresh Interval
Information

Storage Information [ \‘5@)
F Hep

Utilization

Network Information

Machine page

Click the Machine page to view general information about the system’s
components, such as: Base Board, CPU, BIOS, and Physical Memory.
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[ [WeiLcome

—Basic System
Information

210.63.101.3:Basic System Infermation
- Machine Information

@ Base Board
Manufacture ACER
Product Name. MilA
T 7101011

— VO Paripharal @BI0S

Vonior ]
— Netwark Inform: RelsaseDaie 06/05/96

— SystemResource ACRIFEN0-I08-961 106-R01-B5
information

|~ Operating System

— Hardws
Environment

— DMIBIOS.
Information

| Storage Information @cpu

Current Speed Extemal Clock
200 &6

— Utilization Tntel Future ¥86 Class CPUs

@ Physical Memory

Total Memory Maximum Memory Capacity. Memory Slots No. HMemory Slots Used No.
& 3

160 ME 3AME
Refresh Set Refresh Interval

Manager page

Click the Manager page to view information about the person in charge of
the system.

— Basic Systam ) )
Information 210.63.101.3:Basic System Information
» - Manager Information

Manager Name

|— Operating Systsm

{— Hardware Office Address

Environment

Office Phone
— DI BIOS.
information

Home Address

— 1O Paripharal
Information

Home Phone

— Network Information [HLED

| System Resource
Information

‘— Storage Information Submit | Refresh SetFefresh Interval

I Utilization

Operating system

User page

The User page displays the number of users currently logged on to the
server.
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=20
Basic System
’7‘""’""’""" 210.63.101.3:Operating System
|— Operating System - login User
Chi Number of User: 13
e | UserName | LoginTime |
Environment HWVIEWS Thu Qct 14 10:00:42 1993
| owi Bios ARRAT Mon Oct 12 17:54:49 1999
information ARRATsichic Mon Oct 13 175506 1992
A — TEPE_E03574WGOLDEN Wed Oct 20 02 4035 1999
information TPE,_F06592 Wed Oct 20 03:53:37 1999
Ao TPE_E06992ed Wed Oct 20 03:53:37 1999
TEE_E04299 Wed Oct 20 09,10:13 1992
2 niancs TPE_EN4300%slyman Wad Cot 20 09:10:13 1959
information =
TPE,_EDSO72WPAUL Wed Oct 20 09:44:43 1999
[— Storage Information TPE_D19953 Wed Oct 20 02:43:47 1959
TEE_D19963curtis Wed Oct 20 09.50:36 1909

ARRAY Wed Oct 20 09:51:08 1959

Drivers page (only available for Windows NT operating systems)

The Drivers page displays all the device drivers installed in the server. It
also shows the total number of drivers installed in the system.

|
Basic System B
’7‘""’""’""“ 210.63.101.244:Operating System
|— Operating System - Driver
LRUPS
Humber of Driver: 41
- Hardvars
Environment Afd AFD Networking Support Environment
| omiBIOS aicT8c T8
Information AMDFCH AMD FCNET Family Ethemet A dapter Driver
— 11O Peripharal Sl S
information A spi32 Aspi32
| Asynchac Remote Access Mac
atapi atapi
[ EYAin EenaLs AW HOST AW HOST
information = o
Eeep Beep
— Starage Information Cdrom Cdrom
- DC21E4 DEC DC2154 4 dapter Diver
I— Utilization

Disk Disk
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Hardware environment

WELCOME

Basic System

Information 210.63.101.244:Hardware Environment
Operating System

Hardware
Environment

9 Chassis, RDM, Fuse

Chassis Status

RDM Status

Fuse Status \}’)
Mot Avaiable

— DMIBIOS
Information

' UO Peripheral
| Information
' Network Information
| @ power Status
| system Resource
| Information

Power Supply e LS|

i) & ))
“ Mot present.

"ot present,

€y (1)
Not present. Not prasent,

Caution: The events described in the following sections that
generate alerts are critical. If any of them occur, correct the problem
immediately, as damage to your system may result if the problem is
not corrected.

| Storage Information

| Utilization

Power status

Shows the condition of the power supply and its cooling fan. Whenever
either one is not working, an alert is generated.

CPU and system voltage

The voltage for each CPU and system power source is shown here. An
alert is generated whenever the voltage is out of range.

Fan status

The fan status is monitored through the hardware module of the system; no
user configurable setting exists. An alert is generated whenever the fan is
not working.

Temperature

The CPU temperature is monitored in two stages. First Console will give
out a warning when a rise in temperature is detected. If the temperature
continues to rise, a temperature critical alert is issued. In some models,
you can set the threshold values in the BIOS setup.
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DMI BIOS Information

BIOS

The BIOS page displays general information about the BIOS version
installed in the system. It also shows the type of hardware supported by
the BIOS. The check marks show the supported bus, function, boot

device, int13 floppy status, and other services based on the DMI
specification used.

210.63.101.244: DMI BIOS Information

- BIOS
~ Hardware
Environment Bios Vendor ACER Starting Address Segment
~ omisios Release Date Wz rowsice ]
T ;=151 17T
Boot Support | Bus | Other feature Support
% Selectable Boot 2 % Plug and Play
7 COROM I EsA TS e
I~ FOMCIA ol ¥ Upgradable BIOSfash]
vices o I mca F Shadow BIOS
10 Peripheral Cisam ™ VLVESA ¥ ESCD
information
I~ ATAPIZip ™ PCMCIA
~ Networ tion
I use I~ scrr
Systom o
e e ™ AGP ™ Smart Battery
Storage Information I use ¥ EDD Specificstion
¥ BIOS ROM is socksted
~ Utiization

Base board

The Base Board page shows the manufacturer, product name, version and
serial number of the base board.



405

=2
210.63.101.244: DMI BIOS Information
- Base Board
Manufacture Acer
Product Hame MILE
Version -1

Refresh | Set Refresh Intensal ]

@Help

Processor

The Processor page shows the type, speed, version number, and other
information about each CPU on the server.

fo Conf

210.63.101.244: DMI BIOS Information
- Processor

@ cpu

Upgrade V[l"al]E External Clock Current Sp4

Central Processor Oither Intel Other
@ Socket

[ Socket | PD | vesion | ____ _____Stus]

CPU Bocket: Unpopulated
AlleDiIneRan : CPU 3atus: Enabled

Fefresh 1 Set Refresh Interval J

Memory

The Memory page displays information about the memory controller and
the memory module.
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210.63.101.244: DMI BIOS Information
- Memory
@ Memory Controller
Error Detect Method Ad-hit ECC
e Y e Bit Extor Conrecting
Supported Interleave Unknowen,
Comentinerieave [
Max. Memory Size 324MEB
Memory Module Voltage 33V
# of Assoc. Memory Slots 3
@ Capability
™ 30ns I Standard I BIMM
™ 60ns [ FastPage V¥ DIMM
™ 70ns " EDO I" Burst EDO
The Cache page displays attributes of CPU cache devices.
210.63.101.244: DMI BIOS Information
b - Cache

Installed Supported SRA]
e O T Il

Wnte

Internal Enabled 3ZKB 3ZKB Unknown
Wnte
BL12L1 2 No Internal Ena‘uled S513KB 513KB Fipeline Burst
Refresh ] Set Refresh Interval

s'@.
Help

Slot

The Slot page displays information about different slots on the system
board, including the type and availability of each bus. Please refer to the
EISA or PCI specification for definitions of the slot IDs.
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=
210.63.101.244: DMI BIOXS Information
- Slot

Mlﬂl

PCI 32hit Inuse HalfLength 1 Prowvide 5.0 Valts
P2 PCI  32bit Inuse Fulllength 2  Provide 5.0 Vaolts
3 PCI  32hit Inuse FullLength 3  Prowide 5.0 Valts
P4 PCI  32bit Available FullLength 4  Provide 5.0 Valts
B3 PCL  32bit Acvailable FullLength &  Provide 5.0 Volts
u [34  16hit Unknown FullLength  N/& Prowide 5.0 Volts
2 34 16bit Unknown FullLength  N/A Provide 5.0 Volts

Refresh Set Refresh Interval

Help

Connector

The Connector page displays information about the motherboard
connectors.

]
210.63.101.244: DMI BIOS Information
- Connector
| _Internal | Type | Extemal | Type |

Hone SERIAL PORT 1(C DED pin male Serial Port 166504 Com
Hone SERIAL PORT 2(C DB pin male Serial Port 166504 Com
Hone PRINTER{CHE) DEBZ5 pin female Parallel Fort ECP/EPP
Hone EEVBOARD(CHY) PEs2 Keyhoard Port
Hone MMOUSECHS) Pa2 Mouse Port
Hone U3E Fort(CHT) Other UsB
Hone USE Port(CHT) Other UEB

Refresh ‘ SetRefresh Intenval

\\s’} Help

Onboard device

The Onboard Device page displays information about devices found on the
motherboard.
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210.63.101.3: DMI BIOS Information
- Onboard Devices

BCEI Enabled OnBoard 3CEL Adaptec 7380

Refresh 1 SetRefresh Intensal 1

Help

I/O peripheral information

Displays Peripheral information like keyboard, mouse, serial ports, parallel
ports, video ports, and etc.

210.63.101.3: I'O Peripheral Information

Keyhoard e

ouse 8

Serial Port 165504 Compatible DB9 pin male
Sesial Post 165504 Compatible DE9 pin male
Pasallel Port ECE/EPE DB25 pin female
Video Type RISIUIELS

Refresh | Set Refresh Interval

@
Help

Network information

This page displays information about some of the network interface cards;
not all network cards provide this type of information.
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WELCOME

Basic System
Information

Qperating System

Hardware
Environment

DMI BIOS
Infermation

11O Peripheral
Information

Network Information

System Resource
Information

Storage Information
Utilization

Backplane Board

Mylex

iPMI

ILCTRTN DONUT

Dom:

@ Basic NIC Controller Information

0 Memory
Model Hame MACAddres e M@

Ethemet 1016 82358 Fast Bthemet LAN o0 nopoeynppnnn 53 nsn W/a A NP
Matherboard

@ Additional NIC Controller Information(v4.00 only)

IP Address| Net Mask NIC Driver |NIC Driver Version|

10MB/s 10349280 2552552550 1034521 EIO0BNT SYS 4.02.25.0000

@ DNS Table(v4.00 Only)
Index[DNS Server Address|
10341250

2063562
203.67.198.250
2063521
120.175.55.244
1689511

[P R Y

Fefresh I Set Refresh Interval

System resource information

System Resource Information consists of four pages: IRQ, DMA, I/0 Port,
and Memory Address. The following sections briefly describe each of
these types of resource information.

Basic System
Information

Operating 5

Hardware
Environment

DMI BIOS
Information

WO Peripheral
Information

Network Information

System Resource
Information

Storage Information

Utilization

IRQ information

10.34.92.89: System Resource Information

-Resource
Number of Entries: 8
Driver Name
atapi 14 Mf& OLF0-01F7,03F6-03F6 HiA
E100E 31 MfA 7080-708D 82300000-8830001D;88200000-22200010
Flopper 06 02  D3F0-03F3;03F7-03F7 Hi&
804200t 01;12 M/fA  D060-0060,0064-0064 HiA
Farport His Nis 03780374 HiA
Serial 04  MfA D3FE-03FE Hi&
Serial 03 MN/& DZFE-02FE Hi&
Vgalbave Hi& Mf& 03B0-03EB;03C0-03DF;01CE-DICF 000A0000-000EFFFF

Refresh Set Refresh Interval

Help

This screen displays a list of each IRQ and its assigned usage in the
system. It can be used to detect a hardware interrupt conflict.
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r— Basic System
Information

10.34.92.89: System Resource Information-IR(}

|— Operating System

Number of Entries: 7

I— Hardware
‘ Emvironment | mo | Descripion |
- Dmi Bios ! EIE
‘ Information 3 Berdal
| 1[0 Peripheral 4 Serial
‘ Information 6 Floppy
— Network Information B i
| 14 atapi
|— System Resource 5 EL00B
Information
Fefresh | Set Refresh Interval

@
Help
|— Storage Information

= ization

|— Backplane Board

DMA information

This screen displays all the DMA channels used by each device in the
system.

— Basic System
Information

10.34.92.89: System Resource Information-DMA

— Operating System

L v
lardware

Environment E Floppy

— DMI BIOS
Information Fiefresh l Set Refresh Interval |

— UO Paripheral ==
Information Fﬁ‘?}

— Metwork Information Hel

— System Resource
Informatien

‘7 Storage Information

‘7 Utilization

Backplane Board

— Mylex

I/O port information

This displays the range of port addresses occupied by the system
resources.



— Basic System
Information

— Operating System

— Hardware
Environment

— DMI BIOS
Information

1O Peripheral
Information

— Network Information

‘ System Resource
Information

— Storage Information

— Utilization
— Backplane Board

— Mylax

Memory address

411

10.34.92.89: System Resource Information-I'C Port

Number of Entries: 47

~ g Description
0

Ol 050 i8042prt
Oxid Oxid i8042prt
0378 0374 Parport
0:3F8 0:3FE Serial
0:2F% 0:x2FE Serial
0x7080 027080 EI00E
0x3F0 0:5F5 Floppy
0x3F7 0:3F7 Floppy
0x1F0 0x1F7 atapd
0x3F8 0:3F6 atapd
0:3C0 0z3CF S3lne
0304 0:3DB S3lne
Ox42ER Oxd2ER S3lnc
Oxd4ER OxdAES S3lne
OxBZER 0zE2EB S3lne
OxBEER 0zB6EB S3lne
OxBAER OEAER S3lnc

This displays the system’s base memory usage, including the address, the
length, and its description.

[— Basic System
Information

Operating System

Hardware
Environment

DMI BIOS
Information

O Peripheral
Information

Network Information

System Resource
Information

Storage Information

Utilization

Backplane Board

10.34.92.89: System Resource Information
-Memory

Number of Entries: 6

0x22300000 - 0xE2300010 OxlE E100E
0x82200000 - 0xE8200010 OxlE E100E
OxA0000 - DxAFFFF 010000 B3lnc
0x24000000 - 0xE7FFFFFE 04000000 B3lne
0xC0000 - DxCTFFR 02000 B3lnc
OxA0000 - DxBFFFF 0:20000 Vgalave

Fefresh I Set Refresh Interval

s@mm

Storage information

The Storage Information page shows information concerning the size, type,
and controller of all physical and logical hard disks that are configured on

the system.
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Physical disk

Physical disk indicates the number of actual hard disk drives installed in a
system. Each hard disk drive is connected to an adapter that controls
them.

Note: The physical disk screen for the desktop systems differ slightly
from the screen shown here but the functions are the same.

Click Refresh to update the information on the screen.

- ASM Management Pages - Microsoft Internet Explorer

Fie Edt

o Favoites Help
DR AEPR HBH

Links 3] Software Updates &]Best of theWeb & ]Channel Guide 4 ]Customize Links & JFree HolMail & ]Intemet Explorer News & Jintemet Stait - &] Microsoft 8 Quick Search.exe [ »
Address [£] htip://21083. 101 |_Pages/ASM_Main asp?C: 1013 |

| [ WELCoOouE N

pie

Basic System
information 210.63.101.3: Storage Information-Physical
Operating System

= @ Floppy Controller:

a Mot present
b Hot present
@ s1c78x%:
1. Conteoller
e | st ] __vorer | ____empt | _oua_]
e i 07200 o i sicTix
2 Device
[____twe 1D [ Sizes) |
Hazd disk 0z FUIITSI M2952Q-512 0142
e Hazd disk 1 awee SEAGATE STI21S1W 0526
Hazd disk 2 zasan FUIITSI M2952Q-512 0142
Hasd disk 3 s IEM DDRS- 245600 5078
Haxd disk 5 szor ACER ACER AAZI0ZRS 0211

Refresh SetRefrosh Intenval
Help

&]Done & Intemet zone

Logical disk

Logical disks are created when you separate a hard disk into several
partitions and designate each of them as an independent logical drive. This
window shows you information about each logical drive created on the
hard disk drives.

Click Refresh to update the information on the screen.
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7 ASM Management Pages - MictosoltInternet Explorer

Fle Edt Yew Go Favores Hep
€+ QRNA AEIR IJBG
Links 2] Software Updates @]Best of the'web €] Channel Guide @] Customize Links ] Free Hothdail @] Intemet Explorer News @ lntermet Stat @ JMiciosoft 48 Quick Search exe [ »

Address [E] hp/721063701 {_Pages/aSM_H C: 631013 -

| [WELGCOWME |

Basic Systom
information 210.63.101.3:Storage Information
Operating Systam ~Logical

Humiber of Volumn: 7

MS-DOS_S[FATICY 104170 25090
NT SYSTEMNTES|DY 1028128 08714
ASMEADM SRCNTFS)ES 1212875 7461
FTPNTFS]EY 2377424 79660
VSS[NTFS](GY 2449972 1529060
BACKUP[NTFS]Q) 2088416 464528
RAIDNTFSRY 2916040 2592160

Retresh SetRefresh Interval
@

Help

Utilization

ASM monitors the performance of each agent periodically and sends this
information back to the ASM Console. The polling interval of the Console
can be configured to check the agents whenever the system administrator
chooses.

Polling interval

The polling interval determines how frequently the Console polls the Agents
to update its data.

To change the polling interval, type the number of seconds and then click
Set Polling Interval. The polling intervals must be from 1 to 60 seconds.

Processor utilization

This page displays a line graph showing the current load of each CPU
(Central Processing Unit) installed in the system. This can be used to
indicate how much load the system has and how well the system’s
processing power is handling the load.
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/A ASM Management Pages - Microsoft Internet Explorer

Fe Edt Vew Go Favoies Hep

G+ QERRAEIE HBS
Links (2] Software Lipdates @ 7Best of theWeb & ]Channel Guide ] Customize Links & JFree HotMail £ ]Intemet Explorer News €] Intemet Sttt @ Microsoft 4% Ouick Searchese [BF »
Adhess [E] b 4721063701, /M /5.5M_Fages/iSM_Main asp7Cx 103 -

WELCOME | [WELCcoOWE

Basic System
r"'"""“""" 210.63.101.3:Utilization
— Operating System -Kernel Utilization

Environment

L owsios @ CPU #0 Utilization
Information 101
€D
| 10 Paripheral o
Information 0
B0
I Network Information gg
|- Systom Resource 2
information. £

= A e g e
= SetPolinglnterval [[2 finsecond)

| storage Information

Utiization

\9:} Help

&]Done (@ Intemet zone

PCI bus utilization

This page displays a line graph showing the current load of each PCI
(Central Processing Unit) bus installed in the system.



415

23 ASM Management Pages

File Edt Yiew Go Favoites Help
e QR AESY DS

Links (2 Software Updates  @8]Best of theweb @8 Channel Guide £ ]Customize Links & ]Free Hotail @]Intemet Explorer News @] intemet Start - 48 ]Microsoft 48 Quick Searchexe  [Bf »

Address [&] /721063101 _Pages/ASM_Main asp C: 631013
| [(wetcowe ]
Basic System
’7‘""”"“""" 210.63.101.3:Utilization
Operating System -Kernel Utilization
— Hardware
Environmant
e @ CPU #0 Utilization
Information
a0
— 1O Peripheral 80
[ 70
&0
= 50
Network Information o
— System Resource o
information &l

o o A e L e

i
e éﬁé‘;‘é s SetPolingInterval  [[27 fin second)

— Storags information

— Utilization

Q«?:i’) Help

£]Done & Intemet zone
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Memory utilization

The Memory Utilization page shows a graph that measures the utilization of
system memory and memory paging along a time line. It also displays

information like the utilitzation percentage of used and unused memory in
a system.

/3 ASM Management Pages - Micrasoft Intemet Explorer _[5]
Fle Edt View Go Favoiles Hep

QR AEIR | HABRS

Links 3] Software Updates & 1Best of the Wsb & ]Channel Guide & Customize Links & ]Fres HoiMail & Intsmet Explorer News €] Intsmet Start & |Miciosoft 4 Quick Search.exe [ »

Address [E] bipr//21063101.1 M JASM_P ages/ASM_Main asp7C =11Address: 1013 |
Basic System e
i 210.63.101.3:Utilization

I ereting Sy _Memory Utilization

— Hardwara
Environment @ Graph

— DI BioS
information 1 Memory Usage
O Paripheral
information
Network Information

| Systom Resourca
Information

— Storage Information v ; n n 5 5

] T ki i z1)
Utilization =i SetPolingInterval [z (in second)
. 2. Pages
0
1]
11
w
g
5
# i
\&n
[ T e b T L iy
gl féu e S
= SetPolingInterval |2 (in second)
@ Dnformation
[Total Memory(KB) 163840
Used MemoryiKB) 21828 8
T — . . =
] Applet started

& Intemet zone
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Storage utilization

The storage utilization page shows the utilization information of your
storage devices and file systems. For the file system utilization, you can set
a threshold to warn you of excess value.

Edit TView Go Favorits Help
@ - 0RWARIR | ABSGH

Links

Address [] hip #210.63 D8 238 /awmasm_pagesASM_Msin sspfaddres=210 63 101 216 ]
| [(Wwetcowme §
—Basic System
Satormation, 210.63.101.216: Utilization
| Oparating Systam -Storage Utilization
— Hardwara
Environment @ Disk.
- omi Bios .. |Disk ! Operation|
Information Diskp, e e [Py e </ Vet | yiea/ e wnerie e}ty s | SecandsfVtte | Scconla Transfoe| W acs
Type [ ransfered(Transfered| R
1O Peripheral
Information e
0 o i 0 m m m 7 m 77 W
Network Information disk
-
— System Resource ROMO 0 o 0 m m m 77 m 77 W
laformation s
— Storage Information
@ File System
[Total Size(KB)|Used Size(KB)|Uiilization(%0)| Thresholi(%)
U =d
WINNTCC) 1023824 720020 7076 100 | mF
=
APDY 10397 5315% EEN 0 —
Submit | Refresh | SetRefresh lerval
@
Hetp
« | i

(& Internet zone

MIB-II configuration information

This section includes specifications about MIB-Il (Management Information
Base), a database of objects that can be monitored by a network
management system. Both SNMP and RMON use standardized MIB
formats that allow any SNMP and RMON tools to monitor any device
defined by an MIB. For more information about each network working
group, please refer to RFC1213.

The following sections describe the Information menu options that display
when an MIB-Il subagent is selected in the System Listing window.

System information

Implementation of the system group is mandatory for all systems. If an
agent is not configured to have a value for any of these variables, a string
of length 0 is returned.
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= et
Fle Edit ¥iew Qo Favortes Help
2 ORNAOEIR HBGH
Links
Address [£] hep:210 63,0

) Pageeihdib2 | 1013 |

[ System
Information 210.63.101.3: System Information

Interfaces
e Hasdhwase: 186 Fanily 6 Model | Stepping 7 AT/AT COMPATIELE - Software
itk bt R Weindows NT Version 40 (Build Number. 1381 Uniprocessor Free )
SysiemOblace 1361413111313
Identifier

System Up time (imo  [Su—"
since last reboot)
System Contact person

Address
Translation Table

IP Group

icMp.

T

System Location
[Symom soriees (0

Submit | Refresh Set Refresh Lnterval
Help

Parameter Description
System A textual description of the entity. This value should include
Description the full name and version identification of the system's

hardware type, software operating-system, and networking

software
System Object The vendor's authoritative identification of the network
Identifier management subsystem contained in the entity. This value

is allocated within the SMI enterprises subtree (1.3.6.1.4.1)
and provides an easy and unambiguous means for
determining ‘what kind of box’ is being managed. For
example, if vendor ‘Jayson, Inc.” was assigned the subtree
1.3.6.1.4.1.4242, it could assign the identifier
1.3.6.1.4.1.4242.1.1 to its ‘Ann Router’

System Up Time  The time (in hundredths of a second) since the network
management portion of the system was last re-initialized

System Contact  The textual identification of the contact person for this

Person managed node, together with information on how to contact
this person
System Name An administratively-assigned name for this managed node.

By convention, this is the node's fully-qualified domain
name
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Parameter Description

System The physical location of this node (e.g., ‘telephone closet,
Location 3rd floor’)

System Services A value which indicates the set of services that this entity
primarily offers.

Layer functionality:
1 - physical (e.g., repeaters)
2 - datalink/subnetwork (e.g., bridges)
3 - Internet (e.g., IP gateways)
4 - end-to-end (e.g., IP hosts)
7 - applications (e.g., mail relays)

Interface

Implementation of the Interface group is mandatory for all systems. Click
the Details link to display the Details Interface Information page.

Ele Edit Yiew Oo Fovorbs Help

¢ > 0RMOEIE DBS

Links

hddress [ htp 121063 06,238 /awn/Mib2_PagesiMib2_Main asp?Address=210 63101 3 K|

System Detailed Interface Information =l
Information
— Interfaces

e e—
NSTOP Longhackintstcs
T
=
-
[Maximum Transmission Unit 1500
[SpeediBits Per Sec) 10000000
Stitos sstaangalin |
Input: Bytes received 15483

nicast packets received 193

unicast packets received i

iscarded packels [

nknown protocel packets

[Output: Bytes sent 483

- Address
Translation Table

|~ 1P Group

—cmp

utput: Unicast packets 93
[Output: Discarded packets
[Output: Queue length
[Media specific MIB 01D

< GoBak | Refresh | SetRefrosh uerval |

®..

1}
o
1
1
e e
0
o0
o
0.

0
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Parameter Description

Description A textual string containing information about the interface.
This string should include the name of the manufacturer,
the product name and the version of the hardware interface

Media Type The type of interface, distinguished according to the
physical/link protocol(s) immediately "below' the network
layer in the protocol stack

Administrative An administratively-assigned name for this managed node.

Status By convention, this is the node's fully-qualified domain
name

Operational The current operational state of the interface. The testing

Status (3) state indicates that no operational packets can be
passed

MTU The size of the largest datagram which can be sent/

received on the interface, specified in octets. For
interfaces that are used for transmitting network
datagrams, this is the size of the largest network datagram
that can be sent on the interface

Speed The desired state of the interface. The testing (3) state
indicates that no operational packets can be passed

Media Address

Status Last

Change

Input: Bytes The total number of octets received on the interface,
Received including framing characters

Input: Unicast The number of subnetwork-unicast packets delivered to a
Packets higher-layer protocol

Received

Input: Non- The number of non-unicast (i.e., subnetwork-broadcast or

Unicast Packets  subnetwork-multicast) packets delivered to a higher-layer
Received protocol
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Parameter Description

Input: Discard The number of inbound packets which were chosen to be

Packets discarded even though no errors had been detected to
prevent their being deliverable to a higher-layer protocol.
One possible reason for discarding such a packet could be
to free up buffer space

Input: Received The number of inbound packets that contained errors
Error preventing them from being deliverable to a higher-layer
protocol

Input: Unknown

Protocol

Packets

Output: Bytes The total number of octets transmitted out of the interface,
Sent including framing characters

Output: Unicast The total number of packets that higher-level protocols
Packets requested be transmitted to a subnetwork-unicast
address, including those that were discarded or not sent

Output: Non- The total number of packets that higher-level protocols

Unicast Packets  requested be transmitted to a non-unicast (i.e., a
subnetwork-broadcast or subnetwork-multicast) address,
including those that were discarded or not sent

Output: Discard The number of outbound packets which were chosen to be

Packets discarded even though no errors had been detected to
prevent their being transmitted. One possible reason for
discarding such a packet could be to free up buffer space

Output: Transmit ~ The number of outbound packets that could not be
Error transmitted because of errors

Output: Queue
Length

Media Specific
MIB OID
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AT (Address Translation)

Implementation of the Address Translation group is mandatory for all
systems. Note, however, that this group is deprecated by MIB-Il. That is,
it is being included solely for compatibility with MIB-I nodes, and will most
likely be excluded from MIB-Ill nodes. From MIB-IIl and onwards, each
network protocol group contains its own address translation table.

El Efit Yew Go Favories Help

2D ARSI HBSHA

Links

Address [&] hip:1e21053 9 Pagesihib_biad 651013 =l
—
[— Svstem
LA 210.63.101.3: Address Translation Table
Interfaces
s Interface Index Media address Network aiddress
Translation Table 3 210631011 00:2000:08:a7:42
g 21063101109 Q06067706450
1P Group
g 2063101127 0000621 5:0418
3 21063101154 00606706271
i 3 063101157 00:6067:36:31:5%
3 2103101 226 00:200sf ) 3ich
3 21063101 244 00:00:2:03:¢7:c1
3 21063101246 0:00:2:0c5k ad
Refresh Set Refresh Interval
Help

The Address Translation group contains one table which is the union
across all interfaces of the translation tables for converting a Network
Address (e.g., an IP address) into a subnetwork-specific address. This
document refers to such a subnetwork-specific address as a ‘physical’
address.

Parameter Description

Media Address The media-dependent ‘physical’ address

Network Address The NetworkAddress (e.g., the IP address)
corresponding to the media-dependent ‘physical’
address

IP (Internet Protocol)

Implementation of the IP group is mandatory for all systems.



IP Protocol configuration page

| B Edt Yiw Go Fevots Help “

BN BEmBY ARG

& -
Links

Acdress [ hitp #2106 08,238 /awimiMib2_Pagesihib2_Msin asp?Addrese=210.63.101 3

Information 210.63.101.3: IP Protocol configuration

Interfaces

Address Forward IP Datagrams Between IP Interfaces? ot forrarding

Transiation Table Default Value of Time-to-Live 128

Refresh Set Refresh Interval
@ Help
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Ele Bt Vv Go Fovorts Help _
&2 0EABESE DB
Links

WELCOWE

[ System
Information 210.63.101.3: IP Statistics
Interfaces

Input: Datagrams received 1425676
Address errors 6742
Datagrams forwarded i
Unknown protocols [

it Datagrams uiscardes

input: Datagrams delivered 1299213

[output: Datoyrams wiscarges 0

[outout: Rumbe of ruring fafares [

Reasserblytmeous 1

Reassomblysuccesses |

Address
Transiation Table

IP Group

ragmematmn failures
[Number of fragments

Refresh SetRefresh Interval
Q..

| @ Internet zone

IP Address table page

The IP address table contains this entity's IP addressing information.
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=

t View o Favores Help
2 QRN AEIY IR

Links

Address [@] hitpe2110 63 5  PagesMib2_| 1003 E|
System
Information 210.63.101.3: IP Address Table
Interfaces
1P drass Broaicast Addross
Translation Table 127001 1 255000 1 65535
1929.2101 2 255.255255.0 1 65535
21063.1013 3 2532552350 1 65535

Refresh Set Refresh Interval

#13 ARD Tak

IchpP

IP Routing table page

The IP routing table contains an entry for each route presently known to this
entity.

Fle Edit View Oo Fovorts Help

-0 004 AEBY DB S
inks

Li
Addeess [] hit #2106 98.28)ewrm/Mik2_Pogeadit2_Moin asp?Addrms=210 63101 3

Information
Interfaces

- Address
Translation Tahle
Interface| Next hop [Route |Routing Routing

Destination |
index

1P Group

0000 21063.101 1 indirect local 330603 0000
o i, 127000 1 127001 direct. 330809 1 -l -1 -1 -1
local 2552552550 00
il 19292104 1 127001 disect 9603 1 [ -1 i o
focal 255255255255 0.0
210631010 3 21063101 3 direct 339603 1 -l -1 -1 -1
local 255255255255 00
21063101255 3 21063.101 3 direct 330603 1 -l -1 -1 -1
local 24000 00
2352552552552 19293101 direct. TI63 255.255.255.255 011 1 [ 4 g 4

Refresh Set Refresh Interval

(& Internet zone
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Ele  Edit

Vv Go Byt Help
QRN AEIY TBGH

Address 2] htpA210.67.28.

! Pages/Mib2 ) 1013

WELCOME

ystem
Information
Interfaces

- Address
Translation Tahle

3
3
3
3
3
3

00:20:9c:08:a7 42
00:60:67 70:645a
00:00:62:15:04:18
00:60:6708:Fa 71
00:60:67:36:21 5
00:20:af dD:3bch

|

210.63.101.3: TP ARP Table

210631011 dynamic
210.62.101.109 dynamic
21063101 127 dynamic
21063101 154 dynamic
21063.101.157 dynamic
210.63.101 226 dynamic

ICMP (Internet Control Message Protocol)

Implementation of the ICMP group

is mandatory for all systems.

Ele  Edit

> QM AEBSE | HBS A

Yiew o Favorts  Help

Links

Address (] Mtp1210.62 08 2380 miMib2_PagesMib2_Main asp”hddress=21063.101 3

System
Information

| Interfaces

| Address
Translation Table

1P Group

210.63.101.3: ICMP Input Statistics

WELCBM

[Numbh

i 714
Errors 1
n unreachablesfed
ime exceeded eors I
arameter errors o
ource guenches 0
e o
cho requests. 3499
cho replies
ime stamp requests
ime stamp responses
ddress mask requests
ddress mask responses

Refresh Set Refresh Tmerval

0
0

[i
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3 Enhanced ages
Fle Edit View Go Favosles

15 Advanced Web-based Manager

Help

5 010 AR3Y HBRS

Links

| Kidmse |27 hpuzi0 638

1013

! PageslMi2 )

system
Information

- Interfaces

- Address
Translation Table

IP Group

icMp

@Hﬂp

szcoM

210.63.101.3: ICMP Output Statistics

Fros
[Fime excecded crors ]
Farmersr oo ]
[Soure quencies
Redes 1
oo reuess——— E
[rime stamp revests ]
[T stamp rosponses ]

™

ddress mask requests |3
[Address mask responses [

Refresh Set Refresh Inverval

Parameter Description

Input/Output Number

of Messages

The total number of messages which the entity
received/sent. Note that this counter includes all
those counted by InErrors.

Input/Output Errors

The number of messages which the entity received/
sent but determined as having -specific errors (bad
checksums, bad length, etc.).

Input/Output
Destination
Unreachables

The number of Destination Unreachable messages
received/sent.

Input/Output Time
Exceeded Errors

The number of Time Exceeded messages received/
sent.

Input/Output
Parameter Errors

The number of Parameter Problem messages
received/sent.

Input/Output Source

Quenches

The number of Source Quench messages received/
sent.

Input/Output Redirects

The number of Redirect messages received/sent.

Input/Output Echo
Requests

The number of Echo (request) messages received/
sent.
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Parameter Description

Input/Output Echo The number of Echo Reply messages received/sent.
Replies

Input/Output Time The number of Timestamp (request) messages
Stamps Requests received/sent.

Input/Output Time The number of Timestamp Reply messages received/
Stamp Replies sent.

Input/Output Address The number of Address Mask Request messages
Masks Requests received/sent.

Input/Output Address The number of Address Mask Reply messages
Mask Replies received/sent.

TCP (Transmission Control Protocol)

The TCP connection table contains information about the entity’s existing
TCP connections.

Note that instances of object types that represent information about a
particular TCP connection are transient; they persist only as long as the
connection in question.

TCP statistics page
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Parameter Description

Retrans Alg The algorithm used to determine the timeout value used for
re-transmitting unacknowledged octets.

Retrans Timeout  Retrans Min - the minimum value permitted by a TCP
implementation for the retransmission timeout, measured in
milliseconds.

Retrans Max - the maximum value permitted by a TCP
implementation for the retransmission timeout, measured in
milliseconds

Max Conn The limit on the total number of TCP connections the entity
can support. In entities where the maximum number of
connections is dynamic, this object should contain the
value -1

Active Opens The number of times TCP connections have made a direct
transition to the SYN-SENT state from the CLOSED state

Passive Opens The number of times TCP connections have made a direct
transition to the SYN-RCVD state from the LISTEN state

Received The total number of segments received, including those
Segments received in error. This count includes segments received on
currently established connections

Sent Segments The total number of segments sent, including those on
current connections but excluding those containing only
retransmitted octets

TCP Connection table page

The TCP connection table contains information about this entity's existing
TCP connections.
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Fle EAt Viev Go Favorts Help

- 2-QNA AESR HBSH

Address [ hitp 121062 08 236/wmiMib2_FagesiMib2_Msin asp?Address=210.63.101 3 K|

| [(weicowe ]

Information 210.63.101.3: TCP Conection Table

|— Interfaces

e

Translation Table 0000 20 0000 43129 listen
0000 3 0000 43100 listen
0000 az 0000 2141 listen
0000 az 0000 43162 listen
0000 15 0000 26830 listen
0ooo 135 0000 35018 listen
0000 161 0000 10326 listen
0000 954 0000 26705 listen
0000 1046 0000 51333 listen
0000 1049 0000 2288 listen
0ooo 1050 0000 2224 listen.
0ooo 1055 0000 2127 listen
0000 1057 0000 34376 listen
0000 3000 0000 43237 listen -
0000 6L5F 0000 50482 listen
127001 1038 0000 43206 listen
127001 103 127001 1048 established
127000 1045 127001 1038 established
127001 1047 0000 59619 listen
127001 1047 127001 1050 established
127001 1048 0000 18443 listen
127001 1050 127001 1047 established
127001 1056 0000 12497 listen
19292101 137 0000 51253 listen
19292101 138 0000 26679 listen
19292101 139 0000 39443 listen
19202101 139 1929.21037 3177 established j

& Internet zone

Parameter Description

Status The state of this TCP connection

Remote Address The remote IP address for this TCP connection
Remote port The remote port number for this TCP connection
Local Address The local IP address for this TCP connection. In the

case of a connection in the listen state which is willing
to accept connections for any IP interface associated
with the node, the value 0.0.0.0 is used

Local Port The local port number for this TCP connection

UDP (User Datagram Protocol)

The UDP listener table contains information about the entity’s UDP end-
points on which a local application is currently accepting datagrams. The
tables following the figures describe the functions of the two pages in the
MIB-II UDP window — System and Table.
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UDP Statistics page

Ble it Yev Go Fories Hlp [ & ]
¢ 2 QRN VERIY TR

Links

Address 1@ ‘itp #/210.63 98,238 fawm/Mib2_PagesMiba_Main asp?4ddres=210 63.101 3 :_1

st
Information 210.63.101.3: UDP Statistics

- Interfaces

Input datagrams: 654935

{— Address
Tansiaion Table

Input errors 2

1P Group
Output datagrams 444077

Refresh. SetRefresh Interval
@ Help

Parameter Description

Input Datagrams The total number of UDP datagrams delivered to UDP

users
No Receiver on The total number of received UDP datagrams for which
Port there was no application at the destination port
Input Errors The number of received UDP datagrams that could not

be delivered for reasons other than the lack of an
application at the destination port

Output Datagrams ~ The total number of UDP datagrams sent from this entity
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UDP Listener page

The UDP listener table contains information about this entity's UDP end-
points on which a local application is currently accepting datagrams.

File EAt View Go Tavortes Help n
- QNAAEIY | HBES A
Links
Addzess [ ] hip 210,67 98 238 usn/Mib_PagesMib2_Main sephddres=21063 101 3 |
[ System
Inforrmation 210.63.101.3: UDP Listener Table
| Interfaces
e Local Address Local port
Translation Table 0000 @
1P Group oooh 55
0000 161
B 0000 1055
it 19202101 137
19292101 138
B 15292101 1043
20631013 157
ERLDE 210631013 138
= 20631013 1042
Refresh | SetRefrest Inerval

@
Help

Parameter Description

Local Address The local IP address for this UDP listener. In the case of a
UDRP listener which is willing to accept datagrams for any IP
interface associated with the node, the value 0.0.0.0 is used

Local Port The local port number for this UDP listener

EGP (Exterior Gateway Protocol)
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SNMP (Simple Network Management Protocol)

Implementation of the SNMP group is mandatory for all systems which
support an SNMP protocol entity. Some of the objects defined below will
be zero-valued in those SNMP implementations that are optimized to
support only those functions specific to either a management agent or a
management station. In particular, it should be observed that the objects
below refer to the SNMP entity, and there may be several SNMP entities
residing on a managed node (e.g., if the node is acting as a management
station).

Parameter Description

Input/Output packets The total number of Messages delivered to the SNMP
entity from the transport service

Input/Output Get- The total number of SNMP Get-Request PDUs which
Requests have been accepted and processed by the SNMP
protocol entity

Input/Output Get- The total number of SNMP Get-Next PDUs which

Next-Requests have been accepted and processed by the SNMP
protocol entity

Input/Output Set- The total number of SNMP Set-Request PDUs which

Requests have been accepted and processed by the SNMP

protocol entity
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Parameter Description

Input/Output Get- The total number of SNMP Get-Response PDUs
Responses which have been accepted and processed by the
SNMP protocol entity

Input/Output Traps The total number of SNMP Trap PDUs which have
been accepted and processed by the SNMP protocol
entity

Input/Output TooBig The total number of SNMP PDUs which were
Errors delivered to the SNMP protocol entity and for which
the value of the error-status field is ‘tooBig’

Input/Output The total number of SNMP PDUs which were
NoSuchNames Errors delivered to the SNMP protocol entity and for which
the value of the error-status field is ‘noSuchName’

Input/Output The total number of SNMP PDUs which were
BadValues Errors delivered to the SNMP protocol entity and for which
the value of the error-status field is ‘badValue’

Input/Output GenErr The total number of SNMP PDUs which were
Errors delivered to the SNMP protocol entity and for which
the value of the error-status field is ‘genErr’
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Event action configuration

The event action configuration page helps you set what action to take when
a specific system generates a specific event.

To set event actions:

1. Inthe main screen, click the Event Action Configuration link to access
the Event Action Configuration page.

2. Type the IP address and then click an event on the left frame.
3. Enable or disable event actions as you like.
You can also do this:

1. In the main screen, type the device address in the device address
textbox and then click the Configure It! button to access the Event
Action Configuration page.

2. Enable or disable event actions as you like.

3 Event Action Configuration - Microsoft Internet Explorer

Fle Edi Vew Favoites Took Help BE
ek Qd BB 3- 94
Address [] hitp://210.63.38.238/anm /E ventActionCrg/S art asp =] oo ||inks >

Event Actions Setup For
P=210.63.101.3 and Event=All Events

Browser Notify:
# Enable € Disable Mot Set

Send E-Mail:

© Enable " Disable & Mot Set
SMTP Server® 263 net
Wail From [webmaster@campany com
1ail To* [webmaster@company.com
Subject:* [A%Wh Event notification]
Call Pager:
© Enable © Digable @ 1ot Set
Telephone Mumber:* 66866888
Message Code:™ 12348
Delay *(second) 20
® Inteme

Note: You can use wild cards (*), when typing IP addresses. To do
so, simply replace the byte number with an asterisk. For example, to
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look for all the IP addresses in the network type "*.***" To look
for IP addresses beginning with 172, then type "1724**" so on
and so forth.

Event actions

Browser notify - notifies the administrator through the browser. Click
the Enable radio to activate.

Send E:Mail - sends an E-Mail to the administrator when an event
occurs. Click the Enable radio button and fill out the form.

Call Pager - sends a mesage through the administrator’s pager when
an event occurs. Click the Enable radio button and fill out the form.
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Event information configuration

The event information configuration allows you to set event name and
description. All the events are classified by their type and listed in the left
frame in tree view.

To edit sub agents or event type:

1. Click the subagent name or event type in the left frame to display its
form.

2. Edit the contents of the form and then click the Set button to save
your changes.

Note: If you change the subagent name or event name, the name list
in the left frame won’t change until you refreshes the whole page.



) Real time monitoring

An icon flashes in the main page whenever a new event occurs. To view
the detail event information, click on the flashing icon. The Real Time Event

Monitoring window appears.

P Event

[ [O] =]
Event Name: Source Address:
|N‘IC Statistical Counter ‘1?2 25.3.251
Ewent Type: Relay Time
[¥ View Details View History]

traplescription: unkmown
TimeStamp: 11111 (0x2BET)
serverfame: webasm

Identification: 1.3.6.1.4 1 1050 25 0.11

eventPager: 835-1234567
eventhetion: 111 (0xBF)
Communi ty: public
hgenthddress: 172,253,251
T Applet HH

-
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It includes information such as event name, event type, source address,

and relay time. To view details, click the View Details checkbox.

To view the event history, click the View History button. The View History

window displays.

!There are total 4 ewents [_[a]x]
F Recsived ap- |Fri Jum D4 13:25:53 GT+05:00 1999

T;

SHWE Trap: <BatteryFailViNotifica

Hotifi

<> Rel

d

n f

SHME Trap:<BUS Utilization High> from <> Relayed at:19990804132447. 000T05-480
SHWE Trsp: <Redundent Power Supply Fail> from <> Relayed at:19990804132522. 000224-480

19990804 13
0

trapleseription: urdmewn

TimeStamp: 11111 (0xZB6T)

serverllame: webasm

Tdentification: 1.3.6.1.4.1.1050.25.0.11
eventPager: B86-123456T

eventhetion: 111 (0xEF)

(Communi ty: public

ligentaddress: 172.25.3.251

Tl hpplet WO
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Event log view

Event Log View gathers event information in the systems being monitored
and saves them in the event log file for future reference. To access the
Event Log View, click the Event Log view link in the main page. The Event
Log View page appears.

A ASM Management Pages - Microsoft Intemnet Explorer [E]x]
e Edl View Favortes Tsck Help

Al QA QP DB I -

Addess [] htip://21063.98 |_Pages/5M_Main aspC: -Thbddiess=21063101.3 =] @6a ||Links >

| [WEeELcoweE

Basic System
Information

Operating Systam AWM Event log View
—
Environment (Sort by log time, descend ordesy

DI BIOS. |Log Time[Type|Severity Level[Source Address|Event Name|Description]|

Information

Logis empty!
110 Paripheral
ntormation

Network Information Manage Log data

System Resource
Information @ Delete log, time range from: Teai] Month|  Date]

Storage Information To: Yea]  Montt|  Date]
© Orempiylog

Submit | Reset

Note: You can sort the information in the table by clicking on the
table heading.

The lower section of the page allows you to delete event logs from the
table.
To delete log files within a specific time:

1. Click the Delete Log Time Range from and to radio button and specify
the date of the event logs you want to delete.

2. Click Submit to delete.

To delete all the log files; Click the Or Empty Log radio button and then click
Submit to delete all the log entries.
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) Setting automatic refresh interval

[=]

Ei Ex i Favorits  Help

-2 QRN AEIR dB5=H

Links

Address [@] hip: 210 63.98 238 xv s _pagesASM_Main asp7addrecs=192.9.210.31 E
| Cweconc

[~ Basic System
Information

Set Automatic Refresh Interval

— Operating System

Entor Automatic Refrosh Intorval
(T cancel autamatic refresh, just set interval to 0.)

o0 (n second)
Submit

tardvare
Environment

— DMI BIOS
information

1O Pariphral
Information

Network Information

| System Resourca
Information

— Storage Information

Type the number of seconds in the textbox to determine the frequency of
refreshing information on each page. The refresh intervals must be from 1
to 60 seconds. The default refresh interval is 2 seconds.
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A Troubleshooting



This chapter contains tables that describe some
basic troubleshooting techniques you can use to
work around specific problems in ASM.



) General ASM troubleshooting
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The following table describes the error message for different functions in
ASM. It also provides a description of the error message and the action to
take to correct the error.

Function Message Description Action

Hardware Open file Fail Fails to open a file

Information/ to save event log

Event log

Information

Hardware Setting Event Fails to set a Make sure:

Information/ Threshold Failed threshold 1. Agent allows

Event log remote setting

Information configurations
2. Network
connection is OK

Hardware Invalid threshold Threshold is invalid  Don’t set the

Information/ threshold higher

Event log than 100

Information

File System Setting File Make sure:

System Threshold 1. Agent allows
Failed remote setting

configurations
2. Network
connection is OK

Server Setting Manager Make sure:

Information/ Information Failed 1. Agent allows

Basic remote setting

Information configurations
2. Network

connection is OK
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Function Message Description Action
Server Setting Server Make sure:
Information/ Location Failed 1. Agent allows
Basic _ remote setting
Information configurations
2. Network
connection is OK
ASM Console Modem Set up the
Initialization modem from the
Failed control panel.
Station Com Port Fail to initialize
Initialization Com port
Failed
Station Failed to initialize Fail to initialize
(COM1 to COM4) Com port
Utility/CMOS Timeout. It waited Check network
Setup too long to get the connection
setup password
from XXX
Utility/CMOS Socket Initialize Check network
Setup failed connection
Utility/CMOS The client The setup
Setup machine doesn't password does
support to setup not exist. Check
CMOS remotely BIOS version
Utility/CMOS Getting setup Check network
Setup password error connection
Utility/CMOS The setup Input a correct
Setup password is not password
correct
Utility/CMOS Open Cannot open a file Don’t write
Setup WriteParams file to write parameters into a
error existed and read-
only file
Utility/CMOS Failed to set Failed to set Check BIOS
Setup password password version
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Function Message Description Action
Utility/CMOS Cannot open the Cannot open the Check if
Setup driver driver Admcmos.sys is
ADMCMOS.SYS ADMCMOS.SYS existent
Utility/CMOS Write CMOS data ~ Cannot write Check BIOS
Setup error CMOS data version
Utility/CMOS Failed to open Cannot open VxD Check if
Setup VxD file file PROXY.VxD PROXY.VxD is
PROXY.VxD existent
Utility/CMOS Failed to read Cannot read VxD Check if
Setup VxD file file PROXY.VxD PROXY.VxD is
PROXY.VxD existent
Utility/CMOS Failed to write Cannot write VxD Check if
Setup VxD file file PROXY.VxD PROXY.VxD is
PROXY.VxD existent
Utility/CMOS Get CMOS data Cannot get CMOS Check BIOS
Setup error from target version
machine
Utility/CMOS Get BIOS version Cannot get CMOS Check BIOS
Setup error version from target  version manually
machine at target machine
Utility/CMOS Save CMOS data  Cannot put CMOS  Check BIOS
Setup error data into target version
machine
Utility/CMOS Load Cannot load Check if
Setup ADMMISC.DLL admmisc.dll admmisc.dll is
Error existent
Utility/CMOS Get Cannot get Check if
Setup GetSysProductNa  GetSysProductNa admmisc.dll is
me Address Error me Address from existent
admmisc.dll
Utility/CMOS Call Cannot call Check if
Setup GetSysProductNa  GetSysProductNa admmisc.dll is
me Error me from existent

admmisc.dll
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Function Message Description Action
Utility/CMOS Get Cannot get Check if
Setup GetBiosVersion GetBiosVersion admmisc.dll is

Address Error Address from existent
admmisc.dll
Utility/CMOS Save CMOS data  Cannot put CMOS  Check BIOS
Setup error data into target version
machine
Utility/CMOS Load Cannot load Check if
Setup ADMMISC.DLL admmisc.dll admmisc.dll is
Error existent
Utility/CMOS Get Cannot get Check if
Setup GetSysProductNa  GetSysProductNa admmisc.dll is
me Address Error  me Address from existent
admmisc.dll
Utility/CMOS Call Cannot call Check if
Setup GetSysProductNa  GetSysProductNa admmisc.dll is
me Error me from existent
admmisc.dll
Utility/CMOS Get Cannot get Check if
Setup GetBiosVersion GetBiosVersion admmisc.dll is
Address Error Address from existent
admmisc.dll
Utility/CMOS Timeout waits too Check network
Setup long to get the connection
CMOS data from
XXX
Utility/CMOS Timeout waits too Check network
Setup long to get the connection
CMOS data from
XXX
Utility/CMOS Timeout waits too Check network
Setup long to save the connection

CMOS data of
XXX
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Function Message Description Action
Utility/CMOS Cannot find this Check if this
Setup machine :(IP machine exists
address)
Utility/CMOS The file format is The format of Check if the
Setup not correct CMOS file is not CMOS file is
correct. correct.
Utility/CMOS The script file is Cannot find Check if the file
Setup not existed cmos.ver cmos.ver is
existent.

Utility/Update
CMOS

Fail to create
socket

Cannot create
socket to connect
to target machine

Check network
connection

Utility/Update
BIOS

Winsock function
error

Cannot send
update BIOS job to
target machine

Check network
connection

Utility/Update Invalid MAC MAC address is Check network
BIOS address invalid connection
Utility/Update Applied Model of Package model Check the Update

BIOS

package XX(XX) is
not matched with
machine XX(XX)

does not match
machine model

BIOS package

Utility/Update
BIOS

Start update
service before
job(s) can
proceed

User can proceed
to start update
BIOS job

None

Utility/Update
BIOS

The patch list file
was not opened

Cannot find patch
list file

Check if the patch
list file is existed.

Utility/Update
BIOS

Cannot open
profile or sector
XXX not found

Cannot open
profile file or find
sector XXX in
profile file

Check the
contents of the
profile file.
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Function

Utility/Update
BIOS

Message

You should stop
service first

Description

When user applies
the settings, if
there is a service is
running, it must be
interrupted first.

A Troubleshooting

Action

Stop the service
or give up the
new settings

Utility/Update
BIOS

Windows sockets
initialization
failed.

Cannot create
socket to connect
to target machine

Check network
connection

Utility/Update

Cannot start BIOS

Starting Update

Check network

BIOS update service BIOS service failed  connection
Station There is no Cannot set value Make sure:
response from to Agent Agent is still
Agent running
Network

connection
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) ASM agent for SCO OpenServer
troubleshooting

ASMSMUXD

Message Action

AgentAddr, out of memory End unnecessary processes or
reboot the system

Bad Inet address for param Check /etc/snmpd.trap

Can't open /etc/mnttab check /etc/mnttab

Can't open /etc/snmpd.trap Verify file existence & permission
can't open /xsnmpd/portnum.dat Verify file existence & permission
Can't read NIC llistat, verify NIC was found at boot
fail, gettimeofday Check similar msg in /var/adm/

syslog, try to resolve the problem
according to the msg

AgentAddr, out of memory End unnecessary processes or
reboot the system

Bad Inet address for param Check /etc/snmpd.trap

Can't open /etc/mnttab check /etc/mnttab

Can't open /etc/snmpd.trap Verify file existence & permission
Bad Inet address for param Check /etc/snmpd.trap

Can't open /etc/mnttab check /etc/mnttab

Can't open /etc/snmpd.trap Verify file existence & permission
can't open /xsnmpd/portnum.dat Verify file existence & permission

Can't read NIC llistat, verify NIC was found at boot
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Message Action

fail, gettimeofday

Check similar msg in /var/adm/
syslog, try to resolve the problem
according to the msg

fail, xselect

Try restart asmsmuxd or reboot

Fail to allocate

End unnecessary processes or
reboot the system

Fail to malloc

End unnecessary processes or
reboot the system

Fail to open /xsnmpd/asmsmuxd.cfg

Verify file existence & permission

Fail to open /xsnmpd/asmsmuxd.cfg

Verify file existence & permission

Fail to write /xsnmpd/asmsmuxd.cfg

Verify file existence & permission

Filesystem utilization exceeds
threshold

“df —ik” check file system utilization
percentage_clear unnecessary files

get_SCSI: cannot open /etc/conf/
cf.d/mscsi

Verify SCSI card was found at boot,
check SCSI card

get hardware information fail

Check /dev/asm, try reinstall

get system information fail

Check /dev/asm, try reinstall

gethostbyname fail

Verify system hostname can be
found by DNS

gethostname fail to get hostname

Verify system hostname length not
exceeding 32 characters

init_SMUX, out of memory

End unnecessary processes or
reboot the system

malloc fail End unnecessary processes or
reboot the system
no SMUX entry for this SMUX Check /etc/snmpd.peers

daemon in 'peers' file

no syntax defined for object

Check ipmsmuxd.defs
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Message Action

open /dev/asm fail

Check whether /dev/asm installed or
not

out of mem in NotifyManagers

End unnecessary processes or
reboot the system

read kernel sym. fail.

Check /stand/unix & /dev/kmem

readobjects:

Verify file existence & permission

ps: /dev/kmem: cannot open

Check /dev/kmem

ps: /unix: cannot open

Check /stand/unix

ps: /unix: no namelist

Try rebuild kernel or boot with
/stand/unix.old

ps: /unix: not the booted system

Try boot with /stand/unix or edit
/etc/default/boot

ps: read error

Check these 2 files

ps: seek error

Check these 2 files

smux: fork

Try restart program or reboot

Unable to bind at *any* UDP port

Try restart asmsmuxd

Unknown type

Check SCSI card or try another card
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ASMCONFIG

Message Action

Can't open /etc/snmpd.trap Verify file existence & permission
Fail to open /xsnmpd/asmsmuxd.cfg Verify file existence & permission
Fail to write /xsnmpd/asmsmuxd.cfg Verify file existence & permission

BPBSMUXD

Message Action

/dev/gamdev open fail Check /dev/gamdev installed or not
Cannot open /dev/gamdev, errno= Check /dev/gamdev installed or no
fail, xselect Try restart bpbsmuxd or reboot

Fail to open /xsnmpd/asmsmuxd.cfg Verify file existence & permission

no SMUX entry for this SMUX daemon Check /etc/snmpd.peers
in 'peers' file

BPBCONFIG

Message Action

/dev/gamedev open fail Check whether /dev/gamedev
installed or not

Backplane Board open fails Check whether /dev/smb installed
or not
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IPMSMUXD

Message Action

ERROR, ipmi.C, GetSDR)), Verify whether this machine supports
BMCinterface() fail IPMI, & IPMI is well-functioning
ERROR, ipmsmuxd, InitIPMI() Verify whether this machine supports
fail IPMI, & IPMI is well-functioning
ERROR, ipmsmuxd.c, main(), Check /dev/ipmidrv installed or not
InitIPMI() fail

ERROR, sig_alrm(), signal() fail Try restart ipmsmuxd

ERROR, sig_PolllPMI(), signal() Try restart ipmsmuxd

fail

ERROR, trap.cpp, acer_trap(), Verify snmpd is running, try resolve

smux_trap() fail the problem according to the error
msg

fail, xselect Try restart ipmsmuxd or reboot

no SMUX entry for this SMUX Check /etc/snmpd.peers
daemon in 'peers' file

no syntax defined for object Check ipmsmuxd.defs
smux: fork Try restart program or reboot
smux_trap error Verify snmpd is running, check similar

msg in /var/adm/syslog
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) ASM Agent for SCO UnixWare
troubleshooting

ASMSMUXD

Message Description Action

asmsmuxd: open Check whether /dev/asmdrv
(/dev/asmdrv) fail installed or not

enqueue: malloc End unnecessary processes

or reboot the system

ERROR: Check /etc/netmgt/

getsmuxEntrybyname snmpd.peers

ERROR: verify file existence &

getutid(BOOT_TIME) permission of /var/adm/
utmp and wtmp

ERROR: readobjects verify file existence &
permission

ERROR: xselect Try restart asmsmuxd or
reboot

File System utilization “df —k” check file system

exceeds threshold utilization percentage, clear

unnecessary files

fopen(/usr/asm/ verify file existence &
asmsmuxd.conf) fail permission
get_IrgDmaloportMe verify directory existence &
mTable: permission

make_daemon: fork Try restart program or

fail reboot

Memory utilization Memory utilization End unnecessary processes

exceeds threshold exceeds threshold or reboot the system




Message

RRspPDU_failure

Description

fail to register ASM
MIB module with the
snmp agent

Action

Try restart asmsmuxd &
snmp daemon, or reboot

455

SMUX connection fail

fail to start smux
connection

Try restart asmsmuxd &
snmp daemon, or reboot

smux_register: no
response received

fail to register ASM
MIB module with the

Try restart asmsmuxd &
snmp daemon, or reboot

snmp agent

Message Description Action

ERROR: /usr/asm/ /usr/asm/asmsmuxd.conf not Verify file

asmsmuxd.conf not found existence

found

make_daemon: fork fork() fail Try restart

fail program or
reboot

server: can't open
event log file

fail to open /usr/asm/asmevent.log  verify file

existence &
permission
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BPBSMUXD

Message

Ch# ID#, BPB# Tray#,
Physical Disk Failure

Description

Physical Disk Failure

A Troubleshooting

Action

Shutdown_che
ck hark disks

ERROR: Launch fail to launch event Verify

program fail handling program program
existence &
permission

fopen(/usr/bpb/ fail to open /usr/bpb/ Check file

bpbsmuxd.conf fail bpbsmuxd.conf existence &
permission

Going to Shutdown System is going down Check

the server... previous
broadcast
message

make_daemon: fork fork() fail Try restart

fail program or
reboot

No other bpbsmuxd is No other bpbsmuxd is No action

found running

open(/dev/gam) fail fail to open /dev/gam Checkwhether
/dev/gam

installed or not

thr_create(thr_bpb) fail

thr_create() fail

Try restart
bpbsmuxd or
reboot
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IPMSMUXD

Message Description Action

ERROR, init_ipmi(), thr_create() fail Try restart

thr_create() fail ipmsmuxd or
reboot

ERROR, ipmi.C, InitIPMI() fail verify whether this

GetSDR(), machine supports

BMClnterface() fail! IPMI_& IPMl is
well-functioning

ERROR, signal() fail Try restart

sig_PollIPMI(), signal() ipmsmuxd

fail

make_daemon: fork fork() fail Try restart

fail program or reboot

No ipmsmuxd is No other ipmsmuxd is No action

running running

smux_trap: smux_trap() fail Verify snmpd is
running, try
resolve the
problem
according to the
error msg

thr_create() fail thr_create() fail Try restart
ipmsmuxd or
reboot

XASMMON

Message Desctiption Action

MrmFetchWidget() fail MrmFetchWidget() fail Try restart or
reboot the system

MrmOpenHierarchy() fail MrmOpenHierarchy() Try restart or
fail reboot the system
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Message Desctiption Action
MrmRegisterNames) fail MrmRegisterNames() Try restart or

fail reboot the system
thr_create(hw_monitor) fail thr_create() fail Try restart or

reboot the system
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Function Message Description Action

ASM AGENT Cannotlnitialize ~ NIC error Reinstall NIC
NIC driver Adapter/driver
Cannot create Snmpextended  Reinstall SNMP
event for agent error
SnmpExtension
Init

ASM CONFIG Not a valid IP IP address or Use the correct

UTILITY address or a hostname format
host name format error
Startthe SNMP  Cannot start Start SNMP in
service faill SNMP by the Control
Please program Panel
manually restart
the SNMP
service

ASMCI The Win32SL The service Start Win32SL
service is not Win32SL is in the Control
running now stopped Panel
The mif file Win32SL Reinstall ASM
“ASMNT.MIF” service cannot Agent and
cannot be load make sure
installed into “ASMNT.MIF”. Win32SL
DMI Service ASMCI.EXE service is
Layer. cannot be started
Instrumentation  executed

code

“ASMCI.EXE”

will not be

loaded

Remote Setup.iss file is Get the whole
Console missing or the install package,
setup.iss could file is write or change the
notbe updated.  protected file property to
Use default Read/Write

setup directory
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Function Message Description Action
Remote Setup.exefileis  Get the whole
Console setup missing or install package
failed. Remote crash
Console is not
installed
This program Resolution Change the
requires VGAor  requires 640 x resolution
better 480 setting
resolution
Failed to detect ~ HW is not N/A
HW type supported
Type HW is not N/A
comparison supported
failed

ASM AGENT Cannotlnitialize ~ NIC error Reinstall NIC
NIC driver Adapter/driver
Cannot create Snmpextended  Reinstall SNMP
event for agent error
SnmpExtension
Init

ASM CONFIG Not a valid IP IP address or Use the correct

UTILITY address or a hostname format
host name format error
Start the SNMP  Cannot start Start SNMP in
service faill SNMP by the Control
Please program Panel
manually restart
the SNMP
service

ASMCI The Win32SL The service Start Win32SL
service is not Win32SL is in the Control
running now stopped Panel




Function

Message

The mif file
“ASMNT.MIF”
cannot be
installed into
DMI Service
Layer.
Instrumentation
code

Description

Win32SL
service cannot
load
“ASMNT.MIF”.
ASMCI.EXE
cannot be
executed

Action

Reinstall ASM
Agent and
make sure
Win32SL
service is
started
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“ASMCI.EXE”

will not be

loaded

Remote Setup.iss file is Get the whole
Console missing or the install package,
setup.iss could file is write or change the
notbeupdated.  protected file property to
Use default Read/Write
setup directory

Remote Setup.exefileis  Get the whole

Console setup missing or install package
failed. Remote crash
Console is not
installed
This program Resolution Change the
requires VGA or  requires 640 x resolution
better 480 setting
resolution
Failed to detect ~ HW is not N/A
HW type supported
Type HW is not N/A
comparison supported
failed

Asset Manager Windows ASM console Please reboot
sockets cannot initialize  your console
initialization socket system

failed
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Function Message Description Action
Asset Manager Cannot find the ~ ASM agent Search
asset log file. cannot find the “history.cfg” in
asset log file in your file
server side. system. If not,
restart your
server system
and the asset
log file will be
generated
again.
ASM MIB No selected No selected Select a query
Browser item query item
ASM MIB No Machine User didn’t Input machine
Browser selected! select any name
machine in
query
ASM MIB Please enter an User input Input valid
Browser integer invalid polling polling interval
between 1 and interval
60
ASM MIB Load Images ASM Browser Initialize MIB
Browser Error load MIB data database
fail. The MIB
database
maybe
corrupted
ASM MIB Can't view You want to User can
Browser single item and view the single choose single
table together item and table or table OIDs
together. It is only
not accepted in
ASM MIB
Browser
ASM MIB Number of User choose Unselect some
Browser Table OID too many OIDs OIDs

exceeds 128

to view




Function Message Description Action
ASM MIB Only the single When user add
Browser item will be awhole subtree
added into select
window. ASM
MIB Browser
will add the
single OIDs
under this node
ASM MIB Can't delete When youwant  Use the same
Browser this MIB file. to remove a MIB file.
The MIBs file MIB-subtree by
are different. a MIB file. ASM
MIB Browser
finds the OIDs
defined in this
sub-tree are
different to the
MIB file
ASM MIB Can't open ASM MIB Search
Browser initial MIB file Browsercannot  origin.mib and
find the initial put it into the
MIB file, ASM Console
origin.mib. directory.
ASM MIB Set Operation Usercannotset  Check if the
Browser Fails! the OID value OID is
protected by
password or
not.
ASM MIB Please leave Usercannotset  Please change
Browser Rotate Mode the OID value in to normal mode
and Set Again the rotated and set again.
mode.
ASM MIB This OID is The access
Browser readonly mode of this
OID is read-

only.
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Function Message Description Action
ASM MIF Cannot register ~ ASM MIF Check if the
Browser XXX Browser service provider
cannot register is ready in
to the service target system
provider in a or the
machine connection
(network) is OK
ASM MIF You reach the When user
Browser last row access the the
last row for a
attributes table
ASM MIF Set Operation The set
Browser fails operation for a
attribute is
failed
ASM MIF Can't view Youwanttoput  Select one
Browser different tables attributes in group each
together different group time
to view
ASM MIF Can't view You want tp Select single or
Browser single item and view the single table only
table together and table
attributes
together
Statistics Viewer Different You want to Choose the
Recording view two items items with
Interval whose polling same pooling
intervals are intervals
different
Statistics Viewer Statistics The setup Check if the
Operation Fails command is password is
failed correct if
password is
enabled
Statistics Viewer Load Statistics Cannotloadthe  Check the

Configuration
Fails

statistic

Configuration
file

agent side, find
the statcfg.ini
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Function Message Description Action
Statistics Viewer Windows ASM console Please reboot
sockets cannot initialize  your console
initialization socket system
failed
System Alert Can't use this Youwanttouse Reboot the
Manager service! other service system or
but it doesn’t reinstall ASM
work. For console again
example, DMI
Alerts
System Alert Cannot SAM cannot Check if the
Manager connect to XXX  connect to the target system is
target system OK or the
network is
connected
System Alert You need to You wanttoset  Input a mail
Manager have a Mail up a mail for address
Address to test event handling
this function function. But no
mail address
System Alert Please check After finish the Check if the
Manager your Mail test of mail test mail is
messagetosee  setup, You received
if the Test Mail must Check if
worked!! the setting is
OK
System Alert Invalid Phone You wanttoset  Input a valid
Manager Number up a pager for phone number

event handling
function. But
the phone
number is
invalid
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Function Message Description Action
System Alert You need to You wanttoset  Input a valid
Manager have a phone up a pager for phone number

number to test event handling

this function function. But no

phone number

System Alert Please check After finish the Check the
Manager your pager to test of pager pager

see if the
dialing worked!!

setup, You
must check the
setting is OK
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Hardware common part troubleshooting

Function

ASM
AGENT

Message

CPU/Housing Fan
stopped

Description

Fan stops

Action

Replace fan

CPU/On Board

Temperature is

Cool down or

temperature exceeds  going high power off server
threshold
CPU/SYSTEM: Voltage is Check Power
voltage sensor is out abnormal Supply model or
of range contact your H/W
vendor
Redundant Power Redundant Check if it is
supply unit failed Power supply power-off or

unit is abnormal

unplugged. Or
replacing a new
one

Redundant Power Redundant Check if it is
supply fan failed Power supply power-off or
fan stops unplugged. Or
replace a new
one
Power supply failed UPS is Check if it is
abnormal power-off or

unplugged. Or
replace a new

one
Power supply fan UPS fan stops Check if it is
failed power-off or

unplugged. Or
replace a new

one

AC power failed AC power is Replace a new
abnormal one

AC power failed. AC power is Replace a new

Shutdown server in 1 abnormal. one

minute

Server will be
shutdown
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Function Message

UPS battery failed

Description

UPS battery is

A Troubleshooting

Action

Check battery or

abnormal replace a new
one
Fuse failed Fuse is bad Replace the fuse
or contact your H/
W vendor
ECC error DIMM error Replace the

DIMM or contact
your H/W vendor




C RAID utilities



The Redundant Array of Inexpensive Disks
(RAID) combines small, inexpensive disk drives
into an array of disk drives which yields
performance exceeding that of a Single Large
Expensive Drive (SLED). The array of drives
appears to the computer as a single logical
storage unit or drive. These utilities monitor the
RAID Controller information and functions. The
following sections give a brief description of the
utilities.
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) ASM Mylex RAID utility

Mylex RAID controller monitor

This window is used to monitor Mylex RAID Controller Information. The
upper left window displays the hierarchical view of the controller structure,
and the upper right window shows logical drive information.

Controller tab

Click the Controller tab to monitor Mylex RAID Controller Information. Click
on a controller to show controller information.

11AA41 — MyLex Controller
B DACSEOPL : 3.50.0.00

Logical Drive

(&9 Channel 1

Cantroller | Disk | CirlSta. | Ctr Graph | Disk Sta. | PDisk Graph | LDisk Graph |

[DAC3EORL
| Walue | =

Status Functional
Firmware 3800.00
Configured channel 2
Actual Charnel 2
M awirurn Lagical Drive 32
td aximurm Targets / Channel 16
I aximum Fequests Sent E4
Mauirurn D ata Transferred / Request E4 =

Disk tab

Click the Disk tab to monitor Mylex RAID Controller disk information.
Highlight a hard disk to show physical disk information.
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1AA11 — MyLex Controller = B3

DACSEOPL @ 3.50.0.00 Logical Drive

E@ Charirel 0
i

B

DEC 2047 MB B (2] 2047 MB
B 0EC 2047 B
LD Chanrel 1

Controller Disk | Ct Sta. | Cil Graph | Disk Sta. | PDisk Graph | LDisk Graph|

Physical Disk Lagical Disk
Status : [OnLine Status : N2
Wendor: [DEC RAID Level : 7
Product : [D5P32103 Wiite Policy : &
Revision : |>(442 .
i Size |N 78,
Size: [2047 HE Physical Size | 78
Hard Errar : [ Misc Emor: [0 i :
) Stripe Size : I
Parity Error : [0 o —

Controller statistic tab

Click the Controller Statistic tab to monitor Mylex RAID Controller statistics
information.

Logical Drive

Enntmllerl Disk  Cirl Sta. | Chl Graph | Disk Sta. | PDisk Graph | LDisk Graph

[DAC3BIPL
Physical Digk, Logical Dizk.
Fead Request IS)— Fead Request : IQ—
Data iead W Dalaread. IDMB—
‘wirite Request : IU—
wiite Request [0 Data'white: [IWB
Data Wwiite W Read Cache Hit : |3—
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Disk statistic tab

This window is used to monitor Mylex RAID Controller disk statistic
information. Under this tab, the displayed information is as shown below:

iiAA41 — MyLex Controller [-[=]=]

# DACIE0PL : 350.0.00 Logical Diive
- Chanrel D [0] 2047 MEB
[1] 2047 MEB
B (2 2047 B

Cortroller | Disk | CrlSta. Ot Graph | Disk Sta. | PDisk Graph | LDisk Graph

Controller: | DACIGOPL

&0 — LD Read

E 41

E TG — LD Write

57

§ a0 —— PFD Read

# GO0 - 96

04— t {

12:12:56 12130 12:13:06

Physical disk statistic graph tab

i1AA41 — Mylex Controller = E
DACSE0PL : 3.50.0.00 Logical Drive
=& Channel 1
B DEC 2047 ME B3 (112047 M
DEC 2047 MB B (2] 2047 MB
B DEC 2047 MB
L@ Channel 1

Contioller | Disk | CtlSta. | Cil Graph | Disk Sta.  PDisk Graph | LDisk Graph

Physical Disk : [ DEC DGrazils 2047 ME
1100.0]
E G800+ —— FRead Req.
= 166
S G600
% 44004 rire B
Py —— TWrite Req.
230,01 e
i . .
12:15:45 12:15:50 12:15:55
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Logical disk statistic graph tab

HE E |

i1AA41 — Myl ex Controller

DACIEOPL : 3.50.0.00
@& Channel 0
B DEC 2047 ME
DEC 2047 ME
i - EBJDEC 2047 ME
gl Channel 1

o

Contraller | Disk | Ciil Sta. | Ctl Graph | Disk Sta. | PDisk Graph LDisk Graph

Logical Disk : | Disk 0 : 2047 MB

10500.0

2400.0
£300.0
4200.0 —— Write Req.
21000 33

—— FRead Beq.
49

#/ Second

0 t |
12:16:58 1217:03 1217:08
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) ASM DPT RAID utility

This utility monitors the DPT RAID Controller information and functions. The
window shown below is the main screen of the DPT RAID Controller. The
upper left window displays the hierarchical view of the controller structure,
and the upper right window shows the logical drive information.

HBA (Host Bus Adapter) tab

.. ASM DPT Module-- NT [195.9.210.53]

File

=188 PM333UW
B Bus: 0
4B DDRS-39130w
‘i) DCAS-321E0W
(= Bus 1
.- DDRS-39130W/

HEa |Bus | Device | Anay | Statistic| Graph |

[ value [~
Agent Rev. DT SC51 System SHMP Subagent for Windows M1/95; Ver...
Wendor DPT
Model P34 |
Fimware 07Lo
Serial
00 BO10h
BusType Pl
MaxTransferftate 132 MB/sec:
Irq i =l

Iltem Description

Agent Revision DPT SCSI system SNMP agent revision information

Vendor Name of the HBA vendor

Model HBA controller model description

Firmware HBA controller firmware version

Serial Number HBA controller serial number

10 Address HBA controller I/O Address (normally displayed in hex). It
is a 16-bit value for ISA and EISA, and 32-bit value for PCI
devices

Bus Type Host bus type of the computer system to which the HBA is

attached to
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Item Description

Max Transfer Maximum possible transfer rate in MB/seconds

Rate

IRQ HBA controller interrupt level

IRQ Type HBA controller interrupt type

DMA HBA controller DMA channel. Only applicable if an ISA
HBA

RAID Module HBA Disk Array Module. With the addition of the DM4000

Disk Array Module and a caching module, HBAs can
configure hard drives into RAID-0, RAID-1 and RAID-5
arrays, providing disk-fault tolerance and throughput many
times those of non-arrayed disk drives

Cache Module HBA controller caching module

Audio Setting the value of this object to on causes an audible
alarm to start beeping. Setting the value of this object to
off causes the audible alarm to stop beeping

Up Time Time elapsed (in hundredths of a second) since the HBA
last booted
ECC Enabled Shows if the ECC is enabled on the HBA. This object can

set ECC to enabled or disabled

Max ReadAhead Maximum percentage of read-ahead pages brought into
Rate the HBA cache

Max DirtyPages Maximum percentage of dirty pages in the HBA cache
Rate

Write Back Delay Write-back delay in milliseconds

Temperature Temperature as seen on the HBA
Voltage Voltage as seen on the HBA
Bad Memory The value of this object is the last faulty HBA RAM address

Address as determined by the ECC algorithm used by the HBA




477

Bus tab

i ASM DPT Module-- NT [195.9.210.53]
File
=B PM3a3dUw

B

DDRS-33130W

) DCAS 32160
=P Bus: 1
-8 DDRS-33130W

HBA Bus IDEVICEI Anay | Stallsh:l Braphl

Width : fiside

Type: [Single Ended

MasTrancterRate * [20MB7s

SCslD: [7

Item Description

Width SCSI Bus width

Type SCSI Bus transceiver type

Max Transfer SCSI Bus maximum possible transfer rate in MB/s. Valid
Rate values can be 4, 5, 8, 10, 20, 40, 100, etc. depending on

the SCSI technology used

SCSIID SCSI ID of HBA on this SCSI Bus
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Device tab

C RAID utilities

i ASM DPT Module-- NT [195.9.210.53]

File

HBa | Bus

=188 PM3334L0W/

- §f) DDRS-33130W

Device | anay | Statistic | Graph |

| “Walue -
0

SCSID
Lun
Wendor
Model
Fevision
Serial
Status
Bustw/idth
Capacity

0

1BM
DDRAS-39130W
5710
RED0S563
optimal

Wide

8715 MBytes

ltem Description

SCSIID SCSI ID for the device

LUN SCSI Logical Unit Number (LUN) for the device
Vendor Vendor name of the device

Model Model name of the device

Revision Device revision level

Serial Number

Device serial number

Status Administrative state of the device

Bus Width Value of this object indicates the data width of the SCSI
device

Capacity Storage capacity of the device in MBytes

Block Size Device block size in Bytes

Max Transfer Rate

Maximum data transfer rate for the device




479

Item Description

Removable Value of this object indicates if the device is removable or
not

ECC Enable Value of this object indicates if the device has ECC enabled
or disabled

SCSI Version Value of this object indicates the SCSI specification version

supported by the device

Soft Reset Value of this object indicates if the SCSI device is soft reset
capable or not

Cmd Queuing Value of this object indicates if the SCSI device is
command queuing capable or not

Linked Cmds Value of this object indicates if the SCSI device is linked
commands capable or not

Synchronous Value of this object indicates if the SCSI device is
synchronous or not

Relative Address Value of this object indicates if the SCSI device supports
relative addressing or not

SMART Value of this object indicates if the SCSI device supports
SMART specifications
SCAM Value of this object indicates if the SCSI device supports

SCAM specifications

Fast20 Value of this object indicates if the SCSI device supports
Fast20 specifications

Bad Block Value of this object represents the last bad block

Number encountered on this device. It is needed in the definition of
one or more traps. Value 0 means there is no error, and
note that the first block starts from 1 (not zero)

Bad Block Count Value of this object represents the count of the bad blocks
starting at Bad Block Number encountered last time on this
device. It is needed in the definition of one or more traps

Errors Above This object indicates if the error count of this device has
Threshold reached the threshold or not
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Item Description

Drive Locking On This object indicates if the drive is locked or not

Last Req Sense The value of this object is the request sense information
Info and is primarily used in the definition of one or more traps

Hot Spare This object indicates if the drive is a hot-spare or not

Array tab

" ASM DPT Module-- NT [195.9.210.53]
Eile

-1 PrM33340w

5 4@ Bus: 0

DDR5-391 30w
B DCAS-32160W
=& Bus 1
B} DDRS-39130W

HeA | Bus | Device Amay | Statistic| Graph |

Harme =~ Components
. [0:C::0] [BM  DDRS-39130wW
Type [RAIDS [0:0:1:0]1BM - DCAS-321600W

[01:0:0]IBM - DDRS-35130W

Capacity : W
Bkg Progess: [z
Status: fomes
Stripe size '32KB—

Iltem Description

Type RAID Array Group type

Name Name of the RAID Array Group

Capacity Capacity of the RAID Array Group

Background The value of this object returns the percentage complete
Progress status of the outstanding background operations on this

Array Group. This includes initial Build, Rebuild, Verify and
VerifyFix operations. If there is no background operation,
the value of this object shall be 100. The value of this
object will always be 100 for non-redundant array (RAID-0)
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Item Description

Status Invalid(1), ‘active’(2), which indicates that the conceptual
row is available for use by the managed device;
'notinService'(3), which indicates that the conceptual row
exists in the agent, but is unavailable for use by the
managed device; ‘notReady’(4), which indicates that the
conceptual row exists in the agent, but is missing
information necessary in order to be available for use by
the managed device; ‘createAndGo’(5), which is supplied
by a management station wishing to create a new instance
of a conceptual row and to have it available for use by the
managed device; ‘createAndWait’(6), which is supplied by a
management station wishing to create a new instance of a
conceptual row but not to have it available for use by the
managed device; and, ‘destroy’(7), which is supplied by a
management station wishing to delete all of the instances
associated with an existing conceptual row

Stripe Size Stripe size used on the array in KBytes. A stripeis a
contiguous region of disk space. RAID distributes data
evenly across component drives in an array by
concatenating interleaved stripes from each drive

Statistic tab

. ASM DPT Module-- NT [195.9.210.53]

File

=118 PM3334LW

B4 Bus: 0
P DDRS-39130w
) DCAS-3ZIEMW
P Bus 1

“-f9 DDRS-39130wW

HEA | Bus I Dswcel Bnay  Statistic |Graph|

[GO:0]DFT  RAID-S

Fead “wfrite
Total Sestors: [B#1 T
Cache Hits - [190 [0
Read&head Hits : [1959 ‘wirite Back : [0
Stripes Crosseds : |12
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C RAID utilities

ltem Description

Read/Total Total number of sectors read from the device

Sectors

Read/Cache Hits Total number of data accesses in which the requested data
was found in the cache

Read Ahead Hits Total number of data accesses in which the requested data
was found in the read ahead buffer

Write/Total Total number of sectors written to the device

Sectors

Write/Cache Hits Total number of data writes to the device in which the data
was written to the cache and not to the disk

Write Backs Total number of data writes to the device in which the data
was written from the cache to the disk at a time when the
device would otherwise be idle

Stripes Crossed Total number of Array Group accesses which cross stripe
boundaries. Only applicable for array devices; otherwise,
zero is returned

Graph tab

. ASM DPT Module- NT [195.9.210.53]

Eile

E m PHI334LW
=@ Bus: 0

é & Bus: 1

Ti4
B

--§f) DDRS-39130w
- DCAS-32160w

- DDRS-39130w

HBA I Bus I Devicel Aaray I Statistic  Graph

[:0:0] OPT  RAIDS

-Read * 100

~¥rite * 100

s C T8
Tmes
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ltem Description

Read/Total Total number of sectors read from the device
Sectors
Write/Total Total number of sectors written to the device

Sectors
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) AcerAltos 3102RS utility

AcerAltos 3102 RAID Controller monitor window

This window is used to monitor the AcerAltos 3102 RAID Controller
information. The upper left window displays the hierarchical view of the
controller structure, and the upper right window shows the logical drive
information.

Controller tab

This window is used to monitor the AcerAltos 3102RS RAID Controller
Information.

ASMNT-UNICENTER — 3102RS5 - SCSI Bus : aic7fxx Index 1

E) LG 0 4357 MEB
BILG1: 4357 ME

& CHL 0 - Host Channel
& CHL 1 - Drive Charnel
g 1D:1-IBM  DDRS-34560W 4357 MB
& CHL 2 - Drive Channel
& 1D:1-1BM  DDRS-34560W 4357 MB

Contraller | Channel | Drive: | il Sta. | Ctl. 6. | Disk Sta. | PDisk G. | LDisk G. | Device |

| Walue | -
Hardware 1D 304
Hardware Revision 1

Controller Clazs Target Controller

Host Channel Count

Crive Charnnel Count
et i

Firmware Yersion 2110 b
Serial Mumber 3033475

Memory Type EDO Rk

Tatal Channel Count 3

]

A an

Channel tab

This window is used to monitor the AcerAltos 3102RS RAID Controller

Channel information.



A83102R5 w211
ok CHL (- Host Charinel
CHL 1 - Drive Channel

ASMNT-UNICENTER — 3102RS - SCSI Bus

LB ID:1-1BM  DDRS-34560W¢ 4357 MB
E@ CHL 2 - Drrive Channel
e ID:1-1BM  DDRS-34560w 4357 MB

:aicf8xx Index 1

E) LG 0 4357 MEB
BILG1: 4357 ME

Logical Drive

Contraller Channel | Drive: | il Sta. | Ct. 6. | Disk Sta. | PDisk G. | LDisk G. | Device |

| Walue | -
Channel Type SCSI
Max. SCSIID 18
Max. SCSI Lun g
Channel Mode Host Mode
SC5I Termination Enable
SCSI Parity Enable
Support LUM > 0 Dizable -
Chanrel [0 16
Max. Sync Clock 2MB/Sec
Current Sync Clock 40 MB/Sec LI

Drive tab
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This window is used to monitor the AcerAltos RAS700 RAID Controller

Drive information.

A83102R5 w211
& CHL 0 - Host Channel
& CHL 1 - Drive Channel

BASMNT-UNICENTER — 3102RS - 5CSI Bus : aic78xx Index 1

4357 MB

4357 MB

BILG1: 4357 ME

Contraller | Channel  Drive | il Sta. | Ctl. 6. | Disk Sta. | PDisk G. | LDisk G. | Device |

Physical Drive Logical Drive
Drive 1D : [ Lur: o Logical D : ID
Slot: 2 Size : [4357 ME Size : [4357 MB

Maodel : IIBM DDRS-34560W

Speed: [40MB/Sec

Datawidth : fifide

Status : [On Line

i
i

RD Level : [NonREID
Status : IGood
Tatal Drive : I
OnlinesSpare/Fail : IW
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Controller statistic tab

This window is used to monitor the AcerAltos 3102RS RAID Controller
Statistic information.

& CHL 0 - Host Channel
CHL 1 - Dirive Channel
B D:1-1BM  DDRS-34560W 4357 ME
CHL 2 - Dirive Chaninel
: ID:1-1Bt  DDRS-34560W 4357 MB

B LG 1 4357 MB

Controller | Charnel| Drive | Ctil Sta. | Ctl . | Disk Sta. | PDisk G. | LDisk 6. | Deviee |

— Requests / Second— ——————Emors / Second——————————————
Fiead: | i} SCSI Bus Reset: o
wiite: | 1} Select-Timeout : [

Tatal: | 0 Unespected Discornects: o
Unespected Phase Ernars: [

— Sectorz / Second —

Timeouts : 10 Paiity Errars : [0
Fead: [ a Undefined Errars : [0
it : | a Mot Feady Eroes: [0
Total: | 0 ECCComected Emors: 0

Controller statistic graph tab

ASMNT-UNICENTER — 3102RS - SCSI Bus : aic78xx Index 1
AA302R5 w211
&% CHL 0- Host Channel
-8 CHL 1 - Drive Channel
.~ ~BID:1-IBM DDRS-560W 4357 MB
-8 CHL 2 - Drive Channel
ID:1-1BM  DDRS5-345600 4357 MB

A=

B LG 0: 4357 ME
BILG1: 4357 ME

Conlrollerl Channell Diive | Cirl. Sta.

Disk Sta. | PDisk G. | LDisk G. | Device |

12.0 ~ ReadReg

ch — Wfnte Req. g

Req. i Sec.
@
=

t J
A6:42:499 16:42:54 16:43:59
Times
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Disk statistic tab

This window is used to monitor the AcerAltos 3102RS RAID Controller Disk
Statistic information.

ASMNT-UNICENTER — 3102R5 - SC51 Bus : aic78xx¢ Index 1

A43102R5 v2.11
& CHL 0 - Host Channel B LG 0: 4357 ME

& CHL 1 - Drive Channel LG 1: 4357 MB
B ID1-BM DDRS-34560W
=t & CHL 2 - Drive Channel
ID:1 - 1BM  DDRS-34560

4357 MB

4357 MB

Controller| Channel | Diive | Ctl Sta.| Ct. G, Disk Sta | PDisk &. | LDisk &. | Device |

Physical Dri

[D:1-1BM  DDRS-34560W/
—— Requests / Second

Logical D

|LG 0: 4357 ME
Requests / Second

4357 MB

Read: | o Wite: i}
Tatal: | i}

Read | 0 ‘wiite: | ]
Tatal : | ]

Sectors / Second

Sectors / Second

Read:[ 0 ‘Wite: [ g
Tatal | ]

Read: [ g ‘Wwite: [ g
Taotal : | 1]

Physical disk statistic graph tab

ASMNT-UNICENTER — 3102RS - SCSI Bus : aic7fxx Index 1

#AT102RS w211
& CHL 0 - Host Channel B LG O: 4357 MB

& CHL 1 - Drive Charnel LG 1: 4357 ME

B 10:1-1BM  DDRS-34560W 4357 MB
E@ CHL 2 - Drrive Channel
ID:1-1BM  DDRS-34560w 4357 MB

LDisk G. | Device |

Eontrollerl Ehannell Drive I Chrl. Sta.l Chrl. G.I Disk Sta.

2e0
5 240 ReadRey.
e .
I i — Write Req. g
4.0
0 T 1
A6:45:44 A6:45:48 A6:45:54

Times
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Logical disk statistic graph tab

ASMNT-UNICENTER — 3102RS5 - SCSI Bus :

AA02RS w211
&% CHL 0 - Host Channel
|- CHL 1 - Drive Charinel

aic? 8xx¢ Index 1

BILG1: 4357 ME
4357 MB

4357 MB

Contraller | Channel | Drive | Ctl Sta. | Ctl. G. | Disk Sta. | PDisk G, LDisk . | Devics |

52.0 — Fead Reg.
416
3.2 — 1
on Wiite Re. g
0.4

0 t i
A6:45:19 A6:45:24 A6:45:29

Times

5

Req. f Sec.

This window is used to monitor the AcerAltos RAS700 RAID Controller
peripheral box information. The displayed information is shown below:

ASMNT-UNICENTER -- 3102R5 - SCSI Bus : aic78xx Index 1 _[Ex]
AAF102R5 v2.11 [ |

& CHL 0 - Host Channel

EJ LG 0: 17366 MB
-8 CHL 2 - Drive Channel
LB 1D:0 - SEAGATE ST39102LC 8683 MB

Cantraller | Channel| Drive | Ot Sta. | Cl. G, | Disk Sta. | PDisk G. | LDisk G, Device |

Device - Redundant Control ———————
Power Suply: [0 Configuration : [Dizable
Fan: [OK Status: [nactive

Origional Rale - iF'rimaw

uPs: s Current Role : iF'rimaW

ey

|
Temperature : lN i !
|
|
|







If the system has an APC UPS system installed
and has the APC UPS system subagent running
(for Windows NT and NetWare available right
now) then you can monitor and control the APC
UPS system remotely through ASM Console.

There are three parts to the APC UPS System
Control window: Information, Battery and
Control.
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) Information tab

41 — APC UPS control

Information | Balter_l,ll Conlroll

UFS Model : FF’C Smart-LIPS UFS Output : |‘I18VAE
[t Line Minimum : |'I 04var
Ident Name : [UFS for Line Mazximun : [I05YAT
Firmware Rew. : |KWD UFS Temp : |32"E /BIF
Diate: of banut. : |1D.-"29.-"98 Output Freq. : |ED Hz
Senal Mumber : 55?59544055954 Ambient Temp : |N,,.'A
Statug ; IND[ma| Hurnidity © [/
Last Self Test: IDK Test Date : [03/21/97 Bad Batt Packs : IN;’A
Battery Capacity LItility UPS Load

Item Description

UPS Model Model ID of the UPS device

Ident Name An 8 byte ID string identifying the UPS. This object can be
set by the administrator

Firmware Rev. Firmware revision of the UPS system's microprocessor

Date of Manuf. Manufacturing date of the UPS in mm/dd/yy format
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D APC UPS system utility

Item Description

Serial Number

An 8 byte string identifying the serial number of the UPS
internal microprocessor. This number is set at the factory.
NOTE: This number does NOT correspond to the serial
number on the rear of the UPS

Status Status of the UPS batteries. Low value indicates the UPS
will be unable to sustain the current load, and its services
will be lost if power is not restored

UPS Output Output voltage of the UPS system in VAC

Line Minimum

Minimum utility line voltage in VAC over the previous
1-minute period

Line Maximum

Maximum utility line voltage in VAC over the previous
1-minute period

UPS Temp

Current internal UPS temperature

Output Freq.

Current output frequency to the UPS system in Hz

Ambient Temp

Ambient temperature

Humidity

Relative humidity as a percentage

Last Self Test

Results of the last UPS diagnostics test performed

Test Date

Date the last UPS diagnostics test was performed in
mm/dd/yy format

Bad Batt Packs

Number of external battery packs connected to the UPS
that are defective. If the UPS does not use smart cells then
the value is N/A

Battery Capacity

Remaining battery capacity expressed in percent of full
capacity

Utility

Current utility line voltage in VAC

UPS Load

Current UPS load expressed in percent of rated capacity
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) Battery tab

41 — APC UPS control

Infarmation ~ Battery I Conlroll

B attem

Bazic Time : IDD:DD:DD Time Femaining : ID1:29:DD
Last Replace Date : |‘| 0/29/99

Statu Meed Replace Battery Packs
Total :
BDK 8_8 NO Bad: N/A

Yoltage
Input Output
Phase: |1 [i
Wolage : [105VAC [118WAC
Frequency: [60Hz |50 Hz

Iput Line Fail Caze |Brown out

Output Status : ID"' Triet B

Input M ax Line Yoltage : |‘| 05 WaC Output Load ; |‘| 4%
Input Min Line Yoltage : I‘I 044AC Olutput Curent : INM

Item Description

Basic Time Elapsed time since the UPS has switched to battery power
Time Remaining UPS battery run time remaining before battery exhaustion
Last Replace Date when the UPS system's batteries were last replaced
Date in mm/dd/yy format. For Smart-UPS models, this value is

originally set in the factory. When the UPS batteries are
replaced, this value should be reset by the administrator

Status Unknown, OK, or Low for status of UPS batteries

Need Replace Indicates whether the UPS batteries need replacing
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Item Description

Battery Packs/ Number of external battery packs connected to the UPS. If
Total the UPS does not use smart cells then the value is N/A
Battery Packs/ Number of external battery packs connected to the UPS
Bad that are defective. If the UPS does not use smart cells then

the value is N/A

Phase Current input/output phase

Voltage Input/output voltage of the UPS system in VAC

Frequency Current input/output frequency to the UPS system in Hz
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Item Description

Input Line Fail The reason for the occurrence of the last transfer to UPS
Case battery power. The variable is set to:

NoTransfer(1)
HighLineVoltage(2)

Brownout(3)

Blackout(4)

SmallMomentarySag(5)

DeepMomentarySag(6)

SmallMomentarySpike(7)

LargeMomentarySpike(8)

if there is no transfer yet

if the transfer to battery is
caused by an over voltage
greater than the high transfer
voltage

if the duration of the outage is
greater than five seconds and
the line voltage is between
40% of the rated output
voltage and the low transfer
voltage

if the duration of the outage is
greater than five seconds and
the line voltage is between
40% of the rated output
voltage and ground

if the duration of the outage is
less than five seconds and the
line voltage is between 40% of
the rated output voltage and
the low transfer voltage

if the duration of the outage is
less than five seconds and the
line voltage is between 40% of
the rated output voltage and
ground

if the line failure is caused by a
rate of change of input voltage
less than ten volts per cycle

if the line failure is caused by a
rate of change of input voltage
greater than ten volts per cycle

Output Status The current state of the UPS. If the UPS is unable to
determine the state of the UPS this variable is set to
unknown(1). There are 12 defined values:

unknown(1)
onLine(2)
onBattery(3)
onSmartBoost(4)
timedSleeping(5)
softwareBypass(6)

off(7)

rebooting(8)
switchedBypass(9)
hardwareFailureBypass(10)
sleepingUntilPowerReturn(11)
onSmartTrim(12)
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Item Description

Input Max Line Maximum utility line voltage in VAC over the previous
Voltage 1-minute period

Input Min Line Minimum utility line voltage in VAC over the previous
Voltage 1-minute period

Output Load Current UPS load expressed in percent of rated capacity

Output Current Current in amperes drawn by the load on the UPS
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) Control tab

AA4T — APC UPS control

Informationl Battery Contral I

Turn On | Turn DIFf | Sleep |

FeB oot | Flash & Beep | Simulate Power Fail |

Operating Parameter Automatic Test Schedule
Hominal UPS Output © " Unknovn € Biieskly

I120 jv WAC  Wieskly At Tumin

High Transfer Paint :

i+ Never
[132 ~| vac _ s |

Low Transfer Paint : Self Test

I‘IDB vl WAL Last Test Date : |U3,-'21 97

Sensitivity : Test Fesult : IDK
[High 4|
9 Cornm Port : IUK

Set

Item Description

Turn On Pressing this button causes the UPS to be turned on
immediately. This action is only available with the APC
Mini-SNMP Adapter

Turn Off Pressing this button causes the UPS to shut off. When in
this state, the UPS will not provide output power regardless
of the input line state. The ON/OFF switch on the UPS
must be toggled for the UPS to return to operation

Sleep Pressing this button causes the UPS to go to sleep. When
in sleep mode, the UPS will not provide output power
regardless of the input line state. Once the specified time
has elapsed, output power will be restored
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Item Description

Reboot Pressing this button causes the UPS to shut off and turn
back on

Flash & Beep Pressing this button to cause the UPS to beep and at the
same time turn on the UPS front panel lights (Smart-UPS
only)

Simulate Power Pressing this button causes the UPS switch to battery

Fail power

Operating The nominal output voltage from the UPS in VAC. Possible

Parameter/ values are 100, 120, 208, 220, 225, 230 and 240

Nominal UPS NOTE: Only units that are 220, 225, 230 and 240 can be

Output changed. Allowable set values are 220, 225, 230, and 240

For these adjustable units, if a value other than a supported
value is provided in a set request, the UPS interprets it as
the next lower acceptable value. If the provided value is
lower than the lowest acceptable value, the lowest
acceptable value is used

Operating The maximum line voltage in VAC allowed before the UPS
Parameter/High system transfers to battery backup
Transfer Point Allowed values depend on the UPS used:

100 volt units allow settings of 108, 110, 112, and 114

120 volt units allow settings of 129, 132, 135, and 138

208 volt units allow settings of 224, 229, 234, and 239

230 volt units allow settings of 253, 264, 271, and 280
NOTE: Matrix units configured for 208V input allow settings
of 240, 244, 248, and 252. Matrix units configured for 240V
input allow settings of 276, 264, 253, and 282. If a value
other than a supported value is provided in a set request,
the UPS interprets it as the next lower acceptable value. If
the provided value is lower than the lowest acceptable
value, the lowest acceptable value is used
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Item Description

Operating
Parameter/Low
Transfer Point

The minimum line voltage in VAC allowed before the UPS
system transfers to battery backup
Allowable values depend on the UPS used:

100 volt units allow settings of 81, 83, 85, 87

120 volt units allow settings of 97, 100, 103, 106

208 volt units allow settings of 168, 172, 177, 182

230 volt units allow settings of 188, 196, 204, 208
NOTE: Matrix units configured for 208V input have a fixed
low transfer voltage of 156 volts. Matrix units configured for
240V input have a fixed low transfer voltage of 180 volts. If
a value other than a supported value is provided in a set
request, the UPS interprets it as the next higher acceptable
value. If the provided value is higher than the highest
acceptable value, the highest acceptable value is used

Operating
Parameter/
Sensitivity

Sensitivity of the UPS to utility line abnormalities or noises

Automatic Test

UPS system's automatic battery test schedule

Schedule

Self Test/Last Test ~ Date the last UPS diagnostics test was performed in
Date mm/dd/yy format

Self Test/Test Results of the last UPS diagnostics test performed
Result

Self Test/Comm Status of agent's communication with UPS

Port
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E ASM Adaptec CI/O
utility



Adaptec CI/O Array Management software is the interface to all
Adaptec array solutions, simplifying array management and
providing seamless scalability through a built-in upgrade path.

With Adaptec’s CI/O Array Management software, network
managers can monitor and manage storage either locally or
remotely from any PC or workstation on the network. The
management software allows network managers to see at-a-
glance both physical and logical array configurations and other
SCSI peripherals for any server using Adaptec array adapters
and controllers.

This utility monitors status about storage devices and relative
information of Adaptec controller. The sections below give a
brief description of the utility.



503

) Adaptec CI/O monitor window

#MONET — CI10 Information
Controller | Devicel Bus Portl Volumel Stat\slicl

MIE Version :

Cantroller :

Index | Mame I P | UpTime
AIC7E400 2 :21:52

Operational Statu
Status:[Unknown Usage Status : Unknown
Spare: W Enror [Fatal/Majorwaming/ Current] :
Avvailibiity : | Inknovn [ 0/0/0/0
Administrative ; W Predicted Faiure : W

The upper left window displays the hierarchical view of the controller
structure, and the upper right window shows is the logical drive
information.

Controller tab

This window is used to monitor the Adaptec CI/O Controller Information.
The information displayed is shown below:

Item Description

MIB Version The revision number of the CIO SNMP agent

Controller

Index A unique index for each storage controller

Name Name, brand, and hardware revision level of the storage

controller




504 E ASM Adaptec CI/O utility

Item Description

Protection Indicates whether or not the controller provides
Management redundancy or protection against device failures
Up Time The number of seconds that have passed since this

controller was last powered on

Operational Status

Spare For objects which reference this operational state and
which are sparing some other object this attribute
describes sparing status

Availability The availability of the object
Administrative The administrative state of the object
Usage The usage state of the object

Error Count Fatal, The accumulated Fatal or Non-recoverable error count for

the object
Major, The accumulated Major or Critical error count for the object
Warning, The accumulated Warning or Non-critical error count for
the object

This attribute presents the current error status for the
object. The most critical error status in effect should be
presented

Current

Predicted Failure Enumeration describing the current Device Predicted
Failure Status (e.g. the S.M.A.R.T. status of the object)




Device tab

MONET — CIO Information

Controller  Device | Bus F’ortl Volumel Statisticl
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Mumber of Device : |3

|ndex | Type | Diescription | State | Usage |
1 3 FUNITSU M23520-512 0142 Unknown Unknown
2 3 SEAGATE ST32151%W 0526 Unknown Unknawn
3 3 IBM  DDRS-34560W  S97E Unknovn Unknawn

Elock Size: [Unknown Media Removable : |Unknown

Index: 1 -FUIITSU M28520-512 0142

Farmatted Capacity ; m Media Loaded : W
Removable Device: [Unknown  SupportCompression: Unkrown
Dievice Loaded : Unknown Support Encryption : [Unknawn
Operational Statu:
Spare W Error [Fatal/M ajor/ v arning/Curent] :
Availbiity: Urknown | 0/0/0/0
Ludrniriztrative W Predicted Failure : W

This window is used to monitor the Adaptec CI/O Device Information.
Under this tab the displayed information is as shown below:

Iltem Description

Number of Device

The Total number of storage devices

Index A unique index value for each storage device beginning
with 1

Type The type of this mass storage device

Description A longer description of the storage device

State The operational status of the object

Usage The usage state of the object
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Item Description

Device Status

Block Size The size in bytes of the data blocks used on the storage
media. If the media block size is unknown or inconsistent
then this value shall be zero

Formatted Media The total size in kilobytes of this storage media after it has
Capacity been formatted

Removable If true, then this storage device is removable (e.g. PCMCIA
Device device)
Device Loaded If true, then the storage device is loaded

Removable Media  If true, then the media in this storage device

Media Loaded If true, the media in this storage device is loaded
Support If true, the storage device supports compression
Compression

Support If true, the storage device supports encryption

Encryption
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Bus port tab

#MONET — C10 Information

Cuntmllarl Device Bus Port |Vulume| Slal\slicl

Number of Port ;14

—Pait1: SCSIID: 7

Protocal ; SCSIPARALLEL(3)

gCSI o ? tﬂm g Protocal Description : [SCS| Parallel
SCSHD: 3. LUN: 0 Signal Characteristic : singleEnded(3]
No

Supports lsochronous ©

Masiroum Width : (3 Bits

Mawimum Transter Rate : [0 MBytes

M awimun Attachments : (S

Connector Type ; junknawn(2)

Connector Description : 3051 cannectar

Cannector Gender : female(3]

This window is used to monitor the Adaptec CI/O Controller Device
information. Under this tab, the displayed information is as shown below:

Item Description

Number of Port Total number of ports

Port Information

Protocol The protocol describing the electrical characteristics of the
Bus Port. If 'Other' is used, then the Protocol Description
attribute shall be used

Protocol Additional description of the protocol describe above
Description

Signal The electrical characteristics of the Bus Port being
Characteristics described

Support Indicates whether or not the bus port supports isochronous
Isochronous transfers

Maximum Width The maximum width, in bits, of this Bus Port's data path. A
value of 1 should be used for serial
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Item Description

Maximum The theoretical maximum transfer rate, in millions of bytes

Transfer Rate per second, that this Bus Port is capable of achieving under
ideal conditions. A value of zero should be used if the
transfer rate is less than 1 million bytes per second

Maximum The maximum number of directly addressable entities
Attachments supported by this bus port's protocol
Connector Type Describes how options (cards, devices, etc.) physically

connect to this port bus. If 'Other' is used, then the
connector type description attribute shall be used

Connector Additional description of the connector described above
Description
Connector Indicates the gender of the connector described above
Gender

Volume tab

#MONET — CIO Information

Contmllerl Devicel Bus Port  Yolume |Statistic|

Wolume Set :

M arne | Capacity (Bytes) |
UMMAMED SIMGLE 4E93461
2 UNMAMED SINGLE 4197404
3 UNMNAMED SINGLE 8324339

This window is used to monitor the Adaptec CI/O Volume information.
Under this tab, the displayed information is as shown below:
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Item Description

Index A unigue index value for each volume set beginning with 1
Name The name of the volume set
Capacity The total size in bytes of the user data space of this volume
set
Statistic tab

#MONET — CIO Information

Conballer| Device | Bus Part] Vohume Statistc |

| M ame |
AICTE00

IBM  DDRS-34560 5578

SEAGATE ST32151W 0526
Device FUNITSU M29520-612 0142

Black -
‘ Fead: 2 Wik : |2 |

‘ Command

Read: 2 “wirite : |2 |

This window is used to monitor the Adaptec CI/O Statistic information.
Under this tab, the displayed information is as shown below:

ltem Description

Blocks Read The number of 512 byte blocks read from the object

Blocks Written The number of 512 byte blocks written to the object

Read Commands The number of read commands issued for the object

Write Commands The number of write commands issued for the object
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F Management system
snap-in modules



This appendix describes how to install and use
various Snap-in modules with the management
system.
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) CA Unicenter TNG

Note: Before installing the snap-in module, make sure that the CA
Unicenter TNG Framework and ASM Console have been installed.

To install the snap-in module, run Setup.exe from the installation CD under
the directory \Console\CA\ to install/uninstall the ASM snap-in module.

This module creates classes and objects in the repository of Unicenter
TNG. The ASM Agent object is created automatically when a new host is
added into the repository (manually added or by auto discovery).

To launch ASM Console from Unicenter WorldView:
1. Find the node you want to monitor.

2. Double-click the node's icon.

Message [
Installed 20 Icon Successiul

Installed 30 Icon Successful

Installed Service Successful

Import definition Successful

3. Right-click the ASM Agent's icon and launch ASM Console from the
context menu.
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Unicenter TNG

Select Repository

TECH_TMGDE *| Find LCancel
Help

If ASM Agent is previously installed, an ASM Agent's icon will appear.
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) HP OpenView

Note: Before installing the snap-in module, make sure that the HP
OpenView Network Node Manager and ASM Console have been
installed.

To install the snap-in module, run Setup.exe from the installation CD under
the directory \Console\OpenView\.

Launch HP OpenView Management Console and select the "Misc\ASM/
ADM Snap in:ASMMon" menu item to auto-discover ASM machines.
Select one ASM machine and then click on the Tools > ASM menu. The
ASM Console launches.

':,'fwg.hcel ASM Snap-in for Unicenter THNG Framework

UInlnstall

hMessage | =1
Installed 30 lcon Successful
Installed ZTervice Successful.
Irmport definition Successful.

Check windowsHNT _Ser-aer [192.9.210.10]
Check YWindowsMHT_Serc-er [192.9.270.1]
Check YWindowsMT_Serc-er [192.9.270.949]
Check Unclassified_TCF [192.9.270.200]

Check Unixhvare [192.9.2710.201]

Creating A5 Object . (Waitfor 10 seconds)

Found Server Agent [192.9.270.949]

Found Hardware Agent192.9.210.99

Found Server Agent[192.9.270.1]

Found Hardware Agent 192.9.210.1

Install Completed.

Festart “Windows T to complete the installation. —

Intel LDCM

Before launching LCDM from ASM Console, make sure that Intel LDCM has
been installed in the system you want to monitor.
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| :1929210.0:Segment1 __ HEEE
ool ] 2] Fulview =

:mn :a.-—n :a.-—n i
o

IS~TECH  MVLI  MOMET PE_8311070] unixware

19292100 Zegment .1

The ASM Console auto-detects the existence of Intel LDCM in the system.
If LDCM was installed, ASM Console automatically adds a menu item in the
Tools menu.
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) MMC (Microsoft Management
Console)

The MMC snap-in module is included in the ASM Server Agent installation
when installed in Windows NT servers.

Follow the setup wizard during installation and click the Next button to go
to the next page. You can also click the Back button to go back to the
previous screen. Choose MMC when prompted to install snap-in
components. A check indicates that the snap-in component wil be installed
into your machine.

To install and run the MMC:

1. Choose Custom setup and then click Next.

Click the type of Setup vou prefer, then click MNext,

i Typical Program will be installed with the most common
optiohs. Recommended far most users.

i~ Compact Prograrm will be installed with minimurm reguired
ophions.
i« Custum r'ou may choose the options you want to install

FPecommended for advanced users.

CAWINNTYASM Browse...
< Back I Mext > I Cancel |

’7Destinati0n Directony
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2. Click MMC and then click Next.

Inthe Options list select iterms you want to install, clear items
youwant to remove. )
Ifyou wantto cancel installing, just press Cancel Buttan

Companents

v SNMP Agent
Dl
Sewver Mif

v Femote Console

Destination Ditectory
’70 SINNTASM

10742 K
283K
350K

2402 K.

Browse... | ‘

Space Reguired

Space Available:

13313 K
154784 K

Disk Space...

<« Back

I Text > I

Cancel I

3. To run MMC, click the Start button in Windows NT and then choose
Programs, Administrative Tools, and then Advanced System

Management.

nﬁ] Component Services

Q Computer Management
Data Sources (ODBC)
5] m Event Yiewsr

% ‘Windows Update

4 % Accessories
2% Documents
Settings
Q Search
@ Help
ﬂ Run...

@ Shut Down,..

¥ = Startup
3 e Internet Explorer
&] Outlook Express

@ Local Security Policy
i @ Performance

L3 % Services

4 ﬁ Telnet Server Administration



4. The MMC main screen appears.

Hane.

[ Description

£ System

&l Storage

B etwork

b Health

o) Onboard device
Bl Resouree
10 device
&JEventLog

Besic System information
Storage Informstion
Network information
Hardware related information
Onboerd. informtion
Resouee information

110 device information
Event Log information
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5. Click the plus (+) sign besides Advanced System Manager to expand
a list of viewable system information.

v || e =] B2
Tres i Hame [ alue I
Machine Name TPE_ED951
|1 Conssle Boot Operating Sysem Misrosoft?Windows NT{TM)
-8 Advanced Systern Man
S Operating System Version Vexsion 8.0 Busld 1381, Servics Pack 5
Handwaze bodel VeeM
BIOS Version Vi2ROLD2  EN
Provsseor Usiknown 400Mz
@) Onbonad device Memory Size 126 MB
W Cachine Size L1352 KBL2512 KB
<o 10 device Login Uer Jean
&) EventLog Demsin/Workgroup MTE?

For more infornation about the MMC, please refer to its online help.
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